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1 基础开发

1.1 工程创建

1.2 工程调试

1.1 工程创建

1.1.1 昇腾工程
MindStudio支持创建三种类型的昇腾工程，详细信息请参见以下对应章节。

● 模型训练工程

● 应用开发工程

● 算子开发工程

1.1.2 非昇腾工程

1.1.2.1 简介

MindStudio支持创建和导入纯语言类工程、Empty工程功能。

1.1.2.2 C/C++工程创建

MindStudio支持创建“C Executable”、“C Library”、“C++ Executable”和“C++
Library”四种类型的C/C++工程，创建方式相似（以下步骤以创建“C++
Executable”为例）。

说明

● 仅支持创建CMake编译框架的C/C++工程。

● C标准支持范围为C90、C99、C11，C++标准支持范围为C++98、C++11、C++14、C++17、
C++20。

● Library工程支持static和shared两种。

● MindStudio支持对.c、.cpp、.cc、.h源文件关键字着色、跳转功能。
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新建 C/C++工程方式

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在New Project窗口中，选择“C++ Executable”，配置工程相关参数如表1-1所示。

表 1-1 工程参数说明

参数 说明

Name 工程名称，自行配置。

名称必须以字母开头，数字或字母结尾。只能包含字母、数
字、中划线和下划线，且长度不超过64个字符。

Location 工程路径，用户可自定义路径。

Language standard C++标准支持范围，默认“C++ 98”。

Library type 库类型，可选“static”、“shared”。

 

步骤3 单击“Finish”，完成工程创建。

若工作窗口已打开其他工程，会出现如图1-1所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 1-1 工程创建提示

步骤4 成功创建工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

导入 C/C++工程方式

步骤1 导入工程文件。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 进入工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打
开。
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说明

如该工程存在代码风险，在打开时会弹出以下窗口。

● 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust project in <
工作区目录>”复选框信任该目录下的所有工程。）

● 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全模式
预览。

● 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 1-2 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图1-3所示提示。

● 选择“This Window”，则直接在当前工作窗口打开工程。

● 选择“New Window”，则新建一个工作窗口打开工程。

图 1-3 工程创建提示

步骤3 成功导入工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

1.1.2.3 Java 工程创建

MindStudio支持创建“Java”和“Gradle”类型的Java工程，创建方式类似（以下步
骤以创建“Java”为例）。

新建 Java 工程方式

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Java”，配置工程相关参数如表1-2所示。
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表 1-2 工程参数说明

参数 说明

Project SDK 选择JDK所需对应软件包。

Additional Libraries
and Frameworks

默认显示“Python”。

 

步骤3 单击“Next”，在“New Project”页面中，选择是否勾选从模板创建工程文件。

● 是：将根据模板，生成有代码工程。

● 否：将不生成代码文件，用户自行创建。

步骤4 单击“Next”，进入配置工程相关参数。如表1-3所示。

表 1-3 工程参数说明

参数 说明

Project name 工程名称，自行配置。

Project location 工程路径，用户可自定义路径。

More settings “Module name”：与“Project name”一致。

“Content root”：根目录下路径。

“Module file location”：模块文件路径。

单击“Project format”右侧选框，出现下拉菜单。

● .idea（directory-based）：创建项目的时候创建一
个.idea的项目目录来保存项目的信息，默认选项。

● .ipr（file-based）：项目配置文件来保存项目的配置信
息。

 

步骤5 单击“Finish”，完成工程创建。

若工作窗口已打开其他工程，会出现如图1-4所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 1-4 工程创建提示
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步骤6 成功创建工程后，工程目录以树状呈现，请以实际创建结果为准。

说明

用户可以通过进入“File > Project Structure…”，在弹出的如图1-5窗口左侧功能栏中选中
“SDKs”并在右侧功能界面单击“+”，选择“Download JDK”，自行下载Java工程的SDK，
SDK的默认访问地址是https://download-cdn.jetbrains.com/jdk/feed/v1/jdks.json.xz。

图 1-5 Project Structure

----结束

导入 Java 工程方式

步骤1 导入工程文件。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 进入工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打
开。

说明

如该工程存在代码风险，在打开时会弹出以下窗口。

● 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust project in <
工作区目录>”复选框信任该目录下的所有工程。）

● 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全模式
预览。

● 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 1-6 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图1-7所示提示。
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● 选择“This Window”，则直接在当前工作窗口打开工程。

● 选择“New Window”，则新建一个工作窗口打开工程。

图 1-7 工程创建提示

步骤3 成功导入工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

1.1.2.4 Python 工程

MindStudio支持创建Python工程，进行Python工程的开发调测，并支持远端进行调测
的能力。

新建 Python 工程方式

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Python”，配置工程相关参数如表1-4所示。

表 1-4 工程参数说明

参数 说明

Project SDK 选择Python SDK所需版本软件包。

Additional Libraries
and Frameworks

默认置灰，显示“Nothing to show”。

 

步骤3 单击“Next”，进入配置工程相关参数如表1-5所示。

表 1-5 工程参数说明

参数 说明

Project name 工程名称，自行配置。

Project location 用户可自定义路径。

More setting “Module name”：与“Project name”一致。

“Content root”：根目录下路径。
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参数 说明

“Module file location”：模块文件路径。

单击“Project format”右侧选框，出现下拉菜单。

● .idea（directory-based）：创建项目的时候创建一
个.idea的项目目录来保存项目的信息，默认选项。

● .ipr（file-based）：项目配置文件来保存项目的配置信
息。

 

步骤4 单击“Finish”，完成工程创建。

若工作窗口已打开其他工程，会出现如图1-8所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 1-8 工程创建提示

步骤5 成功创建工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

导入 Python 工程方式

步骤1 导入工程文件。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 进入工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打
开。
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说明

如该工程存在代码风险，在打开时会弹出以下窗口。

● 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust project in <
工作区目录>”复选框信任该目录下的所有工程。）

● 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全模式
预览。

● 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 1-9 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图1-10所示提示。

● 选择“This Window”，则直接在当前工作窗口打开工程。

● 选择“New Window”，则新建一个工作窗口打开工程。

图 1-10 工程创建提示

步骤3 成功导入工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

1.1.2.5 Empty 工程创建

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Empty Project”。

步骤3 单击“Next”，进入配置工程相关参数如表1-6所示。

表 1-6 工程参数说明

参数 说明

Project name 工程名称，自行配置。

Project location 工程路径，用户可自定义路径。
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参数 说明

More setting 单击“Project format”右侧选框，出现下拉菜单。

● .idea（directory-based）:创建项目的时候创建一个.idea
的项目目录来保存项目的信息，默认选项。

● .ipr（file-based）：项目配置文件来保存项目的配置信
息。

 

步骤4 单击“Finish”，完成工程创建。

若工作窗口已打开其他工程，会出现如图1-11所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 1-11 工程创建提示

步骤5 成功创建工程后，会自动弹出如图1-12所示设置窗口，需要用户手动创建或导入
Module模块。

图 1-12 Project Structure 设置窗口

步骤6 设置完成单击“OK”，工程目录以树状呈现，请以实际创建结果为准。

----结束

1.1.3 工程转换
MindStudio支持非昇腾工程转换为昇腾工程的功能。
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操作步骤

步骤1 导入工程文件。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 进入工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打
开。

说明

如该工程存在代码风险，在打开时会弹出以下窗口。

● 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust project in <
工作区目录>”复选框信任该目录下的所有工程。）

● 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全模式
预览。

● 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 1-13 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图1-14所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 1-14 工程创建提示

步骤3 单击菜单栏 “Ascend > Convert To Ascend Project”，如图1-15所示。
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图 1-15 工程转换

步骤4 弹出如图1-16窗口。

图 1-16 转换昇腾工程配置

对窗口参数介绍如下，用户请根据实际场景选择：

● Project Type：可选择三种工程类型，分别为Ascend Operator、Ascend Training
和Ascend App。

● Framework：可选择框架如表1-7所示。

表 1-7 FrameWork 可选框架

Project Type Framework

Ascend Operator MindSpore

PyTorch

TensorFlow

ONNX

Ascend Training MindSpore
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Project Type Framework

PyTorch

TensorFlow

Ascend App Ascend ACL App

Ascend Python ACL App

Ascend MindX SDK App

 
● Project Desc：项目描述。

步骤5 单击“OK”，工程目录以树状呈现。此时成功创建带有.project文件的昇腾工程，请以
实际创建结果为准。

----结束

1.2 工程调试

1.2.1 C/C++代码调试

说明

支持在Linux环境与Windows环境进行应用工程调试，并具备远程调试的功能。

1.2.1.1 调试前准备

GDB 安装

若环境中未安装GDB，则需要安装GDB，可通过包管理（如apt-get install gdb、
yum install gdb）进行安装。

如无法使用包管理安装GDB，则需通过源码编译方式安装GDB，操作步骤如下：

步骤1 获取GDB源码（获取链接），如获取“gdb-8.1.1.tar.gz”。

步骤2 解压GDB源码压缩包，以“gdb-8.1.1.tar.gz”为例。
tar -zxvf gdb-8.1.1.tar.gz

步骤3 进入到GDB目录文件，配置编译参数：
cd gdb-8.1.1
./configure --host=aarch64-linux-gnu --prefix=/home/install/gdb

“--host”为可选参数，在需要交叉编译安装GDB时使用。“aarch64-linux-gnu”为
用户获取的交叉编译器示例。

“/home/install/gdb”为指定安装目录示例，请用户自行替换。

步骤4 编译。
make -j8
make install

步骤5 配置环境变量。
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export PATH=/home/install/gdb:$PATH

步骤6 查看GDB是否安装成功。
gdb --version

如出现类似如下回显，表明安装成功。

GNU gdb (GDB) 8.1.1
Copyright (C) 2018 Free Software Foundation, Inc.
License GPLv3+: GNU GPL version 3 or later <http://gnu.org/licenses/gpl.html>
This is free software: you are free to change and redistribute it.
There is NO WARRANTY, to the extent permitted by law.  Type "show copying"
and "show warranty" for details.
This GDB was configured as "x86_64-pc-linux-gnu".
Type "show configuration" for configuration details.

----结束

1.2.1.2 编译与运行配置

1.2.1.2.1 昇腾工程

操作步骤

步骤1 在工具栏选择“Build>Edit Build Configuration...”进入编译配置界面。

在“Build Type”处选择“Debug”，单击Build进行编译，生成用于debug的可执行

文件同时工具栏中debug图标 将点亮，生成的可执行文件在编译结果中查看。

步骤2 在工具栏选择“Run>Edit Configurations...”进入运行配置界面。

● “Executable”：选择编译用可执行文件的路径，选择到文件一级。

● “Run Mode”：选择本地调试（Local Run）或者远程调试（Remote Run）。

● “Environment Variables”：此处直接输入动态链接库路径，如图图1-17。

图 1-17 动态链接库目录

或者单击 ，在弹出的界面内单击 ，填写路径。

图 1-18 环境变量填写
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步骤3 如果选择本地调试，单击Apply后单击OK结束配置。

如果选择远程调试，需要在SSH Connection处配置远程连接的服务器，单击Apply后
单击OK结束配置（具体请参见SSH连接管理）。

----结束

1.2.1.2.2 非昇腾工程

配置“C/C++"工程支持本地和远程编译的功能。

操作步骤

步骤1 （可选）指定“CMakeLists.txt”编译配置文件。

在工程界面左侧目录找到“CMakeLists.txt”文件，右键弹出并单击如图1-19示例所示
“Load CMake Project”，即可指定此配置文件进行工程编译。

图 1-19 右键指定 CMakeLists.txt 编译配置文件

步骤2 在工具栏选择“Build>Edit Configurations...”进入编译配置界面，单击“+”按钮，
添加配置选项如图1-20所示。
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图 1-20 Edit Configurations 配置

表 1-8 Edit Configurations 配置说明

参数及图标 说明

Name 配置名称自定义，默认：“Debug”。

Build type 配置类型，可选：“Debug”或“Release”。

Toolchain 工具链配置器，配置详情请参见CMake编译配置，支持
本地和远程编译功能。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Debug”。

Build directory 编译目录相对路径，该路径是相对于工程目录的路径。

Build options 编译加速选项。

Environment variables 环境变量配置：支持编译前配置环境变量。

 

步骤3 在工具栏选择“Run>Edit Configurations...”进入运行配置界面，用户根据业务需要定
制功能，如图1-21所示。
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图 1-21 运行 Edit Configurations 配置

步骤4 单击“OK”按钮，结束编译与运行配置准备。

----结束

1.2.1.3 断点管理

断点是指在某一行设置一个断点，当程序运行到断点处时暂停执行，然后用户会查看
变量、内存、检查程序逻辑是否正确。您可以设置各种方式的断点，例如让程序暂停
在函数执行的入口处，或者让程序暂停在文件的某一行等。

添加断点

打开想要调试的代码，选定要设置断点的代码行，在行号的区域后面单击鼠标左键，

既可以添加断点，如图1-22所示，断点添加成功后，左侧代码行号处会显示 图标。

图 1-22 添加断点

删除断点

在设置断点的地方，单击左侧的 即可取消断点。

MindStudio
用户指南 1 基础开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 16



Disable 断点

若用户设置了多个断点，执行调试时想使用部分断点又不删除其他断点，则可以通过
该功能将暂不使用的断点Disable，操作方法如下：

右击已经设置断点的代码行号处的 ，在弹出界面中去勾选“Enabled”，可以看到

原有 断点标识变成 ，则再执行调试功能时，该断点不生效。

图 1-23 断点 Disable

Enable 断点

若已经有部分断点设置了Disable，执行新的调试功能时想使原有Disable的断点生效，
则可以通过该功能实现。操作方法如下：

右击已经Disable断点处的 ，在弹出界面中勾选“Enabled”，可以看到原有 断点

标识变成 ，则后续执行调试功能时，该断点生效。

图 1-24 断点 Enable

查看断点

通过该功能，用户可以查看曾经设置过的断点。MindStudio重启以及工程重启后，不
会影响当前工程中已经设置的断点状态和数量。

单击Disable断点或Enable断点界面的“More(Ctrl+Shift+F8)”，弹出图1-25所示断点
查看界面。
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图 1-25 断点查看界面

左侧序号1区域展示了当前代码中所设置的所有断点，序号2对应相应断点的Disable或
Enable功能，序号3为代码展示区域。

● 单击序号1对应断点左侧的复选框，勾选表示该断点Enable，相应序号2处Enable
功能使能，同时序号3对应代码行左侧行号处显示 图标；去勾选表示该断点
Disable，相应序号2处Enable功能去使能，同时序号3对应代码行左侧行号处显示

图标。

● 选中序号1处的断点，单击上方的 可以删除断点，同时序号3代码展示区域，相
应代码行号处的断点图标随之删除。

● 在序号3代码展示区域，相应代码行号处单击，则该行被标记为断点，同时序号1
处会自动增加该断点信息。

1.2.1.4 调试执行

启动调试

1. 设置完断点后，单击工具栏中debug图标 即可启动调试功能。

2. MindStudio界面停下来时，停在设置的第一个断点处，会自动在代码变量所在行
右侧展示该变量的取值信息，调试界面如图1-26的绿色参数信息所示。工程右下
方出现Debugger视图，其中：

– 左侧Frames区域是程序的方法调用栈，在该区域中显示了程序执行到断点处
所调用过的所用方法，越下面的方法被调用的越早。红框中的信息表示当前
调试程序停留的代码行，例如main.cpp程序的第19行。

– 右侧Variables展示变量信息以及线程信息。
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图 1-26 调试工程界面

调试窗口图标解释如表1-9所示。

表 1-9 调试窗口图标说明

图标 名字 作用

Rerun(Ctrl
+F5)

重新执行调试功能。

Resume
program(F9)

继续运行程序，到下一个断点处。

运行一个断点到下一个断点之间需要执行的代
码，如果后面代码没有断点，再次单击该按钮将
会执行完程序。

Stop(Ctrl+F2) 终止调试功能。

View
Breakpoints(C
trl+Shift+F8)

查看所有断点。

查看曾经设置过的断点并设置断点的一些属性，
弹出界面以及功能详细说明请参见查看断点。

Mute
Breakpoints

暂停使用所有断点。

请参见Mute Breakpoints功能。

Step Over(F8) 进入下一行代码。

单击该按钮，程序向下执行一行，如果当前行有
函数调用，该函数将被执行完毕返回，然后到下
一行，同时会显示frame信息和变量信息，详细
操作请参见Step Over功能。

Step Into(F7) 进入函数。

程序向下执行一行。如果该行有自定义函数，则
运行进入自定义函数（不会进入官方库的函
数），同时会显示frame信息和变量信息，详细
操作请参见Step Into功能。
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图标 名字 作用

Force Step
Into(Alt+Shift
+F7)

强制进入函数。

单击按钮，调试时能进入任何函数，包括自定义
函数以及官方库函数，

Step Out(Shift
+F8)

跳出函数。

如果调试时进入了某个函数，若检查该函数没有
问题，则可以使用“Step Out”按钮跳出该函
数，返回到原始位置。详细操作请参见Step Out
功能。

Run to
cursor(Alt
+F9)

运行到光标处。

可以在没有设置断点的情况下，让程序运行到光
标所在行时暂停，同时会显示frame信息和变量
信息，详细操作请参见Run to cursor功能。

 

下面以具体示例介绍各个调试功能。

将变量添加到 Watches 区域

选中要查看的变量，右击选择“Add to Watches”，可以看到变量添加到下方
“ Watches”区域中，如图1-27所示。

图 1-27 将变量添加到 Watches 区域

您也可以单击左侧工具栏的功能按钮，完成更多功能：

● 单击左侧工具栏 添加新的变量到“ Watches”区域中。

● 单击左侧工具栏 删除选中的变量。

● 单击左侧工具栏 复制选中变量，用户可以基于复制后的变量，修改成想要的参
数：

选中复制后的变量，右击选择“Edit”，重新输入新的变量名即可。

● 若 Watches区域变量或线程太多不方便查看变量信息时，可以单击左侧工具栏
打开新的“Watches”窗口，变量会自动呈现到该窗口中，如图1-28所示。单击

“Watches”窗口上方的 ，“Watches”窗口会自动合入“Variables”窗口。

图 1-28 开启 Watches 窗口
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Step Over 功能

1. 设置断点。

2. 启动调试功能，界面停在断点处。

3. 单击 程序向下执行一行。详细示例如图1-29所示。

图 1-29 Step Over 功能

Step Into 功能

1. 设置断点。

2. 启动调试功能，界面停在断点处。

3. 单击 程序向下执行一行。如果该行有自定义方法，则运行进入自定义方法，详
细示例如图1-30所示。
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图 1-30 Step Into 功能

Step Out 功能

若执行调试时，通过Step Into功能进入了一个函数，例如“GetFileList”，若检查该

函数没有问题，则可以通过单击 跳出该函数，返回到原来位置，如图1-31所示。
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图 1-31 Step Out 功能

Run to cursor 功能

若某行代码没有设置断点，用户想调试该行代码，则可以通过单击 ，将断点移到光
标所在代码行，如图1-32所示。
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图 1-32 Run to cursor 功能

Mute Breakpoints 功能

调试过程中，如果想暂停使用所有断点，单击 按钮后，所有断点被置灰，如图1-33

所示，同时该按钮显示灰色底纹，单击 调试代码直接运行完成。
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图 1-33 Mute Breakpoints 功能

1.2.2 Python 代码调试

说明

windows下支持远程python代码的跳转、联想。

1.2.2.1 调试前准备

配置 Python SDK 解析器

为满足应用开发过程中Python代码调试的需求，提供基于Python Community Edition
插件的Python代码调试方法，调试准备如下：

步骤1 添加Python SDK。

1. 在工具栏选择“File>Project Structure...”。

2. 在弹出框左侧选择“Platform Settings>SDKs”，单击“+”，弹出框选择“Add
Python SDK”,如图1-34所示。

图 1-34 配置 Python SDK
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3. 在“Add Python Interpreter”窗口中，选择合适的Python解析器 ，用户自行添
加。可选解析器如表1-10所示。

图 1-35 Add Python Interpreter

表 1-10 Python 解析器选项

解析器 说明

Virtualenv
Environment

集成了Virtual Environment工具，用以创建独立的虚拟环
境。

Conda
Environment

使用Anaconda中带有的Python解释器。

System
Interpreter

系统本地解析器。

Pipenv
Environment

Pipenv是一种工具，提供了为Python项目创建虚拟环境所需
的所有必要手段。

SSH Interpreter 远程解析器。通过SSH方式添加远程设备的Python SDK，并
通过Deployment功能，详细请参见Deployment，可以将指
定项目中的文件、文件夹同步到远程指定机器的指定目录。

 

步骤2 添加项目Python模块。

1. 在工具栏选择“File>Project Structure...”。

2. 在弹出框左侧选择“Project Settings>Modules”，选择“Dependencies”标
签，在Module SDK下拉框选择添加的Python SDK。图1-36为添加示例。
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图 1-36 项目依赖模块添加

----结束

配置文件调试编译

步骤1 在工具栏选择“Run>Edit Configurations...”进入运行配置界面。

步骤2 单击“+”，选择“Python”，新增文件的编译调试配置，如图图1-37中1和2所示。

图 1-37 Add New Configuration
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步骤3 右侧显示配置项，必要项配置相关参数如表1-11所示，其它参数可保持默认，如图
1-38所示。

表 1-11 调试运行参数说明

参数 说明

Name 用户自行定义。

Script path 选择需要编译调试的Python源文件具体路径。

Python interpreter “Use SDK of module”：工程指定好的解析器，如配置
Python SDK解析器步骤。

“Use specified interpreter”：本地/远程解析器，用户自
行切换。

 

图 1-38 源文件配置项示例

步骤4 单击“Apply”后，单击“OK”结束调试配置。

----结束
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1.2.2.2 断点管理

断点是指在某一行设置一个断点，当程序运行到断点处时暂停执行，然后用户会查看
变量、内存、检查程序逻辑是否正确。您可以设置各种方式的断点，例如让程序暂停
在函数执行的入口处，或者让程序暂停在文件的某一行等。

添加断点

打开想要调试的代码，选定要设置断点的代码行，在行号的区域后面单击鼠标左键，

既可以添加断点，如图1-39所示，断点添加成功后，左侧代码行号处会显示 图标。

图 1-39 添加断点

删除断点

在设置断点的地方，单击左侧的 即可取消断点。

Disable 断点

若用户设置了多个断点，执行调试时想使用部分断点又不删除其他断点，则可以通过
该功能将暂不使用的断点Disable，操作方法如下：

右击已经设置断点的代码行号处的 ，在弹出界面中去勾选“Enabled”，可以看到

原有 断点标识变成 ，则再执行调试功能时，该断点不生效。
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图 1-40 断点 Disable

Enable 断点

若已经有部分断点设置了Disable，执行新的调试功能时想使原有Disable的断点生效，
则可以通过该功能实现。操作方法如下：

右击已经Disable断点处的 ，在弹出界面中勾选“Enabled”，可以看到原有 断点

标识变成 ，则后续执行调试功能时，该断点生效。

图 1-41 断点 Enable

查看断点

通过该功能，用户可以查看曾经设置过的断点。MindStudio重启以及工程重启后，不
会影响当前工程中已经设置的断点状态和数量。
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单击Disable断点或Enable断点界面的“More(Ctrl+Shift+F8)”，弹出图1-42所示断点
查看界面。

图 1-42 断点查看界面

左侧序号1区域展示了当前代码中所设置的所有断点，序号2对应相应断点的Disable或
Enable功能，序号3为代码展示区域。

● 单击序号1对应断点左侧的复选框，勾选表示该断点Enable，相应序号2处Enable
功能使能，同时序号3对应代码行左侧行号处显示 图标；去勾选表示该断点
Disable，相应序号2处Enable功能去使能，同时序号3对应代码行左侧行号处显示

图标。

● 选中序号1处的断点，单击上方的 可以删除断点，同时序号3代码展示区域，相
应代码行号处的断点图标随之删除。

● 在序号3代码展示区域，相应代码行号处单击，则该行被标记为断点，同时序号1
处会自动增加该断点信息。

1.2.2.3 调试执行

启动调试

1. 设置完断点后，单击工具栏中debug图标 即可启动调试功能。

说明

● 远程调试的情况下，单击工具栏中debug图标 需要再次输入远程连接的服务器的登
陆密码。

2. MindStudio界面停下来时，停在设置的第一个断点处，调试界面如图1-43工程右
下方出现Debugger视图，其中：
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– 左侧Frames区域是程序的方法调用栈，在该区域中显示了程序执行到断点处
所调用过的所用方法，越下面的方法被调用的越早。蓝色信息表示当前调试
程序停留的代码行。

– 右侧Variables展示变量信息以及线程信息。

图 1-43 调试工程界面
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2 算子和模型速查

算子&模型速查工具帮助客户了解当前版本CANN支持的算子和模型信息。使用该功能
前用户需确保已安装requests库。

2.1 查询算子

2.2 查询模型

2.1 查询算子

查询入口

可以通过如下两种方式进入算子查询界面：

● 在菜单栏选择“Ascend > View Supported Operators”。

● 在菜单栏单击图标 。

说明

如果当前未安装有效的Ascend-cann-toolkit_*.run软件包，会弹出报错信息“No CANN is
found. Please (re)install an CANN in CANN Manager first”。如果出现此报错信息，请检查
Ascend-cann-toolkit_*.run软件包是否正确安装。

算子查询界面

选择“View Supported Operators”或单击图标 后，弹出“Supported Operator
Info”界面（如图2-1所示）。

● 用户可在“Search by Name”输入需要查询的算子名称，或根据算子的类型或硬
件型号筛选需要查询的算子。其中包含算子的以下信息：

– 算子类型（Operator Type）

– 算子支持的硬件型号（Hardware Type）
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图 2-1 Supported Operator Info

● 选中某个算子类型，可在详情页面查看算子具体信息，示例如图2-2。

图 2-2 算子详情示例
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2.2 查询模型

查询入口

可以通过如下两种方式进入模型查询界面：

● 在菜单栏选择“Ascend > View Supported Models”。

● 在菜单栏单击图标 。

模型查询界面
● 支持的模型信息是从昇腾开发者社区的ModelZoo获取。

说明

MindStudio后台是通过ModelZoo.ini文件中的URL：https://apigw-01.huawei.com/api/
ascendcommunity/modelzoo/quickCheck使用公共账号X-HW-ID：
com.huawei.biz.idp_public来获取昇腾开发者社区ModelZoo上支持的模型信息。

● 如果用户环境可以联网，成功获取后台信息，则弹出“Supported Model Info”
界面，显示预训练好的模型，如图2-3所示。界面参数信息说明如表2-1所示。

说明

如果界面显示中文乱码，请参见如何解决中文显示乱码和界面显示不全不规整问题处理。

图 2-3 Supported Model Info

表 2-1 参数说明

参数 说明

Model Name 模型名称。

Application
Area

应用领域，例如图像分类、目标检测。

Categories Id 应用级别，例如Official。

Update Time 更新时间。

Precision 模型精度，例如FP16、INT8。
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参数 说明

Model Type 模型类型，例如离线模型。

Frame 框架，例如PyTorch、TensorFlow。

Processor Type 处理器类型，例如昇腾310、昇腾910。

Version 版本。

Download Link 下载链接，可以复制对应的链接粘贴到浏览器上打开，获取
相应的模型文件。

Model Format 模型格式，例如om、onnx。

File Size 文件大小。

 

可以通过“Search by”后的下拉框选择支持度信息字段或者在输入框中直接输入
关键字进行模型信息的搜索和筛选。

● 如果获取后台信息失败，则弹出ModelZoo对话框，显示ModelZoo的URL，如图
2-4所示。用户可直接访问该URL查询支持的模型。

图 2-4 ModelZoo

● 如果获取ModelZoo的配置文件URL被修改，使得URL域名为非.huawei.com结
尾，则弹出如图2-5所示对话框。

图 2-5 警告窗口

– continue：继续通过该URL查询支持的模型。

– exit：退出查询。
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3 模型训练

3.1 概述

3.2 使用约束

3.3 操作步骤

3.4 模型训练样例参考

3.5 附录

3.1 概述
MindStudio负责运行训练框架，把框架执行的脚本、数据集、参数等相关信息提交给
GE并通过接口指示GE只做网络分析并输出分析结果，MindStudio对网络分析结果进行
界面展示（界面方式提供），对于网络中的不支持算子，支持用户选择触发自定义算
子流程，在自定义算子流程中支持自动生成算子信息库、算子原型库和算子插件。基
于MindStudio的训练流程如图3-1所示。
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图 3-1 业务流程

3.2 使用约束
● 中标麒麟OS7.6-aarch64系统仅提供训练工程创建和配置入口，但不支持进行模型

训练。

● 当前支持MindSpore、TensorFlow和PyTorch框架。

3.3 操作步骤
MindStudio执行模型训练的主要步骤包括：创建训练工程（首次执行训练）/导入训练
工程（已存在训练工程）>运行配置>执行训练。

创建训练工程

当前支持以MindSpore、TensorFlow和PyTorch训练框架为模板创建训练工程，其中
MindSpore可以在完成训练后使用MindInsight组件实现训练过程可视化，MindInsight
详细配置请参见MindInsight训练可视化（Beta）。

步骤1 进入训练工程创建界面，训练工程界面如图3-2所示。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“New Project”，进入创
建工程界面。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”，进入
创建工程界面。

MindStudio
用户指南 3 模型训练

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 38



图 3-2 创建工程界面

步骤2 创建训练工程。

1. 在左侧导航栏选择“Ascend Training”，如图3-2所示，在右侧配置训练工程信
息，配置示例如表3-1所示。

表 3-1 工程信息配置

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字母结尾，
只能包含字母、数字、中划线和下划线，
且长度不能超过64个字符。

MyTraining

Description 工程描述信息，自行配置。 可选配置

CANN
Version

当前CANN的版本号。 选择当前CANN的
版本号

Project
Location

工程的存储路径。 保持默认

 
2. 单击“Next”，进入训练工程选择界面。

3. 训练工程选择界面如图3-3，选择“Templates”下不同框架工程或选择
“Samples”下内置样例，下图选择的为“Templates”下的框架工程，单击
“Finish”完成训练工程的创建。
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图 3-3 训练工程选择界面

说明

当工程选择为TensorFlow工程或样例时，需确保进行模型训练的运行环境（本地环境或远
程环境）中已安装框架插件包Ascend-cann-tfplugin_xxx.run，安装方式请参见《CANN
软件安装指南》中“安装框架插件包”章节。

4. 若工作窗口已打开其他工程，会出现如图3-4所示提示。

– 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

– 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 3-4 工程创建提示

步骤3 查看训练工程目录结构和主要文件。
├── .idea
├── data                                  //数据集目录
├── .project                                 //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN
版本
├── train.py                                //训练脚本文件，为空文件，用户在这里编写训练脚本
├── MyTraining.iml                         

----结束

导入训练工程

如果已有训练工程，则无需新建训练工程，可直接通过MindStudio导入，操作如下。

步骤1 使用MindStudio导入训练工程。
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● 首次登录MindStudio：在MindStudio欢迎界面中单击“Open or Import”，选择
需要导入的工程，单击“OK”确认导入。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > Open...”，选择需要导入
的工程，单击“OK”确认导入。

说明

工程的默认存储路径为安装用户家目录的“AscendProjects”文件夹下。

步骤2 若首次打开工程，将弹出如图3-5所示界面，表示MindStudio提供的功能可能会执行此
工程中的潜在恶意代码，导入工程前需进行确认。

图 3-5 信任窗口

● Trust projects in {此工程所在的目录}：信任此工程所在的目录下的所有工程。

● Trust Project：信任此工程。

● Preview in Safe Mode：在安全模式下预览此工程。

● Don't Open：不打开此工程。

步骤3 若工作窗口已打开其他工程，会出现如图3-6所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 3-6 工程创建提示

----结束

运行配置

步骤1 单击工程界面“Run > Edit Configurations...”或单击图3-7所示菜单，进入运行配置
界面。

图 3-7 快捷方式进入运行配置界面

步骤2 配置训练参数。

● “Run Mode”若选择“Remote Run”，则配置界面如图3-8所示。
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图 3-8 运行配置界面

● “Run Mode”若选择“Local Run”，则配置界面如图3-9所示。

图 3-9 运行配置界面

在右侧配置训练工程运行信息，配置示例如表3-2所示。
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表 3-2 训练工程运行信息

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字
母结尾，只能包含字母、数字、
中划线和下划线，且长度不能超
过64个字符。

MyTraining

Executable 训练工程中的执行入口文件。 /home/xxx/AscendProjects/
MyTraining5/data/
download_cifar10.sh

Run Mode 运行环境选择。选择“Remote
Run”或“Local Run”，默认为
“Remote Run”。

“Remote Run”

Deployment 运行配置。通过Deployment功
能，详细请参见Deployment，可
以将指定项目中的文件、文件夹
同步到远程指定机器的指定目
录。

选择Remote Run模式时可见，
必选配置。

Command
Arguments

训练工程执行参数。 可选配置。

Environmen
t Variables

训练工程环境变量。 可选配置。

 

步骤3 点击“OK”完成训练工程信息的创建。

----结束

执行训练

步骤1 单击工程界面“Run >Run”或单击图3-10所示菜单，执行训练。训练执行过程：连接
远端训练机器 -> 打包训练工程发布到远端训练机器 -> 启动训练工程执行。

图 3-10 快捷方式执行训练

说明

打包训练工程发布到远端训练机器时，不会拷贝后 为.iml文件，不影响功能执行。

步骤2 执行训练后，在工程界面底部“Run”窗口显示运行实时信息，如下图：
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图 3-11 运行实时信息

步骤3 如果训练成功，打印训练成功信息。如果训练失败，在工程根目录下的out/reports下
生成训练工程的整网支持度报告network_analysis_timestamp.report。报告内容如
下：

图 3-12 整网支持度报告

----结束

3.4 模型训练样例参考

3.4.1 概述

本节介绍如何使用昇腾社区ModelZoo上的MindSpore、TensorFlow和PyTorch训练框
架为模板创建训练工程进行MindStudio模型训练。更多训练样例请参见ModelZoo获
取。

使用约束

使用昇腾训练框架为模板，创建训练工程前，用户需确保已安装requests库。
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3.4.2 MindSpore 训练

环境准备

参见MindSpore官方网站安装页面进行运行环境的搭建。使用银河麒麟OS V10 SP1-
aarch架构的用户可参照CentOS-aarch架构搭建运行环境。

注意

● 昇腾社区ModelZoo上MindSpore模型训练脚本是基于安装有昇腾AI处理器的硬件环
境，因此在参考官方网站搭建MindSpore运行环境时，需选择硬件平台为Ascend
910。参见MindSpore官网进行运行环境搭建完成后，需配置Ascend 910 AI处理器
配套软件包的环境变量。

● 如果运行方式为Remote Run时，安装MindSpore的环境为远端环境，MindStudio
部署在本地环境中，请注意区分。

操作步骤

以下为创建基于“ResNet-50 for MindSpore”模板样例的训练工程总体步骤，用户在
操作过程中如需详细了解工程信息及相关弹出窗口，请参见操作步骤。

步骤1 新建Ascend Training工程。

工程信息由用户自行根据实际配置。单击“Next”，进入训练工程选择界面。

图 3-13 创建工程界面

步骤2 训练工程选择界面如图3-14，选择“Samples”下的“ResNet-50 for MindSpore”模
板，单击“Finish”完成模板工程的创建。
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图 3-14 训练工程选择界面

说明

首次创建该样例工程时，工具会下载样例工程模板https://ascend-repo-modelzoo.obs.cn-
east-2.myhuaweicloud.com/c-version/ResNet50_for_MindSpore/zh/1.4/s/
ResNet50_for_MindSpore_1.4_code.zip，请确保所在的设备为联网状态，否则无法进行后续
操作。

步骤3 选择“ResNet-50 for MindSpore”模板样例后工程界面如图3-15所示。

图 3-15 模板工程界面

说明

在Windows系统环境下创建训练样例工程时若出现报错“Unzip failed. There is probleam
occurred when unzipping file.”请参见在Windows系统环境下创建训练样例工程时报错
“Unzip failed. There is probleam occurred when unzipping file.”解决。
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步骤4 用户自行下载cifar10数据集，例如，下载cifar-10-binary.tar.gz。然后拷贝至本地环
境的“data/”（需用自行创建）目录下或者远端运行环境中解压。

说明

拷贝到远端运行环境中需注意将训练脚本中的数据集导入路径需与上传后的数据集路径一致。

步骤5 配置运行参数并运行。

1. 单击训练工程界面“Run > Edit Configurations...”或单击图3-16所示菜单，进入
运行配置界面。

图 3-16 快捷方式进入运行配置界面

2. 配置训练参数，如图3-17所示。

图 3-17 运行配置界面

在右侧配置训练工程运行信息，配置示例如表3-3所示。

表 3-3 训练工程运行信息

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字
母结尾，只能包含字母、数字、
中划线和下划线，且长度不能超
过64个字符。

MyTraining。

Run Mode 运行环境选择。 Local Run。
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参数 参数说明 示例

Deploymen
t

运行配置。通过Deployment功
能，详细请参见Deployment，
可以将指定项目中的文件、文件
夹同步到远程指定机器的指定目
录。

本样例运行环境选择为本地，
即Run mode选择为Local
Run，故此项参数不显示。

Executable 训练工程中的执行入口文件。 scripts/
run_standalone_train.sh。

Command
Arguments

训练工程执行参数。 resnet50 cifar10 ../data/
cifar-10-batches-bin。

Environme
nt
Variables

训练工程环境变量。 可选参数，根据实际自行配
置。

 

说明

训练过程中如果想使用MindInsight进行训练过程可视化，可参见MindInsight训练可视化
（Beta）进行配置。

3. 点击“OK”完成训练工程信息的创建。

4. 单击工程界面“Run >Run”或单击图3-18所示菜单，执行训练。

图 3-18 快捷方式执行训练

训练过程如图3-19所示。

图 3-19 训练过程展示
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步骤6 训练完成后，在scripts/train路径下会生成模型文件.ckpt。

其他操作请参见昇腾社区modelzoo专区ResNet-50模型下的“训练”页签。

----结束

3.4.3 TensorFlow 训练

环境准备

请参见《CANN 软件安装指南》自行安装tfplugin和TensorFlow（1.15.0）并执行以下
命令配置环境变量。

# tfplugin包依赖，可根据不同安装用户执行相应脚本
   # 以root用户安装tfplugin包和toolkit包
   . /usr/local/Ascend/tfplugin/set_env.sh
   . /usr/local/Ascend/ascend-toolkit/set_env.sh
   # 以非root用户安装tfplugin包和toolkit包
   . ${HOME}/Ascend/tfplugin/set_env.sh
   . ${HOME}/Ascend/ascend-toolkit/set_env.sh

请自行准备数据集，参见 TensorFlow模型 > 训练 > 数据集准备的指导完成数据集上
传到训练环境任意目录。

操作步骤

以下为创建基于“ResNet-50 for TensorFlow”模板样例的训练工程总体步骤，用户在
操作过程中如需详细了解工程信息及相关弹出窗口，请参见操作步骤。

步骤1 新建Ascend Training工程。

工程信息由用户自行根据实际配置。单击“Next”，进入训练工程选择界面。

图 3-20 创建工程界面

步骤2 训练工程选择界面如图3-21，选择“Samples”下的“ResNet-50 for TensorFlow”模
板，单击“Finish”完成模板工程的创建。
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图 3-21 训练工程选择界面

说明

首次创建该样例工程时，工具会下载样例工程模板https://ascend-repo-modelzoo.obs.cn-
east-2.myhuaweicloud.com/c-version/ResNet50_for_TensorFlow/zh/1.7/s/
ResNet50_for_TensorFlow_1.7_code.zip，请确保所在的设备为联网状态，否则无法进行后续
操作。

步骤3 选择“ResNet-50 for TensorFlow”模板样例后工程界面如图3-22所示。

图 3-22 模板工程界面

说明

在Windows系统环境下创建训练样例工程时若出现报错“Unzip failed. There is probleam
occurred when unzipping file.”请参见在Windows系统环境下创建训练样例工程时报错
“Unzip failed. There is probleam occurred when unzipping file.”解决。

步骤4 在工程界面左侧目录“src > configs”找到“res50_256bs_xx.py”文件，将环境准备
中数据集的路径配置到“res50_256bs_xx.py”文件内的“data_url”字段下，如图
3-23所示。
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图 3-23 配置数据集路径

说明

MindStudio基于TensorFlow框架的ResNet50模板是在训练脚本的代码中设定了训练参数，如需
自定义训练参数，则需自行学习TensorFlow框架代码。

步骤5 配置运行参数并运行。

1. 单击训练工程界面“Run > Edit Configurations...”或单击图3-24所示菜单，进入
运行配置界面。

图 3-24 快捷方式进入运行配置界面

2. 配置训练参数，如图3-25所示。

图 3-25 运行配置界面

在右侧配置训练工程运行信息，配置示例如表3-4所示。
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表 3-4 训练工程运行信息

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字
母结尾，只能包含字母、数字、
中划线和下划线，且长度不能超
过64个字符。

MyTraining。

Run Mode 运行环境选择。 Local Run。

Deploy 运行配置。通过Deploy功能，
详细请参见Deployment，可以
将指定项目中的文件、文件夹同
步到远程指定机器的指定目录。

本样例运行环境选择为本地，
即Run mode选择为Local
Run，故此项参数不显示。

Executable 训练工程中的执行入口文件。 scripts/train_1p.sh。

Command
Arguments

训练工程执行参数。 可选参数，根据实际自行配
置。

Environme
nt
Variables

训练工程环境变量。 可选参数，根据实际自行配
置。

 

3. 点击“OK”完成训练工程信息的创建。

4. 单击工程界面“Run >Run”或单击图3-26所示菜单，执行训练。

图 3-26 快捷方式执行训练

训练过程如图3-27所示。

图 3-27 训练过程展示

5. 生成的模型文件位于“工程文件/scripts/d_solution/ckptx_{time}”目录。
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步骤6 其他操作请参见昇腾社区modelzoo专区ResNet-50模型下的“训练”页签。

----结束

3.4.4 PyTorch 训练

环境准备

安装PyTorch框架及混合精度模块，详情请参见《PyTorch 1.5.0 网络模型移植&训练
指南》或《PyTorch 1.8.1 网络模型移植&训练指南》的“环境准备”章节。

请自行准备数据集，参见PyTorch模型 > 训练 > 数据集准备的指导将训练集和验证集
图片上传到训练环境的“train/”和“val/”文件夹路径下。

操作步骤

以下为创建基于“ResNet-50 for PyTorch”模板样例的训练工程总体步骤，用户在操
作过程中如需详细了解工程信息及相关弹出窗口，请参见操作步骤。

步骤1 新建Ascend Training工程。

工程信息由用户自行根据实际配置。单击“Next”，进入训练工程选择界面。

图 3-28 创建工程界面

步骤2 训练工程选择界面如图3-29，选择“Samples”下的“ResNet-50 for PyTorch”模
板，单击“Finish”完成模板工程的创建。
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图 3-29 训练工程选择界面

说明

首次创建该样例工程时，工具会下载样例工程模板https://ascend-repo-modelzoo.obs.cn-
east-2.myhuaweicloud.com/c-version/ResNet50_for_PyTorch/zh/1.4/s/
ResNet50_for_PyTorch_1.4_code.zip，请确保所在的设备为联网状态，否则无法进行后续操
作。

步骤3 选择“ResNet-50 for PyTorch”模板样例后工程界面如图3-30所示。

图 3-30 模板工程界面

说明

在Windows系统环境下创建训练样例工程时若出现报错“Unzip failed. There is probleam
occurred when unzipping file.”请参见在Windows系统环境下创建训练样例工程时报错
“Unzip failed. There is probleam occurred when unzipping file.”解决。
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步骤4 在工程界面左侧目录找到“run_xx.sh”文件，将环境准备中训练集和验证集图片的路
径配置到文件内的“data”字段下，如图3-31所示。

图 3-31 配置数据集路径

说明

MindStudio基于PyTorch框架的ResNet50模板是在训练脚本的代码中设定了训练参数，如需自
定义训练参数，则需自行学习PyTorch框架代码。

步骤5 配置运行参数并运行。

1. 单击训练工程界面“Run > Edit Configurations...”或单击图3-32所示菜单，进入
运行配置界面。

图 3-32 快捷方式进入运行配置界面

2. 配置训练参数，如图3-33所示。
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图 3-33 运行配置界面

在右侧配置训练工程运行信息，配置示例如表3-5所示。

表 3-5 训练工程运行信息

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字
母结尾，只能包含字母、数字、
中划线和下划线，且长度不能超
过64个字符。

MyTraining。

Run Mode 运行环境选择。 Local Run。

Deploy 运行配置。通过Deploy功能，
详细请参见Deployment，可以
将指定项目中的文件、文件夹同
步到远程指定机器的指定目录。

本样例运行环境选择为本地，
即Run mode选择为Local
Run，故此项参数不显示。

Executable 训练工程中的执行入口文件。 run_1p.sh。

Command
Arguments

训练工程执行参数。 可选参数，根据实际自行配置

Environme
nt
Variables

训练工程环境变量。 可选参数，根据实际自行配
置。

 
3. 点击“OK”完成训练工程信息的创建。

4. 单击工程界面“Run >Run”或单击图3-34所示菜单，执行训练。
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图 3-34 快捷方式执行训练

训练过程如图3-35所示。

图 3-35 训练过程展示

5. 生成的模型文件位于“工程文件/result”目录。

----结束

3.5 附录

3.5.1 MindInsight 训练可视化（Beta）

概述

MindInsight为MindSpore提供了简单易用的调优调试能力。在训练过程中，可以将标
量、张量、图像、计算图、模型超参、训练耗时等数据记录到文件中，通过
MindInsight可视化页面进行查看及分析。

安装

MindInsight组件为MindStudio的独立组件，请参考开源社区的安装文档，完成
MindInsight组件的安装。

须知

● MindInsight与MindSpore的版本需保持一致。

● 银河麒麟OS V10 SP1-aarch64系统和中标麒麟OS7.6-aarch64系统不支持
MindInsight组件。

安装时默认安装路径为“/usr/local/python/bin/”用户安装时也可指定安装路径。
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配置环境变量：

1. 执行如下命令打开文件系统中的~/.bashrc文件：

vi ~/.bashrc
在文件 后添加如下环境变量：
export PATH=/usr/local/python3/bin:$PATH

“/usr/local/python3/bin”为示例安装路径，请根据实际情况配置。

:wq!保存退出。

2. 执行命令使环境变量生效。

source ~/.bashrc
3. 验证是否成功安装。

执行如下命令：

mindinsight start
如果出现下列提示，说明安装成功。
Web address: http://127.0.0.1:8080
service start state: success

4. 重启MindStudio以启用MindInsight组件。

操作步骤

MindStudio为MindInsight提供了配置入口界面，用户可通过配置界面设置
MindInsight相关参数。用户可以根据自己需求，使用MindStudio创建基于MindSpore
框架训练工程，在训练工程创建后可以随时启动MindInsight，查看训练的可视化信
息。

步骤1 修改训练脚本。

使用MindInsight前，需要修改训练脚本，使用 SummaryCollector 进行数据收集后将
训练过程中的数据记录下来，并指定所保存的数据的位置。在训练脚本train.py中添加
如下代码：

# 在导入模块添加代码
from mindspore.train.callback import SummaryCollector

# 在if config.save_checkpoint语句块后添加加粗代码
if config.save_checkpoint:
        config_ck = CheckpointConfig(save_checkpoint_steps=config.save_checkpoint_epochs * step_size,
                                     keep_checkpoint_max=config.keep_checkpoint_max)
        ckpt_cb = ModelCheckpoint(prefix="resnet", directory=ckpt_save_dir, config=config_ck)
        cb += [ckpt_cb]
summary_collector = SummaryCollector(summary_dir='./summary_dir',collect_freq=32)
cb += [summary_collector]

# 将代码中的dataset_sink_mode值修改为False
    model.train(config.epoch_size - config.pretrain_epoch_size, dataset, callbacks=cb,
                sink_size=dataset.get_dataset_size(), dataset_sink_mode=False)

此处的“summary_dir”为相对于当前训练脚本下的路径。

步骤2 进入MindInsight管理界面。

在工具栏选择“Ascend >MindInsight”打开MindInsight管理界面。MindInsight管理
界面可显示并管理多个MindInsight训练可视化工程。MindInsight管理界面相关属性
说明如表3-6所示。
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图 3-36 MindInsight 管理界面

表 3-6 管理界面属性说明

属性 说明

Run Config 训练工程中的运行配置信息。

Run Type 训练工程运行类型。

MindInsight Staus MindInsight状态。

● ENABLE：开启

● DISABLE：停止

 

用户可在图3-36选择需要可视化的训练工程，然后单击“Enable”按钮打开并配置
MindInsight组件的相关参数界面。

步骤3 配置MindInsight组件相关参数。

用户可在图3-37配置训练可视化相关参数。由用户自行根据实际情况配置参数。
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图 3-37 MindInsight Enable 参数配置界面

表 3-7 参数说明

参数名 参数说明 可
选/
必
选

示例

Summary Base
Dir

指定加载训练日志数据
的根目录。

必
选

示例：“scripts/train/
summary_dir”。

WorkSpace MindInsight组件工作目
录路径。

可
选

默认值：“$HOME/
mindsight”。可通过
MindInsight start 命令查看
当前路径参数值。

Port 数据传输端口。取值范
围：1~65535。

可
选

默认值：8080。取值范围：
1~65535。

URL Path Prefix Web服务器URL地址前
。

可
选

默认值：127.0.0.1。地址前
由斜杠（/）分隔多个部

分，各部分支持由字母/数字/
下划线/连字符/点符组成的字
符串，但不能为单点号（.）
或双点号（..）。

ReLoad Interval 指定加载数据的时间间
隔（单位：秒）。

可
选

默认值：3。取值范围：
0~300。

Enable
Debugger

是否开启Debugger功
能。

可
选

默认值：False。取值范围：
“True，False，1，0”。
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参数名 参数说明 可
选/
必
选

示例

Debugger Port 指定Debugger Server服
务端口（需开启
Debugger功能，才能指
定服务端口）。

可
选

默认值：50051。取值范围：
1~65535。

 

步骤4 单击“OK”完成MindInsight组件相关参数配置，界面自行回到图3-36并显示
MindInsight当前状态信息。

步骤5 可视化查看训练信息。

如果“MindInsight Staus”值为“ENABLE”，即MindInsight可视化为开启状态，用
户可单击“View”查看训练工程训练日志信息。打开Web UI，可视化查看实时训练信
息。或单击“Disable”停止MindInsight可视化进程。

说明

● 查看实时训练信息需要使用浏览器，如果未安装浏览器，请用户自行安装。

● 单击“View”查看训练工程训练日志信息时，若无法连接浏览器，请参见使用MindInsight
查看训练工程日志信息时显示浏览器无法连接。

----结束
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4 脚本转换

4.1 MindConverter

4.2 X2MindSpore

4.3 PyTorch GPU2Ascend

4.4 Tensorflow GPU2Ascend

4.1 MindConverter
原有的MindConverter功能由X2MindSpore代替，MindConverter功能不再提供。
MindConverter为MindInsight的子模块，如需使用MindConverter功能，可参考
MindInsight安装指导安装MindInsight，再使用MindConverter功能，MindConverter
具体使用方法可参考使用MindConverter迁移模型定义脚本。

4.2 X2MindSpore

4.2.1 概述
该脚本转换工具可将PyTorch脚本和TensorFlow 2.x脚本转换成MindSpore代码。

说明

● 脚本转换工具根据适配规则，对用户脚本进行转换，大幅度提高了脚本迁移速度，降低了开
发者的工作量。该脚本转换工具支持对包括但不限于模型列表列出的模型进行转换，转换成
功后可直接运行，部分模型需要根据实际情况进行少量适配。

● 此脚本转换工具当前仅支持PyTorch和TensorFlow 2.x训练脚本转换。

● 此脚本转换工具能支持模型列表中的工程转换后训练成功且收敛，对 终精度和性能暂不做
保证。

● 此脚本转换工具转换后的训练工程支持在MindSpore1.6及更新版本上运行。

使用限制
● MindSpore支持两种运行模式（Graph模式和PyNative模式），由于Graph模式存

在Python语法限制，当前仅支持转换到PyNative模式，训练性能较Graph模式有
所降低。具体差异详见MindSpore文档。
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● 当前为了规避MindSpore中数据处理不支持创建Tensor的限制，在PyTorch转换过
程中将运行模式设置成了算子同步下发模式，可能存在训练性能的部分降低；用
户可通过将context.set_context中的pynative_synchronize=True去除，使用算子
异步下发模式提升性能；此时若报错，可检查数据处理部分代码，去除其中的创
建Tensor行为，改为使用numpy的ndarray。

● 当前TensorFlow 2.x迁移结果不支持多卡运行。

模型列表

注意：脚本转换工具的模型列表仅作参考，可参考表4-1和表4-2。

表 4-1 PyTorch 模型列表

序
号

模型 原始训练工程代码链接参考 备注

1 BERT https://github.com/codertimo/
BERT-pytorch

● 在转换前，master分支的
代码在Loss计算上存在一
定问题，需要参考https://
github.com/codertimo/
BERT-pytorch/issues/
32#issuecomment-4328
77367做少量修改。

● 转换完成后，该工程在需
要安装才能使用，安装步
骤如下：

– 去除requirements.txt
文件中的torch项。

– 执行python3 setup
install。

● 具体使用方式详见仓库
README。

2 BiT-M-
R101x1

https://github.com/google-
research/big_transfer

● 数据集如果使用cifar-10-
bin，可从https://
www.cs.toronto.edu/
~kriz/cifar-10-
binary.tar.gz获取。

● 数据集如果使用cifar-100-
bin，可从https://
www.cs.toronto.edu/
~kriz/cifar-100-
binary.tar.gz获取。

3 BiT-M-
R101x3

4 BiT-M-
R152x2

5 BiT-M-
R152x4

6 BiT-M-
R50x1

7 BiT-M-
R50x3

8 BiT-S-
R101x1
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序
号

模型 原始训练工程代码链接参考 备注

9 BiT-S-
R101x3

10 BiT-S-
R152x2

11 BiT-S-
R152x4

12 BiT-S-
R50x1

13 BiT-S-
R50x3

14 Conforme
r-tiny

https://github.com/
pengzhiliang/Conformer

● 转换前需要将timm库代码
放到原始代码根目录下。

● timm库版本推荐0.3.2。

● 由于框架限制，当前不支
持--repeated-aug，所以
训练时需要使用--no-
repeated-aug参数。

15 Conforme
r-small

16 Conforme
r-base

17 DeiT-tiny

18 DeiT-
small

19 DeiT-base

20 DeepFM https://github.com/
shenweichen/DeepCTR-Torch

由于原始代码库中没有DCN
和DeepFM的训练脚本，转换
前需要进行以下操作：

1. 拷贝examples/run_din.py
文件并将其命名为
run_dcn.py。拷贝
examples/run_din.py文件
并将其命名为
run_deepfm.py。

2. 将run_dcn.py中的第9行替
换为from
deepctr_torch.models.dcn
import DCN。将
run_deepfm.py中的第9行
替换为from
deepctr_torch.models.dee
pfm import DeepFM。

3. 将run_dcn.py中的第47行
替换为model =
DCN(linear_feature_colu
mns=feature_columns,

21 DIN
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序
号

模型 原始训练工程代码链接参考 备注

22 DCN dnn_feature_columns=fea
ture_columns,
device=device)。将
run_deepfm.py中的第47
行替换为model =
DeepFM(linear_feature_c
olumns=feature_columns,
dnn_feature_columns=fea
ture_columns,
device=device)。

23 EfficientN
et-B0

https://github.com/lukemelas/
EfficientNet-PyTorch

-

24 EfficientN
et-B1

25 EfficientN
et-B2

26 EfficientN
et-B3

27 EfficientN
et-B4

28 EfficientN
et-B5

29 EfficientN
et-B6

30 EfficientN
et-B7

31 EfficientN
et-B8

32 SqueezeN
et

https://github.com/weiaicunzai/
pytorch-cifar100

数据集使用cifar-100-bin，可
从https://
www.cs.toronto.edu/~kriz/
cifar-100-binary.tar.gz获
取。

33 Inception
V3

34 Inception
V4

35 Inception
ResNetV2

36 Xception

37 Attention
56
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序
号

模型 原始训练工程代码链接参考 备注

38 Stochasti
cDepth18

39 Stochasti
cDepth34

40 Stochasti
cDepth50

41 Stochasti
cDepth10
1

42 VGG11

43 VGG13

44 VGG16

45 DenseNet
161

46 DenseNet
169

47 DenseNet
201

48 PreActRes
Net34

49 PreActRes
Net50

50 PreActRes
Net101

51 PreActRes
Net152

52 ResNeXt1
52

53 SEResNet
34

54 SEResNet
50

55 SEResNet
101

56 VGG19 https://github.com/kuangliu/
pytorch-cifar

● 数据集需要使用cifar-10-
bin，可从https://
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序
号

模型 原始训练工程代码链接参考 备注

57 PreActRes
Net18

www.cs.toronto.edu/
~kriz/cifar-10-
binary.tar.gz获取。

● 切换不同的网络需要在
main.py中修改使用的网络
名称。

58 DenseNet
121

59 ResNeXt2
9_2x64d

60 MobileNe
t

61 MobileNe
tV2

62 SENet18

63 ShuffleNe
tG2

64 GoogleNe
t

65 DPN92

66 Res2Net https://github.com/Res2Net/
Res2Net-ImageNet-Training

暂不支持torchvision.models
相关接口的转换，需做以下操
作。

修改原始工程：

1. 创建目录res2net_pami/
models。

2. res2net_pami/main.py
中，将import
torchvision.models as
models改为import
models。

67 ResNet18 https://github.com/pytorch/
examples/tree/master/imagenet

暂不支持torchvision.models
相关接口的转换，需做以下操
作。

修改原始工程：

1. 创建目录imagenet/
models。

2. 从torchvision库中拷贝
torchvision/models/
resnet.py至imagenet/
models下，删除
from .utils import
load_state_dict_from_url
语句。

68 ResNet34

69 ResNet50

70 ResNet10
1

71 ResNet15
2

72 ResNeXt-
50
（32x4d
）
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序
号

模型 原始训练工程代码链接参考 备注

73 3. 创建imagenet/models/
__init__.py文件，内容为：
from .resnet import *

4. main.py中，将import
torchvision.models as
models改为import
models。

ResNeXt-
101
（32x8d
）

74 Wide
ResNet-5
0-2

75 Wide
ResNet-1
01-2

76 ShuffleNe
tV2

https://github.com/megvii-
model/ShuffleNet-Series

-

77 ShuffleNe
tV2+

78 Swin-
Transfor
mer

https://github.com/microsoft/
Swin-Transformer

● 转换前需要将timm库代码
放到原始代码根目录下。

● timm库版本推荐0.4.12。

● 当前--cfg参数只支持以下
四个配置文件：

– swin_tiny_patch4_win
dow7_224.yaml

– swin_tiny_c24_patch4_
window8_256.yaml

– swin_small_patch4_wi
ndow7_224.yaml

– swin_base_patch4_win
dow7_224.yaml

79 Transfor
mer

https://github.com/
SamLynnEvans/Transformer

需要对于该代码仓中脚本依赖
的torchtext库进行转换并有
如下注意事项：

● 拷贝转换转换后的
torchtext_x2ms到脚本文
件夹。

● 将torchtext_x2ms重命名
未torchtext，以保证用户
调用的是转换后的
torchtext。

● torchtext版本建议使用
0.6.0。
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序
号

模型 原始训练工程代码链接参考 备注

80 UNet https://github.com/milesial/
Pytorch-Unet

MindSpore暂不支持
ReduceLROnPlateau，需要
替换成其他支持的
scheduler。

81 RCNN-
Unet

https://github.com/bigmb/Unet-
Segmentation-Pytorch-Nest-of-
Unets

转换前需要进行以下操作：

● 由于MindSpore求导存在
语法限制，pytorch_run.py
中248和252行的注释需要
修改为4空格倍数对齐。

● 模型要求输入图片大小为
16的倍数，因此当数据集
图片大小不满足16倍数
时，需取消pytorch_run.py
中121、122行和505、506
行的注释，将图片缩放裁
剪为16倍数。

● 当数据集label图片通道为
1时，需要在
pytorch_run.py的293行尾
加入.convert('RGB')将图
片转换为3通道。

● 由于MindSpore中使用
ModuleList会导致子层的
权重名称改变，需要将
pytorch_run.py第350行的
torch.nn.ModuleList改为
list，避免checkpoint文件
保存后无法重新加载。

82 Attention
Unet

83 RCNN-
Attention
Unet

84 Nested
Unet

85 ViT-B_16 https://github.com/jeonsworld/
ViT-pytorch

● MindSpore 1.6之前的版本
存在construct不能返回
Tensor以外的内容的问
题。

● MindSpore 1.6之前的版本
不支持使用--fp16参数。

● 数据集需要使用cifar-10-
bin，可从https://
www.cs.toronto.edu/
~kriz/cifar-10-
binary.tar.gz获取。

86 ViT-B_32

87 ViT-L_16

88 ViT-L_32

89 ViT-H_14

90 R50-ViT-
B_16
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表 4-2 TensorFlow 2.x 模型列表

序
号

模型 原始训练工程代码链接参考 备注

1 DenseNet
_121

https://github.com/calmisential/
Basic_CNNs_TensorFlow2

请根据需要，在
configuration.py中进行
epoch\batch_size\数据集路
径等配置。2 DenseNet

_169

3 EfficientN
et_B0

4 EfficientN
et_B1

5 Inception
_V4

6 MobileNe
t_V1

7 MobileNe
t_V2

8 ResNet_1
01

9 ResNet_5
0

10 ResNext_
101

11 ResNext_
50

12 Shufflene
t_V2_x0_5

13 Shufflene
t_V2_x1_0

14 AFM https://github.com/ZiyaoGeng/
Recommender-System-with-
TF2.0

各个网络文件夹均依赖
data_process目录，请直接转
换Recommender-System-
with-TF2.0目录或将
data_process复制至网络文件
夹下后再进行转换。

15 DCN

16 Deep_Cro
ssing

17 DeepFM

18 NFM

19 PNN
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序
号

模型 原始训练工程代码链接参考 备注

20 FCN https://github.com/
YunYang1994/TensorFlow2.0-
Examples/tree/master/5-
Image_Segmentation/FCN

parser_voc.py中使用的
scipy.misc.imread方法为scipy
1.2.0以前的旧版本API，
mindspore 低兼容scipy
1.5.2，因此请使用scipy的官
方弃用警告中推荐的
imageio.imread。

 

4.2.2 前提条件
使用此功能执行PyTorch训练脚本转换前须安装如下依赖：

pip3 install pandas         #pandas版本号需大于或等于1.2.4
pip3 install libcst

说明

若使用Windows版本MindStudio，需在Windows安装上述依赖。若使用Linux版本
MindStudio，需在服务器侧安装上述依赖。

4.2.3 执行转换

操作步骤

步骤1 启动脚本转换。

有以下两种方式发起脚本转换任务：

● 在工具栏选择“Ascend > Framework Trans > X2MindSpore”。

● 单击工具栏中 图标。

● 右键单击工程目录中的文件夹，选择“X2MindSpore”。

步骤2 参数配置。

X2MindSpore启动后界面如图4-1所示，用户自行根据实际情况配置参数。
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图 4-1 X2MindSpore 参数配置界面

表 4-3 X2MindSpore 参数说明

参数 参数说明

Framework 要进行转换的原始脚本的框架，可选择
PyTorch和TensorFlow 2。必选。

Input Path 要进行转换的原始工程目录。单击文件
夹图标选择目录。必选。

Output Path 脚本转换结果文件输出路径。会在该路
径下输出带有x2ms或x2ms_multi后 的
目录。必选。

Distributed “Framework”参数选择“PyTorch”，
此参数才会体现。开启此参数，可将
GPU单卡脚本转换为GPU或Ascend多卡
脚本，目前TensorFlow 2.x不支持多卡迁
移。可选。

Device "Distributed"开启后此参数才会体现。
通过该参数可将脚本转换为指定设备的
多卡脚本。"Distributed"开启时必选。

● Ascend
● GPU

ModelArts 开启此参数，转换后的脚本支持在
ModelArts平台进行训练作业。可选。

 

步骤3 单击“Transplant”，执行转换。
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完成后，Output Path输出目录下会生成转换后的xxx_x2ms或xxx_x2ms_multi脚本文
件、x2ms_adapter适配层文件、supported_api.csv支持算子列表文件和
unsupported_api.csv不支持算子列表文件。

步骤4 在执行转换后的模型文件前请先将输出的工程路径加入环境变量PYTHONPATH中。

----结束

报告目录
├── xxx_x2ms              // 脚本转换结果输出目录，默认为原始脚本路径。不开启迁移至多卡脚本功能场景
下，输出目录名为xxx_x2ms；开启迁移至多卡脚本功能场景下，输出目录名为xxx_x2ms_multi。xxx为原始脚本
所在文件夹名称。
│   ├── 转换后的脚本文件             // 与转换前的脚本文件目录结构一致。
│   ├── x2ms_adapter                 // 适配层文件。
│   │   ├── modelarts
│   │   │   ├── path_mapping_config.py          // 启用ModelArts参数，会生成该路径映射配置文件。
│   │   │   ├── modelarts_path_manager.py       // 启用ModelArts参数，会生成该路径映射适配层代码文
件。
│   ├── unsupported_api.csv          // 不支持API列表文件。
│   ├── supported_api.csv            // 支持API列表文件。
│   ├── x2mindspore.log              // 转换日志，日志文件限制大小为1M，若超过限制将分多个文件进行存
储， 多不会超过10个。
│   ├── run_distributed_ascend.sh       // 启用Distributed参数，且Device指定Ascend设备时，会生成该多卡
启动shell脚本。
│   ├── rank_table_2pcs.json            // 启用Distributed参数，且Device指定Ascend设备时，会生成该2卡环
境组网信息样例文件。
│   ├── rank_table_8pcs.json            // 启用Distributed参数，且Device指定Ascend设备时，会生成该8卡环
境组网信息样例文件。

转换完成后
● 如果启用了Distributed参数，转换后需要根据Device指定的设备完成运行多卡脚

本的特定操作。

– Device指定Ascend设备。

i. 参见配置分布式环境变量配置生成的分布式环境变量配置文件。

ii. 将run_distributed_npu.sh文件中的“please input your shell script
here”语句替换成模型原来的训练Python脚本执行命令。
#!/bin/bash
echo 
"=======================================================================
======================================="
echo "Please run the script as: "
echo "bash run_distributed_ascend.sh RANK_TABLE_FILE RANK_SIZE RANK_START 
DEVICE_START"
echo "For example: bash run_distributed_ascend.sh /path/rank_table.json 8 0 0"
echo "It is better to use the absolute path."
echo 
"=======================================================================
======================================="
execute_path=$(pwd)
echo "${execute_path}"
export RANK_TABLE_FILE=$1
export RANK_SIZE=$2
RANK_START=$3
DEVICE_START=$4
for((i=0;i<RANK_SIZE;i++));
do
  export RANK_ID=$((i+RANK_START))
  export DEVICE_ID=$((i+DEVICE_START))
  rm -rf "${execute_path}"/device_$RANK_ID
  mkdir "${execute_path}"/device_$RANK_ID
  cd "${execute_path}"/device_$RANK_ID || exit
  "please input your shell script here" > train$RANK_ID.log 2>&1 &
done
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表 4-4 参数说明

参数 说明

RANK_TABLE_FILE 多卡环境的组网信息文件

RANK_SIZE 卡的数量

RANK_START 卡逻辑起始编号，当前仅支持单
机多卡，填0即可

DEVICE_START 卡物理起始编号

 

注意

该脚本会在工程路径下创建device_{RANK_ID}目录，在该目录内去执行
网络脚本，所以替换训练Python脚本执行命令时要注意训练Python脚本
相对路径的变化。

iii. 执行run_distributed_ascend.sh脚本以启动用户原工程。以8卡环境为
例，命令如下。
bash run_distributed_ascend.sh RANK_TABLE_FILE RANK_SIZE RANK_START DEVICE_START

具体MindSpore分布式训练（Ascend）请参见分布式并行训练
（Ascend）。

– Device指定GPU设备。

在GPU硬件平台上，MindSpore采用OpenMPI的mpirun进行分布式训练，可
通过以下命令运行多卡脚本。
mpirun -n {多卡脚本运行的GPU卡数量} {模型原来的训练shell脚本执行命令}

具体MindSpore分布式训练（GPU）请参见分布式并行训练 （GPU）。

● 如果启用了ModelArts参数，转换后的脚本可在ModelArts平台上进行训练作业，
ModelArts的具体使用方法可参考华为云ModelArts指导手册《AI开发平台
ModelArts》，其他平台的ModelArts使用方法略有差异，但核心步骤和华为云
ModelArts的一致。

在ModelArts执行训练任务前，需要修改Output Path输出目录下的路径映射配置
文件x2ms_adapter/modelarts/path_mapping_config.py：
PATH_MAPPING_CONFIG = {
    'input': {
        # Add path mapping here for downloading data before training
        # format: <local path>: <obs/s3 path>
        # For example: '/data/dataset/imagenet': 'obs://dataset/imagenet',
        
    },
    'output': {
        # Add path mapping here for uploading output after training
        # format: <local path>: <obs/s3 path>
        # For example: './checkpoints': 'obs://outputs/',
        
    }
}

'input'中对应训练前需要下载的数据，映射格式为：本地运行时的数据路径:对应
云端对象存储的路径。

'output'中对应训练完成后需要上传的数据，映射格式为：训练生成的数据文件路
径:生成文件在对象存储上的对应路径。
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● 脚本转换后可以参考模型训练进行训练。

4.2.4 FAQ

4.2.4.1 转换完成后运行出现 pillow/numpy 版本不符合的提示

问题描述

执行转换后的脚本时提示以下pillow和numpy版本不符合信息。

图 4-2 pillow 版本不符合提示信息

图 4-3 numpy 版本不符合提示信息

解决方法

旧版本的pillow和numpy存在安全漏洞，漏洞详情请参见https://mindspore.cn/
security和https://nvd.nist.gov/vuln/detail/CVE-2021-41496。用户需升级pillow版
本至8.2.0或以上，numpy升级至1.22.0或以上。

4.2.4.2 保存 Checkpoint 文件成功，但找不到该文件，可能是哪些原因

问题描述

保存Checkpoint文件后，对该文件进行操作时，显示该文件不存在。
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解决方法

MindSpore中load_checkpoint和save_checkpoint接口仅支持”.ckpt”后 的文件，当
文件名为非“.ckpt”后 时，会自动加上“.ckpt”.ckpt后 ，因此实际保存的文件名
可能和传入的文件名不一致，此时需要用户将传入文件名末尾加上“.ckpt”。

4.2.4.3 数据处理时出现错误，可能是哪些原因

问题描述

数据处理时出现如下错误。

解决方法

在MindSpore中，数据处理过程中需要保持中间处理结果为numpy array，且数据处理
过程中不建议与MindSpore网络计算的算子混合使用。请检查数据处理中是否包含转
换为Tensor和使用MindSpore网络算子的操作，若有，请使用numpy中的等效操作替
换。

4.3 PyTorch GPU2Ascend

4.3.1 概述
NPU是AI算力的发展趋势，但是目前训练和在线推理脚本大多还基于GPU。由于NPU
与GPU的架构差异，基于GPU的训练和在线推理脚本不能直接在NPU上使用，需要转
换为支持NPU的脚本后才能使用。

说明

● 脚本转换工具根据适配规则，对用户脚本进行转换，大幅度提高了脚本迁移速度，降低了开
发者的工作量。该脚本转换工具支持对包括但不限于表4-5列出的模型进行转换，转换成功
后可直接运行，部分模型需要根据实际情况进行少量适配。

● 原脚本需要在GPU环境下且基于python3.7及以上能够跑通。

● 脚本转换后的执行逻辑与转换前保持一致。

● 此脚本转换工具当前支持PyTorch1.5.0和1.8.1版本的训练脚本转换。

表 4-5 模型支持列表

序号 模型名称 序号 模型名称

1 2S-AGCN 163 MobileNetV3

2 3D AttentionNet 164 MobileNetV3-Small

3 3D Nested_UNet 165 Moco V2

4 3D Resnet 166 MSGAN
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序号 模型名称 序号 模型名称

5 3DUNet 167 MSPN

6 ACGAN-Mod-Big-TAC 168 MTCNN

7 ADACOS 169 Multi-Gradient_Descent

8 ADLayer 170 MultiPoseNet

9 Advanced East 171 Mutual-Channel-Loss

10 Adversarial Autoencoder 172 MutualNet

11 Adversarial_Long-Tail 173 NAS-SEGM

12 AFN 174 nest_small

13 AlexNet 175 NeuMF

14 AMDIM 176 nf_resnet26

15 ANTIALIASED-CNNS 177 NFM

16 Attention R2U-Net 178 nfnet_f1s

17 Attention U_Net 179 NFNet-F

18 AUTOAUGMENT 180 NF-ResNet

19 Autodeeplab 181 N-Gran

20 AutoInt 182 Non-Local

21 axial-deeplab 183 NTS-Net

22 BDL 184 ONN

23 BEGAN 185 OpenPose

24 beit_base_patch16_224 186 opl

25 BERT-ITPT-FiT 187 ORDERED-NEURONS

26 BICYCLEGAN 188 PASSRnet

27 BigGAN-Mod-CR 189 PFF

28 BigGAN-Mod-DiffAug 190 PICANET

29 BiT-M-R50x1 191 Pixel-BERT（VQA）

30 BiT-S-R101x1 192 PixelDA

31 BiT-S-R50x1 193 PixelLink

32 BiT-S-R50x3 194 PNet

33 botnet26t_256 195 PointNet++

34 Bottleneck Transformers 196 POSE-TRANSFER
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序号 模型名称 序号 模型名称

35 Boundary-Seeking GAN 197 PPN

36 BYOL 198 PPON

37 CaaM 199 PreactResNet50

38 CausalHTP 200 PROSR

39 CGAN 201 PSENet

40 CIConv 202 PVANet

41 CMC 203 Pysot

42 CoaT 204 R2U-Net

43 coat_mini 205 RAFT

44 CondenseNetV2 206 RANet

45 Context Encoder 207 RCAN

46 Context-Conditional GAN 208 RCNN

47 ContraGAN 209 RecVAE

48 ContraGAN-CR 210 RefineNet

49 ContraGAN-DiffAug 211 regnet

50 convit_small 212 regnetx_002

51 Convit-tiny 213 RegNetX-1.6GF

52 coral-cnn 214 regnety_064

53 COSMIC 215 RegNetY-1.6GF

54 COSMIC 216 ReID

55 Coupled GAN 217 Relativistic GAN

56 CPC 218 repvgg

57 csp-resnet50 219 repvgg_a2

58 DCNMix 220 repvgg_b0

59 Deep & Cross Network 221 Res2Net

60 Deep Convolutional GAN 222 RES2NET-
PRETRAINEDMODELS

61 DeepFM 223 residual_adapters

62 DEEPHYPERX 224 ResMLP

63 DeeplabV3+ 225 ResNeSt
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序号 模型名称 序号 模型名称

64 DeeplabV3+(Xception-
JFT)

226 ResNet101

65 DeepMar 227 ResNet152

66 Deit 228 ResNet18

67 Densenet121 229 ResNet34

68 DenseNet161 230 ResNet50

69 DenseNet169 231 resnet61q

70 DenseNet201 232 resnetv2_101

71 dgc 233 resnetv2_50t

72 DIFM 234 Resnext101

73 DINO 235 Resnext101_32x8d

74 DiscoGAN 236 Resnext50

75 dla34 237 ResNeXt-50-32x4d

76 DnCNN 238 Retinanet

77 DoReFa-Net 239 rexnet

78 Double-DIP 240 RNet

79 DPC 241 RRN

80 DPL 242 SAN

81 DRAGAN 243 SC-SfMLearner

82 DualGAN 244 S-DCNET

83 DYNABERT 245 SegNet

84 EAST 246 sehalonet33ts

85 ECA-NFNet-L0 247 SelecSLS

86 EDSR 248 self-attention-GAN

87 efficientnet_b8 249 SELF-ATTENTION-GAN

88 efficientnet_l2 250 Semi-Supervised GAN

89 Efficientnet-B0 251 semnasnet_050

90 EfficientNet-B1 252 SENet

91 EfficientNet-B2 253 seresnet18

92 EfficientNet-B4 254 SE-ResNet-50
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序号 模型名称 序号 模型名称

93 EfficientNet-b6 255 Se-ResNext-50-32x4d

94 EfficientNet-b7 256 SETR

95 Enhanced Super-
Resolution GAN

257 SGCN

96 ESRGAN 258 SGNAS

97 EXTD 259 Shufflenetv2

98 FACEBOXES-PYTORCH 260 SiamRPN

99 FairDARTS 261 SimplePose

100 FBNet-C 262 sknet

101 fbnetc_100 263 SOF-VSR

102 fbnetv3_b 264 SpanBERT

103 FCN 265 Speech Transformer

104 FD-GAN 266 SPSR

105 FIBINET 267 SqueezeNet1_0

106 FixMatch 268 SqueezeNet1_1

107 FOTS 269 SRCNN

108 FREE 270 SSD_MobileNetV2

109 GAN 271 SSD_MobileNetV3

110 GCANET 272 SSD-Mobilenet

111 GENet 273 SSL-FEW-SHOT

112 gernet_s 274 STARGAN

113 GGAG 275 STGCN

114 GGAN 276 StochasticDepth50

115 Glu-Mixer 277 SUPCONTRAST

116 gluon_senet154 278 Super-Resolution GAN

117 gluon_seresnext101_32x4
d

279 SUPERVISION-BY-
REGISTRATION

118 gluon_xception 280 SWAV

119 gmlp 281 Swin Transformer

120 gmlp_s16_224 282 Tacotron2

121 GoogleNet 283 tnt_s_patch16_224
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序号 模型名称 序号 模型名称

122 GPU-efficient networks 284 TOD

123 GreedyInfoMax 285 Transformer-iN-Transformer

124 GRU 286 TransformerXL

125 halonet_h1 287 TrellisNET

126 haloregnetz_b 288 Twins

127 hardcorenas 289 twins_pcpvt_small

128 hardcorenas_a 290 UCNET

129 Hourglass 291 ULTRA-FAST-LANE-
DETECTION

130 hyperseg 292 U-Net

131 I3D 293 UNET-GAN

132 ICT 294 VAE+GAN

133 IFM 295 VASNET

134 IIC 296 VGG11

135 Inception V4 297 VGG11_BN

136 Inception-ResNet-V2 298 VGG13

137 InceptionV1 299 VGG13_BN

138 InceptionV2 300 VGG16

139 InfoGAN 301 VGG16_BN

140 InsightFace 302 VGG19

141 InsightFace-v2 303 VGG19_BN

142 Lambda Networks 304 VIT

143 lambda_resnet26t 305 VIT-base

144 Least Squares GAN 306 vovnet-39

145 LFFD 307 vsumm-reinforce

146 LGAN 308 Wasserstein GAN

147 LIGHT-WEIGHT-
REFINENET

309 Wasserstein GAN DIV

148 LPRNet 310 Wasserstein GAN GP

149 LSGAN 311 WGAN-WC

150 LSTM 312 Wide & Deep
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序号 模型名称 序号 模型名称

151 MATNET 313 Wide_ResNet101_2

152 MiningFSS 314 Wide_ResNet50_2

153 mixer_s32_224 315 wideresnet

154 mixnet_s 316 Xception

155 MLP-Mixer 317 xception_aligned

156 MNasNet 318 xDeepFM

157 MNASNet0_5 319 yolov5s

158 MNASNet0_75 320 ZERO-DCE

159 MNASNet1_0 321 XLM

160 MNASNet1_3 322 mBart

161 MobileNetV1 323 bert_squard

162 MobileNetV2 - -

 

4.3.2 前提条件
使用此功能执行PyTorch训练脚本转换前须安装如下依赖：

pip3 install pandas         #pandas版本号需大于或等于1.2.4
pip3 install libcst
pip3 install jedi           #跨文件分析库，安装后在单卡转多卡且DataLoader类定义在不同文件场景实现跨文件分
析功能，可选安装

4.3.3 执行转换

操作步骤

步骤1 启动脚本转换。

有以下三种方式发起脚本转换任务：

● 在工具栏选择“Ascend > Framework Trans > PyTorch GPU2Ascend”。

● 右键单击训练工程，然后选择“PyTorch GPU2Ascend”。

● 单击工具栏中 图标。

步骤2 参数配置。

PyTorch GPU2Ascend界面如图4-4所示，用户自行根据实际情况配置参数。
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图 4-4 PyTorch GPU2Ascend 参数配置

表 4-6 PyTorch GPU2Ascend 参数说明

参数 参数说明

PyTorch Version 待转换脚本的PyTorch版本。目前支持
1.5.0和1.8.1。必选。

Input Path 要进行转换的原始脚本文件所在文件夹
路径或文件路径。单击文件夹图标选择
目录。必选。

Output Path 脚本转换结果文件输出路径。单击文件
夹图标选择目录。必选。

Custom Rule 打开自定义转换规则。可选。

Rule File “Custom Rule”开启后此参数才会体
现。单击文件夹图标选择用户自定义通
用转换规则的json文件路径。该json文件
主要包括函数参数修改、函数名称修改
和模块名称修改三部分。必选。

Distributed Rule 将GPU单卡脚本转换为NPU多卡脚本，
此参数仅支持使用
torch.utils.data.DataLoader方式加载数
据的场景。可选。
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参数 参数说明

Main File "Distributed Rule"开启后此参数才会体
现。单击文件夹图标选择训练脚本的入
口python文件。必选。

Target Model "Distributed Rule"开启后此参数才会体
现。目标模型变量名，默认为
“model”，可选。

Replace Unsupported APIs 用功能相似的API替换以下不支持的
API，但有可能导致准确性和性能下降。
可选。

● apex.parallel.DistributedDataParalle
l

● torch.cuda.get_device_properties
● torch.nn.Conv3d
● torch.nn.functional.pad
● torch.nn.ReflectionPad2d
● torch.nn.ReplicationPad2d
● torch.nn.SyncBatchNorm
● torch.nn.SyncBatchNorm.convert_sy

nc_batchnorm
● torch.repeat_interleave
● torch.set_default_tensor_type

Amp Transplant "PyTorch Version"选择1.5.0时此参数才
会体现。开启此参数，可将
torch.cuda.amp混合精度训练脚本转换
为apex.amp混合精度训练脚本。可选。

说明

● 使用该功能可能导致网络性能下降，局限
性较大。

● 只有原始网络使用了torch.cuda.amp进行
混合精度训练，才会进行转换。

Target Model "Amp Transplant"开启后此参数才会体
现。输入模型名称。默认为“model”。
可选。当同时使用“Distributed Rule”
时，两个Target Model需保持一致。

 

自定义转换规则样例如下：

{
    "rules": {
        "ArgsModifyRule": [
            {
                "func_name": "name1",
                "arg_idx": 0,
                "arg_new": "agrs0"
            },
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            {
                "func_name": "name2",
                "arg_idx": 0,
                "arg_new": "agrs0"
            }
        ],
        "FuncNameModifyRule": [
            {
                "old_name": "func",
                "new_name": "new_func"
            }
        ],
        "ModuleNameModifyRule": [
            {
                "old_name": "module",
                "new_name": "new_module",
                "parent_module":"parent_module"
            }
        ]
    }
}

表 4-7 参数说明

参数 说明

ArgsModifyRule 函数参数修改

func_name 函数名称

arg_idx 参数的位置

arg_new 新的参数

FuncNameModifyRule 函数名称修改

ModuleNameModifyR
ule

模块名称修改

old_name 旧名称

new_name 新名称

parent_module 父级模块全名

例如torch.cuda.amp，amp的父级模块全名为
torch.cuda。

 

说明

为了保证转换结果的正确性，请根据样例文件，按照ArgsModifyRule、FuncNameModifyRule
和ModuleNameModifyRule的顺序来自定义转换规则。

步骤3 单击“Transplant”，执行转换。

完成后，Output Path输出目录下会生成转换后的xxx_msft或xxx_msft_multi脚本文
件、msFmkTranspltlog.txt日志文件、unsupported_op.csv不支持算子列表文件、
run_distributed_npu.sh多卡启动shell脚本及change_list.csv修改记录。

----结束
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报告目录
├── xxx_msft              // 脚本转换结果输出目录，默认为原始脚本路径。不开启单卡转多卡功能场景下，输
出目录名为xxx_msft；开启单卡转多卡功能场景下，输出目录名为xxx_msft_multi。xxx为原始脚本所在文件夹名
称。
│   ├── 生成脚本文件                 // 与转换前的脚本文件目录结构一致。
│   ├── msFmkTranspltlog.txt         // 脚本转换过程日志文件，日志文件限制大小为1M，若超过限制将分多
个文件进行存储， 多不会超过10个。
│   ├── unsupported_op.xlsx          // 不支持算子列表文件。
│   ├── change_list.csv              // 修改记录文件。
│   ├── run_distributed_npu.sh       // 多卡启动shell脚本。
│   ├── ascend_function              // 如果启用了Replace Unsupported APIs参数，会生成该包含等价算子的
目录。

转换完成后

● 如果启用了Replace Unsupported APIs参数，在执行转换后的模型文件前请先将
父级文件路径加到环境变量PYTHONPATH中。

● 如果需要用到ascend_function下的similar_api.py文件中的
get_device_properties(device)接口，请用户根据实际需要手动编辑
StubDevicePropertise(object)中的各项参数值。

● 如果启用了Distributed Rule参数，转换后会生成如下run_distributed_npu.sh文
件：
export MASTER_ADDR=127.0.0.1
export MASTER_PORT=29688
export HCCL_WHITELIST_DISABLE=1   

NPUS=($(seq 0 7))
export NPU_WORLD_SIZE=${#NPUS[@]}
rank=0
for i in ${NPUS[@]}
do
    export NPU_CALCULATE_DEVICE=${i}
    export RANK=${rank}
    echo run process ${rank}
    please input your shell script here > output_npu_${i}.log 2>&1 &
    let rank++
done

表 4-8 参数说明

参数 说明

MASTER_ADDR 指定训练服务器的IP地址

MASTER_PORT 指定训练服务器的端口号

HCCL_WHITELIST_DISABLE hccl后端环境

NPUS 指定在特定NPU上运行

NPU_WORLD_SIZE NPU核心数量

RANK 进程号

 

在执行转换后的模型之前需要把run_distributed_npu.sh文件中的“please input
your shell script here”语句替换成模型原来的训练shell脚本。执行
run_distributed_npu.sh文件后会生成指定NPU的log日志。
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● 脚本转换后可以参考模型训练进行训练。

4.3.4 FAQ

4.3.4.1 “Segmentation fault”错误

一般是代码中引用了tensorboard导致，注释掉相关的Summary、Writer调用即可规避
该错误。Summary、Writer多用于记录日志和绘图，不影响网络跑通和精度收敛。如
果第三方库中包含tensorboard，也会引起该错误，以下为已知的引用tensorboard的
第三方库。

● wandb：若该库仅用来打log，可以删除该库的调用。

● transformers：该库深度绑定tensorflow、tensorboard。

4.3.4.2 运行报错：RuntimeError: Attempting to deserialize object on a CUDA
device but torch.cuda.is_available() is False. If you are running on a CPU-
only machine, please use torch.load with
map_location=torch.device(‘cpu’) to map your storages to the CPU

一般在报错代码行加入参数map_location=torch.device(‘cpu’)即可规避此问题。

4.3.4.3 对于引用库找不到的问题

对于引用库找不到的问题，有可能是以下三种情况，请根据实际情况进行排查：

● 如果是当前目录或子目录中存在的文件夹或者文件，只需将该目录的父目录加到
PYTHONPATH环境变量中即可。

● 如果找不到的引用库为requirements.txt中说明需要pip安装的包，可以使用pip
install xxx -i http://cmc-cd-mirror.rnd.huawei.com/pypi/simple/ --trusted-host
cmc-cd-mirror.rnd.huawei.com命令进行安装，若安装失败可以git clone安装包，
使用python3 setup.py install安装。

● 检查找不到的引用库是否为remead.md说明中需要通过git clone下载安装的安装
包，如果是，请按照要求下载并安装。

4.3.4.4 运行报错：Unsupport data type: at::ScalarType::Double.

在报错代码行前添加数据数据类型转换语句即可规避此问题。如报错代码行为pos =
label.data.eq(1).nonzero(as_tuple =False).squeeze().npu()不支持数据类型，在代码
上一行加上label = label.cpu().float().npu()进行数据类型转换。

4.3.4.5 运行报错：IndexError: invalid index of a 0-dim tensor. Use
tensor.item() in Python or tensor.item<T>() in C++ to convert a 0-dim tensor
to a number

遇到类似错误直接将代码中.data[0]改成.item()

例如将：

M = (d_loss_real + torch.abs(diff)).data[0]

改为：
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M = (d_loss_real + torch.abs(diff)).item()

4.3.4.6 对于报错 “No supported Ops kernel and engine are found for
[ReduceStdV2A], optype [ReduceStdV2A]”，算子 ReduceStdV2A 不支持的问
题

可以通过用std求标准差再平方得到var，均值单独调用mean接口求来规避问题。例
如：

具体到代码中修改：

4.3.4.7 Muls 算子不支持 INT64

将如上图中label_batch.npu()改成label_batch.int().npu()，即把当前报错行的变量类
型改成int32，规避此类Muls算子不支持int64的问题。

4.3.4.8 运行报错：Could not run ‘aten::empty_with_format’ with
arguments from the ‘CPUTensorId’ backend.
‘aten::empty_with_format’ is only available for these backend “CUDA、
NPU”

需要将tensor放到npu上，类似input = input.npu()。

4.3.4.9 运行报错：options.device().type() == DeviceType::NPU INTERNAL
ASSERT FAILED xxx:

需要将tensor放到npu上，类似input = input.npu()。
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4.3.4.10 运行报错：Attempting to deserialize object on a CUDA device but
torch.cuda.is_availabel() is False.

此错误一般是torch.load()接口导致的，需要加关键字参数map_location，如
map_location='npu’或map_location=‘cpu’。

4.3.4.11 运行报错：RuntimeError: Incoming model is an instance of
torch.nn.parallel.DistributedDataParallel. Parallel wrappers should only be
applied to the model(s) AFTER

此错误是由于torch.nn.parallel.DistributedDataParallel接口在apex.amp.initial接口之
前调用导致的，需要手动将torch.nn.parallel.DistributedDataParallel接口的调用移到
apex.amp.initial接口调用之后即可。

4.4 Tensorflow GPU2Ascend

4.4.1 概述
NPU是AI算力的发展趋势，但是目前训练和在线推理脚本大多还基于GPU。由于NPU
与GPU的架构差异，基于GPU的训练和在线推理脚本不能直接在NPU上使用，需要转
换为支持NPU的脚本后才能使用。

说明

● 脚本转换工具根据适配规则，对用户脚本给出修改建议并提供转换功能，大幅度提高了脚本
迁移速度，降低了开发者的工作量。脚本的转换结果仅供参考，仍需用户根据实际情况做少
量适配。

● 此脚本转换工具当前仅支持Tensorflow训练脚本转换。

4.4.2 前提条件
使用此功能需已安装好CANN深度学习框架TensorFlow插件包Ascend-cann-
tfplugin_{version}_linux-{arch}.run。如未安装，请参见以下步骤安装此插件包。

步骤1 下载框架适配插件Plugin，用于昇腾软件与Tensorflow框架对接。请参见TensorFlow
Adapter商用版，下载并安装插件框架包Ascend-cann-tfplugin_{version}_linux-
{arch}.run。

步骤2 验证软件包完整性。

为了防止软件包在传递过程或存储期间被恶意篡改，下载软件包时需下载对应的数字
签名文件用于完整性验证。

在软件包下载之后，请参考《OpenPGP签名验证指南》，对从网站下载的软件包进行
PGP数字签名校验。如果校验失败，请不要使用该软件包，先联系华为技术支持工程
师解决。

使用软件包安装/升级之前，也需要按上述过程先验证软件包的数字签名，确保软件包
未被篡改。

步骤3 安装依赖。
pip3 install pandas
pip3 install xlrd==1.2.0
pip3 install openpyxl
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pip3 install tkintertable
pip3 install google_pasta

步骤4 安装tfplugin插件包。
./Ascend-cann-tfplugin_{version}_linux-{arch}.run --install

----结束

4.4.3 执行转换

操作步骤

步骤1 启动脚本转换。有以下三种方式发起脚本转换任务：

● 在工具栏选择“Ascend > Framework Trans > Tensorflow GPU2Ascend”。

● 右键单击训练工程，然后选择“Tensorflow GPU2Ascend”。

● 单击工具栏中 图标。

步骤2 参数配置。

Tensorflow GPU2Ascend界面如图4-5所示，用户自行根据实际情况配置参数。

图 4-5 Tensorflow GPU2Ascend 参数配置
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表 4-9 Tensorflow GPU2Ascend 参数说明

参数 参数说明

CANN Machine 自动填充。远程连接CANN所在环境的SSH地址，表现格
式为<username>@localhost:端口号。

仅Windows系统支持此参数。

Command File Linux环境上的CANN深度学习框架TensorFlow插件包中的
工具脚本文件，为main.py文件。

示例路径：tfplugin安装目录/tfplugin/latest/tfplugin/
python/site-packages/npu_bridge/convert_tf2npu/
main.py

Input Path 本地待转换脚本文件的路径。

Output Path 本地脚本转换后的输出路径。

Main File Python执行入口文件的路径。

如果原始脚本使用了tf.keras/hvd接口，且脚本中没有
main函数，由于迁移工具无法识别入口函数，因此无法进
行NPU资源初始化，以及NPU训练相关配置。针对该场
景，需要通过配置“Main File”参数指定Python执行的入
口文件，以便工具可以将用户脚本进行彻底迁移，保证后
续训练的顺利执行。

Distributed Strategy 分布式策略。

如果原始脚本支持分布式训练，需要指定原始脚本使用的
分布式策略，便于工具对分布式脚本进行自动迁移。打开
此开关，在下方出现的下拉框中选择原始脚本中使用的分
布式策略。

● tf.distributed.Strategy
● horovod

 

步骤3 单击“Transplant”生成结果报告。可在下方“Output”窗口查看运行过程。

若需要转换的脚本为分布式脚本，且“Distributed Strategy”参数没有打开或者选择
的策略与脚本不匹配，将会弹出如图2 Warning1警告窗口。

图 4-6 Warning1

● Continue：忽略警告，继续进行脚本迁移，迁移后脚本将不支持分布式训练。

● Exit：终止脚本迁移进程。

若需要转换的脚本中使用了tf.keras/hvd接口，且没有指定Python执行入口文件，将会
弹出如图4-7警告窗口。
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图 4-7 Warning2

● Continue：继续进行脚本迁移，将忽略对tf.keras/hvd接口的迁移。

● Exit：终止脚本迁移进程。

若需要转换的脚本含有train函数，需要确认是否为Estimator的train方法，将会弹出如
图4-8警告窗口。

图 4-8 Warning3

● Yes：将对该train函数进行分布式迁移。

● No：将不对该train函数进行分布式迁移。

----结束

查看迁移报告

步骤1 报告目录。
├── xxx_msft         // 脚本转换结果输出目录。xxx为原始脚本所在文件夹名称。
│   ├── xxx_npu_202***********                  // 转换结果。
│   ├── report_npu_202***********                 // 转换报告。
│         ├── api_analysis_report.xlsx            //API支持度分析报告。
│         ├── api_brief_report.txt                //工具对该脚本的全部修改点。
│         ├── success_report.txt                  //脚本中API支持度统计结果。

步骤2 查看迁移报告。

● api_analysis_report.xlsx：为API支持度分析报告，用户可以筛选“不支持（无迁
移方案，建议不使用）”和“废弃类”API单独分析，并根据修改建议修改训练脚
本。

图 4-9 API 支持度分析报告举例

表 4-10 工具迁移 API 支持度说明

工具迁移API支持度 说明

支持（无需迁移） 此类API在昇腾AI处理器上绝对支持，无需适配修改。

例如"tf.abs"等接口，在昇腾AI处理器上能够完全支
持，不需要迁移。
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工具迁移API支持度 说明

工具迁移后API功能支
持

工具迁移后，该API在昇腾AI处理器上可以支持。

例如"tf.data.Dataset.batch(xxx)"接口，由于当前仅支
持固定shape下的训练，也就是在进行图编译时shape
的值必须是已知的。当原始网络脚本中使用
dataset.batch(batch_size)返回动态形状时，由于数据
流中剩余的样本数可能小于batch大小。

因此，迁移工具必须将drop_remainder设置为True，
丢弃文件中的 后几个样本，以确保每个批量都具有静
态形状 (batch_size)：
"tf.data.Dataset.batch(xxx)" -->
"tf.data.Dataset.batch(xxx, drop_remainder=True)"

工具迁移后训练功能
打通

工具迁移后，能够保证在昇腾AI处理器训练执行成功，
但原有API功能可能不完全支持。

例如"tf.config.experimental.set_memory_growth"接
口，它的作用一般是将所有GPU设置为仅在需要时申请
显存空间，在昇腾AI处理器上训练时，该接口实际并不
生效。

因此，迁移工具会直接return返回None，从而保证在
昇腾AI处理器上训练正常执行。

"tf.config.experimental.set_memory_growth" --> 直
接return返回None

不支持（不影响迁
移，无需干预）

此类API在昇腾AI处理器上不支持，但不影响脚本执
行，无需用户干预。

例如"tf.config.experimental.get_memory_growth"接
口，由于工具会将
"tf.config.experimental.set_memory_growth"直接
return返回None，因此对应的get接口也不会影响脚本
在昇腾AI处理器上的执行，即便出现这个接口，用户也
无需干预。

不支持（无迁移方
案，建议不使用）

此类API在昇腾AI处理器上不支持，且当前暂无具体迁
移方案，建议您不要使用，否则会引起训练失败。

例如"tf.distribute.experimental.TPUStrategy"等TPU相
关接口，需通过Google TPU设备执行，昇腾AI处理器
上不支持，建议用户不要使用。

另外，"tf.enable_eager_execution"等eager功能相关
接口，在当前版本也不支持，建议用户不要使用。

废弃类 此类API在TensorFlow 1.15版本已经废弃，建议用户使
用TensorFlow官网推荐的API，否则可能会引起训练失
败。

例如"tf.colocate_with"等接口。
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工具迁移API支持度 说明

兼容类 此类API主要作为TensorFlow 2.X版本中支持
TensorFlow 1.X功能所使用，在TensorFlow 1.X脚本中
不会使用到。

例如"tf.compat.v1.abs"和"tf.compat.v2.abs"等接口。

 
● success_report.txt：该文件记录了工具对该脚本的全部修改点，例如：

# 表示resnet_run_loop.py第91行的map_and_batch()的drop_remainder参数配置为True /root/models/
models/official/resnet/resnet_run_loop.py:91 change map_and_batch(xxx) to map_and_batch(xxx, 
drop_remainder=True) # 表示resnet_run_loop.py第4行新增“from npu_bridge.npu_init import *”头文
件引用，用于导入NPU相关库 /root/models/models/official/resnet/resnet_run_loop.py:4 from 
npu_bridge.npu_init import * Finish conver file: /root/models/models/official/resnet/resnet_run_loop.py

● api_brief_report.txt：汇总脚本中API支持度统计结果，例如：
# 未去重的统计结果，分类和API支持度表中的一致 1.In brief: Total API: 231, in which Support: 222, API 
support after migration: 5, Network training support after migration: 0, Not support but no impact on 
migration: 0, Not support or recommended: 2, Compatible: 0, Deprecated: 2, Analysing: 0 # 去重后的统
计结果，分类和API支持度表中的一致 2.After eliminate duplicate: Total API: 98, in which Support: 92, 
API support after migration: 4, Network training support after migration: 0, Not support but no 
impact on migration: 0, Not support or recommended: 1, Compatible: 0, Deprecated: 1, Analysing: 0

----结束

后续操作
● 一般迁移后的模型即可直接在昇腾AI处理器执行训练，具体操作请参见

《TensorFlow网络模型迁移和训练指南》的“执行单Device训练”或“执行分布
式训练”章节。

● 脚本转换后可以参考模型训练在MindStudio上进行训练。

● 如果训练失败，用户可查看api_analysis_report中是否有不支持的接口，也可以查
看success_report中是否存在迁移错误的接口，关于api_analysis_report和
success_report的详细说明请参考查看迁移报告。同时酌情修改训练脚本再次训
练，如果仍然训练失败，欢迎到昇腾开源社区求助。
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5 模型转换

5.1 使用前必读

5.2 模型转换

5.3 模型可视化

5.4 离线模型改图调优

5.1 使用前必读
用户使用Caffe/TensorFlow等框架训练好的模型，可通过ATC工具将其转换为昇腾AI处
理器支持的离线模型，模型转换过程中可以实现算子调度的优化、权重数据重排、内
存使用优化等，可以脱离设备完成模型的预处理，详细架构如图5-1所示。

图 5-1 ATC 工具功能架构
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约束说明

在进行模型转换前，请务必查看如下约束要求：

● 如果要将FasterRCNN、YoloV3、YoloV2等网络模型转成适配昇腾AI处理器的离线
模型， 则务必参见《ATC工具使用指南》“定制网络专题”章节先修改prototxt
模型文件。

● 不支持动态shape的输入，例如：NHWC输入为[?,?,?,3]多个维度可任意指定数
值。模型转换时需指定固定数值。

● 模型中的所有层算子除常量算子外，输入和输出需要满足维度不为0。

● 只支持《CANN 支持Caffe/TensorFlow/ONNX算子清单》中的算子，并需满足
算子限制条件。

● 支持的原始框架类型、输入数据类型和模型文件如表5-1所示。

表 5-1 支持框架类型

原始框架类型 输入数据类型 模型文件说明

Caffe ● FP32。

● FP16：通过设置入参--
input_fp16_nodes实现。

● UINT8：通过配置数据预处
理实现。

说明

● 输入数据 大支持四维，转
维算子（reshape、
expanddim等）不能输出五
维。

● 模型文件：
xxx.prototxt

● 权重文件：
xxx.caffemodel

其中，模型文件和权重
文件的op name、op
type必须保持名称一致
（包括大小写）。

TensorFlow ● FP16
● FP32
● UINT8
● INT32
● INT64
● BOOL

说明
不支持输出数据类型为INT64，
需要用户自行将INT64的数据类
型修改为INT32类型。

模型文件：xxx.pb
只支持FrozenGraphDef
格式的.pb模型转换。

ONNX ● FP32。

● FP16：通过设置入参--
input_fp16_nodes实现。

● UINT8：通过配置数据预处
理实现。

模型文件：xxx.onnx

MindSpore ● FP32。

● UINT8：通过配置数据预处
理实现。

支持以下两种格式：

● xxx.air
● xxx.mindir
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5.2 模型转换

模型转换入口
● 可以通过如下两种方式进入模型转换界面。

– 在菜单栏选择“Ascend > Model Converter”。

– 在菜单栏选择“View > Appearance > Toolbar”，菜单栏下方会出现一行工

具栏，选择 。

转换详情请参见转换步骤。

● 用户也可以通过如下方式使用ATC命令行进行模型转换。

a. 单击MindStudio界面下方的Terminal窗口。

b. 参见《ATC工具使用指南》执行ATC命令进行模型转换。

转换前提

进行模型转换前，使用MindStudio安装用户，将所转换模型的模型文件以及权重文件
上传到Ascend-cann-toolkit开发套件包所在的开发环境。进行模型转换前，用户可以
按需配置环境变量，具体可参考全局环境变量设置。

转换步骤

步骤1 打开模型转换页面，在“Model Information”页签中上传模型文件和权重文件，界面
参考如图5-2或图5-3所示，不同版本请以实际界面显示为准。
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图 5-2 配置模型信息（Linux 系统示例）
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图 5-3 配置模型信息（Windows 系统示例）

参数解释如表5-2所示。

表 5-2 Model Information 界面参数配置

参数 说明

CANN Machine
（仅Windows系
统支持此参数）

自动填充。远程连接CANN所在环境的SSH地址，表现格式为
<username>@localhost:端口号。
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参数 说明

Model File 模型文件。必填。该模型文件需要取消其他用户写的权限。

单击右侧的文件夹图标，选择需要转换的模型模型文件。

● 在Linux上使用模型转换功能时，选择或直接输入本地服务器
上需要转换的模型文件路径。

● 在Windows上使用模型转换功能时，在弹出的窗口中选择
“remote path”，在后台服务器路径选择需要转化的模型文
件并上传；选择“local path”，单击右侧的文件夹图标，在
Windows本地选择或直接输入需要转化的模型文件路径并上
传。

说明
当导入超大模型时，如果提示报错“Failed to get model input
shape.”，请在MindStudio安装路径下bin目录中的
MindStudio.exe.vmoptions文件（32位）或者
MindStudio64.exe.vmoptions文件（64位）中，将Xms和Xmx的数值调
大后重启MindStudio。

Weight File 权重文件。当原始框架是Caffe时，该参数存在且必填：

● 在Windows环境中，模型文件和权重文件需要放在同一目录
下，单击选择模型文件时，权重文件将会自动填充。

● 在Linux环境中，如果模型文件和权重文件存在于后台服务器
同一目录下，且名称和模型文件名称相同，则选择模型文件
后，权重文件会自动填充。

● 如果模型文件和权重文件存在于后台服务器不同目录下，或
者在同一目录下，但名称和模型文件名称不相同。

– 用户手动上传权重文件，单击右侧的文件夹图标，在后台
服务器路径选择模型文件对应的权重文件，上传即可。

– 在参数后面的输入框中自行输入*.caffemodel权重文件在
后台服务器的路径，包括权重文件名称及后 。

Model Name 模型文件名称，必填。选择模型文件后，该参数会自动填充，用
户可以根据需要自行修改名称，要求如下：

只支持a-z、A-Z、0-9、下划线以及短划线的组合， 多支持64
个字符。

如果模型转换的输出路径已经存在相同名称模型文件，单击
“Next”后会提示覆盖原有文件或重命名当前Model Name的信
息，用户根据实际情况选择。

Output Path 输出的另存模型文件路径，用户可通过手动输入或单击右侧文件
夹图标进行选择。进行模型转换后，系统会把默认在$HOME/
modelzoo/${Model Name}/${Target SoC Version}/路径下输出
转换后的om模型文件拷贝至配置的Output Path路径中。

Target SoC
Version

模型转换时指定芯片型号。请根据板端环境具体芯片形态进行选
择。
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参数 说明

Input Format 输入数据格式。

● 当原始框架是Caffe时，取值为NCHW、ND（表示支持任意格
式，N<=4），默认为NCHW。

● 当原始框架是MindSpore、ONNX时，取值为NCHW。

● 当原始框架是TensorFlow时，取值为NCHW、NHWC、ND、
NCDHW、NDHWC，默认为NHWC。

Input Nodes 模型输入节点信息。

● 如果选择模型文件并且解析成功，则该参数下方会展示模型
输入节点的shape信息以及Type信息。

● 如果选择模型文件后，无法解析“Input Nodes”，该场景
下，需要用户根据模型文件中的相关信息手动输入：单击该

参数右侧的 ，在弹出界面中输入模型输入节点的Name、
Shape信息（只支持英文逗号，数字（-1或大于0的整数），
不能以英文逗号开头，只能以数字结尾）和输入节点的数据

类型Type。单击 删除节点信息。

● 如果模型有多个输入，解析成功后，“Input Nodes”参数下
方会展示每一个输入节点的Shape信息和Type信息。

说明
若原始框架为MindSpore，Input Nodes不会自动解析对应模型中的输
入信息，需要用户自行查看相应的网络模型输入，手动填写。如果不
填，后台使用atc命令进行转换时，ATC工具会自动解析网络模型中的
相关参数。
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参数 说明

Shape 模型输入的shape信息。例如图5-2中的数值分别代表输入数据的
N（模型一次处理的图片个数），C（Channel，例如彩色RGB图
像的Channel数为3），H（Height），W（Width)。若开启AIPP
功能，则此处的H，W取值即为AIPP输出数据的高和宽。根据输
入数据格式分为以下两种设置情况。

● 当“Input Format”参数是具有固定形状的输入数据格式，如
NCHW和NCDHW等，

– 设置动态batch：适用于执行推理时，每次处理图片数量不
固定的场景。
将解析的shape中的N设置为-1，单击其他参数或者单击
“Next”，会在shape下方出现Dynamic Batch参数。在
其中的编辑框中输入具体的档位数，每一档通过英文逗号
分隔。 多支持100档配置，每个档位数值建议限制为：
[1~2048]，例如输入1,2,4,8。

如果模型转换时设置了Dynamic Batch参数，则使用应用
工程进行模型推理时，需要在aclmdlExecute接口之前，
增加aclmdlSetDynamicBatchSize接口，用于设置真实的
batch档位。关于aclmdlSetDynamicBatchSize接口的具
体使用方法，请参见《应用软件开发指南（C&C++）》的
“AscendCL API参考”中的模型加载与执行章节。

– 设置输入图片的动态分辨率：适用于执行推理时，每次处
理图片宽和高不固定的场景。
将解析的shape中的H和W设置为-1，单击其他参数或者单
击“Next”，会在shape下方出现Dynamic Image Size参
数。在其中的编辑框中输入具体的动态分辨率参数， 少
输入两组，每一组参数通过英文分号分隔，组内参数使用
英文逗号分隔。 多支持100档配置，例如输入
112,112;224,224。

如果模型转换时设置了Dynamic Image Size参数，则使
用应用工程进行模型推理时，需要在aclmdlExecute接口
之前，增加aclmdlSetDynamicHWSize接口，用于设置
真实的分辨率。关于aclmdlSetDynamicHWSize接口的
具体使用方法，请参见《应用软件开发指南（C&C++）》
的“AscendCL API参考”中的模型加载与执行章节。
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参数 说明

如果模型转换时设置了动态分辨率，并且要使用“Data
Pre-Processing”中的数据预处理功能，该场景下不能设置
数据预处理的Crop和Padding功能。

设置动态batch和动态分辨率不能同时使用，一次只能设置
其中一个参数。

● 当“Input Format”参数为ND，设置ND格式下的动态维度：
适用于执行推理时，每次处理任意维度的场景。
根据需要设置-1在Shape中数量及位置，单击其他参数或者单
击“Next”，会在Shape下方出现Dynamic Dims参数。在
其中的编辑框中输入具体的动态维度参数， 少输入2组，
多100组。组与组之间使用英文分号分隔，组内参数使用英文
逗号分隔。组与组之间的内容不能重复，组内的 小维度为
1。每组中的参数值与Shape参数中的-1标识的参数依次对
应，Shape参数中有几个-1，则每组必须设置几个参数值。例
如输入shape信息为“-1,-1,-1,-1”，输入Dynamic Dims参
数可以为“1,224,224,3;2,448,448,6”。

Type Type：指定输入节点的数据类型。

● 若原始框架类型为Caffe、ONNX，支持的数据类型为FP32、
FP16、UINT8。

● 若原始框架类型为MindSpore，支持的数据类型为FP32、
UINT8。

● 若原始框架类型为TensorFlow，支持的输入数据类型为
FP32、FP16、UINT8、Int32、Int64、Bool。

当原始框架为Caffe、ONNX和MindSpore时，只有Type取值为
UINT8，步骤2中“Data Pre-Processing”页签（配置AIPP功
能）才支持配置，其他类型不支持配置。如果模型有多个输入，
只有Type取值为UINT8的节点，才可以配置“Data Pre-
Processing”页签；如果Type取值为UINT8的节点无法获取
Shape中的H，W信息，也无法配置“Data Pre-Processing”页
签。

当原始框架为TensorFlow时，只有Type取值不为FP16，步骤2中
“Data Pre-Processing”页签（配置AIPP功能）才支持配置。如
果模型有多个输入，只有Type取值不为FP16的节点，才可以配置
“Data Pre-Processing”页签；如果Type取值不为FP16的节点
无法获取Shape中的H，W信息，也无法配置“Data Pre-
Processing”页签。
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参数 说明

Output Nodes 指定输出节点信息。

单击“Select”在弹出的网络拓扑结构中，选中某层节点，右击
选择“Select”，该层由蓝色标签进行标记，单击“OK”后，在
“Output Nodes”参数下面会看到标记层的算子，右击选择
“Deselect”取消选中。

● Op Name：标记层的算子名称。

● Data Type：算子输出的数据类型，包括FP32、UINT8、
FP16，通过该参数用户可以设置单个算子的输出数据类型。

“Output Nodes”参数下方“Select”层的算子，默认为全部选
中，用户可以自行选择将不需要输出的算子去勾选，只有选中的
算子才会作为模型的输出。本章节以选中所有算子为例进行说
明。

某些情况下，用户想要查看某层算子参数是否合适，则需要将该
层算子的参数输出，即可以通过单击“Select”按钮，在弹出网
络拓扑结构中将所需层的算子标记为“Select”，然后在
“Output Nodes”参数下方选中想要输出的算子，模型转换
后，在相应.om模型文件可以看到该算子的输出直接作为模型的
输出。详细信息请参见模型可视化。

说明

● 如果不标记某层算子或标记后Output Nodes节点下方不选中某个算
子，则模型的输出默认为 后一层的算子信息。

● 如果标记某层算子，并且标记后Output Nodes节点下方选中某个或多
个算子，则模型输出为Output Nodes节点下方选中的算子。

● 如果模型转换过程中该算子被融合掉，则该算子不能作为输出节点。

● 如果用户选择的模型中包括不支持的算子，则单击“Select”后，
MindStudio界面“Output”窗口会提示哪些算子不支持并提示shape
信息无法获取等信息，在弹出的网络结构图中该算子呈现红色，该场
景下无法获取算子的输出维度和shape信息。

● 若原始框架为MindSpore，该参数无法编辑，不支持指定输出节点信
息。

Load
Configuration

导入上次模型转换的配置文件。

如果用户之前转换过模型，无论成功与否，在$HOME/
modelzoo/${Model Name}/${Target SoC Version}/路径都会生
成${Model Name}_config.json配置文件，该文件记录用户模型
转换时所选择的配置信息，包括所用模型路径、模型名称、输入
输出配置，数据预处理配置等，下次重新转换模型时，通过单击
“Load Configuration”选择相应路径下的配置文件，则相应的
配置信息会自动填充，用户自行决定是否沿用上次配置还是修改
配置后重新进行模型转换。

 

单击右侧的 按钮，弹出生成模型网络结构图进度条，之后会弹出该模型的原始网
络结构图，如图5-4所示。（MindSpore框架的原始网络模型，不支持查看网络结构
图。）
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说明

● 上/下滑动鼠标滚轮，可以控制模型可视化区域的上/下移动。

● 按住Ctrl键+上下滑动鼠标滚轮，可以实现模型可视化区域的放大/缩小。

图 5-4 模型网络结构

● 查看算子信息

单击某层算子，该层算子会出现绿色选中框，右上角区域会展示该选中框所有的

算子，单击 可以展开所有算子信息，包括算子名称，算子类型以及算子的参数

信息等，单击 折叠所有的算子信息；用户也可以逐层单击相关算子左侧的展开
按钮 ，查看参数的详细信息。展示的信息同模型文件中该层算子的信息。

● 查看算子输出维度和shape信息

图5-4所示界面展示了每一层算子输出的维度和shape信息，如每一层算子连接线
中间的1,3,224,224、1,64,112,112等信息。将鼠标移至某个shape上面，在其上面
会显示算子输出的维度信息，例如NCHW等维度。

如果用户选择的模型中包括不支持的算子，则单击右侧的 按钮，MindStudio
界面“Output”窗口会提示哪些算子不支持并提示shape信息无法获取等信息，
在弹出的网络结构图中该算子呈现红色，该场景下无法获取算子的输出维度和
shape信息。该场景下的处理方法请参见异常处理。

● 搜索算子

搜索区域中给出了该模型所用到的所有算子，您可以在搜索区域“Find”后面的
对话框中输入算子名称，下方搜索区域会列出相关的算子，选择其中一个算子，
左侧网络拓扑结构中相应算子会显示绿色选中框，右上方会展示该选中框所包括
的所有算子信息。
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图 5-5 模型可视化界面的搜索功能

● 搜索算子内部信息

选中某层算子，单击右上方的 展开按钮，右侧区域框会展示该层所包括所有算

子的信息，然后单击 或在右侧区域使用“Ctrl+F”快捷键，弹出图5-6所示搜索
界面，其中：

– Case sensitive：大小写敏感。

– Wrap Search：循环搜索。

– Backward：反向搜索。

用户在输入框中输入想要查询的信息，比如算子的输入输出、属性等信息，然后
在图5-6界面中勾选搜索特性，单击“Find”进行查找，如果匹配到相关信息，则
右侧区域框中相关信息会高亮显示，否则会提示“Value not found”。单击
“Close”退出搜索。

图 5-6 搜索算子内部信息

单击“OK”退出编辑。

步骤2 单击“Next”，进入“Data Pre-Processing”配置数据预处理页签，界面参考如图5-7
所示，不同版本请以实际界面显示为准。

数据预处理是昇腾AI处理器提供的硬件图像预处理模块，包括色域转换，图像归一化
（减均值/乘系数）和抠图（指定抠图起始点，抠出神经网络需要大小的图片）等功
能。

只有当“Model Information”页签，“Input Nodes”参数中，输入节点的“Type”
有配置为“Uint8”类型，“Data Pre-Processing”页签才可以配置该节点的数据预处
理功能。如果模型有多个输入，每个输入节点都可以获取shape信息中的宽和高，并且
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“Input Nodes”参数中每个输入节点的“Type”都配置为“Uint8”，则“Data Pre-
Processing”页签可以配置多个节点的数据预处理功能。

图 5-7 配置数据预处理功能

参数说明如表5-3所示。

表 5-3 节点配置参数

参数 说明

Image Pre-
processing
Mode

图片预处理模式， 包括如下两种：

● Static：静态AIPP。

● Dynamic：动态AIPP。

Load Aipp
Configuration

AIPP配置加载功能。动态AIPP不支持此功能。

开启此功能后，在“Aipp Configuration File”输入框中选择对应
的配置文件或者手动输入配置文件路径。

加载配置文件后，所有“Input Node： (data)”和“Input
Node： (im_info)”下的参数按照配置文件自动设置，如有需要，
用户可自定义修改界面参数。

Image Pre-processing Mode取值为Static，如下参数需要配置：
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参数 说明

Input Node：
(data)

节点配置开关，可以控制是否对该节点开启AIPP。只有图5-2中
Input Nodes参数对应data节点的Type取值为UINT8，该参数才会
自动开启。当模型为TensorFlow时，图5-2中Input Nodes参数对
应data节点的Type取值为FP32、Int32、Int64、Bool时，可以手动
开启该参数。

Input Node：
(im_info)

模型有两个输入时，该参数才出现，表示对模型的第二个输入开启
AIPP。只有图5-2中Input Nodes参数对应im_info节点的Type取值
为UINT8，并且能获取模型的宽和高，该参数才打开。Input
Node： (im_info)中的im_info根据解析的模型不同而变化。
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参数 说明

Input Image
Format

输入图片格式。

若步骤1中“Target SoC Version”选择Ascend310、Ascend710、
Ascend710Pro，则支持的格式为：YUV420 sp、YVU420 sp、RGB
package、BGR package、YUV400。

● 若取值为YUV420 sp、YVU420 sp、YUV422 sp、YVU422 sp，
则右侧会出现输入数据类型选项：
BT.601(Video Range)、BT.601(Full Range)、BT.709(Video
Range)、BT.709(Full Range)
不同的类型，对应不同的色域转换配置（色域转换，用于将输
入的数据格式，转换为模型需要的格式，具体色域转换系数会
在模型转换完成后生成在insert_op.cfg配置文件中）其中：

– BT.601是标准清晰度视频的格式，定义于SDTV标准中。

– BT.709是标准化高清晰度视频的格式，定义于HDTV标准
中。

两种标准又分为NARROW(Video Range)和WIDE(Full
Range)，其中：

NARROW取值范围为： ；WIDE取值范围为：

，关于如何判断输入数据的标准，请参见
《ATC工具使用指南》“FAQ > 使用AIPP色域转换模型时如何
判断视频流的格式标准”章节。

● 若取值为YUV400，不支持色域转换。

● 若取值为RGB package、BGR package、ARGB package、
RGBA package、ABGR package、BGRA package，则不会出
现右侧的输入数据类型选项，根据输出（Model Image
Format）参数的取值不同，模型转换完成后，数据预处理配置
文件insert_op.cfg中如下参数的取值不同：

– 若取值为BGR package，输出为RGB；或取值为RGB
package，输出为BGR：
#色域转换前，R通道与B通道交换开关/U通道与V通道交换开关
rbuv_swap_switch : true

– 若取值为BGR package，输出为BGR；或取值为RGB
package，输出为RGB：
#色域转换前，R通道与B通道交换开关/U通道与V通道交换开关
rbuv_swap_switch : false

– 若取值为ARGB package，输出为RGBA；或取值为ABGR
package，输出为BGRA：
#色域转换前，R通道与B通道交换开关/U通道与V通道交换开关
rbuv_swap_switch : false     
#色域转换前，RGBA->ARGB, YUVA->AYUV交换开关
ax_swap_switch : true

– 若取值为ARGB package，输出为BGRA；或取值为ABGR
package，输出为RGBA：
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参数 说明

rbuv_swap_switch : true 
ax_swap_switch : true

– 若取值为RGBA package，输出为RGBA；或取值为BGRA
package，输出为BGRA：
rbuv_swap_switch : false 
ax_swap_switch : false

– 若取值为RGBA package，输出为BGRA；或取值为BGRA
package，输出为RGBA：
rbuv_swap_switch : true 
ax_swap_switch : false

Input Image
Resolution

原始图片大小。

如果“Input Image Format”取值为“YUV420 sp”，要求原始图
片的宽和高取值是偶数。

Model Image
Format

模型处理图片格式。

输入图片格式不同，模型处理图片格式不同，具体格式如下：

● 若“Input Image Format”取值为YUV420 sp、YVU420 sp、
YUV422 sp、YVU422 sp、BGR package，则“Model Image
Format”取值为RGB、BGR。

● 若“Input Image Format”取值为RGB package，则“Model
Image Format”取值为RGB、BGR、GRAY。

● 若“Input Image Format”取值为YUV400，则“Model Image
Format”取值只能为GRAY。

● 若“Input Image Format”取值为ARGB package、RGBA
package、ABGR package、BGRA package，则“Model
Image Format”取值为RGBA、BGRA。

● 若步骤2中“Aipp Configuration File”选择的AIPP配置文件是
读不出RGB数据的异常文件，则“Model Image Format”默认
取值为GRAY。

该参数同时也是色域转换开关，默认开启。当输入图片格式与模型
处理文件格式不一致时需要开启。
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参数 说明

Crop 抠图开关，若开启，则表示启用抠图功能。默认关闭。

开启该参数后，下方会出现如下两个参数：

● Cropping Start：抠图开始位置。Cropping Start [H][W]的取
值范围要小于Input Image Resolution [H][W]（原始图片的高
和宽）。

● Cropping Area：抠图大小，默认抠图大小的宽和高来自图
5-2“Input Nodes”参数中Shape参数取值的宽和高，修改的
宽和高取值不能超过原始图片Input Image Resolution对应参数
的取值。

抠图约束如下：

● 若“Input Image Format”取值为YUV420 sp、YVU420 sp，
则Cropping Start [H][W]都必须为偶数。

● 若“Input Image Format”取值为YUV422 sp、YVU422 sp，
则Cropping Start [W]必须为偶数。

● 若“Input Image Format”取值为其他值，对Cropping Start
[H][W]没有约束。

● 若开启抠图功能，则Input Image Resolution >= Cropping
Area + Cropping Start。

若开启抠图功能，并且没有开启Padding，该场景下Cropping
Area [H][W]才能取值为0或不配置，此时抠图大小Cropping Area
[H][W]取值来自图5-2Input Nodes中shape取值的高和宽（模型文
件input shape中的高和宽）。

Padding Padding使能开关，若开启，则表示启用补边功能。默认关闭。

Padding Area [L][R][B][T]取值范围为[0,32]。AIPP经过Padding
后，输出的图片的高和宽要与模型需要的高和宽保持一致。

Normalization 归一化开关。

开启后，包括Mean、Min、Variance三个配置项，其中
“Conversion Type”表示计算规则。
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参数 说明

Mean 每个通道的均值。

当开启“Normalization”参数时才呈现。

● 若“Model Image Format”为RGB时，则该参数显示为Mean:
[R][G][B]，每个通道的默认值为104、117、123，可根据需要
手动修改默认值。

● 若“Model Image Format”为BGR时，则该参数显示为Mean:
[B][G][R]，每个通道的默认值为104、117、123，可根据需要
手动修改默认值。

● 若“Model Image Format”为GRAY时，则该参数显示的默认
值为104，可根据需要手动修改默认值。

● 若“Model Image Format”为RGBA时，则该参数显示为
Mean: [R][G][B][A]，每个通道的默认值为104、117、123、
0，可根据需要手动修改默认值。

● 若“Model Image Format”为BGRA时，则该参数显示为
Mean: [B][G][R][A]，每个通道的默认值为104、117、123、
0，可根据需要手动修改默认值。

Min 每个通道的 小值。

当开启“Normalization”参数时才呈现。

● 若“Input Image Format”为YUV420 sp、YVU420 sp、
YUV422 sp、YVU422 sp、YUV400、RGB package、BGR
package，则该参数显示为Min: [R][G][B]，每个通道的默认值
都为0。

● 若“Input Image Format”为ARGB package、RGBA
package、ABGR package、BGRA package，则该参数显示为
Min: [R][G][B][A]，每个通道的默认值都为0。

1/Variance 每个通道的方差的倒数。

当开启“Normalization”参数时才呈现。

● 若“Input Image Format”为YUV420 sp、YVU420 sp、
YUV422 sp、YVU422 sp、YUV400、RGB package、BGR
package，则该参数显示为1/Variance: [R][G][B]，每个通道的
默认值都为1.0。

● 若“Input Image Format”为ARGB package、RGBA
package、ABGR package、BGRA package，则该参数显示为
1/Variance: [R][G][B][A]，每个通道的默认值都为1.0。

Image Pre-processing Mode取值为Dynamic，如下参数需要配置：

Input Node：
(data)

动态AIPP节点配置开关，可以控制是否对该节点开启动态AIPP。只
有图5-2中Input Nodes参数对应data节点的Type取值为UINT8，该
参数才打开。

Input Node：
(im_info)

模型有两个输入时，该参数才出现，表示对模型的第二个输入开启
动态AIPP。只有图5-2中Input Nodes参数对应im_info节点的Type
取值为UINT8，并且能获取模型的宽和高，该参数才打开。Input
Node： (im_info)中的im_info根据解析的模型不同而变化。
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参数 说明

Max Image
Size (Byte)

输入图像 大的size，动态AIPP必须配置（如果为动态batch场
景，N为 大档位数的取值）

● 若输入图像格式为YUV400_U8，则Max Image Size>=N *
Input Image Resolution [W] * Input Image Resolution [H] *
1。

● 若输入图像格式为YUV420SP_U8，则Max Image Size>=N *
Input Image Resolution [W] * Input Image Resolution [H] *
1.5。

● 若输入图像格式为XRGB8888_U8，则Max Image Size>=N *
Input Image Resolution [W] * Input Image Resolution [H] *
4。

● 若输入图像格式为RGB888_U8，则Max Image Size>=N *
Input Image Resolution [W] * Input Image Resolution [H] *
3。

 

须知

模型转换是否开启AIPP功能，执行推理业务时，对输入图片数据的要求：

模型转换时开启AIPP，在进行推理业务时，输入图片数据要求为NHWC排布，该场景
下 终与AIPP连接的输入节点的格式被强制改成NHWC，该场景下可能与步骤1中
“Model Information”页签中“Input Format”参数指定的数据格式不一致。

步骤3 单击“Next”，进入“Advanced Options Preview”高级选项配置页签，界面参考如
图5-8所示，不同版本请以实际界面显示为准。
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图 5-8 高级选项配置

参数解释如下：

表 5-4 Choose Model 界面参数配置

参数 说明

Operator
Fusion

是否关闭融合功能。

● 打开表示关闭融合功能。打开该项将显示“Fusion Passes”。

● 关闭表示开启融合功能。参数默认关闭，即默认打开融合功
能。

说明
关闭融合功能时，仅关闭配置文件中指定的融合规则，当前可以关闭
的融合规则请参见《图融合和UB融合规则参考》，但是由于系统机
制，其他融合规则无法关闭。

如果使用昇腾模型压缩工具量化后的模型通过模型转换得到.om
离线模型，然后进行精度比对，则需要打开该开关。打开后，模
型转换完毕，在生成om模型的同级目录下，会生成
fusion_switch.cfg配置文件，该文件记录哪些功能被关闭。
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参数 说明

Fusion Passes 需要关闭的融合规则。打开“Operator Fusion”功能，会显示该
项，默认关闭的融合规则有： V100RequantFusionPass、
V200RequantFusionPass、ConvConcatFusionPass、
SplitConvConcatFusionPass、TbeEltwiseQuantFusionPass、
TbeConvDequantVaddReluQuantFusionPass、
TbeConvDequantVaddReluFusionPass、
TbeConvDequantQuantFusionPass、
TbeDepthwiseConvDequantFusionPass、
TbeFullyconnectionElemwiseDequantFusionPass、
TbeConv2DAddMulQuantPass、TbePool2dQuantFusionPass、
TbeAippConvReluQuantFusion、
TbeCommonRules0FusionPass、
TbeCommonRules2FusionPass。

● 在文本框中输入需要关闭的融合规则。融合规则名称1:off；融
合规则名称2:off，多个融合规则之间用英文分号隔开。

● 单击文本框后的 图标，在弹出的对话框中单击 填写。

– 在Name中输入融合规则名称：融合规则名称1。

– 在Value中输入环境变量值：off。

说明
用户需要确保输入的融合规则的正确性。
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参数 说明

Auto Tune
Mode

设置算子的自动调优模式。使用该功能时，请确保MindStudio和
运行环境在同一台服务器。

控制TBE算子编译时，是否对算子进行调优，以便在昇腾AI处理
器上寻找 好的性能配置，包括如下几种模式：

● Genetic Algorithm（GA）：遗传算法，用于设置Cube算子的
调优性能。

● Reinforcement Learning（RL）：强化学习，用于设置Vector
算子的调优性能。

● Genetic Algorithm and Reinforcement Learning：GA和RL调
优功能同时开启。

其中：

● GA调优：

– Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/opp/data/tiling/${soc_version}/built-in/路径会
生成内置知识库以及cost model。
该路径负责存储常用shape调优后的知识库和cost model，
如果网络模型中某个shape没有命中内置知识库，则会发起
调优。

– Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/opp/data/tiling/${soc_version}/custom/路径用
于存放调优过程中生成的知识库。如果该路径已经有知识
库，则对该知识库进行追加；如果当前路径没有知识库，
则新建知识库。

进行模型转换时，只有设置Auto Tune Mode=GA或Auto Tune
Mode="RL,GA"，模型编译时才会默认读取自定义知识库中的
调优策略，否则模型编译时直接使用Auto Schedule进行调
优。

● RL调优：

– Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/opp/data/rl/${soc_version}/built-in/路径会生成
内置知识库，该路径负责存储常用shape调优后的知识库。

– Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/opp/data/rl/${soc_version}/custom/路径用于存
放调优过程中调优性能优于built-in或built-in中没有的知识
库。
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参数 说明

说明

● 如果custom路径已经有用户调优过的知识库，由于某种原因导致算子
逻辑变更，例如GEMM算子新增支持的ND输入，该情况下需要在
MindStudio安装服务器设置如下环境变量后，重新发起调优。
export REPEAT_TUNE=True

● 开启auto_tune时，由于上板评估需要申请内存，内存占用相比ATC工
具要大，额外的内存占用大小与同时使用的device设备数有关，可近似
估算为：2*device数量*输入数据大小。如果内存超过ATC运行内存大
小，则会导致调优失败。

● 使用auto_tune工具进行GA模式调优时，需要独占Device资源，不可
以进行需要使用Device资源的其他操作，请将其他进程停止后，重新
进行调优。如果Host有编译业务执行，则会影响调优时长。

● 使用到算子的自动调优模式参数“Auto Tune Mode”时，如果driver
包的安装路径不在默认路径“/usr/local/Ascend”，此时需要在下方
Environment Variables参数中按照如下格式配置环境变量
LD_LIBRARY_PATH，其中，“${install_path}”表示driver包实际安装
路径。

– 推理环境需配置：LD_LIBRARY_PATH= ${install_path}/driver/
lib64:$LD_LIBRARY_PATH

– 训练环境需配置：LD_LIBRARY_PATH= ${install_path}/driver/
lib64/driver:$LD_LIBRARY_PATH

关闭模型转换窗口之后，再次启用“Auto Tune Mode”参数时需要重
新进行上述操作。

Additional
Arguments

扩展转换参数。模型转换界面不支持配置，但是ATC工具支持的
参数，均可通过此选项进行扩展。 多支持输入2048个字符。

在下方编辑框中输入ATC工具可用的参数，用户根据实际情况进
行填写，多个参数使用空格分隔。详细参数请参见《ATC工具使
用指南》的“参数说明”章节，例如：--log=info。

如果界面已经有模型转换支持的参数，例如该页签中的设置算子
的自动调优模式参数“Auto Tune Mode”，对应ATC工具中的
“--auto_tune_mode”参数，则在“Additional Arguments”再
次配置“--auto_tune_mode”为其他数值，例如配置为“--
auto_tune_mode="GA,RL"”，则“Auto Tune Mode”参数指定
的模式不生效。

Environment
Variables

环境变量。可选参数，请根据实际自行配置。

● 在文本框中添加环境变量。PATH_1=路径1；PATH_2=路径
2，多个环境变量用英文分号隔开。

● 单击文本框后的 图标，在弹出的对话框中单击 填写。

– 在Name中输入环境变量名称：PATH_1。

– 在Value中输入环境变量值：路径1。
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参数 说明

Command
Preview

模型转换使用的atc参数预览。不支持修改。

在所有页签配置完相关参数后，该区域会给出界面参数转换成atc
命令的结果预览，例如“Auto Tune Mode”参数配置为
“Genetic Algorithm”，则

“Command Preview”区域展示的atc命令为“--
auto_tune_mode="GA"”。

如果“Additional Arguments”中再次配置界面已有的参数，例
如配置为“--auto_tune_mode="GA,RL"”，则“Command
Preview”区域会追加相应的参数，模型转换时，“Command
Preview”区域后面的参数取值会覆盖前面已有的参数。

 

步骤4 单击“Finish”，开始进行模型转换。

在MindStudio界面下方，“Output”窗口会显示模型转换过程中的日志信息，如果提
示“Model converted successfully”，则表示模型转换成功。“Output”窗口会显示
模型转换所用的命令、所设置的环境变量、模型转换的结果、模型输出路径以及模型
转换日志路径等信息。

步骤5 模型转换完毕，在服务器后台路径“$HOME/modelzoo/resnet50/$Soc_Version ”下
会生成用于运行环境运行的.om模型文件，以及模型转换所用的配置信息文件$
{modelname}_config.json和日志文件ModelConvert.txt。
● 如果开启数据预处理功能，在.om同级目录下，还会生成数据预处理的配置信息文

件（insert_op.cfg）。

● 如果勾选关闭融合功能，在.om同级目录下，还会生成融合开关配置文件
（fusion_switch.cfg），用于记录哪些功能被关闭。

模型转换的日志文件（ModelConvert.txt）所在路径为：“$HOME/modelzoo/
resnet50/$Soc_Version”。回显信息示例如下：

hisisoc@dggphicprd32833:~/modelzoo/resnet50/$ ll
total 150636
drwxr-x--- 4 hisisoc hisisoc      4096 Mar 10 16:46 ./
drwxr-x--- 4 hisisoc hisisoc      4096 Mar 10 16:45 ../
drwxr-x--- 2 hisisoc hisisoc      4096 Mar 10 16:45 Ascend310/
drwxr-x--- 2 hisisoc hisisoc      4096 Mar 10 16:45 Ascend910A/
hisisoc@dggphicprd32833:~/modelzoo/resnet50$ cd Ascend310
hisisoc@dggphicprd32833:~/modelzoo/resnet50/Ascend310$ ll
total 50780
drwxr-x--- 2 hisisoc hisisoc      4096 Mar 10 16:46 ./
drwx------ 3 hisisoc hisisoc      4096 Mar 10 16:45 ../
-rw------- 1 hisisoc hisisoc        127 Mar 10 15:55 fusion_switch.cfg        --融合开关配置文件
-rw------- 1 hisisoc hisisoc       453 Mar 10 16:45 insert_op.cfg             --数据预处理配置文件
-rw-r----- 1 hisisoc hisisoc       453 Mar 10 16:45 ModelConvert.txt         --日志文件
-rw------- 1 hisisoc hisisoc      2095 Mar 10 18:03 resnet50_config.json     --模型转换所用的配置信息文件，
下次模型转换时，可以通过选择该文件沿用上次模型转换的配置数据
-rw------- 1 hisisoc hisisoc  51581408 Mar 10 16:46 resnet50.om               --上板运行的模型文件         

----结束

异常处理
● 问题描述

如果用户选择的模型文件中包括昇腾AI处理器不支持的算子，则模型转换时会弹
出图5-9所示整网支持度评估报告。
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图 5-9 模型整网支持度报告

其中左侧的“Summary”区域中：

– All Operator：显示本次转换的模型所包括所有算子个数，包括不支持的算子
个数。

单击“All Operator”，在右侧的“Result Details”区域，会展示模型所有
的算子详细信息，包括算子类型，算子名称，是否解析成功的结果；如果算
子解析失败，在“Description”处还会展示解析失败的原因。

– UnSupported Operator：本次转换的模型不支持的算子个数。下方会列出不
支持算子的原因，以及每种原因下不支持的算子个数。

单击“UnSupported Operator”，右侧会筛选出所有不支持的算子。

● 解决方法

a. 在图5-9所示整网支持度评估报告界面中，选中右侧“Result Details”区域
“Result”为“failed”的算子，则该算子整行被选中。单击 右侧
“Operation”下面的解决方法，例如“Creator Operator”，创建自定义算
子工程。

如果当前已经打开了算子工程，则会弹出图5-10提示框，可以选择在当前算
子工程添加算子或新建算子工程；如果当前不存在算子工程，则会直接弹出
新建算子工程界面。

关于创建自定义算子工程的详细操作请参见工程创建。

图 5-10 创建算子工程时提示信息

b. 根据引导完成自定义算子工程的创建。

“New Project > Ascend Operator”中的“Operator Type”自定义算子的
类型，会根据模型支持度评估界面选中的算子类型自动填充。创建完成后，
新建工程的默认存储路径为“$HOME/AscendProjects”。

算子工程目录结构以及主要文件如下：
├── .idea
├── build                                  //编译生成的中间文件
├── cmake                                  //编译相关公共文件存放目录
├── framework                              //算子插件实现文件目录
│   ├── tf_plugin                         //存放tensorflow框架的算子插件文件及编译规则文件
│   │   ├── tensorflow_add_plugin.cpp 
......
......

c. 进行自定义算子的开发，详细信息请参见自定义算子开发。

自定义算子开发完成后，重新进行模型转换。
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5.3 模型可视化
对于已经转换成功的.pb模型文件、.onnx模型文件、.prototxt模型文件或.om模型文
件，可以在MindStudio界面呈现其网络拓扑结构，并可以查看模型所使用的算子。下
文中以.om模型文件为例展示模型可视化功能。

步骤1 依次单击菜单栏“Ascend > Model Visualizer”，或在工具栏选择 ，在弹出窗口中
选择要可视化的模型，例如此处的resnet50模型文件。

● 在Linux上使用模型转换功能时，单击右侧的文件夹图标，选择或直接输入本地服
务器上需要转换的模型文件路径。

图 5-11 选择要打开的模型（Linux）

● 在Windows上使用模型转换功能时，在弹出的窗口中单击右侧的文件夹图标，选
择“remote path”，在后台服务器路径选择需要转化的模型文件并上传；选择
“local path”，单击右侧的文件夹图标，在Windows本地选择或直接输入需要转
化的模型文件路径并上传。

MindStudio
用户指南 5 模型转换

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 120



图 5-12 选择要打开的模型（Windows）

说明

查看.prototxt模型文件时，需要保证.prototxt模型文件与其相关的.caffemodel权重文件在
同一目录下。

步骤2 依次选择“resnet50 > Soc_Version”(Soc_Version表示芯片型号) ，选择模型转换中
已经转换成功的resnet50.om模型文件，单击“OK”。
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说明

● 当前优化模型可视化的排版布局效果，使整个网络拓扑结构看起来更加清晰有条理，需要通
过root用户安装node.js工具来实现。优化后的界面如图5-14所示。

– ubuntu操作系统：apt install nodejs

– CentOS、EulerOS和麒麟OS：

1. 如在官网下载软件包。

例如，下载node-v8.10.0-linux-arm64.tar.gz。

2. 解压软件包。

3. 配置环境变量：export NODE_HOME=<软件包解压目录>和export PATH=<软件
包解压目录>/bin:$PATH

● 没有安装node.js工具时，模型可视化的排版和结构如图5-13所示。

图 5-13 模型可视化界面（优化前）

图 5-14 模型可视化界面（优化后）

● 查看算子信息

图5-14展示了模型文件中所有的算子，单击某层算子，该层算子会出现绿色选中
框，右侧区域会展示该算子的详细信息，包括算子名称、算子输入、输出等信
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息。单击 展开算子的所有参数信息，用户也可以逐层单击相关参数左侧的展开

按钮 ，查看参数的详细信息；单击 折叠所有的算子信息。

中间区域会展示该网络模型的整体结构，包括右侧展示框中的算子在整体网络结
构中的位置，即图中的蓝色框选择位置。左侧展示区域下拉，右侧整体区域中的
蓝区选择框随之往下移动。左侧展示框放大和缩小，右侧蓝色框随之缩小和放
大。

说明

– 上/下滑动鼠标滚轮，可以控制模型可视化区域的上/下移动。

– 按住Ctrl键+上下滑动鼠标滚轮，可以实现模型可视化区域的放大/缩小。

● 查看算子输出维度和shape信息

图5-14还展示了每一层算子输出的维度和shape信息，如每一层算子连接线中间
的1,224,224,4等shape信息，将鼠标移至某个shape上面，在其上面会显示算子输
出的维度信息，例如NCHW以及NC1HWC0等维度。

● 搜索算子

在图5-14右侧区域的“Find”右侧的输入框中输入算子名称，下方搜索区域会列
出相关的算子。选择其中一个算子，左侧网络拓扑结构中相应算子会显示绿色选
中框，右上方会展示该算子的详细信息，包括算子名称、算子输入、输出等信
息。如图5-15所示。

图 5-15 模型可视化界面的搜索功能

● 搜索算子内部信息

选中某层算子，单击右上方的 展开按钮，右侧区域框会展示该层所包括所有算

子的信息，单击 或在右侧区域使用“Ctrl+F”快捷键，弹出图5-16所示搜索界
面，其中：

– Case sensitive：大小写敏感。

– Wrap Search：循环搜索。

– Backward：反向搜索。

用户在输入框中输入想要查询的信息，比如算子的输入输出、属性等信息，然后
在图5-16界面中勾选搜索特性，单击“Find”进行查找，如果匹配到相关信息，
则右侧区域框中相关信息会高亮显示，否则会提示“Value not found”。单击
Close退出搜索。
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图 5-16 搜索算子内部信息

● 查看模型输出节点信息

由于模型转换时Select了名称为res2a_branch2a、bn2a_branch2a、
scale2a_branch2a、res2a_branch2a_relu的算子，则在.om模型文件可以看到
Select算子的输出直接作为模型的输出，如图5-17中标记红色的信息，用户可以
单击相应的TransData算子，查看相应的输入信息。

图 5-17 Select 算子前后区别

● 查看模型输出节点的数据类型

如果模型转换时设置了Select节点的输出类型，对应模型转换章节“Model
Information”页签中Output Nodes区域下方节点的Data Type类型，模型转换
完毕，用户可以单击NetOutput节点，查看不同输入节点的数据类型。

如果模型转换时只设置了“Model Information”页签中的“Output Type”参数
取值，没有Select节点，则模型转换完毕，单击NetOutput节点，查看输入数据类
型即可。

dtype为DT_FLOAT，表示数据类型为FP32，dtype为DT_FLOAT16表示数据类型
为FP16，dtype为DT_UINT8表示数据类型为UINT8。
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图 5-18 模型输出数据类型查看

----结束

5.4 离线模型改图调优
离线模型改图调优工具目前支持将ONNX模型中的Transpose算子进行两次轴交换以实
现模型性能调优。

参数说明

表 5-5 参数说明

参数 参数说明

-i/--input_model 待调优模型路径。目前仅支持对带Transpose算子的ONNX
模型进行改图调优。

-o/--output_model 调优后模型输出路径。需要具体到.onnx，例如home/
username/modelname.onnx。

-t/--transpose_name 待做轴交换的Transpose算子名称。

-p1/--perm_one 第一次轴交换的规则。

-p2/--perm_two 第二次轴交换的规则。

-h/--help 显示帮助信息。
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执行离线模型改图调优

步骤1 安装onnx、cmp、future及werkzeug依赖。
pip3 install onnx cmp future werkzeug

步骤2 进入离线模型改图调优工具所在路径。
cd {MindStudio安装路径}/plugins/ascend-model/scripts

步骤3 执行离线模型改图调优。
python3 transpose_operator_optimization.py -i 待调优模型路径 -o 调优后模型输出路径 -t 待做轴交换的
Transpose算子名称 -p1 第一次轴交换的规则 -p2 第二次轴交换的规则

----结束
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6 应用开发

6.1 准备环境

6.2 基于MindX SDK开发应用

6.3 基于AscendCL开发应用

6.1 准备环境
如需在远端运行Python版本的应用工程，在应用开发开始前需要对远端进行环境配
置，可通过修改远端环境中的“.bashrc”文件，将“PYTHONPATH”与Runtime路径
加入，也可在MindStudio启动编译/运行过程时，在“Run/Debug Configuration”功
能中添加“Environment Variables”，补充环境变量，详细操作请参见编译与运行应
用工程。

环境变量请参照以下形式加入：

LD_LIBRARY_PATH=$HOME/Ascend/ascend-toolkit/{version}/runtime/
lib64:$LD_LIBRARY_PATH;PYTHONPATH=$HOME/Ascend/ascend-toolkit/{version}/python/site-packages/acl:
$PYTHONPATH

其中{version}内容请根据实际情况填写。

6.2 基于 MindX SDK 开发应用

6.2.1 开发前须知

● MindX SDK当前适用于UbuntuOS、CentOS、EulerOS、LinxOS、KylinOS等。具
体请查看《mxManufacture 用户指南》或《mxVision 用户指南》的“系统要求
>硬件与OS要求”章节。

● MindX SDK软件包运行版本兼容情况请参见《mxManufacture 用户指南》或
《mxVision 用户指南》的“兼容性要求”章节。

● MindX SDK软件包的安装支持Linux场景与Windows场景，以下步骤以
mxManufacture安装为示例。

● 支持在Linux环境与Windows环境基于MindX SDK开发应用。
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说明

● 截图中遮盖为软件包版本号。

● 目前仅支持mxManufacture和mxVision SDK，暂不支持mxIndex SDK。

● MindX SDK运行依赖python3.9，请在安装CANN前确保python3.9已安装，并完成
python3.9的环境变量配置。

● 如需使用MindX SDK 2.0.4及后续版本，请确保运行环境已安装driver包，在启动
MindStudio之前，需在运行环境上手动执行Ascend-cann-toolkit与MindX SDK安装目
录中的“set_env.sh”设置环境变量，可参照以下方式执行，软件安装路径请以实际为
准。（其中{version}为SDK软件包版本，{arch}为系统架构）
source $HOME/Ascend/mindx_sdk/mxManufacture_{version}/linux-{arch}/mxManufacture/
set_env.sh
source $HOME/Ascend/ascend-toolkit/set_env.sh

或

source $HOME/Ascend/mindx_sdk/mxVision_{version}/linux-{arch}/mxVision/set_env.sh
source $HOME/Ascend/ascend-toolkit/set_env.sh

6.2.2 安装 MindX SDK 软件包

6.2.2.1 Linux 场景离线安装

通过 MindStudio 安装 MindX SDK 软件包

步骤1 在昇腾开发者社区的MindX SDK专区按需要获取mxManufacture 3.0.RC1版本软件包
或mxVision 3.0.RC1版本软件包并上传到服务器。

步骤2 工程创建成功或打开已有的工程后，工具栏点击“File > Settings > Appearance &
Behavior > System Settings > MindX SDK”进入MindX SDK管理界面。界面中
“MindX SDK Location”为软件包的默认安装路径，非root用户为“$HOME/Ascend/
mindx_sdk”，root用户为“/usr/local/Ascend/mindx_sdk”。

步骤3 单击“Install SDK”，在“MindX SDK Settings”界面，如图6-1：

● “Install Source”：安装源，“Online”为在线安装，“Disk”为本地安装。选
择“Disk”。

● “SDK Location”：请用户选择步骤1中获取的安装包的上传路径，需要选择到软
件包名一级。

说明

– SDK安装包拥有者需与实际操作用户保持一致。

– 当前操作用户同属组或其他用户中如存在“写”权限用户，工具会弹出“The
MindxSDK package is insecure because it does not belong to you. Do you want to
continue?”警告。

● “Install Location”：显示软件包的默认安装路径，非root用户为“$HOME/
Ascend/mindx_sdk”，root用户为“/usr/local/Ascend/mindx_sdk”。
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图 6-1 MindX SDK Settings

步骤4 单击“Next”后会显示选中的SDK的安装信息，图6-2为安装信息示例，继续单击
“Next”开始安装。

图 6-2 Verify Settings

步骤5 安装完成后单击“Finish”结束，返回SDK管理界面。

步骤6 在SDK管理界面，可查看安装后的SDK的信息，如图6-3所示，可单击“OK”结束安装
流程。

界面中两个按钮介绍如下：

● ：卸载按钮。

● ：激活按钮。
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说明

对激活按钮说明如下：

● 所有已安装版本的软件中，只能激活一个版本的软件使用。

● 若已有激活的某一版本的SDK软件正在使用并又安装另一版本的SDK软件，原先使用的SDK
软件会被去除激活，并自动激活 新安装的SDK软件。用户如果需要继续使用原先的软件，
需要手动激活。

图 6-3 安装完成后的 MindX SDK 管理界面

----结束

使用 MindStudio 导入已安装的 MindX SDK

须知

该方法适用于当前环境已安装MindX SDK软件包，需在MindStudio中导入的场景。

步骤1 工程创建成功或打开已有的工程后，工具栏点击“File > Settings > Appearance &
Behavior > System Settings > MindX SDK”进入MindX SDK管理界面。
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步骤2 点击界面中的“Import SDK”，在弹出的界面中通过点击右侧 ，选择MindX SDK
软件包安装目录，如图6-4（请选至版本号一级），点击“OK”，完成导入。

图 6-4 导入已安装的 MindX SDK

----结束

6.2.2.2 Linux 场景在线安装

步骤1 工程创建成功或打开已有的工程后，工具栏点击“File > Settings > Appearance &
Behavior > System Settings > MindX SDK”进入MindX SDK管理界面。界面中
“MindX SDK Location”为软件包的默认安装路径，非root用户为“$HOME/Ascend/
mindx_sdk”，root用户为“/usr/local/Ascend/mindx_sdk”。

单击“Install SDK”进入“MindX SDK Settings”界面。

步骤2 在“MindX SDK Settings”界面，如图6-5：

● “Install Source”：安装源，“Online”为在线安装，“Disk”为本地安装。选
择“Online”。

● “SDK Version”：可供选择的软件包版本。请注意，MindStudio 5.0.RC1版本需
配套MindX SDK 3.0.RC1版本软件包。

● “Install Location”：显示软件包的默认安装路径。

非root用户的默认安装路径为“$HOME/Ascend/mindx_sdk”，root用户的默认
安装路径为“/usr/local/Ascend/mindx_sdk”。

单击“Next”后会显示选中的SDK的安装信息，图6-6为安装信息示例，继续单击
“Next”开始安装。
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图 6-5 MindX SDK Settings

图 6-6 Verify Settings

步骤3 安装完成后单击“Finish”结束，返回SDK管理界面。

步骤4 在SDK管理界面，可查看安装后的SDK的信息，如图6-7所示，可单击“OK”结束安装
流程。

界面中两个按钮介绍如下：

● ：卸载按钮。

● ：激活按钮。
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说明

对激活按钮说明如下：

● 所有已安装版本的软件中，只能激活一个版本的软件使用。

● 若已有激活的某一版本的SDK软件正在使用并又安装另一版本的SDK软件，原先使用的SDK
软件会被去除激活，并自动激活 新安装的SDK软件。用户如果需要继续使用原先的软件，
需要手动激活。

图 6-7 安装完成后的 MindX SDK 管理界面

----结束

6.2.2.3 Windows 场景安装

步骤1 请先确保远端环境上MindX SDK软件包已安装完成，安装方式请参见
《mxManufacture 用户指南》和《mxVision 用户指南》的“使用命令行方式开
发”>“安装MindX SDK开发套件”章节。

步骤2 可通过以下两种方式进入MindX SDK管理界面。

1. 如当前未创建任何工程，在欢迎界面左侧导航栏，如图6-8，选择“Customize”
一栏，并在右侧功能界面中找到并单击“All settings”。在打开的“Settings”界
面左侧导航菜单找到“Appearance & Behavior > System Settings > MindX
SDK”，并在右侧的功能界面单击“Install SDK”进入MindX SDK管理界面。
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图 6-8 通过欢迎界面打开 Settings

2. 在Windows本地进入已完成创建的工程页面，工具栏点击“File > Settings”，在
打开的“Settings”界面左侧导航菜单找到“Appearance & Behavior > System
Settings > MindX SDK”进入MindX SDK管理界面。界面中“MindX SDK
Location”为软件包的默认安装路径，默认安装路径为“C:\Users\用户名\Ascend
\mindx_sdk”。单击“Install SDK”进入MindX SDK管理界面。

步骤3 在MindX SDK管理界面，如图6-9。

● “Remote Connection”：远程连接的用户及IP。

● “Remote CANN Location”：远端环境上CANN开发套件包的路径，请配置到版
本号一级。

● “Remote SDK Location”：远端环境上SDK的路径，请配置到版本号一级。IDE
将同步该层级下的“include”、“opensource”、“python”、“samples”文
件夹到本地Windows环境，层级选择错误将导致安装失败。

● “Local SDK Location”：同步远端环境上SDK文件夹到本地的路径。默认安装路
径为“C:\Users\用户名\Ascend\mindx_sdk”。
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图 6-9 MindX SDK 管理界面

步骤4 单击“OK”结束，返回SDK管理界面。

步骤5 在SDK管理界面，可查看安装后的SDK的信息，如图6-10所示，可单击“OK”结束安
装流程。

界面中两个按钮介绍如下：

● ：卸载按钮。

● ：激活按钮。

说明

对激活按钮说明如下：

● 所有已安装版本的软件中，只能激活一个版本的软件使用。

● 若已有激活的某一版本的SDK软件正在使用并又安装另一版本的SDK软件，原先使用的SDK
软件会被去除激活，并自动激活 新安装的SDK软件。用户如果需要继续使用原先的软件，
需要手动激活。
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图 6-10 安装完成后的 MindX SDK 管理界面

----结束

6.2.3 创建应用工程

新建应用工程方式

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Ascend App”，配置工程相关参数如表6-1所示。

表 6-1 工程参数说明

参数 说明

Name 工程名称，自行配置。

名称必须以字母开头，数字或字母结尾，只能包含字母、数
字、中划线和下划线，且长度不超过64个字符。
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参数 说明

Description 工程描述信息，自行配置（ 多256个字符）。

CANN Version 显示当前CANN的版本，单击“Change”可重新配置CANN
包的路径。

Project Location 工程的存储路径，用户可自定义。

 

步骤3 单击“Next”，在“New Project”窗口中，选择工程类型。如图6-11。

若工程类型名称显示不全，鼠标悬停于工程类型名称处，则工程类型名称可以完整显
示。

图 6-11 基于 MindX SDK 开发的应用工程

以下两项为MindX SDK空白工程，仅包括开发框架的工程，不含具体的代码逻辑：

● MindX SDK Project(C/C++)

● MindX SDK Project(Python)

以下两项为MindX SDK样例工程，基于MindX SDK开发的模板工程：

● Detection and Classification(C++)

● Detection and Classification(Python)

步骤4 单击“Finish”，完成工程创建。成功创建工程后，工程目录的主要结构如下，请以实
际创建结果为准。MindX SDK样例工程需要用户下载样例的输入图片，新建Detection
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and Classification(C++)请上传到工程文件夹的“C++”目录下，新建Detection and
Classification(Python)请上传到工程文件夹的“python”目录下，若目录不存在请自
行创建。

● MindX SDK Project(C/C++)：
├── 工程名
    ├── build                   //存放cmake依赖文件。
    │   └── cmake
    ├── CMakeLists.txt          //编译脚本，调用src目录下的CMakeLists文件。
    ├── config
    │   ├── logging.conf       //日志配置文件。
    │   └── sdk.conf
    ├── out                     //存放编译出的可执行文件。
    │   └── config
    └── src
        ├── CMakeLists.txt     //编译脚本。
        └── main.cpp           //主函数的实现文件，当前主函数内无代码逻辑。

● MindX SDK Project(Python)：
├── 工程名
      ├── config                  //存放配置文件。
      │   ├── logging.conf
      │   └── sdk.conf
      ├── .idea                  
      │   ├── misc.xml
      │   ├── modules.xml
      │   └── workspace.xml
      ├── main.py                 //运行入口。
      ├── MyApp3.iml
      └── .project

● Detection and Classification(C++)：
工程目录中的.pipeline文件具体可参照可视化流程编排自行准备与编辑。MindX
SDK样例工程中已经准备好.pipeline文件以供用户使用，无需准备。
├── 工程名
    ├── build                 //存放cmake依赖文件。
    ├── C++                                 //存放cmake依赖文件。
    │   ├── bert_input
    │   ├── CMakeLists.txt                 //实际的编译脚本文件。
    │   ├── main.cpp                       //样例入口。
    │   ├── main_tensorinfer.cpp
    │   ├── README.md                      //样例代码说明。
    │   └── run.sh
    ├── models                              //存放模型相关文件。
    │   ├── bert                           //此样例中未用到。
    │   ├── fasterrcnn                     //此样例中未用到。
    │   ├── resnet50
    │   └── yolov3
    └── pipeline                            //存放pipeline文件。
    │  ├── BertMultiPorts.pipeline
    │  ├── FasterRcnn.pipeline
    │  ├── Sample.pipeline
    │  ├── SamplePlugin.pipeline
    │  ├── SplitterNms.pipeline
    │  └── VideoObjectDetection.pipeline
    └── CMakeLists.txt                     //编译脚本，调用src目录下的CMakeLists文件。

● Detection and Classification(Python)：
工程目录中的.pipeline文件具体可参照可视化流程编排自行准备与编辑。MindX
SDK样例工程中已经准备好.pipeline文件以供用户使用，无需准备。
├── 工程名
    ├── models                                    //存放模型相关文件。
    │   ├── bert
    │   ├── fasterrcnn
    │   ├── resnet50
    │   └── yolov3
    ├── pipeline                                 //存放pipeline文件。
    │   ├── BertMultiPorts.pipeline
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    │   ├── FasterRcnn.pipeline
    │   ├── Sample.pipeline
    │   ├── SamplePlugin.pipeline
    │   ├── SplitterNms.pipeline
    │   └── VideoObjectDetection.pipeline
    └── python                                 //存放Python脚本文件。
        ├── main.py                            //样例入口。
        ├── main_tensorinfer.py
        ├── README.md                          //样例代码说明。
        └── run.sh

----结束

导入应用工程方式

步骤1 导入工程文件，可通过选择以下任意一种方式完成。

● 首次登录MindStudio，在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 在工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打开。

说明

如该工程存在代码风险，在打开时会弹出以下窗口。

● 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust project in <
工作区目录>”复选框信任该目录下的所有工程。）

● 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全模式
预览。

● 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 6-12 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图6-13所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 6-13 工程创建提示

步骤3 成功导入工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

6.2.4 开发应用
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6.2.4.1 典型业务流程

典型推理业务流程如图6-14所示，先通过目标检测获取目标坐标，然后通过图像分类
识别目标属性。流程中有两次图像缩放的操作，两者主要区别在于设置的缩放宽高参
数不同。

图 6-14 典型推理业务流程

6.2.4.2 开发流程

说明

加载的模型路径中不能有空格。

使用MindStudio开发和运行推理业务步骤如图6-15所示，其中“深入开发”为SDK高
级特性，用户可以视情况选择执行。

图 6-15 推理业务开发与运行流程

步骤1 确定业务流程：

根据业务的功能如目标检测、图像分类、属性识别等，将业务流程进行模块化，请参
见图6-14。

步骤2 寻找合适插件：

首先根据已有SDK插件的功能描述和规格限制来匹配业务功能。当SDK提供的插件无法
满足功能需求时，用户可以开发自定义插件。请参见插件开发、《mxManufacture
用户指南》或《mxVision 用户指南》的“已有插件介绍”与“插件开发介绍”章节。

步骤3 准备推理模型文件与数据：

根据插件的实际应用场景，添加用于推理的模型文件和数据集。
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1. 转换模型。

在添加模型文件前，请参见模型转换将第三方模型转换为适配昇腾AI处理器的离
线模型（*.om文件）。SDK样例工程的模型转换请参见SDK样例工程使用指导中
的步骤步骤4至步骤6。模型转换具体指导与相关参数设置请参见《ATC工具使用
指南》。

2. 添加模型文件。

请用户将准备好的模型文件上传到应用工程中用户自定义目录下。

3. 准备推理数据。

准备推理所用数据，并上传到应用工程文件目录下。

步骤4 流程编排：

请参见可视化流程编排、《mxManufacture 用户指南》或《mxVision 用户指南》的
“流程编排介绍”与“数据流程介绍”章节。

步骤5 业务集成：

编写C++程序或Python程序，调用业务流管理的API（MxStreamManager），先进行
初始化，再加载业务流配置文件（*.pipeline），然后根据stream配置文件中的
StreamName往指定Stream获取输出数据， 后销毁Stream。

可用API请参见《mxManufacture 用户指南》或《mxVision 用户指南》的“API参考
（C++）”章节与“API参考（Python）”章节。

步骤6 编译与运行应用：

请参见编译与运行应用工程。

----结束

6.2.5 可视化流程编排
MindX SDK实现功能的 小粒度是插件，每一个插件实现特定的功能，如图片解码、
图片缩放等。将这些插件按照合理的顺序编排，实现相应的功能。可视化流程编排是
以可视化的方式，开发数据流图，生成pipeline文件供应用框架使用。

步骤1 进入工程创建页面，用户可通过以下方式开始流程编排。

● 在顶部菜单栏中选择“Ascend>MindX SDK Pipeline”，打开空白的pipeline绘制
界面，如图6-16。

● 在顶部菜单栏中选择“File>Open...”，打开用户自行绘制的pipeline文件，如图
6-17（若自行绘制pipeline文件已放入工程目录中，也可在工程目录栏直接双击该
文件打开）。

图 6-16 pipeline 绘制界面
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图 6-17 自行绘制 pipeline 文件

绘制界面分为左侧插件库、中间编辑区、右侧插件属性展示区，左侧插件库与中间编
辑区请见图6-17，右侧插件属性展示区请见图6-20，介绍如表6-2。
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表 6-2 绘制界面介绍

区域 介绍

插件库 ● 根据已安装的MindX SDK动态扫描获取，以保证生成的
pipeline可以找到对应的so。用户可将插件库目录展开直接将
所需插件拖动到编辑区内（图6-18）或在搜索框中以关键字
查找到插件后点击拖动到编辑区内（图6-19）。

● SDK开发套件有自带插件库，安装完成SDK开发套件后打开绘
制界面，左侧插件库会自动加载，自带插件库可查询
《mxManufacture 用户指南》或《mxVision 用户指南》的
“已有插件介绍”章节。

● 若自带插件库无法满足开发需求，用户可自行开发插件并将
生成的插件放在“工程文件根目录/lib/plugins”目录下以导
入插件库，若目录不存在需要自行创建。开发插件的指导可
参见插件开发、《mxManufacture 用户指南》或
《mxVision 用户指南》的“插件开发介绍”章节。

图 6-18 插件库目录直接拖动

图 6-19 关键字查找插件
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区域 介绍

编辑区 ● 从插件库中拖动某个插件，放入编辑区。可以连接两个插
件，形成功能数据流，支持1对1、1对多、多对1等连接关
系。

● 每个插件的可配置的属性信息可被扫描，单击选中编辑区内
的插件，用户可以在插件属性展示区自定义配置（如插件属
性中的路径参数），如图6-20。

注意
Remote场景mxpi_modelinfer插件中，选择完模型、标签和配置文件
的输入路径后，请参照Linux系统手动同步改为Remote端的绝对路
径，如模型文件路径修改为：“/home/workplace/*.om”，且保证
所选路径有对应文件才能运行成功。

图 6-20 路径参数的修改

说明
“Name”字段为元件自定义名称，若用户修改后会以该字段内容作
为元件名称进行使用，具体请查看《mxManufacture 用户指南》或
《mxVision 用户指南》。

● 以图6-17为例，紫色为输入插件，粉色为输出插件，输入输
出插件之间的插件为蓝色，灰色为当前插件库中未定义的插
件。

● 鼠标悬停在插件上时，会显示该插件的功能描述信息，如图
6-21。
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区域 介绍

图 6-21 鼠标悬停展示插件功能描述信息

● 点击键盘“Del”键可删除选中的插件或连线，在选中状态
下，可对插件块进行大小拖放操作， 大尺寸可支持2倍宽度
和2倍高度。

● 打开已有内容的pipeline文件，编辑区的左下方会有
“Pipeline Stream Editor”与“Text”选项（如图6-17）。
支持图形化显示（默认）与代码显示两种方式，建议用户以
图形化显示方式使用流程编排可视化功能。

插件属性展示区 ● 点击编辑区中的插件时，会展示插件的属性，如图6-20。

● 插件属性以key-value的一对一简单形式或subkey-subvalue
的复杂形式展现。如图6-22与图6-23。subkey-subvalue形

式下，单击 删除键值对，单击 新增键值对。

图 6-22 key-value

图 6-23 subkey-subvalue

 

图6-17中界面右下方按键介绍如表6-3：
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表 6-3 界面按键介绍

按键 作用

Format 格式化按键，可一键解决插件的重叠或一键格式化
整理用户绘制完成的插件流程。

New 新建画板。

Open 打开pipeline文件。

Save 保存绘制完成的插件流程图为pipeline文件。单击
弹出保存窗口，如图6-24。对图6-24中的参数介
绍如下，用户可自行定义：

● “Pipeline Filename”：pipeline文件的名称。

● “Output Path”：保存的路径。

图 6-24 保存窗口
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按键 作用

Export 以jpg格式导出pipeline文件，单击弹出图片导出窗
口，如图6-25。对图6-25中的参数介绍如下，用
户可自行定义：

● “Pipeline Export Filename”：图片导出文件
名称，无需带.jpg后 。

● “Export Path”：图片导出路径，用户可自行
定义。

图 6-25 图片导出窗口

 

步骤2 在左侧编辑框选择插件，拖动至中间编辑框，按照用户的业务流程进行连接。如果拖
动错误插件或者错误连线，选中错误插件或者错误连线单击键盘Del键删除。用户自定
义的流水线绘制完成后，选中流水线中的所有插件，右键选择“Set Stream Name”
设置Stream名称，如果有多条流水线则需要对每一条流水线设置Stream名称。

说明

默认“Stream name”为“stream0”，“Device Id”为“0”。用户请按需要自行修改，如果
需要对插件设置Device Id，请将属于同一Stream的插件选中设置为相同的Device Id。

步骤3 绘制完成后，单击“Save”按钮保存。

----结束

6.2.6 插件开发

通过插件开发工程

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Ascend App”，配置工程相关参数如表6-4所示。
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表 6-4 工程参数说明

参数 说明

Name 工程名称，自行配置。

名称必须以字母开头，数字或字母结尾，只能包含字母、数
字、中划线和下划线，且长度不超过64个字符。

Description 工程描述信息，自行配置（ 多256个字符）。

CANN Version 显示当前CANN的版本，单击“Change”可重新配置CANN
包的路径。

Project Location 工程的存储路径，用户可自定义。

 

步骤3 单击“Next”，在“New Project”窗口中，选择工程类型。如图6-26。

图 6-26 插件开发的工程

● MindX SDK Plugin：MindX SDK插件开发空白工程。仅包括开发框架的工程，不
含具体的代码逻辑。

● MxpiSamplePlugin：MindX SDK插件开发样例工程。

步骤4 单击“Finish”，完成工程创建。成功创建工程后，工程目录的主要结构如下，请以实
际创建结果为准。

● MindX SDK Plugin：
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说明

请用户将MindX SDK插件开发空白工程的工程名（也就是以下工程目录中的工程名）设置
为开发的插件的名称。

├── 工程名
    ├── build                       //存放cmake依赖文件。
    ├── lib
    │   └── plugins                //开发的插件so文件的存放目录。
    ├── src
    │   └── 工程名
    │        ├── CMakeLists.txt    //编译脚本。
    │        ├── 工程名.cpp         //主函数的实现文件。
    │        └── 工程名.h           //主函数的依赖头文件。
    ├── .project                    //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN
版本。
    └── CMakeLists.txt              //编译脚本，调用src目录下的CMakeLists文件。

● MxpiSamplePlugin：
├── 工程名
    ├── build               //存放cmake依赖文件。
    ├── lib
    │   └── plugins        //开发的插件so文件的存放目录。
    ├── src
    │   └── mxpi_sampleplugin
    │        ├── CMakeLists.txt         //编译脚本。
    │        ├── MxpiSamplePlugin.cpp   //主函数的实现文件。
    │        └── MxpiSamplePlugin.h     //主函数的依赖头文件。
    ├── .project                         //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及
CANN版本。
    └── CMakeLists.txt                   //编译脚本，调用src目录下的CMakeLists文件。

步骤5 插件开发空工程的代码实现请参见《mxManufacture 用户指南》或《mxVision 用户
指南》的“插件开发介绍”章节。

插件开发样例工程的具体代码实现请查看工程文件下的MxpiSamplePlugin.cpp（主函
数的实现文件）和MxpiSamplePlugin.h（主函数的依赖头文件）。

步骤6 插件开发编译，以插件开发样例工程为例。

1. 在MindStudio工程界面，在顶部菜单栏中选择“Build > Edit Build
Configuration...”，进入编译配置页面，参数选择请查看编译与运行应用工程。

2. 编译完成后，开发插件so文件会在“工程目录/lib/plugins”下生成，如图6-27。

3. 在顶部菜单栏中选择“Ascend>MindX SDK Pipeline”，打开pipeline绘制界面。
在插件库中可找到插件MxpiSamplePlugin，可正常使用（如拖动至编辑区、连
线、查看插件属性等）如图6-27。

图 6-27 插件开发

----结束
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通过新增插件模板

步骤1 在新建空白工程MindX SDK Project（C/C++）或样例工程Detection and
Classification（C++）后，在IDE页面内的工程目录处右键工程名，选择“New MindX
SDK Plugin”会出现如图6-28弹窗。

图 6-28 插件创建弹窗

● “Plugin Name”：插件名称，用户自行定义。

● “Plugin Path”：插件创建目录，建议放在工程下的“plugin”目录，若目录不
存在请自行创建。

步骤2 创建完成后会在工程目录中生成如下目录层级，Plugin Name为图6-28中用户设定的
插件名称。
└── plugin
    └── Plugin Name          // 插件模板。
        ├── Plugin Name.cpp
        ├── Plugin Name.h
        └── CMakeLists.txt

步骤3 在工程文件根目录下的“CMakeLists.txt”（图中标号“1”所示文件）或在工程文件
下C++目录下的“CMakeLists.txt”（图中标号“2”所示文件）中指引新增插件的
“CMakeLists.txt”（图中标号“3”所示文件）所在的位置，以将新增插件加入编译
过程。以新增插件mxpi_sample为填写示例。

● 在“工程文件根目录”下的“CMakeLists.txt”中加入：
add_subdirectory("./plugin/mxpi_sample")

“./plugin/mxpi_sample”为新增插件的“CMakeLists.txt”相对于“工程文件根
目录”下的“CMakeLists.txt”所在的路径。

● 在工程文件下C++目录下的“CMakeLists.txt”中加入：
add_subdirectory("../plugin/mxpi_sample")

“../plugin/mxpi_sample”为新增插件的“CMakeLists.txt”相对于在工程文件下
C++目录下的“CMakeLists.txt”所在的路径。
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图 6-29 add_subdirectory

步骤4 编译完成后的.so文件在“工程文件根目录/lib/plugins”生成，并将文件权限设置为
“640”。

步骤5 请用户参照《mxManufacture 用户指南》或《mxVision 用户指南》的“插件开发介
绍”章节，完成插件开发。

----结束

6.2.7 编译与运行应用工程

6.2.7.1 Linux 场景编译运行
● 若SDK已有插件满足开发需求，则直接执行以下的编译运行操作。

● 若已有插件不满足开发需求，用户需要开发自定义插件并编写相应的CMakeLists
文件，执行编译操作得到插件动态库文件。将后处理库文件放置于工程目录下的
lib目录下，将插件库文件放置于工程目录下的“lib/plugins”目录下，流程编排
可自动识别放置于该目录下的自定义插件。完成以上操作后继续执行以下的编译
运行操作。

● SDK暂不支持交叉编译。

编译应用工程

说明

● 若新建的工程为Python版本的应用工程，由于不需要执行“编译应用工程”，在MindStudio
工程界面中“Build > Edit Build Configuration...”会置灰，不可以使用。

● 远端编译时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中“dump”、
“model”、“profiling”目录不会被拷贝。

步骤1 （可选）修改工程目录下的“src/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：
include_directories(
directoryPath1
directoryPath2
)
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● link_directories：添加库文件所在的目录。

示例如下：
link_directories(
directoryPath3 
directoryPath4
)

● add_executable：添加*.cpp文件所在的目录。

示例如下：
add_executable(
main
directoryPath5 
directoryPath6
)

● target_link_libraries：添加编译应用依赖的库文件。

示例如下：
target_link_libraries(
main 
ascendcl 
libName1 
libName2)

● install：选择编译产物main安装到指定路径。

示例如下：
install(TARGETS main DESTINATION ${CMAKE_RUNTIME_OUTPUT_DIRECTORY})

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。

步骤2 （可选）指定“CMakeLists.txt”编译配置文件。

在工程界面左侧目录找到“CMakeLists.txt”文件，右键弹出并单击如图1所示“Load
CMake Project”，即可指定此配置文件进行工程编译。
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图 6-30 右键指定 CMakeLists.txt 编译配置文件

步骤3 编译配置。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面。

1. 配置编译参数，点击 添加新增配置。

图 6-31 编译配置
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表 6-5 编译配置参数说明

参数配置 参数说明

Name 编译配置的名称。

Build Type 配置类型，可选：“Debug”或
“Release”。

Toolchain 工具链配置器，配置详情请参见
CMake编译配置，支持本地和远程编
译功能。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Debug”。

Build directory 编译目录相对路径，该路径是相对于
工程目录的路径。

Build options 编译加速选项。

Environment Variables 环境变量配置。

可直接手动配置或单击 符号，在
弹出窗中配置管理。

 
2. 单击“OK”保存编译工程。

步骤4 编译用户代码的修改部分，增量编译。

在MindStudio工程界面，依次选择“Build >Build”。或者在编译配置完成后直接单击
“Build”开始编译。

如果在编译过程中无错误提示，且编译进度到“100%”，则表示编译成功。

----结束

运行应用工程

说明

远端运行时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中dump、profiling
目录不会被拷贝。

步骤1 在MindStudio工程界面，依次选择“Run > Edit Configurations...”，进入运行配置页
面。

步骤2 选择“Ascend App > 工程名”配置应用工程运行参数，图6-32为配置示例，参数说明
如表6-6所示。
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图 6-32 运行参数配置

表 6-6 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步到远
程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选配
置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后在出

的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执行
文件前，编译可执行文件。

 

步骤3 配置完成后，单击“Apply”保存运行配置，单击“OK”，关闭运行配置窗口。

步骤4 在MindStudio工程界面，依次选择“Run > Run...”。

在弹出框中选择已创建好的运行配置信息，运行应用。
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● 如果在运行过程中无错误提示，且提示“Running *** finished”，则表示运行结
束。

● 如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束

6.2.7.2 Windows 场景编译运行
● 若SDK已有插件满足开发需求，则直接执行以下的编译运行操作。

● 若已有插件不满足开发需求，用户需要开发自定义插件并编写相应的CMakeLists
文件，执行编译操作得到插件动态库文件。将后处理库文件放置于工程目录下的
lib目录下，将插件库文件放置于工程目录下的“lib/plugins”目录下，流程编排
可自动识别放置于该目录下的自定义插件。完成以上操作后继续执行以下的编译
运行操作。

● SDK暂不支持交叉编译。

编译应用工程

说明

● 若新建的工程为Python版本的应用工程，由于不需要执行“编译应用工程”，在MindStudio
工程界面中“Build > Edit Build Configuration...”会置灰，不可以使用。

● 远端编译时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中“dump”、
“model”、“profiling”目录不会被拷贝。

步骤1 （可选）修改工程目录下的“src/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：
include_directories(
directoryPath1
directoryPath2
)

● link_directories：添加库文件所在的目录。

示例如下：
link_directories(
directoryPath3 
directoryPath4
)

● add_executable：添加*.cpp文件所在的目录。

示例如下：
add_executable(
main
directoryPath5 
directoryPath6
)

● target_link_libraries：添加编译应用依赖的库文件。

示例如下：
target_link_libraries(
main 
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ascendcl 
libName1 
libName2)

● install：选择编译产物main安装到指定路径。

示例如下：
install(TARGETS main DESTINATION ${CMAKE_RUNTIME_OUTPUT_DIRECTORY})

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。

步骤2 （可选）指定“CMakeLists.txt”编译配置文件。

在工程界面左侧目录找到“CMakeLists.txt”文件，右键弹出并单击如图1所示“Load
CMake Project”，即可指定此配置文件进行工程编译。

图 6-33 右键指定 CMakeLists.txt 编译配置文件

步骤3 编译配置。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面（如Windows场景编译运行，图为配置示例），配置完成后单击“OK”保
存编译配置。
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图 6-34 编译配置

步骤4 编译用户代码的修改部分，增量编译。

在MindStudio工程界面，依次选择“Build >Build”。或者在编译配置完成后直接单击
“Build”开始编译。

如果在编译过程中无错误提示，且编译进度到“100%”，则表示编译成功。

----结束

说明

如果Windows本地时间晚于远程编译环境的时间，需要通过以下方式将本地的修改加入编译过
程：

● 调整Windows本地时间与远程编译环境的时间，使两者保持一致后，通过增量编译（即工具
栏“Build >Build”）方式执行编译。

运行应用工程

说明

远端运行时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中dump、profiling
目录不会被拷贝。

步骤1 在MindStudio工程界面，依次选择“Run > Edit Configurations...”，进入运行配置页
面。

步骤2 选择“Ascend App > 工程名”配置应用工程运行参数，图6-35为配置示例。
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图 6-35 运行参数配置

表 6-7 应用工程运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步到远
程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选配
置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后在出

的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执行
文件前，编译可执行文件。
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图 6-36 环境变量配置

步骤3 配置完成后，单击“Apply”保存运行配置，单击“OK”，关闭运行配置窗口。

步骤4 在MindStudio工程界面，依次选择“Run > Run...”。

在弹出框中选择已创建好的运行配置信息，运行应用。

● 如果在运行过程中无错误提示，且提示“Running *** finished”，则表示运行结
束。

● 如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束

6.2.8 SDK 样例工程使用指导

Detection and Classification（C++）使用指导

步骤1 请参照开发前须知与安装MindX SDK软件包章节，完成依赖的配置软件包的获取与安
装。

步骤2 请参见创建应用工程创建Detection and Classification（C++）样例工程。

步骤3 准备输入图片。

请用户自行下载一张包含有一个动物的非渐进式图片（例如一只狗的图片），命名为
test.jpg，上传到环境中工程文件的“C++”目录下。

步骤4 参见表6-8，前往昇腾开发者社区下载YOLOv3和ResNet50模型pb文件。
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表 6-8 模型获取

模型名称 版本 获取链接

YOLOv3 1.1 获取地址

关键词搜索：YOLOv3
应用级别：Released
框架：TensorFlow
进入模型页面后，选择“历史
版本”中版本1.1下载。

ResNet50 获取地址

关键词搜索：ResNet-50
应用级别：Released
框架：TensorFlow
进入模型页面后，选择“历史
版本”中版本1.1下载。

 

步骤5 模型转换。

在工程创建页面的工具栏选择“Ascend > Model Converter”。

1. 在“Model Information”页面，页面参数配置指导如下：

– 样例中YOLOv3、ResNet50模型适用参数及配置项请参考表6-9。

– YOLOv3模型参数配置页面结果请参考图6-38。

– ResNet50模型参数配置页面结果请参考图6-39。

表 6-9 Model Information 配置项说明及 YOLOv3、ResNet50 模型适用参数

配置项 配置项说明 本样例YOLOv3模型适
用参数

本样例ResNet50模型
适用参数

Model File 获取模型pb文件后，选
择上传到环境中的模型
pb文件路径。需要选择
到pb文件一级。

请根据实际情况设置模型pb文件路径。

Model Name 转换后的模型名称。 请以
“yolov3_tf_bs1_fp16
”命名。

请以
“resnet50_aipp_tf”
命名。

Target SoC Version 模型转换时指定芯片版
本。

请根据实际使用的芯片类型进行选择。
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配置项 配置项说明 本样例YOLOv3模型适
用参数

本样例ResNet50模型
适用参数

OutputPath 输出的另存模型文件路
径，用户可通过手动输
入或单击右侧文件夹图
标进行选择。进行模型
转换后，系统会把默认
在$HOME/modelzoo/$
{Model Name}/$
{Target SoC Version}/
路径下输出转换后的
om模型文件拷贝至配
置的Output Path路径
中。

请使用默认设置，不需要修改。

Input Format 输入数据格式。 请使用默认设置，不需要修改。

input/input_data 模型转换入参，
“Shape”模型输入的
图形信息，“Type”为
指定输入节点的数据类
型。

– “Shape”请使用
“1,416,416,3”。

– “Type”请使用
“FP32”。

– “Shape”请使用
“1,224,224,3”。

– “Type”请使用
“FP32”。

Output Nodes 指定输出节点信息。

1. 单击“Select”按
钮。
进入输出节点选择界
面。

2. 在搜索出的节点上，
右击“Select”选
中，如图6-37。

请选择“conv_lbbox/
BiasAdd”、
“conv_mbbox/
BiasAdd”、
“conv_sbbox/
BiasAdd”三项。

无需选择。
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图 6-37 选择输出节点
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图 6-38 YOLOv3 模型参数配置
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图 6-39 ResNet50 模型参数配置

2. 单击“Next”，进入“Data Pre-Processiong”页面，参照图6-40作为示例配置
参数，详细请参见2。
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图 6-40 Data Pre-Processiong

3. 单击“Next”，进入“Advanced Options Preview”页面，参照图6-41配置参
数。

“Additional Arguments”处请单击滑块启用该选项并填写模型aipp配置文件的
绝对路径，$HOME为运行环境的用户家目录，MyApp为新建SDK样例工程名，请
用户自行替换。

转换YOLOv3模型时请配置：
--insert_op_conf=$HOME/AscendProjects/MyApp/models/yolov3/aipp_yolov3_416_416.aippconfig

转换ResNet50模型时请配置：
--insert_op_conf=$HOME/AscendProjects/MyApp/models/resnet50/aipp_resnet50_224_224.aippconfig
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图 6-41 Advanced Options Preview

4. 点击“Finish”，开始模型转换。

步骤6 转换完成的模型om文件默认生成在“$HOME/modelzoo”下。请分别移动放置于
“工程文件根目录/models/resnet50”和“工程文件根目录/models/yolov3”下。

步骤7 编译应用工程。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面。

1. 配置编译参数。

图6-42为编译配置示例。在“Build Type”下拉框处选择“Release”，修改
“Name”，将编译配置组命名为“Release”。
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图 6-42 编译配置

2. 单击“Build > Release”编译工程。

如果在编译过程中无错误提示，且编译进度到“100%”，则表示编译成功，您可
以在如下目录中查看可执行文件main。
├── 工程名
│   ├── C++
│   │   ├──main         //可执行文件

步骤8 运行应用工程。

1. 配置运行参数。

图6-65为配置示例，配置完成后，单击“Apply”保存运行配置，单击“OK”，
关闭运行配置窗口。

说明

– Windows使用场景Run Mode中的Local Run选项置灰，具体请参见Windows场景编译
运行。

– 如需远端运行应用工程，请确保运行环境已完成环境变量的配置，具体请参见开发前须
知。
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图 6-43 运行参数配置

表 6-10 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode – Remote Run：远程运行。

– Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步
到远程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选
配置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后

在出的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执
行文件前，编译可执行文件。

 

2. 在MindStudio工程界面，依次选择“Run > Run...”。在弹出框中选择已创建好的
运行配置信息，运行应用。

如下显示为SDK样例工程运行成功的返回示例。
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Results:{"MxpiObject":[{"MxpiClass":[{"classId":163,"className":"beagle","confidence":
0.87109375}],"classVec":[{"classId":16,"className":"dog","confidence":
0.99641436299999997,"headerVec":[]}],"x0":125.63256800000001,"x1":918.29089399999998,"y0":
116.434044,"y1":597.21276899999998}]}

说明

如需对该样例进行调试操作，请在操作前修改以下内容：

1. 在“C++/Cmakelist.txt”中找到以下命令。
set(CMAKE_EXE_LINKER_FLAGS "${CMAKE_EXE_LINKER_FLAGS} -Wl,-z,relro,-z,now,-z,noexecstack  
-s -pie")

2. 将该命令替换为如下形式。
set(CMAKE_EXE_LINKER_FLAGS "${CMAKE_EXE_LINKER_FLAGS} -Wl,-z,relro,-z,now,-z,noexecstack -
pie")

----结束

Detection and Classification（Python）使用指导

步骤1 请参照开发前须知与安装MindX SDK软件包章节，完成依赖的配置软件包的获取与安
装。

步骤2 请参见创建应用工程创建Detection and Classification（Python）样例工程。

步骤3 准备输入图片。

请用户手动下载一张包含动物的图片（例如一只狗的图片），命名为test.jpg，上传到
环境中工程文件的“python”目录下。

步骤4 参见表6-11，前往昇腾开发者社区下载YOLOv3和ResNet50模型pb文件。

表 6-11 模型获取

模型名称 版本 获取链接

YOLOv3 1.1 获取地址

关键词搜索：YOLOv3
应用级别：Released
框架：TensorFlow
进入模型页面后，选择“历史
版本”中版本1.1下载。

ResNet50 获取地址

关键词搜索：ResNet-50
应用级别：Released
框架：TensorFlow
进入模型页面后，选择“历史
版本”中版本1.1下载。

 

步骤5 模型转换。

在工程创建页面的工具栏选择“Ascend > Model Converter”。

1. 在“Model Information”页面，页面参数配置指导如下：
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– 样例中YOLOv3、ResNet50模型适用参数及配置项请参考表6-12。

– YOLOv3模型参数配置页面结果请参考图6-45。

– ResNet50模型参数配置页面结果请参考图6-46。

表 6-12 Model Information 配置项说明及 YOLOv3、ResNet50 模型适用参数

配置项 配置项说明 本样例YOLOv3模型适
用参数

本样例ResNet50模型
适用参数

Model File 获取模型pb文件后，选
择上传到环境中的模型
pb文件路径。需要选择
到pb文件一级。

请根据实际情况设置模型pb文件路径。

Model Name 转换后的模型名称。 请以
“yolov3_tf_bs1_fp16
”命名。

请以
“resnet50_aipp_tf”
命名。

Target SoC Version 模型转换时指定芯片版
本。

请根据实际使用的芯片类型进行选择。

OutputPath 输出的另存模型文件路
径，用户可通过手动输
入或单击右侧文件夹图
标进行选择。进行模型
转换后，系统会把默认
在$HOME/modelzoo/$
{Model Name}/$
{Target SoC Version}/
路径下输出转换后的
om模型文件拷贝至配
置的Output Path路径
中。

请使用默认设置，不需要修改。

Input Format 输入数据格式。 请使用默认设置，不需要修改。

input/input_data 模型转换入参，
“Shape”模型输入的
图形信息，“Type”为
指定输入节点的数据类
型。

– “Shape”请使用
“1,416,416,3”。

– “Type”请使用
“FP32”。

– “Shape”请使用
“1,224,224,3”。

– “Type”请使用
“FP32”。

Output Nodes 指定输出节点信息。

1. 单击“Select”按
钮。
进入输出节点选择界
面。

2. 在搜索出的节点上，
右击“Select”选
中，如图6-44。

请选择“conv_lbbox/
BiasAdd”、
“conv_mbbox/
BiasAdd”、
“conv_sbbox/
BiasAdd”三项。

无需选择。

 

MindStudio
用户指南 6 应用开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 171



图 6-44 选择输出节点
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图 6-45 YOLOv3 模型参数配置
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图 6-46 ResNet50 模型参数配置

2. 单击“Next”，进入“Data Pre-Processiong”页面，参照图6-47作为示例配置
参数，详细请参见2。
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图 6-47 Data Pre-Processiong

3. 单击“Next”，进入“Advanced Options Preview”页面，参照图6-48配置参
数。

“Additional Arguments”处请单击滑块启用该选项并填写模型aipp配置文件的
绝对路径，$HOME为运行环境的用户家目录，MyApp为新建SDK样例工程名，请
用户自行替换。

转换YOLOv3模型时请配置：
--insert_op_conf=$HOME/AscendProjects/MyApp/models/yolov3/aipp_yolov3_416_416.aippconfig

转换ResNet50模型时请配置：
--insert_op_conf=$HOME/AscendProjects/MyApp/models/resnet50/aipp_resnet50_224_224.aippconfig
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图 6-48 Advanced Options Preview

4. 点击“Finish”，开始模型转换。

步骤6 转换完成的模型om文件默认生成在“$HOME/modelzoo”下。请分别移动放置于
“工程文件根目录/models/resnet50”和“工程文件根目录/models/yolov3”下。

步骤7 运行应用工程。

1. 配置运行参数。

图6-68为配置示例，Windows使用场景Run Mode中的Local Run选项置灰，具体
请参见Windows场景编译运行。配置完成后，单击“Apply”保存运行配置，单
击“OK”，关闭运行配置窗口。
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图 6-49 运行参数配置

表 6-13 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode – Remote Run：远程运行。

– Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步
到远程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选
配置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后

在出的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执
行文件前，编译可执行文件。

 

2. 在MindStudio工程界面，依次选择“Run > Run...”。在弹出框中选择已创建好的
运行配置信息，运行应用。

如下显示为SDK样例工程运行成功的返回示例。
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Results:{"MxpiObject":[{"MxpiClass":[{"classId":163,"className":"beagle","confidence":
0.87109375}],"classVec":[{"classId":16,"className":"dog","confidence":
0.99641436299999997,"headerVec":[]}],"x0":125.63256800000001,"x1":918.29089399999998,"y0":
116.434044,"y1":597.21276899999998}]}

----结束

6.3 基于 AscendCL 开发应用

6.3.1 开发前须知
支持在Linux环境与Windows环境基于AscendCL开发应用。

6.3.2 创建应用工程

新建应用工程方式

步骤1 进入工程创建页面。

● 首次登录MindStudio：单击“New Project”。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”。

步骤2 在“New Project”窗口中，选择“Ascend App”，配置工程相关参数如表6-14所
示。

表 6-14 工程参数说明

参数 说明

Name 工程名称，自行配置。

名称必须以字母开头，数字或字母结尾，只能包含字母、数
字、中划线和下划线，且长度不超过64个字符。

Description 工程描述信息，自行配置（ 多256个字符）。

CANN Version 显示当前CANN的版本，单击“Change”可重新配置CANN
包的路径。

Project Location 工程的存储路径，用户可自定义。

 

步骤3 单击Next，在New Project窗口中，选择工程类型，如图6-50。
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图 6-50 AscendCL 应用工程

● Acl Project为AscendCL空白工程，仅包括开发框架的工程，不含具体的代码逻
辑。

● Acl ResNet-50为AscendCL样例工程，是以acl_resnet50样例为模板的工程。

acl_resnet50样例主要是基于Caffe ResNet-50网络（单输入、单Batch）实现图片分类
的功能。将Caffe ResNet-50网络的模型文件转换为适配昇腾AI处理器的离线模型
（*.om文件），在样例中，加载该om文件，对2张*.jpg图片进行同步推理，分别得到
推理结果后，再对推理结果进行处理，输出top5置信度的类别标识。
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图 6-51 Sample 示例

步骤4 单击Finish，完成工程创建。成功创建工程后，工程目录的主要结构如下，请以实际
获取为准。

● Acl Project（C/C++）：
├── 工程名
│   ├── .idea                  //IntelliJ IDEA自动创建的，用于存放项目的配置信息。
│   ├── build
│   │    ├──cmake             //存放cmake依赖文件。
│   ├── out                    //存放编译出的可执行文件。
│   ├── src
│   │    ├── CMakeLists.txt   //编译脚本。
│   │    ├── main.cpp         //主函数的实现文件，当前主函数内无代码逻辑。
│   ├── .project               //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN版
本。
│   ├── CMakeLists.txt         //编译脚本，调用src目录下的CMakeLists文件。
│   ├── 工程名.iml             //IntelliJ IDEA自动创建的模块文件，用于Java应用开发，存储一些模块开
发相关的信息。

● Acl Project（Python）：无代码目录。

● Acl ResNet-50（C++）：
├── 工程名
│   ├── .idea                     //IntelliJ IDEA自动创建的，用于存放项目的配置信息。
│   ├── build
│   │    ├──cmake                //存放cmake依赖文件。
│   ├── data  
│   ├── model
│   ├── inc
│   │    ├── model_process.h     //声明模型处理相关函数的头文件。
│   │    ├── sample_process.h    //声明资源初始化/销毁相关函数的头文件。
│   │    ├── utils.h             //声明公共函数（例如：文件读取函数）的头文件。
│   ├── out                       //存放编译出的可执行文件。
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│   ├── script
│   │    ├── transferPic.py      //将*.jpg转换为*.bin，同时将图片从1024*683的分辨率缩放为
224*224。
│   ├── src
│   │    ├── acl.json            //系统初始化的配置文件。
│   │    ├── CMakeLists.txt      //编译脚本。
│   │    ├── main.cpp            //主函数，图片分类功能的实现文件。
│   │    ├── model_process.cpp   //模型处理相关函数的实现文件。
│   │    ├── sample_process.cpp  //资源初始化/销毁相关函数的实现文件。
│   │    ├── utils.cpp           //公共函数（例如：文件读取函数）的实现文件。 
│   ├── .project                  //工程信息文件，包含工程类型、工程描述、运行目标设备类型、CANN版
本号等。
│   ├── CMakeLists.txt            //编译脚本，调用src目录下的CMakeLists文件。
│   ├── 工程名.iml                //IntelliJ IDEA自动创建的模块文件，用于Java应用开发，存储一些模块
开发相关的信息。
│   ├── readme.md                 //样例工程的readme文件。

● Acl ResNet-50（Python）：
├── 工程名
│   ├── .idea                  //IntelliJ IDEA自动创建的，用于存放项目的配置信息。
│   ├── data   
│   ├── model
│   ├── src
│   │    ├── acl_net.py       //运行文件。
│   │    ├── constant.py      //常量定义。
│   ├── .project               //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN版
本。
│   ├── 工程名.iml             //IntelliJ IDEA自动创建的模块文件，用于Java应用开发，存储一些模块开
发相关的信息。

----结束

导入应用工程方式

步骤1 导入工程文件，可通过选择以下任意一种方式完成。

● 首次登录MindStudio，在MindStudio欢迎界面中单击“Open”，选择需要导入
的工程，单击“OK”确认导入。

● 在工程创建页面，在顶部菜单栏中选择“File > Open...”，选择现有工程打开。

说明

如该工程存在代码风险，在打开时会弹出以下窗口。

– 如该工程源码可被信任且安全，请单击“Trust Project”。（可通过勾选“Trust
project in <工作区目录>”复选框信任该目录下的所有工程。）

– 如该工程不被信任，仅用于查看其中源码，请单击“Preview in Safe Mode”进入安全
模式预览。

– 如放弃打开该工程，请单击“Don't Open”取消工程导入操作。

图 6-52 信任工程

步骤2 若工作窗口已打开其他工程，会出现如图6-53所示提示。

● 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

● 选择“New Window”，则新建一个工作窗口打开新创建的工程。

MindStudio
用户指南 6 应用开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 181



图 6-53 工程创建提示

步骤3 成功导入工程后，工程目录以树状呈现，请以实际创建结果为准。

----结束

6.3.3 准备模型文件和数据

创建 Acl Project 工程时

根据实际应用的场景，添加用于推理的模型文件和图片数据集。

步骤1 转换模型。

在添加模型文件前，您需要先参见模型转换将第三方模型转换为适配昇腾AI处理器的
离线模型（*.om文件）。

步骤2 添加模型文件。

请用户自行将准备好的模型om文件上传到创建的工程中。

步骤3 （可选）如果需要使用dump功能：

1. 准备xxx.json（例如acl.json）配置文件。

请参见准备离线模型dump数据准备。

2. 在代码aclInit接口或者acl.init接口中将配置文件作为输入参数完成dump配置。

请参见《应用软件开发指南（C&C++）》或《应用软件开发指南（Python）》。

步骤4 准备推理数据。

准备推理所用数据，并上传到应用工程文件目录下。

----结束

创建 Acl ResNet-50 工程时

步骤1 准备数据。

您可以从以下链接中获取ResNet-50网络的模型文件（*.prototxt）、预训练模型文件
（*.caffemodel），并以MindStudio安装用户将获取的文件上传至MindStudio安装服
务器。

● ResNet-50网络的模型文件（*.prototxt）：单击Link下载该文件。

● ResNet-50网络的预训练模型文件（*.caffemodel）：单击Link下载该文件。

步骤2 转换模型。

在添加模型文件前，您需要先按照如下步骤将第三方模型转换为适配昇腾AI处理器的
离线模型（*.om文件）。详情请参见参见模型转换。

步骤3 添加模型文件。

请用户自行将模型om文件上传到“工程文件根目录/model”文件夹下。添加模型文件
后，可按如下目录在“Project”窗口查看模型文件。
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├── 工程名
│   ├── model          
│   │   ├──resnet50.om           //模型文件。

步骤4 （可选）如果需要使用dump功能：

1. 准备xxx.json（例如acl.json）配置文件。

请参见准备离线模型dump数据准备。

2. 在代码aclInit接口或者acl.init接口中将配置文件作为输入参数完成dump配置。

请参见《应用软件开发指南（C&C++）》或《应用软件开发指南（Python）》。

步骤5 准备推理数据。

● Linux使用场景请参照创建的应用工程根目下的“README_CN.md”文件中的
“编译运行”章节下的“准备输入图片”进行处理。

● Windows使用场景下，也可以执行以下步骤转换图片格式，以图片存放在“C:
\Users\user1\AscendProjects\MyApp1\data”路径为例。

a. 打开系统命令提示符。

b. 执行以下命令进入工程文件下“C:\Users\user1\AscendProjects
\MyApp1\data”。
cd C:\Users\user1\AscendProjects\MyApp1\data

c. 执行以下命令转换图片格式。
python ..\script\transferPic.py

----结束

6.3.4 添加自定义动态链接库（可选）
用户应用中经常需要使用其他第三方动态链接库（例如使用OpenCV对YOLOv3的推理
结果进行后处理）。在开发环境与运行环境部署在不同的机器的场景下，若用户仅能
通过MindStudio使用运行环境，则远程运行会由于无法找到对应动态链接库而失败。
为解决这一问题，在MindStudio的应用开发中增加对用户自定义动态链接库的支持，
提高客户开发效率。

用户添加自定义动态链接库的步骤参考如下：

步骤1 完成动态链接库的交叉编译。

具体交叉编译步骤请参见使用的动态链接库的对应文档，需要注意交叉编译器应与运
行环境系统架构相对应。

步骤2 新建存放动态链接库的目录，将交叉编译出的动态链接库拷贝或软链接至该目录下，
目录名称可由用户自定义（如图6-54中lib目录下的libcustom.so）。

图 6-54 存放动态链接库的目录

需要注意：新建的存放动态链接库的目录，需要在应用工程运行参数配置（编译与运
行应用工程）时进行环境变量的配置。环境变量的配置是以可执行文件main所在位置
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“工程名/out/main”为基准，即截图中配置的../mylib位置，mylib为存放动态链接库
的目录名称，文件夹位置在工程名目录下。有以下两种方式配置：

● 在Environment Variables处直接输入，如图图6-55。

图 6-55 动态链接库目录

● 单击 后在出的弹窗内单击 ，填写。

图 6-56 环境变量填写

----结束

6.3.5 开发应用

说明

加载的模型路径中不能有空格。

创建 Acl Project 工程时

请参见《应用软件开发指南（C&C++）》或《应用软件开发指南（Python）》。

创建 Acl ResNet-50 工程时
● 创建应用工程后，工程的src目录下自带应用的模板代码，包含系统初始化、模型

执行、模型卸载、资源销毁等代码，若想直接使用src目录下的*.cpp模板代码，则
只需按照模型文件和图片的名称、所在的路径修改sample_process.cpp中的如下
代码，此处只能设置相对路径，不能设置绝对路径。

– 请根据实际情况，修改图片文件的名称以及路径。
//此处的..表示相对路径，相对可执行文件所在的目录
//例如，编译出来的可执行文件存放在out目录下，此处的..就表示out目录的上一级目录
string testFile[] = {
        "../data/dog1_1024_683.bin",
        "../data/dog2_1024_683.bin"
    };
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– 请根据实际情况，修改*.om模型文件的名称。
//此处的..表示相对路径，相对可执行文件所在的目录
//例如，编译出来的可执行文件存放在out目录下，此处的..就表示out目录的上一级目录
const char* omModelPath = "../model/resnet50.om";

在模板代码中，“接口名称以acl开头”的接口是系统对用户开放的接口，关于接
口的详细说明，请参见《应用软件开发指南（C&C++）》或《应用软件开发指南
（Python）》。

● 创建应用工程后，若不想使用工程中的模板代码，您可以查看《应用软件开发指
南（C&C++）》或《应用软件开发指南（Python）》。

6.3.6 编译与运行应用工程

6.3.6.1 Linux 场景编译运行

编译应用工程

说明

● 若新建的工程为Python版本的应用工程，由于不需要执行“编译应用工程”，在MindStudio
工程界面中“Build > Edit Build Configuration...”会置灰，不可以使用。

● 远端编译时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中“dump”、
“model”、“profiling”目录不会被拷贝。

步骤1 （可选）修改工程目录下的“src/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：
include_directories(
directoryPath1
directoryPath2
)

● link_directories：添加库文件所在的目录。

示例如下：
link_directories(
directoryPath3 
directoryPath4
)

● add_executable：添加*.cpp文件所在的目录。

示例如下：
add_executable(
main
directoryPath5 
directoryPath6
)

● target_link_libraries：添加编译应用依赖的库文件。

示例如下：
target_link_libraries(
main 
ascendcl 
libName1 
libName2)

● install：选择编译产物main安装到指定路径。

示例如下：
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install(TARGETS main DESTINATION ${CMAKE_RUNTIME_OUTPUT_DIRECTORY})

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。

步骤2 （可选）指定“CMakeLists.txt”编译配置文件。

在工程界面左侧目录找到“CMakeLists.txt”文件，右键弹出并单击如图1所示“Load
CMake Project”，即可指定此配置文件进行工程编译。

图 6-57 右键指定 CMakeLists.txt 编译配置文件

步骤3 编译配置。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面。

1. 配置编译参数。
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图 6-58 编译配置

表 6-15 编译配置参数说明

参数配置 参数说明

Name 编译配置的名称。

Build Type 配置类型，可选：“Debug”或
“Release”。

Toolchain 工具链配置器，配置详情请参见
CMake编译配置，支持本地和远程编
译功能。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Debug”。

Build directory 编译目录相对路径，该路径是相对于
工程目录的路径。

Build options 编译加速选项。

Environment Variables 环境变量配置。

可直接手动配置或单击 符号，在
弹出窗中配置管理。

 
2. 单击“Save”保存编译工程。

步骤4 编译用户代码的修改部分，增量编译。

在MindStudio工程界面，依次选择“Build >Build”。或者在编译配置完成后直接单击
“Build”开始编译。

如果在编译过程中无错误提示，且提示“build successfully”，则表示编译成功。

----结束
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运行应用工程

说明

远端运行时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中dump、profiling
目录不会被拷贝。

步骤1 在MindStudio工程界面，依次选择“Run > Edit Configurations...”，进入运行配置页
面。

步骤2 选择“Ascend App > 工程名”配置应用工程运行参数，图6-59为配置示例，参数说明
如表6-16所示。

图 6-59 运行参数配置

表 6-16 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步到远
程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选配
置。
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配置参数 参数说明

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后在出

的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执行
文件前，编译可执行文件。

 

步骤3 配置完成后，单击“Apply”保存运行配置，单击“OK”，关闭运行配置窗口。

步骤4 在MindStudio工程界面，依次选择“Run > Run...”。

在弹出框中选择已创建好的运行配置信息，运行应用。

● 如果在运行过程中无错误提示，且提示“Running *** finished”，则表示运行结
束。

● 如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束

6.3.6.2 Windows 场景编译运行

使用编译参数配置界面Build Mode的“Local Build”选项与运行参数配置界面Run
Mode的“Local Run”选项，需要先参照《MindStudio安装指南》中的“安装依赖”
章节安装Windows版本的软件包，否则这两项置灰，不能使用。

编译应用工程

说明

● 若新建的工程为Python版本的应用工程，由于不需要执行“编译应用工程”，在MindStudio
工程界面中“Build > Edit Build Configuration...”会置灰，不可以使用。

● 远端编译时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中“dump”、
“model”、“profiling”目录不会被拷贝。

步骤1 （可选）修改工程目录下的“src/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：
include_directories(
directoryPath1
directoryPath2
)

● link_directories：添加库文件所在的目录。

示例如下：
link_directories(
directoryPath3 
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directoryPath4
)

● add_executable：添加*.cpp文件所在的目录。

示例如下：

add_executable(
main
directoryPath5 
directoryPath6
)

● target_link_libraries：添加编译应用依赖的库文件。

示例如下：

target_link_libraries(
main 
ascendcl 
libName1 
libName2)

● install：选择编译产物main安装到指定路径。

示例如下：

install(TARGETS main DESTINATION ${CMAKE_RUNTIME_OUTPUT_DIRECTORY})

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。

步骤2 （可选）指定“CMakeLists.txt”编译配置文件。

在工程界面左侧目录找到“CMakeLists.txt”文件，右键弹出并单击如图1所示“Load
CMake Project”，即可指定此配置文件进行工程编译。

图 6-60 右键指定 CMakeLists.txt 编译配置文件
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步骤3 编译配置。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面（如Windows场景编译运行，图为配置示例），配置完成后单击“OK”保
存编译配置。

图 6-61 编译配置

步骤4 编译用户代码的修改部分，增量编译。

在MindStudio工程界面，依次选择“Build >Build”。或者在编译配置完成后直接单击
“Build”开始编译。

如果在编译过程中无错误提示，且编译进度到“100%”，则表示编译成功。

----结束

说明

如果Windows本地时间晚于远程编译环境的时间，需要通过以下方式将本地的修改加入编译过
程：

● 调整Windows本地时间与远程编译环境的时间，使两者保持一致后，通过增量编译（即工具
栏“Build >Build”）方式执行编译。

运行应用工程

说明

远端运行时，会对工程文件夹进行目录拷贝到远端连接的环境，工程文件夹中dump、profiling
目录不会被拷贝。

步骤1 在MindStudio工程界面，依次选择“Run > Edit Configurations...”，进入运行配置页
面。

MindStudio
用户指南 6 应用开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 191



步骤2 选择“Ascend App > 工程名”配置应用工程运行参数，参数说明如表6-17所示。

图 6-62 运行参数配置

表 6-17 应用工程运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步到远
程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选配
置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后在出

的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执行
文件前，编译可执行文件。
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步骤3 配置完成后，单击“Apply”保存运行配置，单击“OK”，关闭运行配置窗口。

步骤4 在MindStudio工程界面，依次选择“Run > Run...”。

在弹出框中选择已创建好的运行配置信息，运行应用。

● 如果在运行过程中无错误提示，且提示“Running *** finished”，则表示运行结
束。

● 如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束

6.3.7 AscendCL 样例工程使用指导
本节介绍AscendCL样例工程Acl ResNet-50（C++）与Acl ResNet-50（Python）的使
用，若需要更多样例，请查看https://gitee.com/ascend/samples。

功能描述

该样例主要是基于Caffe ResNet-50网络（单输入、单Batch）实现图片分类的功能。

将Caffe ResNet-50网络的模型文件转换为适配昇腾AI处理器的离线模型（*.om文
件），在样例中，加载该om文件，对2张*.jpg图片进行同步推理，分别得到推理结果
后，再对推理结果进行处理，输出top5置信度的类别标识。

MindStudio
用户指南 6 应用开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 193

https://www.hiascend.com/document/detail/zh/canncommercial/51RC1/troublemanagement/logreference
https://www.hiascend.com/document/detail/zh/canncommercial/51RC1/troublemanagement/logreference
https://gitee.com/ascend/samples


图 6-63 Sample 示例

原理介绍

在该Sample中，涉及的关键功能点，如下表所示（以C++接口为例）。API接口的详细
介绍请参见《应用软件开发指南（C&C++）》或《应用软件开发指南（Python）》。

初始化 ● 调用aclInit接口初始化AscendCL配置。

● 调用aclFinalize接口实现AscendCL去初始化。

Device管理 ● 调用aclrtSetDevice接口指定用于运算的Device。

● 调用aclrtGetRunMode接口获取昇腾AI软件栈的运行模式，根据
运行模式的不同，内部处理流程不同。

● 调用aclrtResetDevice接口复位当前运算的Device，回收Device
上的资源。

Context管理 ● 调用aclrtCreateContext接口创建Context。
● 调用aclrtDestroyContext接口销毁Context。

Stream管理 ● 调用aclrtCreateStream接口创建Stream。

● 调用aclrtDestroyStream接口销毁Stream。
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内存管理 ● 调用aclrtMalloc接口申请Device上的内存。

● 调用aclrtFree接口释放Device上的内存。

数据传输 如果在Host上运行应用，则需调用aclrtMemcpy接口：

● 将数据从Host传输到Device上，作为解码的输入数据。

● 模型推理结束后，将推理结果从Device传输到Host。
如果在Device上运行应用，则无需进行数据传输。

如果在开发者板上运行应用，则无需进行数据传输。

模型推理 ● 调用aclmdlLoadFromFileWithMem接口从*.om文件加载模型。

● 调用aclmdlExecute接口执行模型推理，同步接口。

● 调用aclmdlUnload接口卸载模型。

数据后处理 提供样例代码，处理模型推理的结果，直接在终端上显示top5置信
度的类别编号。

另外，样例中提供了自定义接口DumpModelOutputResult，用于将
模型推理的结果写入文件（运行可执行文件后，推理结果文件在运
行环境上的应用可执行文件的同级目录下），默认未调用该接口，
用户可在sample_process.cpp中，在调用OutputModelResult接口
前，增加如下代码调用DumpModelOutputResult接口：
// print the top 5 confidence values with indexes.use function 
DumpModelOutputResult
// if want to dump output result to file in the current directory
processModel.DumpModelOutputResult();
processModel.OutputModelResult();

 

Acl ResNet-50（C++）使用指导

步骤1 用户可以创建应用工程或导入应用工程。

● 创建应用工程：请参见新建应用工程创建Acl ResNet-50（C++）样例工程。

● 导入应用工程：

a. 执行git clone -b master https://gitee.com/ascend/samples.git命令下载
样例代码，acl_resnet50样例为“下载路径/samples/cplusplus/
level2_simple_inference/1_classification”下的
resnet50_imagenet_classification。

b. 请参见导入应用工程。

步骤2 准备模型文件和数据请参见创建Acl ResNet-50工程。

步骤3 编译应用工程。

在MindStudio工程界面，依次选择“Build > Edit Build Configuration...”，进入编译
配置页面。

1. 配置编译参数，点击 添加新增配置。
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图 6-64 编译配置

表 6-18 编译配置参数说明

参数配置 参数说明

Name 编译配置的名称。

Build Type 配置类型，可选：“Debug”或
“Release”。

Toolchain 工具链配置器，配置详情请参见
CMake编译配置，支持本地和远程编
译功能。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Debug”。

Build directory 编译目录相对路径，该路径是相对于
工程目录的路径。

Build options 编译加速选项。

Environment Variables 环境变量配置。

可直接手动配置或单击 符号，在
弹出窗中配置管理。

 

2. 单击“OK”保存编译工程。

步骤4 运行应用工程。

在MindStudio工程界面，依次选择“Run > Edit Configuration...”，进入编译配置页
面。

1. 配置运行参数。
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图6-65为Linux使用场景配置示例，Windows使用场景Run Mode中的Local Run
选项置灰，具体请参见Windows场景编译运行。配置完成后，单击“Apply”保
存运行配置，单击“OK”，关闭运行配置窗口。

图 6-65 运行参数配置

表 6-19 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode – Remote Run：远程运行。

– Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步
到远程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选
配置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后

在出的弹窗内单击 ，填写。

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执
行文件前，编译可执行文件。
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2. 在MindStudio工程界面，依次选择“Run > Run...”。在弹出框中选择已创建好的
运行配置信息，运行应用。

运行结果示例如图6-66，index及其value会根据运行环境的实际情况有所不同：

图 6-66 运行结果

如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束
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Acl ResNet-50（Python）使用指导

步骤1 请参见新建应用工程创建Acl ResNet-50（Python）样例工程。

步骤2 准备模型文件和数据请参见创建Acl ResNet-50工程。

步骤3 运行应用工程。

1. 配置运行参数。

图6-67为Linux使用场景配置示例，Windows使用场景Run Mode中的Local Run
选项置灰，具体请参见Windows场景编译运行。配置完成后，单击“Apply”保
存运行配置，单击“OK”，关闭运行配置窗口。

图 6-67 运行参数配置

表 6-20 运行配置参数说明

配置参数 参数说明

Name 运行配置名称，可修改。

Run Mode – Remote Run：远程运行。

– Local Run：本地运行。

Deployment 运行配置。通过Deployment功能，详细请参见
Deployment，可以将指定项目中的文件、文件夹同步
到远程指定机器的指定目录。

Executable 选择可执行文件的位置。

Command
Arguments

运行应用传入的参数，和用户的代码实现有关，为可选
配置。

Environment
Variables 环境变量配置。可以直接在框中输入也可以单击 后

在出的弹窗内单击 ，填写。

MindStudio
用户指南 6 应用开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 199



配置参数 参数说明

Before launch 此栏中可配置运行前的预处理操作，为可选配置。

例如，单击 添加“Ascend App Build”，在运行可执
行文件前，编译可执行文件。

 
2. 在MindStudio工程界面，依次选择“Run > Run...”。在弹出框中选择已创建好的

运行配置信息，运行应用。

运行结果示例如图6-68，index及其value会根据运行环境的实际情况有所不同：

图 6-68 运行结果
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如果运行过程中有错误提示，且需要查看运行环境的详细日志时，请参见《日志
参考》：

– 可参见“日志文件介绍”查看日志，日志文件路径默认为“$HOME/
ascend/log ”。

– 可参见“设置日志级别”查看或修改日志级别（默认为ERROR）。

----结束
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7 自定义算子开发

7.1 使用前必读

7.2 开发流程

7.3 算子分析

7.4 工程创建

7.5 TBE算子开发

7.6 AI CPU算子开发

7.7 其他功能及操作

7.8 参考

7.1 使用前必读

介绍

本章介绍如何使用MindStudio工具实现不同框架的算子开发。包括支持MindSpore、
PyTorch、TensorFlow、Caffe、ONNX的TBE算子开发和支持TensorFlow、PyTorch、
ONNX的AI CPU算子开发。此过程中，主要介绍MindStudio工具操作部分，对代码实
现部分仅做基本介绍，如需了解更多代码开发技巧，请参见对应算子开发指南。

MindStudio工具提供了算子开发样例，配置完成Ascend-cann-toolkit开发套件包后，
可从MindStudio安装目录下的“/MindStudio/plugins/ascend-foundation/samples/
operator_demo_projects/quick_start”获取算子开发样例。样例请参见自定义算子样
例。

Ascend-cann-toolkit安装目录/ascend-toolkit/latest/opp/op_impl/built-in/
ai_core/tbe/impl目录下为昇腾AI处理器支持的内置AI Core算子的实现文件，开发者
在进行算子代码实现时可进行参考。

算子开发依赖

算子开发前，须确保MindStudio运行的Python环境安装以下依赖。
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表 7-1 算子开发 MindStudio 需要的 Python 依赖

依赖包 版本
要求

应用场景 参考安装方法（以python3.7在X86架构为例）

xlrd 1.2.0 创建算子
工程

pip3.7 install xlrd==1.2.0 --user

gnureadlin
e

- TIK开发 pip3.7 install gnureadline --user

mindspore - MindSpor
e算子开发

安装方式参考MindSpore安装指南。

absl-py - UT测试 pip3.7 install absl-py --user

coverage - pip3.7 install coverage --user

onnx - ST测试 pip3.7 install onnx --user

tensorflow 1.15.0 pip3.7 install tensorflow==1.15.0 --user

csv - pip3.7 install python-csv --user

google - pip3.7 install google --user

 

说明

ARM架构的操作系统，安装依赖时可能会安装失败。请使用源码编译安装或者参考依赖官方安
装指导操作。

7.2 开发流程

7.2.1 TBE 算子开发流程
通过MindStudio工具进行TBE算子开发的总体开发流程如下：

● TensorFlow/ONNX/Caffe TBE算子开发流程：图7-1
● PyTorch TBE算子开发流程：图7-2
● MindSpore TBE算子开发流程：图7-3
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图 7-1 TensorFlow/ONNX/Caffe TBE 算子开发流程图

图 7-2 PyTorch TBE 算子开发流程图
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图 7-3 MindSpore TBE 算子开发流程

1. 算子分析：确定算子功能、输入、输出、算子开发方式、算子OpType以及算子实
现函数名称等。

2. 工程创建：通过MindStudio工具创建TBE算子工程，创建完成后，会自动生成算
子工程目录及相应的文件模板，开发者可以基于这些模板进行算子开发。

3. 算子开发：MindSpore框架的算子实现和注册信息文件以及算子原型定义具体实
现方式请参考MindSpore编程指南>自定义算子（Ascend）。

– 算子代码实现：描述算子的实现过程。

– 算子原型定义：算子原型定义规定了在昇腾AI处理器上可运行算子的约束，
主要包含定义算子输入、输出、属性和取值范围，基本参数的校验和shape的
推导，原型定义的信息会被注册到GE的算子原型库中。网络运行时，GE会调
用算子原型库的校验接口进行基本参数的校验，校验通过后，会根据原型库
中的推导函数推导每个节点的输出shape与dtype，进行输出tensor的静态内
存的分配。

– 算子信息库定义：算子信息配置文件用于将算子的相关信息注册到算子信息
库中，包括算子的输入输出dtype、format以及输入shape信息。网络运行
时，FE会根据算子信息库中的算子信息做基本校验，判断是否需要为算子插
入合适的转换节点，并根据算子信息库中信息找到对应的算子实现文件进行
编译，生成算子二进制文件进行执行。

– 算子适配插件实现：基于第三方框架（TensorFlow/ONNX/Caffe）进行自定
义算子开发的场景，开发人员完成自定义算子的实现代码后，需要进行插件
的开发将基于第三方框架的算子映射成适配昇腾AI处理器的算子，将算子信
息注册到GE中。基于第三方框架的网络运行时，首先会加载并调用GE中的插
件信息，将第三方框架网络中的算子进行解析并映射成昇腾AI处理器中的算
子。

4. UT测试：即单元测试（Unit Test），仿真环境下验证算子实现的功能正确性，包
括算子逻辑实现代码及算子原型定义实现代码。

5. 算子编译：将算子插件实现文件、算子原型定义文件、算子信息定义文件编译成
算子插件、算子原型库、算子信息库。

6. 算子部署：将算子实现文件、编译后的算子插件、算子原型库、算子信息库部署
到昇腾AI处理器算子库，为后续算子在网络中运行构造必要条件。

7. PyTorch算子适配：昇腾AI处理器具有内存管理、设备管理、算子调用实现功能。
PyTorch算子适配根据PyTorch原生结构进行昇腾AI处理器扩展。
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8. ST测试：即系统测试（System Test），可以自动生成测试用例，在真实的硬件环
境中验证算子功能的正确性。

7.2.2 AI CPU 算子开发流程
通过MindStudio工具进行AI CPU算子开发的总体开发流程如图7-4所示。

图 7-4 AI CPU 算子开发流程

1. 算子分析：明确算子的功能、输入、输出，规划算子类型名称以及算子编译生成
的库文件名称等。

2. 工程创建：通过MindStudio工具创建AI CPU算子工程，创建完成后，会自动生成
算子工程目录及相应的文件模板，开发者可以基于这些模板进行算子开发。

3. 算子开发。

– 算子实现：实现算子的计算逻辑。

– 算子原型定义：算子原型定义规定了在昇腾AI处理器上可运行算子的约束，
主要体现算子的数学含义，包含定义算子输入、输出、属性和取值范围，基
本参数的校验和shape的推导，原型定义的信息会被注册到GE的算子原型库
中。离线模型转换时，GE会调用算子原型库的校验接口进行基本参数的校
验，校验通过后，会根据原型库中的推导函数推导每个节点的输出shape与
dtype，进行输出tensor的静态内存的分配。

– 算子信息定义：算子信息配置文件用于将算子的相关信息注册到算子信息库
中，包括算子的OpType、输入输出dtype、name等信息。网络运行时，AI
CPU Engine会根据算子信息库中的算子信息做基本校验，并进行算子匹配。

– 算子适配插件实现：基于第三方框架（TensorFlow/Caffe/ONNX）进行自定
义算子开发的场景，开发人员完成自定义算子的实现代码后，需要进行插件
的开发将基于TensorFlow/Caffe/ONNX的算子映射成昇腾AI处理器的算子。

4. UT测试：即单元测试（Unit Test），仿真环境下验证算子实现的功能正确性，包
括算子逻辑实现代码及算子原型定义实现代码。

5. 算子编译：将算子适配插件实现文件、原型定义文件、信息定义文件编译成算子
插件库文件、算子原型库、算子信息库。

6. 算子部署：将算子实现文件、插件库文件、原型库、信息库部署到算子库中（opp
的对应目录下）。
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7. PyTorch算子适配：NPU具有内存管理，设备管理，以及算子调用实现。PyTorch
算子适配根据PyTorch原生结构进行NPU扩展。

8. ST测试：即系统测试（System Test），可以自动生成测试用例，在真实的硬件环
境中，验证算子功能的正确性。

7.3 算子分析

简介

本节以Add TBE算子和AI CPU算子开发为例进行算子分析，帮助读者快速掌握算子分
析流程。MindSpore算子工程的Square TBE算子分析请读者自行完成。

TBE 算子分析

使用TBE DSL方式开发Add算子前，我们需要确定算子功能、输入、输出，算子开发方
式、算子类型以及算子实现函数名称等。

步骤1 明确算子的功能以及数学表达式。

add算子的数学表达式为：

 z=x+y

计算过程：将两个输入参数相加，得到 终结果z并将其返回。

步骤2 明确输入和输出。

● add算子有两个输入：x与y，输出为z。

● 本样例中算子的输入支持的数据类型为float16、float32、int32，算子输出的数
据类型与输入数据类型相同。

● 算子输入支持所有shape，输出shape与输入shape相同。

● 算子输入支持的format为：NCHW,NC1HWC0,NHWC,ND。

步骤3 确定算子开发方式及使用的计算接口。

1. 计算过程只涉及加法操作，初步分析可使用tbe.dsl.vadd(lhs, rhs)接口实现x+y，
请查看《TBE自定义算子开发指南》。

2. 由于tbe.dsl.vadd(lhs, rhs)接口要求两个输入tensor的shape需要相同，所以需要
首先获取两个输入tensor中较大的shape值，然后调用tbe.dsl.broadcast(var,
shape, output_dtype=None)接口将入参广播成指定的shape大小。

步骤4 明确算子实现文件名称、算子实现函数名称以及算子的类型（OpType）。

算子命名规则如下：

● 算子类型需要采用大驼峰的命名方式，即采用大写字符区分不同的语义。

● 算子文件名称和算子函数名称，可选用以下任意一种命名规则：

– 用户自定义，此时需要在算子信息定义中配置opFile.value与
opInterface.value。

– 不配置算子信息定义中opFile.value与opInterface.value，FE会将OpType按
照如下方式进行转换后进行算子文件名和算子函数名的匹配。

▪ 首字符的大写字符转换为小写字符。

例如：Abc -> abc
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▪ 小写字符后的大写字符转换为下划线+小写字符。

例如：AbcDef -> abc_def

▪ 紧跟数字以及大写字符后的大写字符，作为同一语义字符串，查找此字
符串后的第一个小写字符，并将此小写字符的前一个大写字符转换为下
划线+小写字符，其余大写字符转换为小写字符。若此字符串后不存在小
写字符，则直接将此字符串中的大写字符转换为小写字符。

例如：ABCDef -> abc_def；Abc2DEf -> abc2d_ef；Abc2DEF ->
abc2def；ABC2dEF -> abc2d_ef。

因此本例中，算子类型定义为Add。算子的实现文件名称及实现函数名称将首字母转
换小写字符，定义为add。

通过以上分析，得到Add算子的设计规格如下：

表 7-2 Add 算子设计规格

算子类型
（OpType）

Add

算子输入 name
：x1

shape
：all

data type：

float16、float32、
int32

format：
NCHW,NC1HWC0,NH
WC,ND

name
：x2

shape
：all

data type：

float16、float32、
int32

format：
NCHW,NC1HWC0,NH
WC,ND

算子输出 name
：y

shape
：all

data type：

float16、float32、
int32

format：
NCHW,NC1HWC0,NH
WC,ND

算子实现使用
的主要DSL接
口

tbe.dsl.broadcast(var, shape, output_dtype=None)
tbe.dsl.vadd(lhs, rhs)

算子实现文件/
实现函数名称

add

 

----结束

AI CPU 算子分析

使用AI CPU方式开发算子前，我们需要确定算子功能、输入、输出、算子类型以及算
子实现函数名称等。

步骤1 明确算子的功能以及数学表达式。

以Add算子为例，Add算子的数学表达式为：

 z=x+y

计算过程是：将两个输入参数相加，得到 终结果z并将其返回。
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步骤2 明确输入和输出。

● 例如Add算子有两个输入：x与y，输出为z。

● 本样例中算子的输入支持的数据类型为float16、float32、 int32，算子输出的数
据类型与输入数据类型相同。

● 算子输入支持所有shape，输出shape与输入shape相同。

● 算子输入支持的format为：NCHW,NHWC,ND。

步骤3 明确算子实现文件名称以及算子的类型（OpType）。

● 算子类型需要采用大驼峰的命名方式，即采用大写字符区分不同的语义。

● 算子文件名称，可选用以下任意一种命名规则：

建议将OpType按照如下方式进行转换，得到算子文件名称。

转换规则如下：

– 首字符的大写字符转换为小写字符。

例如：Abc -> abc
– 小写字符后的大写字符转换为下划线+小写字符。

例如：AbcDef -> abc_def
– 紧跟数字以及大写字符后的大写字符，作为同一语义字符串，查找此字符串

后的第一个小写字符，并将此小写字符的前一个大写字符转换为下划线+小写
字符，其余大写字符转换为小写字符。若此字符串后不存在小写字符，则直
接将此字符串中的大写字符转换为小写字符。

例如：ABCDef -> abc_def；Abc2DEf -> abc2d_ef；Abc2DEF -> abc2def；
ABC2dEF -> abc2d_ef。

因此本例中，算子类型定义为Add，算子的实现文件名称为add，因此各个交付件的名
称建议命名如下：

● 算子的代码实现（即kernel实现）文件命名为add_kernel.h与add_kernel.cc。

● 插件实现文件命名为add_kernel_plugin.cc。

● 原型定义文件命名为：add.h与add.cc。

● 信息定义文件命名为add.ini。

通过以上分析，得到Add算子的设计规格如下：

表 7-3 Add 算子设计规格

算子类型
（OpType）

Add

算子输入 name：x shape：all data type：

float16、float32、 int32

name：y shape：all data type：

float16、float32、 int32

算子输出 name：z shape：all data type：

float16、float32、 int32

算子实现文件名称 add
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----结束

7.4 工程创建

7.4.1 创建算子工程

简介

本节介绍如何通过MindStudio工具创建算子工程，创建完之后工具会自动生成算子工
程目录及相应的文件模板，开发者可以基于这些模板进行算子开发。

操作步骤

步骤1 进入算子工程创建界面。

● 首次登录MindStudio：在MindStudio欢迎界面中单击“New Project”，进入创
建工程界面。

● 非首次登录MindStudio：在顶部菜单栏中选择“File > New > Project...”，进入
创建工程界面。

图 7-5 创建工程界面

步骤2 创建算子工程。

1. 在左侧导航栏选择“Ascend Operator”，在右侧配置算子工程信息，配置示例如
表7-4所示。
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表 7-4 工程信息配置

参数 参数说明 示例

Name 工程名称，用户自行配置。

名称必须以字母开头，数字或字母结尾，
只能包含字母、数字、中划线和下划线，
且长度不能超过64个字符。

MyOperator

Description 工程描述信息，自行配置。 可选配置

CANN
Version

当前CANN的版本号。 选择当前CANN的
版本号

Project
Location

工程的存储路径。 保持默认

 
2. 单击“Next”，在弹出的页面中配置算子相关信息，请参考表7-5进行配置。

表 7-5 算子信息配置

参数 参数说明 示例

New Operator（算子创建方式）

Sample
Template

表示基于样例创建算子工程。

选择此选项，下方显示AICPU、DSL、TIK三种
算子实现方式。每种实现方式按照AI框架分类提
供了算子样例，供用户选择。用户可以选择一个
实现方式下的一个AI框架中的一个或多个算子创
建算子工程。

– AICPU：AI CPU算子样例

– DSL：基于DSL方式实现的TBE算子样例

– TIK：基于TIK方式实现的TBE算子样例

四选一，当前
默认选择
“Sample
Template”
。

Empty
Template

表示创建空的算子工程。

选择此选项，下方会显示“Operator Type”配
置项，请在此处输入需要创建的算子的类型，请
根据算子分析进行配置。
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参数 参数说明 示例

IR Template 表示基于IR定义模板创建算子工程。IR定义模板
文件有json和Excel两种格式。

选择此选项，下方会显示“Template File”配
置项，用户需要选择IR原型定义文件。

须知

– Ascend_IR_Template.json
请从Ascend-cann-toolkit安装目录/ascend-
toolkit/latest/toolkit/python/site-packages/
op_gen/json_template目录下获取IR定义的json
模板。

– Ascend_IR_Template.xlsx
请从Ascend-cann-toolkit安装目录/ascend-
toolkit/latest/toolkit/tools/msopgen/
template目录下获取IR定义Excel模板。

请在模板文件中的“Op”页签修改自定义算子的
IR定义。

IR定义的配置请参见IR定义配置说明。

Tensorflow
Template

表示基于Tensorflow原型定义创建算子工程。

选择此方式创建算子工程，请先在安装
MindStudio的服务器中下载Tensorflow源码。
选择此选项后，下方会出现详细配置栏。

– Operator Path：请选择Tensorflow源码所在
目录，为提升搜索效率，建议选择到
tensorflow/core/ops目录。

– Operator Type：请配置为需要创建算子的
Op Type。

Plugin
Framework

算子所在模型文件的框架类型。选择“Sample
Template”创建算子工程时不显示此配置项。

– MindSpore
– PyTorch
– TensorFlow
– Caffe
– ONNX
Caffe不支持Tensorflow Template创建算子工
程。

MindSpore

Compute
Unit

有以下两种选项，选择“Sample Template”创
建算子工程时不显示此配置项。

– AI Core/Vector Core：算子运行在AI Core或
者Vector Core上，代表TBE算子

– AI CPU：算子运行在AI CPU上，代表AI CPU
算子

“Plugin Framework”选择“MindSpore”，
仅支持选择“AI Core/Vector Core”。

AI Core/
Vector Core
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参数 参数说明 示例

Unit Type – 当“Compute Unit”选择“AI Core/Vector
Core”时显示此配置项。

– 当选择“Sample Template”创建算子工程
时不显示此配置项。

– “Plugin Framework”选择“MindSpore”
时不显示此配置项。

请根据实际昇
腾AI处理器版
本下拉选择算
子计算单元。

 
3. 单击“Finish”，完成算子工程的创建。

若工作窗口已打开其他工程，会出现如图7-6所示提示。

– 选择“This Window”，则直接在当前工作窗口打开新创建的工程。

– 选择“New Window”，则新建一个工作窗口打开新创建的工程。

图 7-6 工程创建提示

须知

– 新建工程的默认存储路径为安装用户家目录的“AscendProjects”文件夹下。

– 若开发者需要自定义多个算子，需要在同一算子工程中进行实现和编译。可选
中算子工程根目录，右键选择New > Operator 增加算子。

– 同一算子工程中，暂时不支持AI CPU算子和TBE算子同名。

– 目前Windows版本中，新建算子工程的代码中可能会出现无法识别的语义被红
色波浪线标出，但不影响正常开发流程，用户可忽略该提示。

– 目前Windows版本中，支持实现算子原型文件和AI CPU算子代码实现的C++代
码跳转功能。需要用户手动配置系统环境变量。

变量名为ASCEND_OPP_PATH，变量值为C:\Users\用户名\.mindstudio
\huawei\adk\remote\CANN包版本号\opp
请以实际用户名和CANN包版本号修改变量值。

– 若使用远程进行算子开发，支持自动同步文件功能。

步骤3 查看算子工程目录结构和主要文件。

框架为TensorFlow、PyTorch、ONNX、Caffe时的工程目录结构和主要文件。
├── .idea
├── build                                  //编译生成的中间文件
├── cmake                                  //编译相关公共文件存放目录
├── cpukernel                              //AI CPU算子文件目录，TensorFlow TBE算子和PyTorch算子工程不会创
建此目录
│   ├── impl                              //算子实现文件目录
│   │   ├── reshape_cust_kernel.cc       //算子源文件  
│   │   ├── reshape_cust_kernel.h        //算子头文件       
│   ├── op_info_cfg                       //算子信息库文件目录
│   │   ├── aicpu_kernel           
│   │   │   ├── reshape_cust.ini        //算子信息定义文件
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│   ├── CMakeLists.txt                    //编译规则文件，会被算子工程根目录中的CMakeLists.txt文件调用
│   ├── toolchain.cmake                   
├── framework                              //算子插件实现文件目录
│   ├── tf_plugin                         //存放tensorflow框架的算子插件文件及编译规则文件，若“Plugin 
Framework”为“PyTorch”，不会创建此目录
│   │   ├── tensorflow_add_plugin.cc    //add为算子类型，TBE算子示例为add，AI CPU算子为
reshape_cust
│   │   ├── CMakeLists.txt               //编译规则文件，会被上级目录中的CMakeLists.txt文件调用
│   ├── caffe_plugin                         //存放caffe框架的算子插件文件及编译规则文件，若“Plugin 
Framework”为“PyTorch”，不会创建此目录
│   │   ├── caffe_add_plugin.cc    //add为算子类型，TBE算子示例为add，AI CPU算子为reshape_cust
│   │   ├── CMakeLists.txt               //编译规则文件，会被上级目录中的CMakeLists.txt文件调用
│   └── onnx_plugin   //原始框架类型为ONNX时生成的算子适配插件代码所在目录
│       ├── CMakeLists.txt
│       └── xxx_plugin.cc/    /算子适配插件实现文件
│   ├── CMakeLists.txt                    //编译规则文件，会被算子工程根目录中的CMakeLists.txt文件调
├── op_proto                               //算子IR定义文件目录
│   ├── add.cc                           //add为算子类型，TBE算子示例为add，AI CPU算子为reshape_cust
│   ├── add.h                             //add为算子类型，TBE算子示例为add，AI CPU算子为reshape_cust
│   ├── CMakeLists.txt                    //编译规则文件，会被算子工程根目录的CMakeLists.txt文件调用
├── scripts                                //工程相关脚本
├── tbe                                    //TBE算子文件目录，TensorFolw AI CPU算子工程不会创建此目
录               
│   ├── impl                              //算子实现文件目录
│   │   ├── add.py         
│   ├── op_info_cfg                       //算子信息库文件目录
│   │   ├── ai_core
│   │   │   ├── {soc_version}             
│   │   │   │   ├── add.ini
├── .project                                 //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN
版本
├── Add_READEME.md                                 //介绍算子基本功能、基本信息和主要的算子工程
├── CMakeLists.txt               
├── MyOperator.iml    

框架为MindSpore时的工程目录结构和主要文件。

├── .idea
├── mindspore
│   ├── impl                  //算子实现文件目录
│   │   ├── cus_square_impl.py      //实现算子和注册算子信息 py文件
├── op_proto
│   ├── cus_square.py               //算子原语py文件
├── .project                   //工程信息文件，包含工程类型、工程描述、运行目标设备类型以及CANN版
本              
├── MyOperator.iml 

----结束

7.4.2 设置 Python 库
算子开发之前，开发者需要参考本章节设置算子工程依赖Python库。

● 全局依赖的Python SDK设置：必选操作。但仅需配置一次，对全部算子工程生
效，后续创建算子工程时无需重复配置。

● 设置当前算子工程依赖的Python SDK：必选操作。每次创建算子工程后，必须进
行此步配置，仅对当前算子工程生效。

● （可选）添加自定义Python SDK：可选操作。用户需要添加自定义Python SDK
时配置。

设置当前算子工程依赖的 Python SDK
若开发者在算子代码开发过程中，自行引入了其他第三方Python库或自定义Python
库，需要参考如下操作在工程中添加相应的python sdk。
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步骤1 在工程界面中，单击菜单栏中的“File > Project Structure”，进入“Project
Structure”设置页面。

步骤2 在左侧菜单栏中选择“Project Settings > Project”，进行“Project”设置。

在Project SDK中，下拉选择全局依赖的Python SDK设置中配置的Python SDK，并单
击“Apply”，如图7-7所示。

图 7-7 选择 Project SDK

步骤3 在左侧菜单栏中选择“Project Settings > Modules”，进行Modules设置。

在Dependencies页签中，下拉选择全局依赖的Python SDK设置中配置的Python
SDK，并单击“Apply”，如图7-8所示。

图 7-8 选择 Modules SDK

步骤4 单击“OK”，关闭“Project Structure”窗口。

此时，在工程底部菜单栏中会显示如图7-9所示提示。

图 7-9 更新界面
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步骤5 更新成功后，Python代码可以实现自动解析，如图7-10所示。单击导入的Python模块
代码，然后按Ctrl+Q，会出现相应的“提示”。按住Ctrl键，单击还可进入对应的模块
定义文件。

图 7-10 Python 代码自动解析示例

说明

若仍然无法自动解析，请关闭工程后重新打开。

----结束

（可选）添加自定义 Python SDK

若开发者在算子代码开发过程中，自行引入了其他第三方Python库或自定义Python
库，需要参考如下操作在工程中添加相应的Python SDK。

步骤1 在工程界面中，单击菜单栏中的“File > Project Structure”，进入“Project
Structure”设置页面。

步骤2 在左侧菜单栏中选择“Platform Settings > SDKs”，进行“Python SDK”设置。

步骤3 选择对应的python库，在Classpath栏中单击“+”，可添加自定义的Python库，如图
7-11所示。

需要注意的是：

● 在新建的Python库中，务必确保系统默认的算子开发相关Python库已存在，包括
tbe、topi等。

● 由于“Platform Settings”页签中的Python库为全局配置，对所有算子工程生
效。
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图 7-11 添加用户自定义 Python 库

步骤4 单击“OK”，关闭Project Structure窗口。

----结束

7.5 TBE 算子开发
TBE算子开发流程将以算子开发样例工程中“Add”算子为例，供开发者参考。

7.5.1 算子原型定义
进入“op_proto/”目录，编写IR实现文件“add.h”和“add.cc”，将算子注册到算子
原型库中。网络运行时，GE会调用算子原型库的校验接口进行基本参数的校验，校验
通过后，会根据原型库中的推导函数推导每个节点的输出shape与dtype，进行输出
tensor的静态内存的分配。

add.h 实现

MindStudio已在add.h文件中生成了算子注册的代码模板文件，开发者可根据需要进行
修改，Add算子的原型定义如下所示：

#ifndef GE_OPS_OP_PROTO_ADD_H_
#define GE_OPS_OP_PROTO_ADD_H_
#include "graph/operator_reg.h"
namespace ge {
REG_OP(Add)
    .INPUT(x1,
        TensorType({DT_FLOAT, DT_INT32, DT_INT64, DT_FLOAT16, DT_INT16, DT_INT8, DT_UINT8, 
DT_DOUBLE, DT_COMPLEX128,
            DT_COMPLEX64, DT_STRING}))
    .INPUT(x2,
        TensorType({DT_FLOAT, DT_INT32, DT_INT64, DT_FLOAT16, DT_INT16, DT_INT8, DT_UINT8, 
DT_DOUBLE, DT_COMPLEX128,
            DT_COMPLEX64, DT_STRING}))
    .OUTPUT(y,
        TensorType({DT_FLOAT, DT_INT32, DT_INT64, DT_FLOAT16, DT_INT16, DT_INT8, DT_UINT8, 
DT_DOUBLE, DT_COMPLEX128,
            DT_COMPLEX64, DT_STRING}))
    .OP_END_FACTORY_REG(Add)
}

#endif //GE_OPS_OP_PROTO_ADD_H
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● REG_OP(Add)中的Add为算子注册到昇腾AI处理器中的Type，第三方框架
（TensorFlow/ONNX/Caffe）需要与算子适配插件实现（TensorFlow/Caffe/
ONNX）中REGISTER_CUSTOM_OP("Add")中的算子类型保持一致。

● .INPUT与.OUTPUT分别为算子的输入、输出Tensor的名称与数据类型，输入输出
的顺序需要与算子代码实现函数形参顺序以及算子信息库定义中参数的顺序保持
一致。

add.cc 实现

开发者需要在add.cc中实现InferShape与Verify方法。

● Verify函数，即如下代码示例中的IMPLEMT_VERIFIER(Add, AddVerify)函数，用
于校验Add算子的两个输入的DataType是否一致。

● InferShape函数，即如下代码示例中的
IMPLEMT_COMMON_INFERFUNC(AddInferShape)函数，用于推导出算子的输
出张量描述，这样在网络运行时就可以为所有的张量静态分配内存，避免动态内
存分配带来的开销。

add.cc的实现代码如下所示：
#include "./add.h"         //IR注册头文件
#include <vector>        //可使用vector类模板并调用vector相关接口
#include <string>        //C++标准库，可使用string类构造对象并调用string相关接口

namespace ge {
bool InferShapeAndTypeAdd(Operator& op,
    const string& inputName1,
    const string& inputName2, const string& outputName)
 {
    TensorDesc vOutputDesc = op.GetOutputDescByName(outputName.c_str());

    DataType inputDtype = op.GetInputDescByName(inputName1.c_str()).GetDataType();
    Format inputFormat = op.GetInputDescByName(inputName1.c_str()).GetFormat();
    // 针对shape维度大小进行交换
    ge::Shape shapeX = op.GetInputDescByName(inputName1.c_str()).GetShape();
    ge::Shape shapeY = op.GetInputDescByName(inputName2.c_str()).GetShape();
    std::vector<int64_t> dimsX = shapeX.GetDims();
    std::vector<int64_t> dimsY = shapeY.GetDims();
    if (dimsX.size() < dimsY.size()) {
        std::vector<int64_t> dimsTmp = dimsX;
        dimsX = dimsY;
        dimsY = dimsTmp;
    }

  // 对小的shape进行1补齐
  if (dimsX.size() != dimsY.size()) {
    int dec = dimsX.size() - dimsY.size();
    for (int i = 0; i < dec; i++) {
      dimsY.insert(dimsY.begin(), (int64_t)1);
    }
  }

    // 设置输出的shape维度
    std::vector<int64_t> dimVec;
    for (size_t i = 0; i < dimsX.size(); i++) {
        if ((dimsX[i] != dimsY[i]) && (dimsX[i] != 1) && (dimsY[i] != 1)) {
            return false;
        }

        int64_t dims = dimsX[i] > dimsY[i] ? dimsX[i] : dimsY[i];
        dimVec.push_back(dims);
    }
    ge::Shape outputShape = ge::Shape(dimVec);

    vOutputDesc.SetShape(outputShape);
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    vOutputDesc.SetDataType(inputDtype);
    vOutputDesc.SetFormat(inputFormat);
    op.UpdateOutputDesc(outputName.c_str(), vOutputDesc);

    return true;
}

//----------------Add-------------------
IMPLEMT_VERIFIER(Add, AddVerify)
{
    if (op.GetInputDescByName("x1").GetDataType() != op.GetInputDescByName("x2").GetDataType()) {
        return GRAPH_FAILED;
    }
    return GRAPH_SUCCESS;
}

// Obtains the processing function of the output tensor description.
IMPLEMT_COMMON_INFERFUNC(AddInferShape)
{
    if(InferShapeAndTypeAdd(op, "x1", "x2", "y")) {
        return GRAPH_SUCCESS;
    }
    return GRAPH_FAILED;
}

//Registered inferfunction，第一个参数为算子的OpType
COMMON_INFER_FUNC_REG(Add, AddInferShape);      

//Registered verify function，第一个参数为算子的OpType
VERIFY_FUNC_REG(Add, AddVerify);
//----------------Add-------------------
}

7.5.2 算子代码实现
通过调用TBE DSL接口，在算子工程下的“tbe/impl/add.py”文件中进行Add算子的
实现，包括算子函数定义、算子入参校验、compute过程实现及调度与编译。

代码模板介绍

MindStudio在“tbe/impl/add.py”中生成代码模板。
# 导入依赖的Python模块
import tbe.dsl as tbe
from tbe import tvm
from tbe.common.register import register_op_compute
from topi import generic

# 算子计算函数
@register_op_compute(("Add")
def add_compute(x, y, z, kernel_name="add"):
    """
    To do: Implement the operator by referring to the
           TBE Operator Development Guide.
    """

    res = tbe.XXX(x, y)
    return res

# 算子定义函数
def add(x, y, z, kernel_name="add"):
    """
    To do: Implement the operator by referring to the
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           TBE Operator Development Guide.
    """
    # 输入参数占位
    data_x = tvm.placeholder(x.get("shape"), dtype=x.get("dtype"), name="data_x")
    data_y = tvm.placeholder(y.get("shape"), dtype=y.get("dtype"), name="data_y")

    # 调用算子计算函数
    res = add_compute(data_x, data_y, z, kernel_name)

    # 自动调度
    with tvm.target.cce():
        schedule = tbe.auto_schedule(res)

    # 编译
    config = {"name": kernel_name,
              "tensor_list": [data_x, data_y, res]}
    tbe.build(schedule, config)

● 引入算子开发时依赖的Python模块。

– “tbe.dsl”：引入TBE支持的特定域语言接口，包括常见的运算vmuls、
vadds、matmul等。

具体的接口定义可查看Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/compiler/python/site-packages/tbe/dsl目录下的Python函数。

– “tbe.tvm”：引入TVM后端代码生成机制。

具体的接口定义可查看Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/compiler/python/site-packages/tbe/tvm目录下的Python函数，使
用方法请参见https://docs.tvm.ai/。

– “tbe.common.register.register_op_compute”：提供了实现算子的UB自动
融合的接口。

具体的接口定义可查看Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/compiler/python/site-packages/tbe/common/register/
register_api.py文件中的register_op_compute函数的定义。

● 模板生成以算子名称_compute命名的计算函数声明。

– 若创建算子工程时选择的“From Template”或者“From Tensorflow”，输
入输出参数及属性会根据原型定义自动生成。

– 若创建算子工程时选择“Empty”，默认生成的参数为一个输入与一个输
出，不带属性。

● 模板生成以算子名称命名的定义函数的声明与部分实现，模板中提供的实现函数
中的示例代码包含如下功能：

– 获取输入tensor的shape与dtype。

– 对输入参数进行校验。

– 对输入tensor进行占位。

– 调用算子的compute函数进行计算、调度与编译。

算子定义函数实现

开发者需要根据MindStudio生成的模板代码进行算子计算函数的实现。同时需要在算
子定义函数中增加算子输入/输出/属性的校验代码。由于Add算子允许两个输入数据的
shape不同，但算子计算接口tbe.dsl.vadd( )要求两个输入shape相同，因此需要对算
子两个输入的shape进行广播并对其进行校验。有助于在算子编译阶段，提前发现问
题。修改后代码如下所示：
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说明

若开发者通过Windows上远程打开的MindStudio，复制以下代码时可能会出现无法复制的情
况，解决方法请参见Windows上远程打开MindStudio时，偶现复制的内容无法粘贴到编辑器
窗口中。

from __future__ import absolute_import
import tbe.dsl as tbe
from functools import reduce
from tbe import tvm
from tbe.common.register import register_op_compute
from tbe.common.utils import para_check
from tbe.common.utils import shape_util

SHAPE_SIZE_LIMIT = 2147483648

# 实现Add算子的计算逻辑
@register_op_compute("Add", op_mode="dynamic", support_fusion=True)
def add_compute(input_x, input_y, output_z, kernel_name="add"):
    # 将shape转换为list
    shape_x = shape_util.shape_to_list(input_x.shape)    
    shape_y = shape_util.shape_to_list(input_y.shape) 

    # shape_max取shape_x与shape_y的每个维度的大值
    shape_x, shape_y, shape_max = shape_util.broadcast_shapes(shape_x, shape_y,
                                                              param_name_input1="input_x",
                                                              param_name_input2="input_y")
    shape_size = reduce(lambda x, y: x * y, shape_max[:])
    if shape_size > SHAPE_SIZE_LIMIT:
        raise RuntimeError("the shape is too large to calculate")

    # 将input_x的shape广播为shape_max
    input_x = tbe.broadcast(input_x, shape_max)
    input_y = tbe.broadcast(input_y, shape_max)

    # 执行input_x + input_y
    res = tbe.vadd(input_x, input_y)

    return res

# 算子定义函数
@para_check.check_op_params(para_check.REQUIRED_INPUT, para_check.REQUIRED_INPUT,
                            para_check.REQUIRED_OUTPUT, para_check.KERNEL_NAME)
def add(input_x, input_y, output_z, kernel_name="add"):
    # 获取算子输入tensor的shape与dtype
    shape_x = input_x.get("shape")
    shape_y = input_y.get("shape")

    # 检验算子输入类型
    check_tuple = ("float16", "float32", "int32")
    input_data_type = input_x.get("dtype").lower()
    para_check.check_dtype(input_data_type, check_tuple, param_name="input_x")

    # shape_max取shape_x与shape_y的每个维度的 大值
    shape_x, shape_y, shape_max = shape_util.broadcast_shapes(shape_x, shape_y,
                                                              param_name_input1="input_x",
                                                              param_name_input2="input_y")

     # 如果shape的长度等于1，就直接赋值，如果shape的长度不等于1，做切片，将 后一个维度舍弃（按照内
存排布， 后一个维度为1与没有 后一个维度的数据排布相同，例如2*3=2*3*1，将 后一个为1的维度舍弃，可
提升后续的调度效率）
    if shape_x[-1] == 1 and shape_y[-1] == 1 and shape_max[-1] == 1:
        shape_x = shape_x if len(shape_x) == 1 else shape_x[:-1]
        shape_y = shape_y if len(shape_y) == 1 else shape_y[:-1]
        shape_max = shape_max if len(shape_max) == 1 else shape_max[:-1]

    # 使用TVM的placeholder接口对输入tensor进行占位，返回一个tensor对象
    data_x = tvm.placeholder(shape_x, name="data_1", dtype=input_data_type)
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    data_y = tvm.placeholder(shape_y, name="data_2", dtype=input_data_type)

    # 调用compute实现函数
    res = add_compute(data_x, data_y, output_z, kernel_name)

    # 自动调度
    with tvm.target.cce():
        schedule = tbe.auto_schedule(res)
    # 编译配置
    config = {"name": kernel_name,
              "tensor_list": (data_x, data_y, res)}
    tbe.build(schedule, config)

1. 算子定义函数声明包含算子输入信息、输出信息以及内核名称。
def add(input_x, input_y, output_z, kernel_name="add"):

– input_x, input_y：Add算子的两个输入tensor，每个tensor需要采用字典的形
式进行定义，包含shape和dtype等信息。输入tensor的个数需要与算子信息
定义文件“tbe/op_info_cfg/ai_core/add.ini”中的定义保持一致。

– output_z：输出tensor，包含shape和dtype等信息，字典格式，此字段为预
留位。

输出tensor的个数需要与算子信息定义文件“tbe/op_info_cfg/ai_core/
add.ini”中的定义保持一致。

– kernel_name：算子在内核中的名称（即生成的二进制文件以及算子描述文
件的名称），用户自定义，保持唯一，只能是大小写字母、数字、“_”的组
合，且必须是字母或者“_”开头，长度小于或等于200个字符。

2. 算子输入校验和输出形状推导。

Add算子需要对两个输入tensor的shape进行校验，且仅支持数据类型float16,
float32, int32，此外Add算子允许两个输入shape不同，因此需要调用
shape_util.broadcast_shapes()生成广播后的shape并对其进行校验。

3. 对输入tensor进行占位。

调用TVM的placeholder接口分别对两个输入tensor进行占位，并分别返回一个
tensor对象。

须知

5中的tensor_list的输入tensor需要是tvm.placeholder接口返回的tensor对象，所
以此对象在后续计算过程实现中不能被替换。

4. 调用add_compute计算函数。
res = add_compute(data_x, data_y, output_z, kernel_name)  

data_x、data_y为3生成的占位tensor对象。

计算函数的实现请参见算子Compute函数实现。

5. 算子调度与编译实现。

调度配置config中的tensor_list为：

"tensor_list": (data_x, data_y, res)

分别为两个输入tensor与一个输出tensor。

算子 Compute 函数实现

开发者需要根据算子计算逻辑自定义实现算子compute函数，Add算子的Compute函
数实现如下：
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@register_op_compute("Add", op_mode="dynamic", support_fusion=True)
def add_compute(input_x, input_y, output_z, kernel_name="add"):
    # 将shape转换为list
    shape_x = shape_util.shape_to_list(input_x.shape)    
    shape_y = shape_util.shape_to_list(input_y.shape) 

    # shape_max取shape_x与shape_y的每个维度的大值
    shape_x, shape_y, shape_max = shape_util.broadcast_shapes(shape_x, shape_y,
                                                              param_name_input1="input_x",
                                                              param_name_input2="input_y")
    shape_size = reduce(lambda x, y: x * y, shape_max[:])
    if shape_size > SHAPE_SIZE_LIMIT:
        raise RuntimeError("the shape is too large to calculate")

    # 将input_x的shape广播为shape_max
    input_x = tbe.broadcast(input_x, shape_max)
    input_y = tbe.broadcast(input_y, shape_max)

    # 执行input_x + input_y
    res = tbe.vadd(input_x, input_y)

    return res

1. add_compute函数的声明如下所示。
@register_op_compute("Add", op_mode="dynamic", support_fusion=True)
def add_compute(input_x, input_y, output_z, kernel_name="add")

装饰器@register_op_compute("Add", op_mode="dynamic",
support_fusion=True)是DSL算子开发方式中必需的，其作用是整网运行时算子支
持做UB自动融合，使得当前自定义算子可以在UB中根据UB融合规则自动与其他
算子的计算进行组装。

其中：

– input_x，input_y：compute函数的入参，为在3中声明的输入tensor对应的
placeholder，包含shape和dtype等信息。

– output_z：为1中算子接口函数透传过来的dict类型。

– kernel_name：算子在内核中的名称。

2. 进行Add算子的计算逻辑的实现。

Add算子要求相加的两个tensor的shape相同，所以首先通过调用tbe.broadcast接
口将两个输入tensor广播成相同的shape，然后调用tbe.vadd接口实现输入tensor
的相加，并返回计算结果tensor。

算子编译验证

步骤1 在算子python文件 下方添加main函数调用该算子，通过MindStudio编译算子实现文
件，用于单算子代码的简单语法校验，代码示例如下所示：
# 算子调用
if __name__ == '__main__':
    input_output_dict = {"shape": (5, 6, 7),"format": "ND","ori_shape": (5, 6, 7),"ori_format": "ND", "dtype": 
"float16"}
    add(input_output_dict, input_output_dict, input_output_dict, kernel_name="add")

步骤2 右键单击“tbe/impl/add.py”，选择“Run‘add'”，编译算子。

如果编译没有报错，且在当前目录“tbe/impl”下生成kernel_meta文件夹，包括以下
文件，则表示算子代码能够编译运行。

● 算子二进制文件*.o。

● 算子描述文件*.json：用于定义算子属性及运行时所需要的资源。

----结束
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7.5.3 算子信息库定义

需要通过配置算子信息文件，将算子的相关信息注册到算子信息库中。算子信息库主
要体现算子在昇腾AI处理器上物理实现的限制，包括算子的输入输出dtype、format以
及输入shape信息。网络运行时，FE会根据算子信息库中的算子信息做基本校验，判断
是否需要为算子插入合适的转换节点，并根据算子信息库中信息找到对应的算子实现
文件进行编译，生成算子二进制文件进行执行。

进入“tbe/op_info_cfg/ai_core/soc_version”目录，配置算子信息库文件
“add.ini”。

soc_version为当前昇腾AI处理器的版本，例如ascend310、ascend910等。

开发者需要基于MindStudio自动生成的add.ini文件进行修改，修改后的Add算子的算
子信息定义如下所示。

[Add]
input0.name=x1
input0.dtype=float16,float16,float16,float16,float,float,float,float,int32,int32,int32,int32
input0.format=NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND
input0.shape=all
input0.paramType=required
input1.name=x2
input1.dtype=float16,float16,float16,float16,float,float,float,float,int32,int32,int32,int32
input1.format=NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND
input1.shape=all
input1.paramType=required
output0.name=y
output0.dtype=float16,float16,float16,float16,float,float,float,float,int32,int32,int32,int32
output0.format=NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND,NCHW,NC1HWC0,NHWC,ND
output0.shape=all
output0.paramType=required
opFile.value=add
opInterface.value=add

参数说明请参见表7-6。下表仅列出常用的算子信息库配置项，其他配置项请参见
《TBE自定义算子开发指南》的“算子信息库定义”章节。

表 7-6 Add 算子的算子信息定义说明

信息 Add算子配置 说明

[OpType] [Add] 算子类型，以英文半角方括号，标
识一个算子信息开始，根据算子分
析，算子类型为Add。

input0.name x1 Add算子的第一个输入tensor的名
称，根据算子分析，第一个输入名
称为x1，所以此处配置为x1，且需
要跟算子原型定义中的名称保持一
致。

input0.dtype input0.dtype=float1
6,float16,float16,fl
oat16,float,float,flo
at,float,int32,int32,i
nt32,int32
input0.format=NC
HW,NC1HWC0,NH

定义输入tensor支持的数据类型与
数据排布格式。

根据算子分析，Add算子的输入数
据类型支持float16、float32与
int32三种；支持的数据排布格式有
NCHW、NC1HWC0、NHWC、
ND。
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input0.format WC,ND,NCHW,NC1
HWC0,NHWC,ND,N
CHW,NC1HWC0,N
HWC,ND

说明
若算子输入支持多种规格，算子输入的
dtype与format需要一一对应、按对应
顺序进行配置，列出算子支持的所有
dtype与format的组合，中间以“,”分
隔。

input0.shape all 定义输入tensor支持的形状。

input0.paramType required 定义输入tensor的类型。

● dynamic：表示该输入是动态个
数，可能是1个，也可能是多
个。

● optional：表示该输入为可选，
可以有1个，也可以不存在。

● required：表示该输入有且仅有
1个。

Add算子的input0为固定输入1个，
此处配置为required。

input1.name x2 因为Add算子有两个输入，生成的
配置模板中只有一个输入，所以此
处需要添加input1的相关配置。

此配置项代表Add算子的第二个输
入tensor的名称，根据算子分析，
第二个输入名称为x2，所以此处配
置为x2，且需要跟算子原型定义中
的名称保持一致。

input1.dtype input1.dtype=float1
6,float16,float16,fl
oat16,float,float,flo
at,float,int32,int32,i
nt32,int32
input1.format=NC
HW,NC1HWC0,NH
WC,ND,NCHW,NC1
HWC0,NHWC,ND

定义输入tensor支持的数据类型与
数据排布格式。

根据算子分析，Add算子的输入数
据类型支持float16、float32与
int32三种；支持的数据排布格式有
NCHW,NC1HWC0,NHWC,ND。

说明
若算子输入支持多种规格，算子输入的
dtype与format需要一一对应、按对应
顺序进行配置，列出算子支持的所有
dtype与format的组合，中间以“,”分
隔。

input1.format

input1.shape all 定义输入tensor支持的形状。
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input1.paramType required 定义输入tensor的类型。

● dynamic：表示该输入是动态个
数，可能是1个，也可能是多
个。

● optional：表示该输入为可选，
可以有1个，也可以不存在。

● required：表示该输入有且仅有
1个。

Add算子的input1为固定输入1个，
此处配置为required。

output0.name y Add算子的输出tensor的名称，根
据算子分析，算子的输出名称为
y，所以此处配置为y，且需要跟算
子原型定义中的名称保持一致。

output0.dtype output0.dtype=floa
t16,float16,float16,f
loat16,float,float,fl
oat,float,int32,int3
2,int32,int32
output0.format=NC
HW,NC1HWC0,NH
WC,ND,NCHW,NC1
HWC0,NHWC,ND

定义输出tensor支持的数据类型与
数据排布格式。

根据算子分析，Add算子的输出数
据类型支持float16、float32与
int32三种；支持的数据排布格式有
NCHW,NC1HWC0,NHWC,ND。

说明
若算子输入支持多种规格，算子输入的
dtype与format需要一一对应、按对应
顺序进行配置，列出算子支持的所有
dtype与format的组合，中间以“,”分
隔。

output0.format

output0.shape all 定义输出tensor支持的形状。

output0.paramType required 定义输出tensor的类型。

● dynamic：表示该输出是动态个
数，可能是1个，也可能是多
个。

● optional：表示该输出为可选，
可以有1个，也可以不存在。

● required：表示该输出有且仅有
1个。

Add算子的output0为固定输出1
个，此处配置为required。

opFile.value add 算子代码实现文件的名称。

因为算子实现代码的名称符合算子
OpType到代码实现名称的转换规
则，参见步骤4，所以此字段可不
配置。
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opInterface.value add 算子实现文件中定义函数的名称。

因为算子定义函数的名称符合算子
OpType到算子定义函数名称的转
换规则，参见步骤4，所以此字段
可不配置。

 

7.5.4 算子适配插件实现（TensorFlow/Caffe/ONNX）
开发者需要进行算子适配插件的开发，实现将第三方框架（TensorFlow/Caffe/
ONNX）网络中的算子进行解析并映射成昇腾AI处理器中的算子。

TensorFlow/Caffe
MindStudio在“framework/tf_plugin/tensorflow_add_plugin.cc”（以TensorFlow为
例）文件已自动生成了Add算子的插件代码。

● 包含头文件。
//包含该头文件，可使用算子注册类相关，调用算子注册相关的接口，为Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/compiler/include/register/register.h文件
#include "register/register.h"

● 进行插件注册。
namespace domi{
REGISTER_CUSTOM_OP("Add")
    .FrameworkType(TENSORFLOW) 
    .OriginOpType({ge::AscendString("Add")})  
    .ParseParamsByOperatorFn(AutoMappingFn) 
    .ImplyType(ImplyType::TVM);    //需手动添加
}  

– REGISTER_CUSTOM_OP：算子注册到GE的算子类型，根据算子分析，算子
类型为“Add”。

– FrameworkType：TENSORFLOW，原始框架类型为TensorFlow。

– OriginOpType：算子在TensorFlow框架中的类型。

– ParseParamsByOperatorFn：用来注册解析模型的函数，使用
AutoMappingFn函数自动实现解析。

– ImplyType：指定算子的实现方式，ImplyType::TVM表示该算子是TBE算子。
需要手动添加。

ONNX
MindStudio在“framework/onnx_plugin/Add_plugin.cc”文件已自动生成了Add算子
的插件代码。

● 包含头文件。
//包含该头文件，可使用算子注册类相关，调用算子注册相关的接口，为Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/compiler/include/register/register.h文件
#include "register/register.h"

● 进行插件注册。
using namespace ge;    // 需手动添加
namespace domi {
// Onnx ParseParams
Status ParseParamAdd(const Message* op_src, ge::Operator& op_dest) {
    // To do: Implement the operator plugin by referring to the Onnx Operator Development Guide.
    return SUCCESS;
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}

// register op info to GE
REGISTER_CUSTOM_OP("Add")
    .FrameworkType(ONNX)   // Operator name with the original framework
    .OriginOpType("")      // Set the original frame type of the operator
    .ParseParamsByOperatorFn(ParseParamAdd)// Registering the callback function for parsing 
operator parameters 
    .ImplyType(ImplyType::TVM);    // 需手动添加
}  // namespace domi

– REGISTER_CUSTOM_OP：注册自定义算子，Add作为注册到GE中的算子类
型，可以任意命名但不能和已有的算子命名冲突，且需要与原型注册中的
OpType保持一致。

– FrameworkType：ONNX代表原始框架为ONNX。

– OriginOpType：算子在原始框架中的类型，需要用户填写。例如自定义算子
Add，对应ONNX算子库版本opset_version=11的原始框架类型为“ai.onnx::
11::Add”，此处填写为OriginOpType("ai.onnx::11::Add") 。

– ParseParamsByOperatorFn(ParseParamAdd)：用来注册解析算子属性的函
数，需要用户自定义实现回调函数ParseParamAdd。

回调函数ParseParamAdd的声明如下所示：
Status ParseParamAdd(const ge::Operator& op_src, ge::Operator& op_dest)

▪ ParseParamAdd：函数名称，用户自定义，需要保持唯一。

▪ op_src：ONNX框架定义的Operator类对象，包含ONNX模型中自定义
的算子属性信息，定义来源ONNX框架的原始模型文件。

▪ op_dest：CANN算子数据结构，保存算子信息。

– ImplyType：指定算子的实现方式，ImplyType::TVM表示该算子是TVM算
子，需要手动添加。

7.5.5 UT 测试

简介

MindStudio提供了基于gtest框架的新的UT测试方案，简化了开发者开发UT测试用例
的复杂度。

UT（Unit Test：单元测试）是开发人员进行单算子运行验证的手段之一，主要目的
是：

● 测试算子代码的正确性，验证输入输出结果与设计的一致性。

● UT侧重于保证算子程序能够跑通，选取的场景组合应能覆盖算子代码的所有分支
（一般来说覆盖率要达到100%），从而降低不同场景下算子代码的编译失败率。

说明

测试类的详细定义可参见Ascend-cann-toolkit安装目录/ascend-toolkit/latest/toolkit/
python/site-packages/op_test_frame/ut/op_ut.py文件。

前提条件

需完成自定义算子的开发，包括算子实现代码和算子原型定义，详情可参见算子代码
实现和算子原型定义。
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说明

● CentOS7.8 arm容器暂不支持算子实现代码的UT测试功能。

● Windows版本的MindStudio UT测试的算子工程目录中不要出现空格。

操作步骤

步骤1 创建UT测试用例。

1. 创建UT测试用例，有以下两种方式：

右键单击算子工程根目录，选择“New Cases > TBE UT Case”。

若已经存在了算子的UT测试用例，可以右键单击“testcases”目录，或者
“testcases > ut”目录，选择“New Cases > TBE UT Case”，创建UT测试用
例。

2. 在弹出的算子选择界面，选择需要创建UT测试用例的算子，单击OK，如下图所
示。

说明

若已存在此算子的UT测试用例，系统会提示“testcases/ut/ops_test/xx already exists. Do
you want to overwrite?”

可以选择“Overwrite”覆盖当前测试用例或者“Cancel”。

创建完成后，会在算子工程根目录下生成testcases文件夹，目录结构如下所示：
├── MyOperator            //工程根目录  
│   ├──  testcases                            
│   │   ├── libs                  // gtest框架，为第三方依赖，用户无需关注
│   │   ├──  ut                              
│   │   │   ├── ops_test
│   │   │   │   ├── add   
│   │   │   │   │   ├── CMakeLists.txt        //用于编译可执行文件
│   │   │   │   │   ├── test_add_impl.py      //算子实现代码的测试用例文件
│   │   │   │   │   ├── test_add_proto.cc    //算子原型定义代码的测试用例文件
│   │   │   │   ├── CMakeLists.txt             //用于编译可执行文件
│   │   │   │   ├── test_main.cc              //测试用例调用总入口
│   │   │   ├ CMakeLists.txt

步骤2 在中标麒麟和银河麒麟运行时，请在./testcases/ops_test/add/CMakeLists.txt文件中
添加加粗内容，其他操作系统请忽略此步骤。
add_definitions(-D_GLIBCXX_USE_CXX11_ABI=0)
set(CMAKE_CXX_FLAGS "-std=c++11")   
set(PROJECT_DIR "$ENV{PROJECT_PATH}")
set(GTEST_DIR ${PROJECT_DIR}/testcases/libs/gtest)
set(ADK_DIR "$ENV{ADK_PATH}")
set(ATC_DIR ${ADK_DIR}/atc)
set(OP_PROTO_SRC_DIR ${PROJECT_DIR}/op_proto)

message(STATUS "ATC_DIR=${ATC_DIR}")

enable_testing()

include_directories(
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        "${GTEST_DIR}/include"
        "${ATC_DIR}/include"
        "${OP_PROTO_SRC_DIR}"
        )

aux_source_directory(${OP_PROTO_SRC_DIR} OP_PROTO_SOURCE_SRCS)
file(GLOB OP_PROTO_TEST_FILES **proto.cc)

link_directories(
        "${ATC_DIR}/lib64"
        "${GTEST_DIR}"
        "/usr/local/gcc7.3.0/lib64/" 
)

set(CUSTOM_OBJECT_NAME "add_proto_test")

add_executable(${CUSTOM_OBJECT_NAME}
        ${PROJECT_DIR}/testcases/ut/ops_test/test_main.cc ${OP_PROTO_SOURCE_SRCS} $
{OP_PROTO_TEST_FILES})

target_link_libraries(${CUSTOM_OBJECT_NAME} gtest c_sec alog pthread error_manager graph register)

说明

UT测试需要gcc版本为7.5.0及以上，若gcc版本不满足要求，请升级gcc版本。

步骤3 编写算子实现代码的UT Python测试用例。

在“testcases/ut/ops_test/add/test_add_impl.py”文件中，编写算子实现代码的UT
Python测试用例，计算出算子执行结果，并取回结果和预期结果进行比较，来测试算
子逻辑的正确性。

import ...
from op_test_frame.ut import BroadcastOpUT   # 导入UT测试类，可根据算子类型选择使用哪个测试类

ut_case = BroadcastOpUT("add")      # 实例化UT测试用例，ut_case为UT测试框架关键字，不可修改；add为算
子的Type

def calc_expect_func(input_x, input_y, output_z):    # 自定义实现生成期望数据的函数
    res = input_x["value"] + input_y["value"]
    return [res, ]    # 返回期望数据

# 添加测试用例
ut_case.add_precision_case("all", {
    "params": [{"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (32,), "shape": (32,),
                "param_type": "input"},
               {"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (32,), "shape": (32,),
                "param_type": "input"},
               {"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (32,), "shape": (32,),
                "param_type": "output"}],
    "calc_expect_func": calc_expect_func
})
# 若定义多个用例，定义多个ut_case.add_precision_case函数
ut_case.add_precision_case("all", {
    "params": [{"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (16,2), "shape": (16,2),
                "param_type": "input"},
               {"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (16,2), "shape": (16,2),
                "param_type": "input"},
               {"dtype": "float16", "format": "ND", "ori_format": "ND", "ori_shape": (16,2), "shape": (16,2),
                "param_type": "output"}],
    "calc_expect_func": calc_expect_func
})

说明

目前Windows版本不支持导入te或者tbe模块。故在编写算子实现代码的UT Python测试用例时
不支持导入算子实现文件及涉及te或tbe模块的文件。
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1. 首先导入UT测试类，用户可根据算子类型自行选择使用哪个UT测试类，详细可参
见UT测试接口参考。

2. 实例化测试用例，OpUT的使用方法可参见OpUT测试类定义。

3. 用户自定义实现生成期望数据的函数。

4. 添加测试用例。

测试用例params中字段和字段取值范围需根据算子实现文件入口参数确定。输入
tensor中的"ori_shape"和"ori_format"字段为可选字段，但若使用参数校验修饰器
检验参数"ori_shape"和"ori_format"字段必选。

可参见UT测试接口参考查看每个测试类接口的使用方法。

若要与期望数据进行结果的比对，请使用add_precision_case接口。

步骤4 编写算子原型定义的UT C++测试用例。

在“testcases/ut/ops_test/add/test_add_proto.cc”文件中，编写算子原型定义的UT
C++测试用例，用于定义算子实例、更新算子输入输出并调用InferShapeAndType函
数， 后验证InferShapeAndType函数执行过程及结果的正确性。

1. 导入gtest测试框架和算子IR定义的头文件。

UT的C++用例采用的是gtest框架，所以需要导入gtest测试框架；算子原型定义在
原型定义头文件中，所以需要导入原型定义的*.h文件。
//导入gtest框架
#include <gtest/gtest.h>
//导入基础的vector类库
#include <vector>
//导入算子的IR定义头文件
#include "add.h"

2. 定义测试类。

UT的C++用例采用的是gtest框架，所以需要定义一个类来继承gtest的测试类。
#include <gtest/gtest.h>
#include <vector>
#include "add.h"

class AddTest : public testing::Test {
protected:
    static void SetUpTestCase() {
        std::cout << "add test SetUp" << std::endl;
}

    static void TearDownTestCase() {
        std::cout << "add test TearDown" << std::endl;
    }
};

测试类的名称可自定义，以“Test”为后 。

3. 编写测试用例。

每一个场景写一个测试用例函数，该用例中需要构造算子实例，包括算子名称、
shape、数据类型。然后调用InferShapeAndType函数，并将推导出的shape、
dtype与预期结果进行对比。

示例如下：
TEST_F(AddTest, add_test_case_1) {
    // 定义算子实例及输入shape和type，以TensorDesc实例承载
    ge::op::Add add_op;  //Add为算子的Type，需要与原型定义的REG_OP(OpType)中的OpType保持一致
    ge::TensorDesc tensorDesc;
    ge::Shape shape({2, 3, 4});
    tensorDesc.SetDataType(ge::DT_FLOAT16);
    tensorDesc.SetShape(shape);
    tensorDesc.SetOriginShape(shape);
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    // 更新算子输入，输入的名称需要与原型定义*.h文件中的名称保持一致，例如:x1与x2分别为Add算子的
两个输入
    add_op.UpdateInputDesc("x1", tensorDesc);
    add_op.UpdateInputDesc("x2", tensorDesc);
    // 调用InferShapeAndType函数，InferShapeAndType()接口为固定接口，用例执行时会自动调用算子原
型定义中的shape推导函数
    auto ret = add_op.InferShapeAndType();
    // 验证调用过程是否成功
    EXPECT_EQ(ret, ge::GRAPH_SUCCESS);  

    // 获取算子输出并比较shape和type，算子输出的名字需要与原型定义*.h文件中的名称保持一致，例如:
算子的输出为y
    auto output_desc = add_op.GetOutputDesc("y");
    EXPECT_EQ(output_desc.GetDataType(), ge::DT_FLOAT16);
    std::vector<int64_t> expected_output_shape = {2, 3, 4};
    EXPECT_EQ(output_desc.GetShape().GetDims(), expected_output_shape);
}

若不同输入的shape不同，请自行定义多个TensorDesc对象进行设置，例如：
    ge::op::Operator1 operator1_op;  //Operator1为算子的Type
    ge::TensorDesc tensorDesc1;
    ge::TensorDesc tensorDesc2;
    ge::Shape shape1({2, 3, 4});
    ge::Shape shape2({3, 4, 5});
    tensorDesc1.SetDataType(ge::DT_FLOAT16);
    tensorDesc1.SetShape(shape1);
    tensorDesc1.SetOriginShape(shape1);
    tensorDesc2.SetDataType(ge::DT_FLOAT16);
    tensorDesc2.SetShape(shape2);
    tensorDesc2.SetOriginShape(shape2);

    // 更新算子输入
    operator1_op.UpdateInputDesc("x1", tensorDesc1);
    operator1_op.UpdateInputDesc("x2", tensorDesc2);

步骤5 运行算子实现文件的UT测试用例。

开发人员可以执行当前工程中所有算子的UT测试用例，也可以执行单个算子的UT测试
用例。

● 右键单击“testcases/ut/ops_test”文件夹，选择“Run Tbe Operator‘All’UT
Impl with coverage”，执行整个文件夹下算子实现代码的测试用例。

● 右键单击“testcases/ut/ops_test/算子名称”文件夹，选择“Run Tbe
Operator‘算子名称’UT Impl with coverage”，执行单个算子实现代码的测试
用例。

第一次运行时会弹出运行配置页面，请参考配置，然后单击“Run”。后续如需
修改运行配置，请参考修改运行配置。

表 7-7 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择ut_impl。
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参数 说明

Compute Unit 选择计算单元。

– AI Core/Vector Core
– AI CPU
选择不同的计算单元可以实现AI Core/Vector Core
和AI CPU UT测试配置界面的切换。

SoC Version 下拉选择当前版本的昇腾AI处理器类型。

Target 运行环境。

– Simulator_Function：功能仿真环境。

– Simulator_Performance：性能仿真环境。该功
能仅支持Ascend 710系列AI处理器。

– Simulator_TMModel：快速展示算子执行的调
度流水线，不进行实际算子计算。该功能仅支持
Ascend 310和Ascend 910系列AI处理器。

Enable Advisor 开启专家系统。

当Target为Simulator_TMModel时，可以对单测试
用例性能进行专家系统分析。专家系统请参见操作
步骤（算子工程入口）。

Operator Name 选择运行的测试用例。

– all表示运行所有用例。

– 其他表示运行某个算子下的测试用例。

CANN Machine CANN工具所在设备的deployment信息。

说明
仅支持Windows操作系统。

Case Names 勾选需要运行的测试用例，即算子实现代码的UT
Python测试用例。支持全选和全不选所有测试用
例。

 

● 查看运行结果。

a. 运行完成后，通过界面下方的“Run”日志打印窗口查看运行结果。

b. 若配置算子期望函数"calc_expect_func": calc_expect_func，运行成功后，日
志会打印对比结果。

▪ Error count：误差大于绝对容忍率（atol）的数量。

▪ Max atol error count：误差大于期望值 * 大容忍率（max_atol）的数
量。

▪ Threshold count (rtol * data_size)：允许超过自定义精度的 大错误
(相对容忍率（rtol） * tensor元素数量)数量。

测试结果：

▪ Max atol error count>0则UT测试失败。
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▪ Error count>Threshold count则UT测试失败。

c. 在“Run”窗口中单击index.html的URL（URL中的localhost为MindStudio安
装服务器的IP，建议直接单击打开），查看UT测试用例的覆盖率结果，如图
7-12所示。

说明

查看UT测试用例运行结果需要使用浏览器，如果未安装浏览器，请用户自行安装。

图 7-12 查看 UT 用例覆盖率结果

表示算子的UT用例覆盖率为100%，UT验证通过。

如果出现"Page'http://***.html'requested without authorization, you can
copy URL and open it in browser to trust it."提示，请参考配置不受信任的
网址访问浏览器解决。

d. 在html页面中单击对应算子，进入UT用例覆盖率详情页面，如图7-13所示，
通过绿色和红色标签区分是否覆盖。

图 7-13 UT 覆盖率详情页面

e. 运行完成后，生成结果如下所示：

▪ 如果在配置运行信息选择的“Target”为“Simulator_Performance”，
可以在Profiling窗口查看执行流水线，如下图所示。
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Parallel Analysis：并行度视图。并行度视图展示单算子运行中各个指令
执行的并行度情况，横轴为时间（Tick，时钟周期），纵轴为各指令单
元，鼠标移动到时间块上，可以显示单条指令的消耗时间以及相关指
令。

说明

○ “Start”和“End”表示数据展示的时间范围。“End”为Cycle数，此数值
越大，代表运行时间越长。图中数据展示的时间范围可通过调整右上方的滑
块进行变更。

○ 右键单击时间块，弹出跳转到Profiling指令流视图和TBE、CCE、Assembly
源代码菜单。

▪ 如果在配置运行信息选择的“Target”为“Simulator_TMModel”，可
以查看执行流水线，如下图所示。

若用户使用TIK方式实现算子开发，MindStudioUT测试支持流线图到TIK
代码和CCE代码的跳转，帮助用户快速定位到流水图中对应的代码位
置，配置详情请参见设置代码跳转功能。

说明

在芯片进行运算前，vector、cube、MTE1、MTE2、MTE3等单元会做初始化操
作，对应在timeline显示上会出现数据还未搬运，各个单元就产生流水数据。

▪ 如果在配置运行信息勾选了“Enable Advisor”，可以查看专家建议，

详情请参见分析结果展示。可以通过点击 按钮，显示和隐藏专家建
议。

步骤6 运行算子原型定义的UT测试用例。

开发人员可以执行当前工程中所有算子的UT测试用例，也可以执行单个算子的UT测试
用例。

● 右键单击“testcases/ut/ops_test”文件夹，选择“Run Tbe Operator‘All’UT
Proto”，执行整个文件夹下算子原型定义代码的测试用例。

● 右键单击“testcases/ut/ops_test/算子名称”文件夹，选择“Run Tbe
Operator‘算子名称’UT Proto”，执行单个算子原型定义代码的测试用例。

第一次运行时会弹出运行配置页面，请参考配置，然后单击“Run”。后续如需
修改运行配置，请参考修改运行配置。

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 235



表 7-8 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择ut_proto。

Compute Unit 选择计算单元

– AI Core/Vector Core
– AI CPU
选择不同的计算单元可以实现AI Core/Vector Core
和AI CPU UT测试配置界面的切换。

Operator Name 选择运行的测试用例。

– all表示运行所有用例。

– 其他表示运行某个算子下的测试用例。

Case Names 勾选需要运行的测试用例，即TEST_F中定义的用
例。支持全选和全不选所有测试用例。

 

运行完成后，通过界面下方的日志打印窗口，查看运行结果。结果中展示此次运行用
例、成功用例和失败用例的数量，如下图所示。

----结束

7.5.6 算子工程编译

简介

将自定义算子工程编译生成自定义算子安装包custom_opp_Linux_Arch.run。

具体编译内容为：将算子插件实现文件、算子原型定义文件、算子信息定义文件分别
编译成算子插件、算子原型库、算子信息库。编译过程示意如图7-14。
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图 7-14 编译过程

说明

Windows操作系统不支持本地编译。

编译操作

步骤1 在MindStudio工程界面，选中算子工程。

步骤2 单击顶部菜单栏的“ Build > Edit Build Configuration...”。

步骤3 进入编译配置页面。单击 添加新增配置，默认添加编译类型
“Release(default)”，请参考表7-9进行编译配置。

图 7-15 编译配置页面
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表 7-9 编译配置参数说明

参数 说明

Name 配置名称自定义，默认为Release。

Build type 配置类型，可选，默认为Release。

Toolchain 工具链配置器，根据已安装的CANN包预置架构
一致的自定义Toolchain，支持本地和远程编译功
能。

可单击“Manage toolchains……”自定义配置
Toolchain，配置详情请参见CMake编译配置。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Release”。

Build directory 编译目录相对路径，该路径是相对于工程目录的
路径。

Build options 编译加速选项。

Environment variables 环境变量配置：支持编译前配置环境变量。

可直接手动配置或单击 符号，在弹出窗中配
置管理。

 

若选用远程Toolchain，将默认添加一个Deployment，用户需要配置环境变量。

在Environment Variables输入框中输入ASCEND_TENSOR_COMPILER_INCLUDE环境
变量。
ASCEND_TENSOR_COMPILER_INCLUDE=Ascend-cann-toolkit安装目录/ascend-toolkit/latest/include

步骤4 单击 或“Build>Build Project”进行工程编译。

步骤5 在界面 下方的窗口查看编译结果，并在算子工程的cmake-build目录下生成自定义算
子安装包custom_opp_Linux_Arch.run。

其中Arch的取值根据安装的CANN包和Toolchain的信息获取。

----结束

7.5.7 算子部署（本地）

须知

● 执行ST测试操作时，会自动编译生成自定义算子安装包并将其部署到开发环境的
opp目录下，若用户已参见ST测试进行了算子的ST测试，则此步骤可跳过；若需要
单独部署自定义算子安装包，可参见此章节进行部署。

● 进行算子部署前，需要参见算子工程编译生成自定义算子安装包
custom_opp_Linux_Arch.run。

● Windows操作系统不支持算子本地部署。
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步骤1 在MindStudio工程界面菜单栏依次选择“Ascend > Operator Deployment”。弹出算
子部署界面。

步骤2 在弹出的界面中选择“Operator Deploy Locally”，在“Operator Package”中选择
指定的算子库OPP包目录并单击“Operator deploy”。

在下方Output页签出现如下信息，代表自定义算子部署成功。

自定义算子包安装成功后，会将自定义算子部署在Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/opp目录下或指定的算子库OPP目录下的对应文件夹中。

目录结构示例如下所示：

├── opp      //算子库目录
│   ├── op_impl
│       ├── built-in        
│       ├── custom
│           ├── ai_core
│               ├── tbe
│                   ├── config
│                       ├── soc_version     //昇腾AI处理器版本
│                           ├── aic-soc_version-ops-info.json     //自定义算子信息库文件
│                   ├── custom_impl               //自定义算子实现代码文件
│                       ├── add.py
│           ├── vector_core   //此目录预留，无需关注
│   ├── framework
│       ├── built-in
│       ├── custom
│           ├── caffe      
│           ├── tensorflow          //存放tensorflow框架的自定义算子插件库
│               ├── libcust_tf_parsers.so
│               ├── npu_supported_ops.json   //Ascend 910场景下使用的文件，Ascend 310场景下无需关注
│   ├── op_proto
│       ├── built-in
│       ├── custom
│           ├── libcust_op_proto.so    //自定义算子原型库文件

----结束

7.5.8 算子部署（远程）

将自定义算子安装包custom_opp_Linux_Arch.run部署到昇腾AI处理器所在硬件环境
的算子库中，为后续算子在网络中运行构造必要条件。

步骤1 在MindStudio工程界面，选中算子工程。

步骤2 单击顶部菜单栏的“Ascend > Operator Deployment”，进入算子打包部署界面。

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 239



请在“Operator Deploy Remotely > Deployment”选择配置项，配置
“Deployment”的方法请参见Deployment。

步骤3 配置环境变量。

两种方式如下所示：

● 在昇腾AI处理器所在硬件环境Host侧配置环境变量。

MindStudio使用Host侧的运行用户在Host侧进行算子部署，进行算子部署执行
前，需要在Host侧进行如下环境变量的配置。

a. 以运行用户在Host侧的$HOME/.bashrc文件中配置如下环境变量。
export ASCEND_OPP_PATH=Ascend-cann-toolkit安装目录/ascend-toolkit/latest/opp

Ascend-cann-toolkit安装目录/ascend-toolkit/latest为OPP组件（算子
库）的安装路径，请根据实际情况配置。

b. 执行命令使环境变量生效。

source ~/.bashrc
● 在“Environment Variables”中添加环境变量。

可以在“Environment Variables”中直接输入ASCEND_OPP_PATH=Ascend-
cann-toolkit安装目录/ascend-toolkit/latest/opp。

Ascend-cann-toolkit安装目录/ascend-toolkit/latest为OPP组件（算子库）的
安装路径，请根据实际情况配置。

也可以点击文本框后的图标，在弹出的对话框中填写。

– 在Name中输入环境变量名称：ASCEND_OPP_PATH。

– 在Value中输入环境变量值：Ascend-cann-toolkit安装目录/ascend-
toolkit/latest/opp。

步骤4 选择指定的算子库OPP包。

在“Operator Package”中选择指定的算子库OPP包目录。

步骤5 选择算子部署的目标服务器，单击“Operator deploy”。

步骤6 算子部署过程即算子工程编译生成的自定义算子安装包的安装过程，部署完成后，算
子被部署在Host侧算子库OPP对应文件夹中，若不选择指定的算子库OPP包则默认路
径为/usr/local/Ascend/opp/。

图 7-16 算子部署日志打印

Host侧自定义算子部署完成后目录结构示例如下所示：

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 240



├── opp      //算子库目录
│   ├── op_impl
│       ├── built-in        
│       ├── custom
│           ├── ai_core
│               ├── tbe
│                   ├── config
│                       ├── aic_ops_info.json     //自定义算子信息库文件
│                   ├── custom_impl               //自定义算子实现代码文件
│                       ├── add.py
│           ├── vector_core   //此目录预留，无需关注
│   ├── framework
│       ├── built-in
│       ├── custom
│           ├── caffe      
│           ├── tensorflow          //存放tensorflow框架的自定义算子插件库
│               ├── libcust_tf_parsers.so
│   ├── op_proto
│       ├── built-in
│       ├── custom
│           ├── libcust_op_proto.so    //自定义算子原型库文件

----结束

7.5.9 PyTorch 适配

说明

MindStudio暂不支持PyTorch算子适配，在完成TBE算子开发后，Pytorch适配请参见《PyTorch
1.5.0 算子开发指南》或《PyTorch 1.8.1 算子开发指南》。

PyTorch适配请读者根据《PyTorch 1.5.0 算子开发指南》或《PyTorch 1.8.1 算子开发
指南》完成以下操作。

● 安装PyTorch依赖环境

● 编译和安装PyTorch框架

● PyTorch框架下适配TBE算子

7.5.10 ST 测试

概述

MindStudio提供了新的ST（System Test）测试框架，可以自动生成测试用例，在真实
的硬件环境中，验证算子功能的正确性和计算结果准确性，并生成运行测试报告，包
括：

● 基于算子信息库生成算子测试用例定义文件。

● 基于算子测试用例定义文件生成不同shape、dtype的测试数据和基于AscendCL的
测试用例。

● 编译算子工程并将算子部署到算子库， 后在硬件环境中执行测试用例，验证算
子运行的正确性。

● 自动生成运行报表（st_report.json）功能，报表记录了测试用例信息及各阶段运
行情况。

● 根据用户定义并配置的算子期望数据生成函数，回显期望算子输出和实际算子输
出的对比测试结果，验证计算结果的准确性。
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前提条件
● 完成自定义算子的开发，请参见算子代码实现、算子原型定义、算子信息库定

义、算子适配插件实现（TensorFlow/Caffe/ONNX）。

● MindStudio已连接硬件设备。

生成 ST 测试用例定义文件

步骤1 创建ST测试用例。

有以下三种方式：

● 右键单击算子工程根目录，选择“New Cases > ST Case”。

● 右键单击算子信息定义文件：{工程名} /tbe /op_info_cfg_ai_core/{SoC
version} /xx.ini，选择“New Cases > ST Case”。

● 若已经存在了对应算子的ST Case，可以右键单击“testcases”目录，或者
“testcases > st”目录，选择“New Cases > ST Case”，追加ST测试用例。

步骤2 在弹出的“Create ST Cases for an Operator”界面中选择需要创建ST测试用例的算
子。

如下图所示。

Operator Name：下拉选择算子名称。

SoC Version：下拉选择昇腾AI处理器的类型。

● 若不勾选“Import operator info from a model”，单击“OK”后，会生成
shape为空的算子测试用例定义文件，

用户需要进行shape信息的配置，用于生成测试数据及测试用例，也可以根据需要
进行其他字段的配置，每个字段的详细要求可参见TBE算子测试用例定义文件参
数解释。

● 若用户勾选“Import operator info from a model”，选择包含算子的模型文件
（如Tensorflow的模型文件*.pb）后，界面会显示获取到的模型文件的首层shape
信息。

用户也可以在“Input Nodes Shape”中修改首层输入的shape信息。

单击“OK”后，工具会自动根据首层shape信息dump出选择算子的shape信息，
生成对应的算子测试用例定义文件。

此文件用于生成测试数据及测试用例，可以参见TBE算子测试用例定义文件参数
解释进行相关字段的修改。

说明

该功能需要在运行环境中安装第三方框架（PyTorch使用该功能需要在运行环境中安装
onnx库）。
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步骤3 若要将算子与标杆数据对比，需要定义并配置算子期望数据生成函数。

1. 自定义实现算子期望数据生成函数。

算子期望数据生成函数需要开发者使用Python语言自行实现，用于在CPU上运行
生成标杆数据。例如，开发者可以使用numpy等接口实现与自定义算子功能相同
的函数。标杆数据用来与自定义算子生成数据进行对比，根据对比结果确定自定
义算子精度。算子期望数据生成函数用python语言实现，在一个python文件中可
以实现多个算子期望数据生成函数。该函数的输入、输出、属性与自定义算子的
输入、输出、属性的Format、Type、Shape保持一致。

2. 配置算子测试用例定义文件。

在算子测试用例文件中配置算子期望数据生成函数。有两种场景，分别为
“Design”视图和“Text”视图下进行配置。

– 若在“Design”视图下，配置方法为在“Expected Result Verification”下的
“Script Path”中选择算子期望数据生成函数的python文件所在路径。在
“Script Function”中输入算子期望数据生成函数的函数名。

说明

“Script Function”中可以输入算子期望数据生成函数的函数名，也可以为空。

▪ 当输入算子期望数据生成函数的函数名时，ST测试时会使用该函数名对应的函数
生成标杆数据。

▪ 当输入为空时，会自动匹配Script Path路径下的python文件中与自定义算子同名
的函数，用于ST测试时生成标杆数据。若无同名函数，则会提示匹配失败。

– 若在Text视图下，增加“calc_expect_func_file”参数，其值为算子期望数据
生成函数对应的文件路径及算子函数名，如：
"calc_expect_func_file": "/home/teste/test_*.py:function",   //配置期望算子文件

其中，/home/teste/test_*.py为算子期望数据生成函数的实现文件，function
为对应的函数名称。算子期望数据生成函数文件路径和函数名称用冒号隔
开。

示例：test_add.py文件为add算子期望数据生成文件，函数实现如下：
def calc_expect_func(input_x, input_y, out):    
    res = input_x["value"] + input_y["value"]
    return [res, ]

说明

用户需根据开发的自定义算子完成算子期望数据生成函数。测试用例定义文件中的全
部Input、Output、Attr的name作为算子期望数据生成函数的输入参数。

步骤4 若要使用python脚本批量生成测试用例，采用fuzz方式生成测试用例。

1. 实现fuzz测试参数生成脚本。该脚本可以自动生成测试用例定义文件中
Input[xx]、Output[xx]、Attr内除了name的任何参数。

下面以随机生成shape和value参数为例，创建一个fuzz_shape.py供用户参考。该
示例会随机生成一个1-4维，每个维度取值范围在1-64的shape参数，用于ST测
试。
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a. 导入脚本所需依赖。
import numpy as np

b. 实现fuzz_branch()方法，若用户自定义随机生成待测试参数的方法名，需要
在算子测试用例定义文件中Fuzz Function字段配置自定义方法。
def fuzz_branch():
    # 生成测试参数shape值
    dim = random.randint(1, 4)
    x_shape_0 = random.randint(1, 64)
    x_shape_1 = random.randint(1, 64)
    x_shape_2 = random.randint(1, 64)
    x_shape_3 = random.randint(1, 64)
    if dim == 1:
        shape = [x_shape_0]
    if dim == 2:
        shape = [x_shape_0, x_shape_1]
    if dim == 3:
        shape = [x_shape_0, x_shape_1, x_shape_2]
    if dim == 4:
        shape = [x_shape_0, x_shape_1, x_shape_2, x_shape_3]
    # 根据shape随机生成x1、x2的value
    fuzz_value_x1 = np.random.randint(1, 10, size=shape)
    fuzz_value_x2 = np.random.randint(1, 10, size=shape)

    # 用字典数据结构返回shape值，将生成的shape值返回给input_desc的x1、x2和output_desc的y
的shape参数。其中x1、x2、y测试用例定义文件输入、输出的name。
    return {"input_desc": {"x1": {"shape": shape,"value": fuzz_value_x1}, 
                           "x2": {"shape": shape,"value": fuzz_value_x2}},
            "output_desc": {"y": {"shape": shape}}}

▪ 该方法生成测试用例定义文件Input[xx]、Output[xx]、Attr内除了name
的任何参数参数，用户可自定义实现参数的生成方法，以满足算子测试
的需求。

▪ 该方法的返回值为字典格式，将该方法生成的参数值以字典的方式赋值
给算子进行st测试。返回的字典结构与测试用例定义文件中参数结构相
同。

2. 将算子测试用例定义文件中需要随机生成的字段的值设为"fuzz"。

此时显示K-Level Test Cases配置项，包含Fuzz Script Path和Fuzz Case Num选
项。

3. 在Fuzz Script Path中输入fuzz生成测试参数的脚本的相对路径或绝对路径，如：
“fuzz_shape.py”。

4. 在Fuzz Case Num中输入利用fuzz脚本生成多少条测试用例，如：2000。

5. （可选）在Fuzz Function中配置自定义的随机生成待测试参数的方法，若不配置
默认使用 fuzz_branch方法。

6. fuzz用例不采取正交生成，因此在该场景下算子测试用例定义文件中各字段的取
值需唯一。

步骤5 修改Case信息后，单击“Save”，修改会保存到算子测试用例定义文件。

算子测试用例定义文件存储目录为算子工程根目录下的“testcases/st/OpType/{SoC
Version}”文件夹下，命名为OpType_case_timestamp.json

说明

请勿更改算子测试用例定义文件命名格式和将其他文件的以该命名格式保存在算子工程根目录下
的“testcases/st/OpType/{SoC Version}”文件夹下。否则会导致文件解析错误。

----结束
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运行 ST 测试用例

步骤1 在算子工程根目录下的“testcases> st > add > {SoC Version} ”文件夹下，右键单击
生成ST测试用例定义文件中生成的ST测试用例定义文件，选择 “Run ST Case
'xxx.json'”。

表 7-10 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择st_cases 。

Execute Mode ● Remote Execute：远程执行测试

● Local Execute：本地执行测试

说明
Local Execute不支持Windows操作系统。

Deployment 当Execute Mode选择Remote Execute时，
deployment功能，详细请参见Deployment，可以将
指定项目中的文件、文件夹同步到远程指定机器的指
定目录。

CANN Machine CANN工具所在设备deployment信息。

说明
该参数仅支持Windows操作系统。

Environment Variables ● 在文本框中添加环境变量
PATH_1=路径1;PATH_2=路径2
多个环境变量用英文分号隔开。

● 也可以点击 ，在弹出的对话框中填写。

– 在Name中输入环境变量名称：PATH_1。

– 在Value中输入环境变量值：路径1。

勾选Instead system environment variables可以显示
系统环境变量。

Operator Name 选择需要运行的算子。

SoC Version 选择处理器版本。

Executable File Name 下拉选择需要执行的测试用例定义文件。

若对AI CPU算子进行ST测试，测试用例文件前有（AI
CPU）标识。

Toolchain 工具链配置器，根据已安装的CANN包预置架构一致
的自定义Toolchain，支持本地和远程编译功能。

可单击“Manage toolchains……”自定义配置
Toolchain，配置详情请参见CMake编译配置。
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参数 说明

Case Names 选择运行的Case Name。

默认勾选所有用例，可以取消勾选部分不需要运行的
用例。

Enable Auto
Build&Deploy

选择是否在ST运行过程中执行编译和部署。

默认开启。

Advanced Options 高级选项。

ATC Log Level 选择ATC 日志级别。

● INFO
● DEBUG
● WARNING
● ERROR
● NULL

Precision Mode 精度模式。

● force_fp16
● allow_mix_precision
● allow_fp32_to_fp16
● must_keep_origin_dtype

Device Id 设备ID，设置运行ST测试的芯片ID。用户根据使用的
AI芯片ID填写。

Error Threshold 配置自定义精度标准，取值为含两个元素的列表：
[val1，val2]
● val1：算子输出结果与标杆数据误差阈值，若误差

大于该值则记为误差数据。

● val2：误差数据在全部数据占比阈值。若误差数据
在全部数据占比小于该值，则精度达标，否则精度
不达标。

取值范围为[0.0,1.0]。
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参数 说明

Enable System Profier 使能profiling，获取算子在昇腾AI处理器上的性能数
据。该功能需要将运行环境中的msprof工具所在路径
配置到PATH环境变量中，msprof工具所在路径为：
toolkit工具路径下的toolkit/tools/profiler/bin/
msprof。
该选项默认关闭，打开情况下会出现下拉框，可下拉
选择AI Core性能指标采集项，采集项如下：

● PipeUtilization（默认）

● ArithmeticUtilization
● Memory
● MemoryL0
● MemoryUB
● ResourceConflictRatio

 

说明

● ST测试支持板端日志级别设置及查询，具体操作请参见日志管理。

● 在Windows操作系统中不支持Local Execute功能。

步骤2 Host侧运行用户设置。

Host侧运行用户需在deployment中添加，并且该用户必须为HwHiAiUser属组。配置
deployment请参见Deployment。

步骤3 在运行环境上有两种方式配置相关组件的环境变量。

● 在远程设备上配置环境变量。

– 针对Ascend EP，需要在硬件设备的Host侧配置安装组件路径的环境变量。

以Host侧运行用户在~/.bashrc文件中配置runtime或compiler、driver组件的
安装路径。

i. 打开运行用户下的.bashrc文件。

vi ~/.bashrc
ii. 在文件 后添加如下信息。

export ASCEND_DRIVER_PATH=/usr/local/Ascend/driver
export ASCEND_HOME=/usr/local/Ascend//ascend-toolkit/latest
若远程设备为推理环境：

export LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64:$
{ASCEND_HOME}/lib64:$LD_LIBRARY_PATH
若远程设备为训练环境：

export
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64/driver:$
{ASCEND_DRIVER_PATH}/lib64/common:${ASCEND_HOME}/
lib64:$LD_LIBRARY_PATH
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若已存在如上所述环境变量，请确认为当前运行环境实际安装组件所在
路径。

<target architecture>为操作系统架构，例如：x86_64-linux或arm64-
linux。

iii. 保存退出。

:wq
iv. 使环境变量生效。

source ~/.bashrc

● 在Environment Variables中添加环境变量。

在步骤1中运行的窗口中Environment Variables参数进行环境变量配置。

– 在文本框中添加环境变量
ASCEND_DRIVER_PATH=/usr/local/Ascend/driver;
ASCEND_HOME=/usr/local/Ascend/ascend-toolkit/latest;
若远程设备为推理环境：
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64:${ASCEND_HOME}/
lib64:$LD_LIBRARY_PATH;
若远程设备为训练环境：
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64/driver:${ASCEND_DRIVER_PATH}/lib64/
common:${ASCEND_HOME}/lib64:$LD_LIBRARY_PATH;

请根据driver和CANN的实际安装路径配置，远程操作系统的使用架构修改环
境变量内容。

– 点击 ，在弹出的对话框中填写。

分别在Name中输入环境变量名称，在Value中输入环境变量值。

步骤4 单击“Run”。

MindStudio会根据算子测试用例定义文件在算子根目录“testcases/st/out/<operator
name>”下生成测试数据和测试代码，并编译出可执行文件，在指定的硬件设备上执
行测试用例。运行成功后会打印对比报告及保存运行信息。

● 将执行结果和与标杆数据对比报告打印到Output窗口中。

– 总体信息

total_count：对比元素总数量。

max_diff_thd： 大误差阈值，若存在预期结果与真实结果误差超出该阈
值，直接判定该测试用例失败。

– 详细信息

Index（对比元素序号）、ExpectOut（期望输出）、RealOut（实际输
出）、FpDiff（精度误差）、RateDiff（误差比）。

– 误差容忍信息及结果

预期结果与真实结果误差小于DiffThd（误差阈值）的数量占比高于PctThd
（准确率阈值）则Result（比对结果）为通过，否则失败，同时会打印出
PctRlt（实际准确率）。

– system_profiler信息及结果

在步骤1开启“Enable System Profier”开关，配置采集项后才会以表格形式
输出system_profiler信息及结果。具体字段含义请参见《Profiling工具使用
指南》。

● 在算子根目录“testcases/st/out/<operator name>”下生成st_report.json文件。
st_report.json文件信息含义请参见表7-11。
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表 7-11 st_report.json 报表主要字段及含义

字段 说明

run_cmd - - 命令行命令。

report_list - - 报告列表，该列表中可包含多个
测试用例的报告。

trace_detail - 运行细节。

st_case_info 测试信息，包含如下内容。

– expect_data_path：期望计
算结果路径。

– case_name：测试用例名称

– input_data_path：输入数据
路径

– planned_output_data_paths
：实际计算结果输出路径

– op_params：算子参数信息

stage_result 运行各阶段结果信息，包含如下
内容。

– status：阶段运行状态，表示
运行成功或者失败

– result：输出结果

– stage_name：阶段名称

– cmd：运行命令

case_name - 测试名称。

status - 测试结果状态，表示运行成功或
者失败。

expect - 期望的测试结果状态，表示期望
运行成功或者失败。

summary - - 统计测试用例的结果状态与期望
结果状态对比的结果。

test case
count

- 测试用例个数。

success
count

- 测试用例的结果状态与期望结果
状态一致的个数。

failed count - 测试用例的结果状态与期望结果
状态不一致的个数。

 

----结束
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7.6 AI CPU 算子开发
AI CPU算子开发流程将以算子开发样例工程中“reshape_cust”算子为例，供开发者
参考。

7.6.1 算子原型定义
进入算子工程的“op_proto”目录，编写IR实现文件“reshape_cust.h”和
“reshape_cust.cc”，将算子注册到算子原型库中。网络运行时，GE会调用算子原型
库的校验接口进行基本参数的校验，校验通过后，会根据原型库中的推导函数推导每
个节点的输出shape与dtype，进行输出tensor的静态内存的分配。

reshape_cust.h 实现

MindStudio已在reshape_cust.h文件中生成了算子注册的代码模板文件，开发者可根
据需要进行修改，ReshapeCust算子的原型定义如下所示：

#ifndef GE_OP_INTERP_RESHAPE_CUST_H
#define GE_OP_INTERP_RESHAPE_CUST_H

#include "graph/operator_reg.h"
namespace ge {
REG_OP(ReshapeCust)
    .INPUT(tensor, TensorType({DT_BOOL, DT_FLOAT16, DT_FLOAT, DT_INT8, DT_INT32, DT_UINT32, 
DT_UINT8,
                          DT_INT64, DT_UINT64, DT_INT16, DT_UINT16, DT_DOUBLE, DT_COMPLEX64,
                          DT_COMPLEX128, DT_QINT8, DT_QUINT8, DT_QINT16, DT_QUINT16, DT_QINT32}))
    .INPUT(shape, TensorType({DT_INT32, DT_INT64}))
    .OUTPUT(output, TensorType({DT_BOOL, DT_FLOAT16, DT_FLOAT, DT_INT8, DT_INT32, DT_UINT32, 
DT_UINT8,
                           DT_INT64, DT_UINT64, DT_INT16, DT_UINT16, DT_DOUBLE, DT_COMPLEX64,
                           DT_COMPLEX128, DT_QINT8, DT_QUINT8, DT_QINT16, DT_QUINT16, DT_QINT32}))
    .OP_END_FACTORY_REG(ReshapeCust)

}
#endif // GE_OP_INTERP_RESHAPE_CUST_H

● REG_OP(ReshapeCust)中的Add为算子注册到昇腾AI处理器中的Type，需要与算
子适配插件实现（TensorFlow）中REGISTER_CUSTOM_OP("ReshapeCust")中的
算子类型保持一致。

● .INPUT与.OUTPUT分别为算子的输入、输出Tensor的名称与数据类型，输入输出
的顺序需要与算子代码实现函数形参顺序以及算子信息定义中参数的顺序保持一
致。

reshape_cust.cc 实现

原型定义的关键点是推理输出Tensor的shape。ReshapeCust算子推理输出shape的原
理为：首先获取两个输入，一个是输入tensor，一个是目标的shape，校验输入tensor
元素个数是否与目标shape相同，校验成功则将输出shape设置为目标shape值。

MindStudio已在reshape_cust.cc文件中生成了代码模板文件，开发者可根据需要进行
修改。reshape_cust.cc的实现代码如下所示：
#include "reshape_cust.h"         //IR注册头文件
#include <vector>        //可使用vector类模板并调用vector相关接口
#include <string>        //C++标准库，可使用string类构造对象并调用string相关接口
#include <iostream>      //C++标准库，调用输入输出流接口

namespace {
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// 获取目标shape
template <typename T>
std::vector<int64_t> AsInt64(const T *data, int64_t dataSize) 
{
  std::vector<int64_t> ret(dataSize);
  for (int64_t i = 0; i < dataSize; ++i) {
    ret[i] = data[i];
  }
  return ret;
}

// 根据shape获取元素个数
int64_t GetElementNum(const std::vector<int64_t> &shape) 
{
  int64_t ret = 1;
  for (size_t i = 0; i < shape.size(); ++i) {
    ret *= shape[i];
  }
  return ret;
}
}

namespace ge {
IMPLEMT_COMMON_INFERFUNC(ReshapeCustInferShape) {
  TensorDesc tensordesc_tensor = op.GetInputDescByname("tensor");
  TensorDesc tensordesc_shape = op.GetInputDescByname("shape");
  TensorDesc tensordesc_output = op.GetOutputDescByname("output");
  Tensor shape_tensor;
  // 获取目标shape的值
  if (op.GetInputConstData("shape", shape_tensor) == GRAPH_SUCCESS) {
    DataType shape_type = tensordesc_shape.GetDataType();
    std::vector<int64_t> shape_values;
    if (shape_type == DT_INT32) {
      auto shape_data = reinterpret_cast<const int32_t *>(shape_tensor.GetData());
      shape_values = AsInt64<int32_t>(shape_data, shape_tensor.GetSize()/sizeof(int32_t));
    } else {
      auto shape_data = reinterpret_cast<const int64_t *>(shape_tensor.GetData());
      shape_values = AsInt64<int64_t>(shape_data, shape_tensor.GetSize()/sizeof(int64_t));
    }

    // 校验目标shape是否合法
    std::vector<int64_t> input_shape = tensordesc_tensor.GetShape().GetDims();
    int64_t input_element_num = GetElementNum(input_shape);
    int64_t shape_element_num = GetElementNum(shape_values);
    if (input_element_num != shape_element_num) {
      return GRAPH_FAILED;
    }

    // 设置输出tensor的shape
    tensordesc_output.SetShape(Shape(shape_values));
    tensordesc_output.SetOriginShape(Shape(shape_values));
  }

  tensordesc_output.SetDataType(tensordesc_tensor.GetDataType());

  std::vector<std::pair<int64_t,int64_t>> range;
  auto status = op.GetInputDesc("tensor").GetShapeRange(range);
  if (status != GRAPH_SUCCESS) {
    return GRAPH_FAILED;
  }
  tensordesc_output.SetShapeRange(range);

  (void)op.UpdateOutputDesc("output", tensordesc_output);
  return GRAPH_SUCCESS;
}

COMMON_INFER_FUNC_REG(ReshapeCust, ReshapeCustInferShape);

}
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7.6.2 算子代码实现

简介

AI CPU算子的实现包括两部分：

● 头文件（.h文件）：进行算子类的声明，自定义算子类需要继承CpuKernel基类。

● 源文件（.cc文件）：重写算子类中的Compute函数，进行算子计算逻辑的实现。

头文件代码模块介绍

用户需要在算子工程的“cpukernel/impl/reshape_cust_kernel.h”文件中进行算子类
的声明，代码模块介绍如下所示：

#ifndef _AICPU_RESHAPE_CUST_KERNELS_H_
#define _AICPU_RESHAPE_CUST_KERNELS_H_

#include "cpu_kernel.h"        // CpuKernel基类以及注册宏定义
// 以下头文件根据算子需求引入 
#include "cpu_tensor.h"        // Tensor定义以及相关方法
#include "cpu_tensor_shape.h"  // Tensor shape的定义以及相关方法
#include "cpu_types.h"         // 数据类型以及格式等定义
#include "cpu_attr_value.h"    // AttrValue定义及相关方法

namespace aicpu {        // 定义命名空间aicpu
class ReshapeCustCpuKernel : public CpuKernel {        // ReshapeCust算子类继承CpuKernel基类
public:
    ~ReshapeCustCpuKernel() = default;
    virtual uint32_t Compute(CpuKernelContext &ctx) override;    // 声明函数Compute，且Compute函数需要
重写
};
} // namespace aicpu
#endif

● 引入相关头文件。

– 头文件cpu_kernel.h，包含AI CPU算子基类CpuKernel的定义，以及Kernels
的注册宏的定义。

– 头文件cpu_tensor.h，包含AI CPU的Tensor类的定义及相关方法。

– 头文件cpu_tensor_shape.h，包含AI CPU的TensorShape类及相关方法。

– 头文件cpu_types.h，包含AI CPU的数据类型以及格式等定义。

– 头文件cpu_attr_value.h，包含AttrValue类的属性定义以及方法。

● 进行算子类的声明，此类为CpuKernel类的派生类，并需要声明重载函数
Compute，Compute函数需要在算子实现文件中进行实现，详细请参见源文件代
码模块介绍。算子类的声明需要在命名空间“aicpu”中，命名空间的名字
“aicpu”为固定值，不允许修改。

源文件代码模块介绍

用户需要在算子工程的“cpukernel/impl/reshape_cust_kernel.cc”文件中进行算子的
计算逻辑实现，代码模块介绍如下所示：
#include "reshape_cust_kernel.h"     // 引入声明ReshapeCust算子类的头文件

namespace {          
const char *RESHAPE_CUST = "ReshapeCust";      //算子的OpType为ReshapeCust
}

namespace aicpu {    // 定义命名空间aicpu
uint32_t ReshapeCustCpuKernel::Compute(CpuKernelContext &ctx)  // 实现自定义算子类的Compute函数
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{
    return 0;
}

REGISTER_CPU_KERNEL(RESHAPE_CUST, ReshapeCustCpuKernel);  // 注册ReshapeCust算子实现
} // namespace aicpu

1. 引入相关头文件。

头文件reshape_cust_kernel.h，头文件代码模块介绍中声明的头文件。

以下头文件，若在头文件代码模块介绍已经引入，无需在重复引入。

– 头文件cpu_kernel.h，包含AI CPU算子基类CpuKernel的定义，以及Kernels
的注册宏的定义。

– 头文件cpu_tensor.h，包含AI CPU的Tensor类的定义及相关方法。

– 头文件cpu_tensor_shape.h，包含AI CPU的TensorShape类及相关方法。

– 头文件cpu_types.h，包含AI CPU的数据类型以及格式等定义。

– 头文件cpu_attr_value.h，包含AttrValue类的属性定义以及方法。

2. 定义命名空间，声明常量字符指针指向算子的OpType。

如下所示：
namespace {          
const char *RESHAPE_CUST = "ReshapeCust";
}

其中，ReshapeCust为算子的OpType，RESHAPE_CUST为声明的指向算子
OpType的常量指针。

3. 定义命名空间aicpu，并在命名空间aicpu中实现自定义算子的Compute函数，定
义算子的计算逻辑。

命名空间的名称aicpu为固定值，基类及相关定义都在aicpu命名空间中。

– Compute函数声明。
uint32_t ReshapeCustCpuKernel::Compute(CpuKernelContext &ctx)

ReshapeCustCpuKernel为头文件中定义的自定义算子类，形参
CpuKernelContext为CPU Kernel的上下文，包括算子的输入输出Tensor以及
属性等相关信息。

– Compute函数体中，根据算子开发需求，编写相关代码实现获取输入tensor
相关信息，并根据输入信息组织计算逻辑，得出输出结果，并将输出结果设
置到输出tensor中。

4. 注册算子的Kernel实现。
REGISTER_CPU_KERNEL(RESHAPE_CUST, ReshapeCustCpuKernel);

– 第一个参数RESHAPE_CUST为2中定义的指向算子OpType的字符串指针。

– 第二个参数ReshapeCustCpuKernel为自定义算子类的名称。

Compute 函数实现

AI CPU算子实现的关键代码是Compute的实现，ReshapeCust算子的功能是将输入
tensor的数据拷贝到输出tensor中，输出的tensor的shape信息将在算子原型定义的
Infershape中进行推导。算子实现代码示例如下所示：
namespace aicpu {
uint32_t ReshapeCustCpuKernel::Compute(CpuKernelContext &ctx)
{
    Tensor *inputTensor = ctx.Input(0);    // 可根据获取到的输入input_tensor获取输入的shape,数据等信息
    if (inputTensor == nullptr) {
        return -1;
    }
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    Tensor *outputTensor = ctx.Output(0);    // 可根据获取到的输出output_tensor获取输出的shape,数据等信息
    if (outputTensor == nullptr) {
        return -1;
    }

    // 获取输入tensor的数据地址
    auto inputData = inputTensor->GetData();
    if (inputData == nullptr) {
        return -1;
    }

    // 获取输出tensor的数据地址
    auto outputData = outputTensor->GetData();
    if (outputData == nullptr) {
        return -1;
    }

    // 将输入tensor的数据拷贝至输出tensor中
    uint64_t inputDataSize = inputTensor->GetDataSize();
    memcpy(outputData, inputData, inputDataSize);
    return 0;
}

7.6.3 算子信息库定义

原理

算子信息库作为算子开发的交付件之一，主要体现算子在昇腾AI处理器上的具体实现
规格，包括算子支持输入输出type、name等信息。网络运行时，根据算子信息库中的
算子信息做基本校验，并进行算子匹配。

配置说明

进入“cpukernel/op_info_cfg/aicpu_kernel”目录，配置算子信息库文件
“reshape_cust.ini”。开发者需要基于MindStudio自动生成的reshape_cust.ini文件进
行修改，修改后的ReshapeCust算子的算子信息定义如下所示。

[ReshapeCust]
opInfo.engine=DNN_VM_AICPU
opInfo.flagPartial=False
opInfo.computeCost=100
opInfo.flagAsync=False
opInfo.opKernelLib=CUSTAICPUKernel
opInfo.kernelSo=libcust_aicpu_kernels.so
opInfo.functionName=RunCpuKernel
opInfo.workspaceSize=1024

参数说明请参见表7-12。下表仅列出常用的算子信息库配置项，其他配置项请参见
《AI CPU自定义算子开发指南》的“算子信息库定义”章节。

表 7-12 ReshapeCust 算子的算子信息定义说明

信息 ReshapeCust算子配
置

说明

[OpType] [ReshapeCust] 算子类型，以英文半角范括号，标
识一个算子信息开始，根据算子分
析，算子类型为ReshapeCust。
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opInfo.engine DNN_VM_AICPU 配置算子调用的引擎。

AI CPU自定义算子的引擎固定为
“DNN_VM_AICPU”。

opInfo.flagPartial False 此字段为预留字段，请保持固定值
“False”。

opInfo.computeCost 100 此字段为预留字段，请保持固定值
“100”。

opInfo.flagAsync False 此字段为预留字段，请保持固定值
“False”。

opInfo.opKernelLib CUSTAICPUKernel 配置算子调用的kernelLib。

AI CPU自定义算子调用的kernelLib
固定为“CUSTAICPUKernel”。

opInfo.kernelSo libcust_aicpu_kerne
ls.so

配置AI CPU算子编译生成的so的名
称。

opInfo.functionName RunCpuKernel 配置自定义算子调用的kernel函数
接口名称。

自定义算子的kernel函数接口固定
为“RunCpuKernel”。

opInfo.workspaceSize 1024 此字段为预留字段。

配置为内存空间，用于分配算子临
时计算的内存。

单位为KB，取值范围为：
0~1048576（1G）。

建议配置为：1024

 

7.6.4 算子适配插件实现（TensorFlow/ONNX）
开发者需要进行算子适配插件的开发，实现将第三方框架（TensorFlow/ONNX）网络
中的算子进行解析并映射成昇腾AI处理器中的算子。

TensorFlow
MindStudio在“framework/tf_plugin/tensorflow_reshape_cust_plugin.cc”文件已自
动生成了ReshapeCust算子的插件代码。

● 包含头文件。
//包含该头文件，可使用算子注册类相关，调用算子注册相关的接口，为Ascend-cann-toolkit开发套件包中
compiler/include/register/register.h文件
#include "register/register.h"

● 进行插件注册。
using namespace ge;    // 需手动添加
namespace domi {
// register op info to GE
REGISTER_CUSTOM_OP("ReshapeCust")
    .FrameworkType(TENSORFLOW)   // type: CAFFE, TENSORFLOW
    .OriginOpType("ReshapeCust")      // name in tf module

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 255



    .ParseParamsByOperatorFn(AutoMappingByOpFn);
    .ImplyType(ImplyType::AI_CPU);    // 需手动添加
}  // namespace domi

– REGISTER_CUSTOM_OP：算子注册到GE的算子类型，根据算子分析，算子
类型为“ReshapeCust”。

– FrameworkType：TENSORFLOW，原始框架类型为TensorFlow。

– OriginOpType：算子在TensorFlow框架中的类型。

– ParseParamsByOperatorFn：用来注册解析模型的函数，使用
AutoMappingFn函数自动实现解析。

– ImplyType：指定算子的实现方式，ImplyType::AI_CPU表示该算子是AI CPU
算子。需要手动添加。

ONNX

MindStudio在“framework/onnx_plugin/xxx_plugin.cc”文件已自动生成了算子的插
件代码。

● 包含头文件。
//包含该头文件，可使用算子注册类相关，调用算子注册相关的接口，为Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/compiler/include/register/register.h文件
#include "register/register.h"

● 进行插件注册。
using namespace ge;    // 需手动添加
namespace domi {
// Onnx ParseParams
Status ParseParamAdd(const Message* op_src, ge::Operator& op_dest) {
    // To do: Implement the operator plugin by referring to the Onnx Operator Development Guide.
    return SUCCESS;
}

// register op info to GE
REGISTER_CUSTOM_OP("Add")
    .FrameworkType(ONNX)   // Operator name with the original framework
    .OriginOpType("")      // Set the original frame type of the operator
    .ParseParamsByOperatorFn(ParseParamAdd)// Registering the callback function for parsing 
operator parameters 
    .ImplyType(ImplyType::TVM);    // 需手动添加
}  // namespace domi

– REGISTER_CUSTOM_OP：注册自定义算子，Add作为注册到GE中的算子类
型，可以任意命名但不能和已有的算子命名冲突，且需要与原型注册中的
OpType保持一致。

– FrameworkType：ONNX代表原始框架为ONNX。

– OriginOpType：算子在原始框架中的类型，需要用户填写。例如自定义算子
Add，对应ONNX算子库版本opset_version=11的原始框架类型为“ai.onnx::
11::Add”，此处填写为OriginOpType("ai.onnx::11::Add") 。

– ParseParamsByOperatorFn(ParseParamAdd)：用来注册解析算子属性的函
数，需要用户自定义实现回调函数ParseParamAdd。

回调函数ParseParamAdd的声明如下所示：

Status ParseParamAdd(const ge::Operator& op_src, ge::Operator& op_dest)

▪ ParseParamAdd：函数名称，用户自定义，需要保持唯一。

▪ op_src：ONNX框架定义的Operator类对象，包含ONNX模型中自定义
的算子属性信息，定义来源ONNX框架的原始模型文件。
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▪ op_dest：CANN算子数据结构，保存算子信息。

– ImplyType：指定算子的实现方式，ImplyType::TVM表示该算子是TVM算
子，需要手动添加。

7.6.5 UT 测试

简介

MindStudio提供了基于gtest框架的新的UT测试方案，简化了开发者开发UT测试用例
的复杂度。

UT（Unit Test：单元测试）是开发人员进行单算子运行验证的手段之一，主要目的
是：

● 测试算子代码的正确性，验证输入输出结果与设计的一致性。

● UT侧重于保证算子程序能够跑通，选取的场景组合应能覆盖算子代码的所有分支
（一般来说覆盖率要达到100%），从而降低不同场景下算子代码的编译失败率。

说明

● 测试类的详细定义可参见Ascend-cann-toolkit安装目录/ascend-toolkit/latest/toolkit/
python/site-packages/op_test_frame/ut/op_ut.py文件。

前提条件
● 需完成自定义算子的开发，包括算子实现代码和算子原型定义，详情可参见算子

代码实现和算子原型定义。

● 安装lcov依赖，要求1.1.3版本以上。

● 安装CMake，要求版本为3.14及以上，若CMake版本不满足要求，请升级CMake
版本。

说明

CentOS7.8 arm容器暂不支持UT测试功能。

操作步骤

步骤1 创建UT测试用例。

1. 创建UT测试用例，有以下两种方式：

右键单击算子工程根目录，选择“New Cases > AI CPU UT Case”。

若已经存在了算子的UT测试用例，可以右键单击“testcases”目录，或者
“testcases > ut”目录，选择“New Cases > AI CPU UT Case”，创建UT测试
用例。

2. 在弹出的算子选择界面，选择需要创建UT测试用例的算子，单击“OK”，如下图
所示。
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说明

若已存在此算子的UT测试用例，系统会提示“testcases/ut/ops_test/xx already exists. Do
you want to overwrite?”

可以选择“Overwrite”覆盖当前测试用例或者“Cancel”。

创建完成后，会在算子工程根目录下生成testcases文件夹，目录结构如下所示：
├── MyOperator            //工程根目录  
│   ├──  testcases                            
│   │   ├── libs                  // gtest框架，为第三方依赖，用户无需关注
│   │   ├──  ut                              
│   │   │   ├── aicpu_test
│   │   │   │   ├── reshape_cust   
│   │   │   │   │   ├── CMakeLists.txt        //用于编译可执行文件
│   │   │   │   │   ├── test_reshape_cust_impl.cc      //算子实现代码的测试用例文件
│   │   │   │   │   ├── test_reshape_cust_proto.cc    //算子原型定义代码的测试用例文件
│   │   │   │   ├── CMakeLists.txt             //用于编译可执行文件
│   │   │   │   ├── test_main.cc             //测试用例调用总入口
│   │   │   ├ CMakeLists.txt

步骤2 在中标麒麟和银河麒麟运行时，请在./testcases/aicpu_test/reshape_cust/
CMakeLists.txt文件中添加加粗内容，其他操作系统请忽略此步骤。
cmake_minimum_required(VERSION 3.14)
set(CMAKE_CXX_FLAGS "-std=c++11")

...

link_directories(
            "${ATC_DIR}/lib64"
            "${GTEST_DIR}"
            "/usr/local/gcc7.3.0/lib64/"   //若用户自己配置dockerfile请修改为实际gcc7.3.0的lib64路径
    )

    set(CUSTOM_OBJECT_NAME "reshape_cust_proto_test")
    add_executable(${CUSTOM_OBJECT_NAME}
            ${PROJECT_DIR}/testcases/ut/aicpu_test/test_main.cc
            ${OP_PROTO_SOURCE_SRCS}
            ${OP_PROTO_TEST_FILES})

    target_link_libraries(${CUSTOM_OBJECT_NAME} gtest c_sec alog pthread error_manager graph register)
endif()

说明

使用AI CPU UT测试功能时，gcc版本为7.3.0及以上，若gcc版本不满足要求，请升级gcc版本。

步骤3 编写算子实现代码的UT C++测试用例。

在“testcases/ut/aicpu_test/reshape_cust/test_reshape_cust_impl.cc”文件中，编写
算子实现代码的UT C++测试用例，计算出算子执行结果，并取回结果和预期结果进行
比较，来测试算子逻辑的正确性。

步骤4 编写算子原型定义的UT C++测试用例。

在“testcases/ut/aicpu_test/reshape_cust/test_reshape_cust_proto.cc”文件中，编
写算子原型定义的UT C++测试用例，用于定义算子实例、更新算子输入输出并调用
InferShapeAndType函数， 后验证InferShapeAndType函数执行过程及结果的正确
性。

步骤5 运行算子实现文件的UT测试用例。

开发人员可以执行当前工程中所有算子的UT测试用例，也可以执行单个算子的UT测试
用例。
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● 右键单击“testcases/ut/aicpu_test”文件夹，选择“Run AI CPU
Operator‘All’UT Impl with coverage”，运行整个文件夹下算子实现代码的测
试用例。

● 右键单击“testcases/ut/aicpu_test/算子名称”文件夹，选择“Run AI CPU
Operator 算子名称’UT Impl with coverage”‘，运行单个算子实现代码的测试
用例。

第一次运行时会弹出运行配置页面，请参考配置，然后单击“Run”。后续如需
修改运行配置，请参考修改运行配置。

图 7-17 运行配置页面

表 7-13 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择ut_impl。

Compute Unit 选择计算单元

– AI Core/Vector Core
– AI CPU
选择不同的计算单元可以实现AI Core/Vector Core
和AI CPU UT测试配置界面的切换。

Operator Name 选择运行的测试用例。

– all表示运行所有用例。

– 其他表示运行某个算子下的测试用例。
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参数 说明

Case Names 勾选需要运行的测试用例，即算子实现代码的UT C
++测试用例。支持全选和全不选所有测试用例。

 

● 查看运行结果。

a. 运行完成后，通过界面下方的“Run”日志打印窗口查看运行结果。

b. 在“Run”窗口中单击report index.html的URL（URL中的localhost为
MindStudio安装服务器的IP，建议直接单击打开），查看UT测试用例的覆盖
率结果。

说明

查看UT测试用例运行结果需要使用浏览器，如果未安装浏览器，请用户自行安装。

如果出现"Page'http://***.html'requested without authorization, you can
copy URL and open it in browser to trust it."提示，请参考配置不受信任的
网址访问浏览器解决。

步骤6 （可选）调试算子实现文件的UT测试。

1. 右键单击“testcases/ut/aicpu_test/算子名称”文件夹，选择“Debug AI CPU
Operator‘算子名称’UT Impl ”，调试单个算子实现代码的测试用例。

调试详细操作请参见工程调试，调试快捷键设置方法请参见其他。

第一次运行时会弹出运行配置页面，请参考配置，然后单击Debug。后续如需修
改运行配置，请参考修改运行配置。

表 7-14 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择ut_impl。

Compute Unit 选择计算单元。

– AI Core/Vector Core
– AI CPU
选择不同的计算单元可以实现AI Core/Vector Core
和AI CPU UT测试配置界面的切换。

Operator Name 选择运行的测试用例。

– all表示运行所有用例。

– 其他表示运行某个算子下的测试用例。

Case Names 勾选需要运行的测试用例，即算子实现代码的UT C
++测试用例。支持全选和全不选所有测试用例。

 
2. 查看调试信息。

调试过程中，通过界面下方的“Debug”窗口进行调试、查看调试信息和调试结
果。
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步骤7 运行算子原型定义的UT测试用例。

开发人员可以执行当前工程中所有算子的UT测试用例，也可以执行单个算子的UT测试
用例。

● 右键单击“testcases/ut/aicpu_test”文件夹，选择“Run AI CPU
Operator‘All’UT Proto”，执行整个文件夹下算子原型定义代码的测试用例。

● 右键单击“testcases/ut/aicpu_test/算子名称”文件夹，选择“Run AI CPU
Operator‘算子名称’UT Proto”，执行单个算子原型定义代码的测试用例。

第一次运行时会弹出运行配置页面，请参考配置，然后单击“Run”。后续如需
修改运行配置，请参考修改运行配置。

图 7-18 配置页面

表 7-15 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择ut_proto。

Compute Unit 选择计算单元

– AI Core/Vector Core
– AI CPU
选择不同的计算单元可以实现AI Core/Vector Core
和AI CPU UT测试配置界面的切换。
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参数 说明

Operator Name 选择运行的测试用例。

– all表示运行所有用例。

– 其他表示运行某个算子下的测试用例。

Case Names 勾选需要运行的测试用例，即TEST_F中定义的用
例。支持全选和全不选所有测试用例。

 

运行完成后，通过界面下方的日志打印窗口，查看运行结果。结果中展示此次运行用
例、成功用例和失败用例的个数。。

----结束

说明

旧的UT测试工程在更新Ascend-cann-toolkit开发套件包后，可能会出现UT测试运行失败。解决
方法为删除旧的UT测试依赖文件夹后重新运行UT测试。旧的UT测试依赖文件夹路径为“AI
CPU算子工程目录/testcases/libs/aicpu_depend”。

其他

AI CPU算子的UT测试支持单步调试，在顶部菜单栏中选择“File > Settings > Keymap
> Main menu > Run > Debugging Actions”修改调试快捷键。

7.6.6 算子工程编译

简介

算子交付件开发完成后，需要对算子工程进行编译，生成自定义算子安装包*.run，详
细的编译操作包括：

● 将AI CPU算子代码实现文件*.h与*.cc编译成libcust_aicpu_kernels.so。

● 将AI CPU算子信息定义文件*.ini编译成cust_aicpu_kernel.json。

● 将原型定义文件*.h与*.cc编译成libcust_op_proto.so。

● 将算子适配插件实现文件*.cc编译成libcust_tf_parsers.so。
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须知

● Windows操作系统不支持本地编译。

● 旧版本的AI CPU算子工程在使用 新版本的Ascend-cann-toolkit开发套件包
时，存在不兼容问题，需要修改CMakeLists.txt文件后重新编译算子工程。解
决方法如下。

1. 修改算子工程目录下/cpukernel/CMakeLists.txt文件。
...
set(AICPU_SOC_VERSION $ENV{AICPU_SOC_VERSION}) 
message(STATUS "AICPU_SOC_VERSION=${AICPU_SOC_VERSION}")

# 添加如下代码
if(EXISTS "${ASCEND_AICPU_PATH}/opp/op_impl/built-in/aicpu/aicpu_kernel/lib/$
{AICPU_SOC_VERSION}/libascend_protobuf.a")
    target_link_options(${AICPU_KERNEL_TARGET} PRIVATE
        -s 
        -Wl,-Bsymbolic
        -Wl,--exclude-libs=libascend_protobuf.a
    ) 
    target_link_libraries(${AICPU_KERNEL_TARGET} PRIVATE
        -Wl,--whole-archive
        ${ASCEND_AICPU_PATH}/opp/op_impl/built-in/aicpu/aicpu_kernel/lib/$
{AICPU_SOC_VERSION}/libascend_protobuf.a
        -Wl,--no-whole-archive
    ) 
endif()

if(EXISTS "${ASCEND_AICPU_PATH}/opp/op_impl/built-in/aicpu/aicpu_kernel/lib/$
{AICPU_SOC_VERSION}/libcpu_kernels_context.a")
...

2. 参考本章节重新编译算子工程。

编译操作

步骤1 （可选）修改工程目录下的“cpukernel/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：
include_directories(
directoryPath1
directoryPath2
)

● link_directories：添加库文件所在的目录。

示例如下：
link_directories(
directoryPath3 
directoryPath4
)

● link_libraries：添加算子实现文件的库文件。

示例如下：
link_libraries( 
libName1 
libName2)

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。
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步骤2 编译配置。

在MindStudio工程界面，选中算子工程，单击顶部菜单栏的“Build > Edit Build
Configuration...”。

步骤3 进入编译配置页面。单击 添加新增配置，默认添加编译类型
“Release(default)”，请参考表7-16进行编译配置。

图 7-19 编译配置页面

表 7-16 编译配置参数说明

参数 说明

Name 配置名称自定义，默认为Release。

Build type 配置类型，可选，默认为Release。

Toolchain 工具链配置器，根据已安装的CANN包预置架构
一致的自定义Toolchain，支持本地和远程编译功
能。

可单击“Manage toolchains……”自定义配置
Toolchain，配置详情请参见CMake编译配置。

CMake options CMake选项，默认：“-
DCMAKE_BUILD_TYPE=Release”。

Build directory 编译目录相对路径，该路径是相对于工程目录的
路径。

Build options 编译加速选项。
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参数 说明

Environment variables 环境变量配置：支持编译前配置环境变量。

可直接手动配置或单击 符号，在弹出窗中配
置管理。

 

若选用远程Toolchain，将默认添加一个Deployment，用户需要配置环境变量。

在Environment Variables输入框中输入ASCEND_OPP_PATH、TOOLCHAIN_DIR、
ASCEND_TENSOR_COMPILER_INCLUDE、ASCEND_AICPU_PATH环境变量。
ASCEND_OPP_PATH=Ascend-cann-toolkit安装目录/ascend-toolkit/latest/opp;
TOOLCHAIN_DIR=Ascend-cann-toolkit安装目录/ascend-toolkit/latest/toolkit/toolchain/hcc; 
ASCEND_TENSOR_COMPILER_INCLUDE=Ascend-cann-toolkit安装目录/ascend-toolkit/latest/include;
ASCEND_AICPU_PATH=Ascend-cann-toolkit安装目录/ascend-toolkit/latest

建议用户配置AICPU_KERNEL_TARGET环境变量。并添加软件版本号的后 ，避免后
续由于AI CPU软件升级造成自定义AI CPU动态库文件的冲突。若不配置此环境变量，
使用默认值：cust_aicpu_kernels。

AICPU_KERNEL_TARGET=cust_aicpu_kernels_3.3.0

说明

● 若选用本地编译需用户在操作系统中增加环境变量。
export ASCEND_AICPU_PATH=Ascend-cann-toolkit安装目录/ascend-toolkit/latest
export AICPU_KERNEL_TARGET=cust_aicpu_kernels_3.3.0（建议配置）

● 若选用远程Ascend310RC编译场景，需安装交叉编译环境和修改TOOLCHAIN_DIR环境变
量。

前提需安装交叉编译环境，请参见《MindStudio安装指南》的“配置编译环境”章节。

Environment Variables输入框中修改环境变量TOOLCHAIN_DIR=/usr。

步骤4 单击 或“Build>Build Project”进行工程编译。

步骤5 在界面 下方的窗口查看编译结果，并在算子工程的cmake-build目录下生成自定义算
子安装包custom_opp_Linux_Arch.run。

其中Arch的取值根据安装的CANN包和Toolchain的信息获取。

----结束

7.6.7 算子部署（本地）

须知

● 执行ST测试操作时，会自动编译生成自定义算子安装包并将其部署到开发环境的
opp目录下，若用户已参见ST测试进行了算子的ST测试，则此步骤可跳过；若需要
单独部署自定义算子安装包，可参见此章节进行部署。

● 进行算子部署前，需要参见算子工程编译生成自定义算子安装包
custom_opp_Linux_Arch.run。

● Windows操作系统不支持算子本地部署。
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步骤1 在MindStudio工程界面菜单栏依次选择“Ascend > Operator Deployment”。弹出算
子部署界面

步骤2 在弹出的界面中选择“Operator Deploy Locally”，在“Operator Package”中选择
指定的算子库OPP包目录并单击“Operator deploy”按钮。

在下方Output页签出现如下信息，代表自定义算子部署成功。

自定义算子包安装成功后，会将自定义算子部署在Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/opp目录下或指定的算子库OPP目录下的对应文件夹中。

目录结构示例如下所示：

├── opp      //算子库目录
│   ├── op_impl
│       ├── built-in        
│       ├── custom
│           ├── ai_core
│           ├── cpu
│               ├── aicpu_kernel/
│                   ├── custom_impl               //自定义算子实现代码文件
│                       ├── libcust_aicpu_kernels.so
│               ├── config
│                       ├── cust_aicpu_kernel.json     //自定义算子信息库文件
│           ├── vector_core   //此目录预留，无需关注
│   ├── framework
│       ├── built-in
│       ├── custom
│           ├── caffe      
│           ├── tensorflow          //存放tensorflow框架的自定义算子插件库
│               ├── libcust_tf_parsers.so
│               ├── npu_supported_ops.json   //Ascend 910场景下使用的文件，Ascend 310场景下无需关注
│   ├── op_proto
│       ├── built-in
│       ├── custom
│           ├── libcust_op_proto.so    //自定义算子原型库文件

----结束

7.6.8 算子部署（远程）

将自定义算子安装包custom_opp_Linux_Arch.run部署到昇腾AI处理器所在硬件环境
的算子库中，为后续算子在网络中运行构造必要条件。

步骤1 在MindStudio工程界面，选中算子工程。
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步骤2 单击顶部菜单栏的“Ascend > Operator Deploymen”，进入算子打包部署界面。

请在Deploy Remotely > Deployment选择配置项，配置Deployment的方法请参见
Deployment。

步骤3 配置环境变量。

两种方式如下所示：

● 在昇腾AI处理器所在硬件环境Host侧配置环境变量。

MindStudio使用Host侧的运行用户在Host侧进行算子部署，进行算子部署执行
前，需要在Host侧进行如下环境变量的配置。

a. 以运行用户在Host侧的$HOME/.bashrc文件中配置如下环境变量。
export ASCEND_OPP_PATH=/home/xxx/Ascend/ascend-toolkit/latest/opp

/home/xxx/Ascend/ascend-toolkit/latest为OPP组件（算子库）的安装路
径，请根据实际情况配置。

b. 执行命令使环境变量生效。

source ~/.bashrc

● 在Environment Variables中添加环境变量。

可以在Environment Variables中输入ASCEND_OPP_PATH=/home/xxx/Ascend/
ascend-toolkit/latest/opp。

/home/xxx/Ascend/ascend-toolkit/latest为OPP组件（算子库）的安装路径，请
根据实际情况配置。

也可以点击文本框后的图标，在弹出的对话框中填写。

– 在Name中输入环境变量名称：ASCEND_OPP_PATH。

– 在Value中输入环境变量值：home/xxx/Ascend/ascend-toolkit/latest/opp。

步骤4 选择指定的算子库OPP包。

在“Operator Package”中选择指定的算子库OPP包目录。

步骤5 选择算子部署的目标服务器，单击“Operator deploy”。

步骤6 算子部署过程即算子工程编译生成的自定义算子安装包的安装过程，部署完成后，算
子被部署在Host侧算子库OPP对应文件夹中，若不选择指定的算子库OPP包则默认路
径为/usr/local/Ascend/opp/。

图 7-20 算子部署日志打印
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Host侧自定义算子部署完成后目录结构示例如下所示：

├── opp      //算子库目录
│   ├── op_impl
│       ├── built-in        
│       ├── custom
│           ├── ai_core
│           ├── cpu
│               ├── aicpu_kernel/
│                   ├── custom_impl               //自定义算子实现代码文件
│                       ├── libcust_aicpu_kernels.so
│               ├── config
│                       ├── cust_aicpu_kernel.json     //自定义算子信息库文件
│           ├── vector_core   //此目录预留，无需关注
│   ├── framework
│       ├── built-in
│       ├── custom
│           ├── caffe      
│           ├── tensorflow          //存放tensorflow框架的自定义算子插件库
│               ├── libcust_tf_parsers.so
│   ├── op_proto
│       ├── built-in
│       ├── custom
│           ├── libcust_op_proto.so    //自定义算子原型库文件

----结束

7.6.9 PyTorch 适配

说明

MindStudio暂不支持PyTorch算子适配，在完成AI CPU算子开发后，Pytorch适配请参见
《PyTorch 1.5.0 算子开发指南》或《PyTorch 1.8.1 算子开发指南》。

PyTorch适配请读者根据《PyTorch 1.5.0 算子开发指南》或《PyTorch 1.8.1 算子开发
指南》完成以下操作。

● 安装PyTorch依赖环境

● 编译和安装PyTorch框架

● PyTorch框架下适配TBE算子

7.6.10 ST 测试

概述

MindStudio提供了新的ST（System Test）测试框架，可以自动生成测试用例，在真实
的硬件环境中，验证算子功能的正确性和计算结果准确性，并生成运行测试报告，包
括：

● 基于算子信息库生成算子测试用例定义文件。

● 基于算子测试用例定义文件生成不同shape、dtype的测试数据和基于AscendCL的
测试用例。

● 编译算子工程并将算子部署到算子库， 后在硬件环境中执行测试用例，验证算
子运行的正确性。

● 自动生成运行报表（st_report.json）功能，报表记录了测试用例信息及各阶段运
行情况。

● 根据用户定义并配置的算子期望数据生成函数，回显期望算子输出和实际算子输
出的对比测试结果，验证计算结果的准确性。
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前提条件
● 完成自定义算子的开发，请参见算子代码实现、算子原型定义、算子信息库定

义、算子适配插件实现（TensorFlow）。

● MindStudio已连接硬件设备。

生成 ST 测试用例定义文件

步骤1 创建ST测试用例。

有以下三种方式：

● 右键单击算子工程根目录，选择“New Cases > ST Case”。

● 右键单击算子信息定义文件：{工程名} /cpukernel/op_info_cfg/aicpu_kernel/
xx.ini，选择“New Cases > ST Case”。

● 若已经存在了对应算子的ST Case，可以右键单击“testcases”目录，或者
“testcases > st”目录，选择“New Cases > ST Case”，追加ST测试用例。

步骤2 在弹出的“Create ST Cases for an Operator”界面中选择需要创建ST测试用例的算
子。如下图所示。

● Operator：下拉选择算子名称。

● SoC Version：下拉选择昇腾AI处理器的类型。若对AI CPU算子进行ST测试，默认
选择aicpu_kernel。

● 若不勾选“Import operator info from a model”，单击“OK”后，会生成
shape为空的算子测试用例定义文件。

用户需要进行shape信息的配置，用于生成测试数据及测试用例，也可以根据需要
进行其他字段的配置，每个字段的详细要求可参见AI CPU算子测试用例定义文件
参数解释。

● 若用户勾选“Import operator info from a model”，选择包含算子的
Tensorflow模型文件（*.pb）或者onnx格式的模型文件后，界面会显示获取到的
模型文件的首层shape信息。

用户也可以在“Input Nodes Shape”中修改首层输入的shape信息。

单击“OK”后，工具会自动根据首层shape信息dump出选择算子的shape信息，
生成对应的算子测试用例定义文件。

此文件用于生成测试数据及测试用例，可以参见AI CPU算子测试用例定义文件参
数解释进行相关字段的修改。

说明

该功能需要在运行环境中安装TensorFlow框架和onnx库。若为Windows操作系统则需要在
Windsows本地安装TensorFlow框架和onnx库。

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 269



步骤3 若要将算子与标杆数据对比，需要定义并配置算子期望数据生成函数。

1. 自定义实现算子期望数据生成函数。

算子期望数据生成函数需要开发者使用Python语言自行实现，用于在CPU上运行
生成标杆数据。例如，开发者可以使用numpy等接口实现与自定义算子功能相同
的函数。标杆数据用来与自定义算子生成数据进行对比，根据对比结果确定自定
义算子精度。算子期望数据生成函数用python语言实现，在一个python文件中可
以实现多个算子期望数据生成函数。该函数的输入、输出、属性与自定义算子的
输入、输出、属性的Format、Type、Shape保持一致。

2. 配置算子测试用例定义文件。

在算子测试用例文件中配置算子期望数据生成函数。有两种场景，分别为
“Design”视图和“Text”视图下进行配置。

– 若在“Design”视图下，配置方法为在“Expected Result Verification”下的
“Script Path”中选择算子期望数据生成函数的python文件所在路径。在
“Script Function”中输入算子期望数据生成函数的函数名。

说明

“Script Function”中可以输入算子期望数据生成函数的函数名，也可以为空。

▪ 当输入算子期望数据生成函数的函数名时，ST测试时会使用该函数名对应的函数
生成标杆数据。

▪ 当输入为空时，会自动匹配Script Path路径下的python文件中与自定义算子同名
的函数，用于ST测试时生成标杆数据。若无同名函数，则会提示匹配失败。

– 若在Text视图下，增加“calc_expect_func_file”参数，其值为算子期望数据
生成函数对应的文件路径及算子函数名，如：
"calc_expect_func_file": "/home/teste/test_*.py:function",   //配置期望算子文件

其中，/home/teste/test_*.py为算子期望数据生成函数的实现文件，function
为对应的函数名称。算子期望数据生成函数文件路径和函数名称用冒号隔
开。

示例：test_add.py文件为add算子期望数据生成文件，函数实现如下：
def calc_expect_func(input_x, input_y, out):    
    res = input_x["value"] + input_y["value"]
    return [res, ]

说明

用户需根据开发的自定义算子完成算子期望数据生成函数。测试用例定义文件中的全
部Input、Output、Attr的name作为算子期望数据生成函数的输入参数。

步骤4 若要使用python脚本批量生成测试用例，采用fuzz方式生成测试用例。

1. 实现fuzz测试参数生成脚本。该脚本可以自动生成测试用例定义文件中
Input[xx]、Output[xx]、Attr内除了name的任何参数。

下面以随机生成shape和value参数为例，创建一个fuzz_shape.py供用户参考。该
示例会随机生成一个1-4维，每个维度取值范围在1-64的shape参数，用于ST测
试。
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a. 导入脚本所需依赖。
import numpy as np

b. 实现fuzz_branch()方法，若用户自定义随机生成待测试参数的方法名，需要
在算子测试用例定义文件中Fuzz Function字段配置自定义方法。
def fuzz_branch():
    # 生成测试参数shape值
    dim = random.randint(1, 4)
    x_shape_0 = random.randint(1, 64)
    x_shape_1 = random.randint(1, 64)
    x_shape_2 = random.randint(1, 64)
    x_shape_3 = random.randint(1, 64)
    if dim == 1:
        shape = [x_shape_0]
    if dim == 2:
        shape = [x_shape_0, x_shape_1]
    if dim == 3:
        shape = [x_shape_0, x_shape_1, x_shape_2]
    if dim == 4:
        shape = [x_shape_0, x_shape_1, x_shape_2, x_shape_3]
    # 根据shape随机生成x1、x2的value
    fuzz_value_x1 = np.random.randint(1, 10, size=shape)
    fuzz_value_x2 = np.random.randint(1, 10, size=shape)

    # 用字典数据结构返回shape值，将生成的shape值返回给input_desc的x1、x2和output_desc的y
的shape参数。其中x1、x2、y测试用例定义文件输入、输出的name。
    return {"input_desc": {"x1": {"shape": shape,"value": fuzz_value_x1}, 
                           "x2": {"shape": shape,"value": fuzz_value_x2}},
            "output_desc": {"y": {"shape": shape}}}

▪ 该方法生成测试用例定义文件Input[xx]、Output[xx]、Attr内除了name
的任何参数参数，用户可自定义实现参数的生成方法，以满足算子测试
的需求。

▪ 该方法的返回值为字典格式，将该方法生成的参数值以字典的方式赋值
给算子进行st测试。返回的字典结构与测试用例定义文件中参数结构相
同。

2. 将算子测试用例定义文件中需要随机生成的字段的值设为"fuzz"。

此时显示K-Level Test Cases配置项，包含Fuzz Script Path和Fuzz Case Num选
项。

3. 在Fuzz Script Path中输入fuzz生成测试参数的脚本的相对路径或绝对路径，如：
“fuzz_shape.py”。

4. 在Fuzz Case Num中输入利用fuzz脚本生成多少条测试用例，如：2000。

5. （可选）在Fuzz Function中配置自定义的随机生成待测试参数的方法，若不配置
默认使用 fuzz_branch方法。

6. fuzz用例不采取正交生成，因此在该场景下算子测试用例定义文件中各字段的取
值需唯一。

步骤5 修改Case信息后，单击“Save”，修改会保存到算子测试用例定义文件。

算子测试用例定义文件存储目录为算子工程根目录下的“testcases/st/OpType/
aicpu_kernel”文件夹下，命名为OpType_case_timestamp.json

说明

请勿更改算子测试用例定义文件命名格式和将其他文件的以该命名格式保存在算子工程根目录下
的“testcases/st/OpType/aicpu_kernel”文件夹下。否则会导致文件解析错误。

----结束
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运行 ST 测试用例

步骤1 （可选）修改工程目录下的“cpukernel/CMakeLists.txt”文件。

● include_directories：添加头文件所在的目录。

示例如下：

include_directories(
directoryPath1
directoryPath2
)

● link_directories：添加库文件所在的目录。

示例如下：

link_directories(
directoryPath3 
directoryPath4
)

● link_libraries：添加编译算子依赖的库文件。

示例如下：

link_libraries( 
libName1 
libName2)

说明

关于cmake参数的详细介绍，请参见https://cmake.org/cmake/help/latest/guide/tutorial/
index.html，选择对应版本后查看参数。

步骤2 运行ST测试用例。

右键单击生成ST测试用例定义文件中生成的ST测试用例定义文件（路径：“testcases
> st > OpType > aicpu_kernel > xxxx.json”），选择“Run ST Case 'xxx'”。

表 7-17 运行配置信息

参数 说明

Name 运行配置名称，用户可以自定义。

Test Type 选择st_cases 。

Execute Mode ● Remote Execute 远程执行测试

● Local Execute 本地执行测试

说明
Local Execute不支持Windows操作系统。

Deployment 当Execute Mode选择Remote Execute时，
deployment功能，详细请参见Deployment，可以将
指定项目中的文件、文件夹同步到远程指定机器的指
定目录。

CANN Machine CANN工具所在设备deployment信息。

说明
该参数仅支持Windows操作系统。
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参数 说明

Environment Variables ● 在文本框中添加环境变量。
PATH_1=路径1;PATH_2=路径2
多个环境变量用英文分号隔开。

● 也可以点击文本框后的图标，在弹出的对话框中填
写。

– 在Name中输入环境变量名称：PATH_1
– 在Value中输入环境变量值：路径1

勾选Instead system environment variables可以显示
系统环境变量。

Operator Name 选择需要运行的算子。

SoC Version 配置 昇腾AI处理器的类型。

Product Form 配置产品形态。若SoC Version配置为Ascend310时显
示该配置项。

● EP
● RC

Executable File Name 下拉选择需要执行的测试用例定义文件。

若对AI CPU算子进行ST测试，测试用例文件前有（AI
CPU）标识。

Toolchain 工具链配置器，根据已安装的CANN包预置架构一致
的自定义Toolchain，支持本地和远程编译功能。

可单击“Manage toolchains……”自定义配置
Toolchain，配置详情请参见CMake编译配置。

Case Names 选择运行的Case Name。

说明：默认全选所有用例，可以去除勾选部分不需要
运行的用例。

Enable Auto
Build&Deploy

选择是否在ST运行过程中执行编译和部署。

Advanced Options 高级选项。

ATC Log Level 选择ATC 日志级别。

● INFO
● DEBUG
● WARNING
● ERROR
● NULL
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参数 说明

Precision Mode 精度模式。

● force_fp16
● allow_mix_precision
● allow_fp32_to_fp16
● must_keep_origin_dtype

Device Id 设备ID，设置运行ST测试的芯片ID。用户根据使用的
AI芯片ID填写。

Error Threshold 配置自定义精度标准，取值为含两个元素的列表：
[val1，val2]
● val1：算子输出结果与标杆数据误差阈值，若误差

大于该值则记为误差数据。

● val2：误差数据在全部数据占比阈值。若误差数据
在全部数据占比小于该值，则精度达标，否则精度
不达标。

取值范围为[0.0,1.0]。

 

说明

● ST测试支持板端日志级别设置及查询，具体操作请参见日志管理。

● 在Windows操作系统中不支持Local Execute功能。

步骤3 Host侧运行用户设置。

Host侧运行用户需在deployment中添加，并且该用户必须为HwHiAiUser属组。配置
deployment请参见Deployment。

步骤4 在运行环境上有两种方式配置相关组件的环境变量。

● 在远程设备上配置环境变量。

– 针对Ascend EP，需要在硬件设备的Host侧配置安装组件路径的环境变量。

以Host侧运行用户在~/.bashrc文件中配置runtime或comlpiler、driver组件的
安装路径。

i. 打开运行用户下的.bashrc文件。

vi ~/.bashrc
ii. 在文件 后添加如下信息。

export ASCEND_DRIVER_PATH=/usr/local/Ascend/driver
export ASCEND_HOME=/usr/local/Ascend//ascend-toolkit/latest
export ASCEND_AICPU_PATH=${ASCEND_HOME}/<target
architecture>
若远程设备为推理环境：

export LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64:$
{ASCEND_HOME}/lib64:$LD_LIBRARY_PATH
若远程设备为训练环境：
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export
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64/driver:$
{ASCEND_DRIVER_PATH}/lib64/common:${ASCEND_HOME}/
lib64:$LD_LIBRARY_PATH
若已存在如上所述环境变量，请确认为当前运行环境实际安装组件所在
路径。

<target architecture>为操作系统架构，例如：x86_64-linux或arm64-
linux。

iii. 保存退出。

:wq
iv. 使环境变量生效。

source ~/.bashrc
● 在Environment Variables中添加环境变量。

在运行ST测试用例中运行的窗口中Environment Variables参数进行环境变量配
置。

– 在文本框中添加环境变量
ASCEND_DRIVER_PATH=/usr/local/Ascend/driver;
ASCEND_HOME=/usr/local/Ascend/ascend-toolkit/latest;
ASCEND_AICPU_PATH=${ASCEND_HOME}/<target architecture>-linux;
若远程设备为推理环境：
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64:${ASCEND_HOME}/
lib64:$LD_LIBRARY_PATH;
若远程设备为训练环境：
LD_LIBRARY_PATH=${ASCEND_DRIVER_PATH}/lib64/driver:${ASCEND_DRIVER_PATH}/lib64/
common:${ASCEND_HOME}/lib64:$LD_LIBRARY_PATH;

请根据driver和CANN的实际安装路径，远程操作系统的使用架构修改环境变
量内容。

– 也可以单击 ，在弹出的对话框中填写。

分别在Name中输入环境变量名称，在Value中输入环境变量值。

步骤5 单击“Run”。

MindStudio会根据算子测试用例定义文件在算子根目录“testcases/st/out/<operator
name>”下生成测试数据和测试代码，并编译出可执行文件，在指定的硬件设备上执
行测试用例。运行成功后会打印对比报告及保存运行信息。

● 将执行结果和与标杆数据对比报告打印到Output窗口中。

– 总体信息

total_count：对比元素总数量。

max_diff_thd： 大误差阈值，若存在预期结果与真实结果误差超出该阈
值，直接判定该测试用例失败。

– 详细信息

Index（对比元素序号）、ExpectOut（期望输出）、RealOut（实际输
出）、FpDiff（精度误差）、RateDiff（误差比）。

– 误差容忍信息及结果

预期结果与真实结果误差小于DiffThd（误差阈值）的数量占比高于PctThd
（准确率阈值）则Result（比对结果）为通过，否则失败，同时会打印出
PctRlt（实际准确率）。

– system_profiler信息及结果
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在步骤1开启“Enable System Profier”开关，配置采集项后才会以表格形式
输出system_profiler信息及结果。具体字段含义请参见《Profiling工具使用
指南》。

● 在算子根目录“testcases/st/out/<operator name>”下生成st_report.json文件。
st_report.json文件信息含义请参见表7-18。

表 7-18 st_report.json 报表主要字段及含义

字段 说明

run_cmd - - 命令行命令。

report_list - - 报告列表，该列表中可包含多个
测试用例的报告。

trace_detail - 运行细节。

st_case_info 测试信息，包含如下内容。

– expect_data_path：期望计
算结果路径。

– case_name：测试用例名称

– input_data_path：输入数据
路径

– planned_output_data_paths
：实际计算结果输出路径

– op_params：算子参数信息

stage_result 运行各阶段结果信息，包含如下
内容。

– status：阶段运行状态，表示
运行成功或者失败

– result：输出结果

– stage_name：阶段名称

– cmd：运行命令

case_name - 测试名称。

status - 测试结果状态，表示运行成功或
者失败。

expect - 期望的测试结果状态，表示期望
运行成功或者失败。

summary - - 统计测试用例的结果状态与期望
结果状态对比的结果。

test case
count

- 测试用例个数。

success
count

- 测试用例的结果状态与期望结果
状态一致的个数。
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字段 说明

failed count - 测试用例的结果状态与期望结果
状态不一致的个数。

 

----结束

7.7 其他功能及操作

7.7.1 算子工程管理

7.7.1.1 导入算子工程样例

MindStudio工具提供了完整的算子实现代码样例，可以参考本节内容导入算子工程样
例，无需修改算子代码即可体验算子验证、算子部署、算子网络验证过程。

步骤1 进入工程导入页面。

● 首次登录MindStudio：在“Welcome to MindStudio”窗口中，单击“Open”。

● 非首次登录MindStudio：在顶部菜单栏单击“File > Open...”。

步骤2 在“Open File or Project”窗口中，选择样例工程所在文件夹。

样例工程所在路径为MindStudio安装路径下的“MindStudio/plugins/ascend-
foundation/samples/operator_demo_projects/quick_start”。

步骤3 单击“OK”，导入样例工程。

若首次打开工程，将弹出如图7-21所示界面，表示MindStudio提供的功能可能会执行
此工程中的潜在恶意代码，导入工程前需进行确认。

图 7-21 信任窗口

● Trust projects in {此工程所在的目录}：信任此工程所在的目录下的所有工程。

● Trust Project：信任此工程。

● Preview in Safe Mode：在安全模式下预览此工程。

● Don't Open：不打开此工程。

若打开工程时出现如图7-22所示提示，是因为样例工程配置文件中未配置CANN的版
本号，需要单击“OK”修改为当前实际使用的CANN版本号，如图7-23所示。
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图 7-22 工程打开异常提示

图 7-23 工程属性修改

----结束

7.7.1.2 修改算子工程属性

创建完算子工程后，支持修改工程属性，包括CANN版本以及产品形态，方便用户通过
一个工程运行不同的产品形态。

前提条件

已经创建工程，算子工程创建详细操作请参见自定义算子开发。

操作步骤

步骤1 选中已经创建的算子工程，右击选择“Edit Operators Property”，弹出图7-24所示
界面。
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图 7-24 工程属性修改

界面参数解释如表7-19所示。

表 7-19 工程属性修改界面参数

参数 说明

Name 工程名称，创建算子工程时决定，不支持修改。

Description 工程描述信息，支持修改。

CANN Version 当前CANN的版本号。

Project
Location

工程的存储路径，创建算子工程时决定，不支持修改。

 

步骤2 根据实际情况修改“CANN Version”，修改完后，单击“OK”。进行其他工程开
发。

----结束

7.7.1.3 切换到算子逻辑视图

开发者可以将前算子工程视图切换为算子逻辑视图，该视图按照算子维度展示算子工
程目录下的文件，实际文件结构和位置不发生变化。

开发者可以在算子逻辑视图下进行算子开发、算子验证、并且能方便地新增和删除算
子。

在算子工程的Project窗口中，单击 按钮，在下拉框中选择“Operators”，如图
7-25所示。
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图 7-25 切换入口

切换成功后，可以查看算子逻辑视图，如图7-26所示。

图 7-26 查看算子逻辑视图

该视图以算子维度展示算子交付件，包括算子信息定义文件、算子实现文件、算子原
型定义文件、算子插件实现文件、算子融合信息定义文件、算子测试用例。

7.7.1.4 新增/删除算子

本节介绍如何在已创建的工程中添加新算子，删除已有算子。
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在算子工程视图中新增算子

在算子工程视图中，选中算子工程，右键选择“New > Operator”，可以在弹出框中
设置新算子信息，如图7-27所示。从而实现在当前算子工程中实现多个算子，如果算
子类型重复，会提示用户是否进行覆盖。

图 7-27 在算子工程视图中新增算子

在算子逻辑视图中新增算子

在算子逻辑视图，选中算子工程，右键选择“New > Operator”，可以在弹出框中新
增算子信息，如图7-28所示。如果算子类型重复，会提示用户是否进行覆盖。

图 7-28 在算子逻辑视图中新增算子

在算子逻辑视图中删除算子

在算子逻辑视图，选中待删除的算子名称，右键选择“Delete Operator”，如图7-29
所示。
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图 7-29 在算子逻辑视图中删除算子

7.7.2 运行生成*.cce 文件

分析算子*.cce文件，可以了解到底层实现的数据搬运过程、buffer切分等，用以优化算
子实现。

正常情况下，算子运行后，生成算子二进制文件*.o和算子描述文件*.json，如果还需要
生成*.cce文件，请在算子运行前编辑Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/compiler/python/site-packages/te/platform/cce_build.py文件，配置
save_temp_cce_file为True。

算子运行后，在算子二进制文件*.o和算子描述文件*.json同级目录下，生成*.cce文件。

7.7.3 查看单算子 Profiling 数据

查看 Profiling 数据

在执行TBE算子UT测试时，设置运行配置参数Target为Simulator__TMModel，并运行
UT测试用例。Profiling执行成功后，在IDE下方控制台会展示执行仿真过程中所生成的
Profiling性能数据。如果已经执行过UT测试，通过右键单击算子工程名称，并选择
View Profiling Result查看Profiling性能数据。Profiling性能数据展示如图7-30所
示。

图 7-30 查看 Profiling 性能数据

并行度视图（Parallel Analysis）展示单算子运行中各个指令执行的并行度情况，横轴
为时间（Tick，时钟周期），纵轴为各指令单元，鼠标移动到时间块上，可以显示单
条指令的消耗时间以及相关指令。

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 282



说明

“Start”和“End”表示数据展示的时间范围。“End”为Cycle数，此数值越大，代表运行时间
越长。图中数据展示的时间范围可通过调整右上方的滑块进行变更。

设置代码跳转功能

针对TIK方式开发的算子，如果使用从并行度视图（Parallel Analysis）跳转到TBE、
CCE代码功能，需要在运行UT测试用例前，开启Debug开关。

开启Debug开关的方法：在算子代码中的BuildCCE接口中增加config参数，并设置参
数tbe_debug_level值为2，编译生成cce代码，生成的算子目标文件中包含debug信
息。

TIK算子开启Debug配置参数如下。

        config = {
                 "tbe_debug_level": 2
                 }

         self.tik_instance.BuildCCE(
             kernel_name = self.kernel_name,
             inputs=(self.var_gm, self.indices_gm, self.updates_gm),
             enable_l2 = Fales,
             config=config)

TIK算子开启Debug开关，并执行UT测试后，显示的并行度视图（Parallel Analysis）
如图7-31所示。右键单击时间块，显示“Goto TIK Code”和“Goto CCE Code”，单
击即可跳转。

图 7-31 并行度视图（Parallel Analysis）

7.7.4 TIK 功能调试

简介

MindStudio支持TIK算子的可视化调试，可以实现断点设置、单步调试、连续运行直到
结束或下一断点、查看变量信息、退出调试等功能。

前提条件
● 完成环境变量配置，需要完成用户级别的环境变量配置。若没有配置，请参考以

下操作。

a. 修改~/.bashrc文件。在文件中添加如下内容。
source Ascend-cann-toolkit安装目录/ascend-toolkit/set_env.sh
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b. 执行命令。
source ~/.bashrc

● 已完成TIK算子实现代码。

操作步骤

本章节以simple_add算子为例介绍TIK功能调试方法。

步骤1 编写simple_add算子调试代码.py文件。

完整代码示例参考：(以文件名simple_add.py为例）
import numpy as np

from tbe import tik
from tbe.common.platform import set_current_compile_soc_info

def simple_add():
    tik_instance = tik.Tik()
    kernel_name = "tik_vec_add_128_float32"
    dst_ub = tik_instance.Tensor("float32", [128], tik.scope_ubuf, "dst_ub")
    dst_gm = tik_instance.Tensor("float32", (128,), tik.scope_gm,  "dst_gm")
    src0_gm = tik_instance.Tensor("float32", (128,), tik.scope_gm, "src0_gm")
    src0_ub = tik_instance.Tensor("float32", (128,), tik.scope_ubuf, "src0_ub")
    src1_gm = tik_instance.Tensor("float32", (128,), tik.scope_gm, "src1_gm")
    src1_ub = tik_instance.Tensor("float32", (128,), tik.scope_ubuf, "src1_ub")

    tik_instance.data_move(src0_ub, src0_gm, 0, 1, 16, 0, 0)
    tik_instance.data_move(src1_ub, src1_gm, 0, 1, 16, 0, 0)
    tik_instance.vec_add(64, dst_ub, src0_ub, src1_ub, 2, 8, 8, 8)
    tik_instance.data_move(dst_gm, dst_ub, 0, 1, 16, 0, 0)
    tik_instance.BuildCCE(kernel_name, [src0_gm, src1_gm], [dst_gm])

    return tik_instance

if __name__=='__main__':
    set_current_compile_soc_info（"Ascend310"）   # 请根据芯片实际版本设置，具体请参考
set_current_compile_soc_info接口说明
    tik_instance = simple_add()
    data_x = np.ones((128,)).astype("float32")
    data_y = np.ones((128,)).astype("float32")
    feed_dict = {'src0_gm': data_x, 'src1_gm': data_y}
    model_data, = tik_instance.tikdb.start_debug(feed_dict=feed_dict,interactive=True) # 添加TIK调试代码
    print(model_data)

步骤2 设置断点。

● 添加断点

左键单击需要设置tik断点的行，在弹出的对画框中选择“Tik Operator
Breakpoint”。如图7-32。

图 7-32 设置断点
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须知

– TIK断点必须添加在TIK 语句上。

– 若一行代码被分为多行，需在 后一行设置断点。

● 其他断点操作请参见断点管理。

步骤3 运行调试。

● 首次调试，右键单击simple_add.py文件选择“Tik Operator Debug ”运行调
试。

● 非首次调试，可以通过点击 按钮或“Ctrl +F5”按键运行调试。

步骤4 调试执行。

调试执行操作步骤请参见调试执行。

----结束

7.7.5 自定义算子样例
MindStudio工具提供了自定义算子样例，供用户学习与参考。打开样例工程步骤如
下。

步骤1 进入工程导入页面。

● 首次登录MindStudio：在“Welcome to MindStudio”窗口中，单击“Open”。

● 非首次登录MindStudio：在顶部菜单栏单击“File > Open...”。

步骤2 在“Open File or Project”窗口中，选择样例工程所在文件夹。

样例工程所在路径为MindStudio安装路径下的“MindStudio/plugins/ascend-
foundation/samples/operator_demo_projects/cann/”。

cann目录结构如下，选择需要打开的样例工程，在样例工程下执行算子编译、部署等
操作。算子模板清单参见表7-21。
├── AICPU
│   ├── Onnx
│   └── Tensorflow
├── DSL
│   ├── Mindspore
│   ├── Onnx
│   ├── PyTorch
│   └── Tensorflow
└── TIK
    ├── Mindspore
    ├── PyTorch
    └── Tensorflow

步骤3 单击“OK”，导入样例工程。

弹出“Import Support Configuration”对话框，选择相应参数后，单击Create按钮。
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表 7-20 “Import Support Configuration”对话框

参数 值

Type 项目类型

● Ascend Operator
● Ascend App
● Ascend Training
下拉框选择Ascend Operator

Framework 算子所在模型文件的框架类型。

● MindSpore
● PyTorch
● TensorFlow
● Onnx
根据打开的样例工程框架选择

 

----结束

说明

● 更换CANN包时，算子样例工程中cann目录会被覆盖。如果用户有修改，请在更换CANN包
之前进行备份。

● 自定义算子模板代码仅作为示例，供算子开发过程参考，不支持用户基于自定义算子模板进
行产品化开发。

● Onnx算子编译时需要protoc版本为3.13.0。

● 目前在Windows版本下：

● 自定义算子样例代码中可能会出现无法识别的语义被红色波浪线标出，但不影响正常开
发流程，用户可忽略该提示。

● 若UT测试运行配置信息中的Case Names列表为空。可能由于算子样例的UT测试代码
中导入了te或tbe模块，该样例暂不支持UT测试。

● 在ST测试阶段，请参考步骤3配置如下环境变量：
ASCEND_HOME=/usr/local/Ascend/ascend-toolkit/latest
ASCEND_OPP_PATH=${ASCEND_HOME}/opp

表 7-21 自定义算子模板清单

算子实现
方式

框架 算子名称 主要功能

AI CPU TensorFlo
w

Less 判断元素1是否小于元素2。

TopK 获取前k个 大元素的值和索
引。

Cast 类型转化。

Where 返回tensor中非零值的位置。

SparseToDense 稀疏矩阵转密集矩阵。
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算子实现
方式

框架 算子名称 主要功能

Onnx AdaptiveMaxPool2d 自适应2D 大池化。

TBE DSL PyTorch LpNorm 批量操作归一化。

SmoothL1Loss 平滑版的L1 Loss。

ReduceStd 返回张量中所有元素的标准差和
均值。

SoftPlus softplus激活函数。

MaskedFill 通过掩码替换某值。

SigmoidCrossEntropy
WithLogitsGrad

计算损失。

SigmoidCrossEntropy
WithLogitsGradV2

计算梯度。

TensorFlo
w

Mul 元素乘。

BasicLSTMCell 基本LSTM计算单元。

Fill 将数值填充到Tensor中。

ApplyAdamD 使用Adam更新值。

InplaceUpdate 实现将Tensor lhs的指定行用rhs
来替换。

UnsortedSegmentMa
x

计算segment中张量 大值。

Conv3D 三维卷积。

Conv2D 二维卷积。

Relu ReLU激活函数。

ReduceAll 在给定的维度上进行逻辑与操
作，并根据条件去除该维度。

BatchNorm 批量归一化。

MaxPool 大池化。

Onnx FillV2D 将value填充到tensor里面。

MindSpore Add3 把所有元素相加。

CusCorrectionMul 使用校正因子处理权重。

Square 计算元素平方根。

TBE TIK TensorFlo
w

Add 矩阵加法运算（适合初学者）。

 

MindStudio
用户指南 7 自定义算子开发

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 287



7.7.6 UT 测试接口参考

7.7.6.1 OpUT

概述

OpUT为UT测试框架的基类，提供了测试用例定义及测试用例执行的接口，主要包含
如下两个接口：

● add_case
● add_precision_case

OpUT 测试类定义
● 函数原型

OpUT(op_type, op_module_name=None, op_func_name=None)
● 参数说明

– op_type: 算子的类型。

– op_module_name: 算子的module名称（即算子的实现文件名称和路径），
例如：impl.add （文件路径为：impl/add.py）。默认值为None，可根据
op_type自动生成，op_type到算子实现文件名称的转换规则可参见步骤4，例
如BiasAdd算子自动生成module名称"impl.bias_add"。

– op_func_name: 算子的接口名称，算子实现文件中的算子接口名。默认值为
None，可根据op_type自动生成，op_type到算子实现文件中接口名称的转换
规则可参见步骤4，例如Add算子，则需要在 impl/add.py 中存在add接口，
接口定义如下所示：
@check_op_params(REQUIRED_INPUT, REQUIRED_INPUT, REQUIRED_OUTPUT, KERNEL_NAME)
def add(input_x, input_y, output_z, kernel_name="add"):

add_case 接口
● 函数原型

OpUT.add_case(support_soc=None, case=None)
● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– support_soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取
值范围可从“compiler/data/platform_config”目录下查看，对应“*.ini”文
件的名字即为可配置的昇腾AI处理器类型。support_soc支持的数据类型为
str、tuple或者list，tuple或者list表示可以支持多个SoC。若配置为“all”或
者“None”，表示支持所有的SoC。

– case：该参数为dict类型。

不带属性算子case示例：
{
    "params": [
        {
          "shape": (32, 64),
          "ori_shape": (32, 64),
          "format": "ND",
          "ori_format": (32, 64),
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          "dtype": "float16"
        },
        {
          "shape": (32, 64),
          "ori_shape": (32, 64),
          "format": "ND",
          "ori_format": (32, 64),
          "dtype": "float16" 
        }
    ],
    "case_name": "test_add_case_1",
    "expect": "success"      
}

带属性算子case示例：
# 以conv2d算子为例，详细算子实现请参见“样例工程”提供的conv2d算子实现文件。
# def get_op_support_info(inputs, weights, bias, offset_w, outputs, strides, pads, 
dilations,groups=1, data_format='NCHW', offset_x=0, kernel_name="conv2d")

{
    "params": [
        # inputs参数（tensor）
        {'shape': (1, 1, 16, 16, 16), "format": "NC1HWC0", 'ori_shape': (1, 16, 16, 16), 'ori_format': 
'NCHW', 'dtype': 'float16', "param_type": "input", "value_range": [1.0, 2.0]},
        # weights参数（tensor）
        {'shape': (1, 1, 16, 16), "format":"FRACTAL_Z", 'ori_shape': (16, 16, 1, 1), 'ori_format': 
'NCHW', 'dtype': 'float16', "param_type": "input", "value_range": [1.0, 2.0]},
        # bias参数
        None,
        # offset_w参数
        None,
        # outputs参数（tensor）
        {'shape':(1, 1, 16, 16, 16), 'ori_shape':(1, 16, 16, 16), "format": "NC1HWC0",  'ori_format': 
'NCHW', "param_type": "output", 'dtype': 'float16'},
        # strides参数
        (1, 1, 1, 1), 
        # pads参数
        (0, 0, 0, 0), 
        # dilations参数
        (1, 1, 1, 1), 
        # 可选groups参数
         1,
        # 可选data_format参数
         'NCHW', 
        # 可选offset_x参数
         0
    "case_name": "test_conv2d_case_1",
    "expect": "success" 
}

该dict中key字段含义如表7-22所示：
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表 7-22 key 字段配置信息

参数 值

params 该字段在测试用例运行时透传给算子接口。该字段中
的参数应与算子接口的参数顺序一致。

● 若输入的参数为tensor，可选择如下字段传递。

– shape：tensor的形状

– ori_shape：tensor的原始形状

– format：tensor的格式

– ori_format：tensor的原始格式

– param_type：tensor类型

– dtype：tensor的数据类型

– value_range：tensor取值范围，默认值为[0.1,
1.0]

● 若输入的参数为非tensor，请传递实际参数值。

● 若输入的参数为空，请传递None。

case_name 测试用例的名称，可选参数。

若不设置，测试框架会自动生成用例名称，生成规则
如下：

test_{op_type}_auto_case_name_{case_count}
例如： test_Add_auto_case_name_1

expect 期望结果。

默认为期望“success”，也可以是预期抛出的异
常，例如RuntimeError。

 

add_precision_case 接口
● 函数原型

OpUT.add_precision_case(support_soc=None, case)
● 功能说明

添加算子编译+精度测试的用例。

● 参数说明

– support_soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取
值范围可从“compiler/data/platform_config”目录下查看，对应“*.ini”文
件的名字即为可配置的昇腾AI处理器类型。support_soc支持的数据类型为
str、tuple或者list，tuple或者list表示可以支持多个SoC。若配置为“all”或
者“None”，表示支持所有的SoC。

– case：该参数为dict类型，示例如下：

不带属性算子case示例：
{
    "params": [
        {
          "shape": (32, 64),
          "ori_shape": (32, 64),
          "format": "ND",
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          "ori_format": "ND",
          "dtype": "float16",
          "param_type": "input"
        },
        {
          "shape": (32, 64),
          "ori_shape": (32, 64),
          "format": "ND",
          "ori_format": "ND",
          "dtype": "float16",
          "param_type": "output"
        }
    ],
    "case_name": "test_add_case_1",
    "calc_expect_func": np_add #一个函数
    "precision_standard": precision_info.PrecisionStandard(0.001, 0.001)  #可选字段
}

带属性算子case示例：
# 以conv2d算子为例，详细算子实现请参见“样例工程”提供的conv2d算子实现文件。
# def get_op_support_info(inputs, weights, bias, offset_w, outputs, strides, pads, 
dilations,groups=1, data_format='NCHW', offset_x=0, kernel_name="conv2d")

{
    "params": [
        # inputs参数（tensor）
        {'shape': (1, 1, 16, 16, 16), "format": "NC1HWC0", 'ori_shape': (1, 16, 16, 16), 'ori_format': 
'NCHW', 'dtype': 'float16', "param_type": "input", "value_range": [1.0, 2.0]},
        # weights参数（tensor）
        {'shape': (1, 1, 16, 16), "format":"FRACTAL_Z", 'ori_shape': (16, 16, 1, 1), 'ori_format': 
'NCHW', 'dtype': 'float16', "param_type": "input", "value_range": [1.0, 2.0]},
        # bias参数
        None,
        # offset_w参数
        None,
        # outputs参数（tensor）
        {'shape':(1, 1, 16, 16, 16), 'ori_shape':(1, 16, 16, 16), "format": "NC1HWC0",  'ori_format': 
'NCHW', "param_type": "output", 'dtype': 'float16'},
        # strides参数
        (1, 1, 1, 1), 
        # pads参数
        (0, 0, 0, 0), 
        # dilations参数
        (1, 1, 1, 1), 
        # 可选groups参数
         1,
        # 可选data_format参数
         'NCHW', 
        # 可选offset_x参数
         0
    "case_name": "test_conv2d_case_1",
    "calc_expect_func": np_conv2d #一个函数
    "precision_standard": precision_info.PrecisionStandard(0.001, 0.001)  #可选字段
}

该dict中key字段含义如表7-23所示：
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表 7-23 key 字段配置信息

参数 值

params 该字段在测试用例运行时透传给算
子接口。该字段中的参数应与算子
接口的参数顺序一致。

● 若输入的参数为tensor，可选择
如下字段传递。

– shape：tensor的形状

– ori_shape：tensor的原始形
状

– format：tensor的格式

– ori_format：tensor的原始格
式

– param_type：tensor类型

– dtype：tensor的数据类型

– value_range：tensor取值范
围，默认值为[0.1, 1.0]

● 若输入的参数为非tensor，请传
递实际参数值。

● 若输入的参数为空，请传递
None。

case_name 测试用例的名称，可选参数。若不
设置，测试框架会自动生成用例名
称，生成规则如下：

test_{op_type}_auto_case_name_{c
ase_count}
例如：
test_Add_auto_case_name_1

calc_expect_func 期望结果生成函数。
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参数 值

precision_standard 自定义精度标准，取值为：(rtol,
atol, Max_atol)。
● rtol：相对容忍率

● atol：绝对容忍率

● Max_atol：（可选） 大容忍率

说明
若不配置此字段，按照如下默认精度与
期望数据进行比对：

● 数据类型为float16时：双千分之
一，(0.001, 0.001, 0.1)，即每个数
据之间的误差不超过千分之一，误
差超过千分之一的数据总和不超过
总数据数的千分之一。

● 数据类型为float32时：双万分之
一，(0.0001, 0.0001, 0.01)，即每个
数据之间的误差不超过万分之一，
误差超过万分之一的数据总和不超
过总数据数的万分之一。

● 数据类型为int8或uint8时：(0.001,
1, 1)，即每个数据之间的误差不超
过一，误差超过一的数据总和不超
过总数据数的千分之一。

 

● 调用示例

示例1：
from op_test_frame.ut import OpUT
# "ut_case" 为UT测试框架的关键字，不可修改
ut_case = OpUT("Add", "impl.add", "add")

def np_add(x1, x2, y):
    y = (x1.get("value") + x2.get("value"), )
    return y

ut_case.add_precision_case(case={
    "params": [
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
            "ori_format": "ND",
            "dtype": "float16",
            "param_type": "input"
        },
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
            "ori_format": "ND",
            "dtype": "float16",
            "param_type": "input"
        },
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
            "ori_format": "ND",
            "dtype": "float16",
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            "param_type": "output"
        }
    ],
    "case_name": "test_add_case_1",
    "calc_expect_func": np_add
})

if __name__ == '__main__':
    ut_case.run("Ascend910",None,"ca","/home/allan/Ascend/toolkit/tools/simulator")

说明：

ut_case.run：请参见run接口。

此样例未设置算子的输入数据值，测试框架将默认使用
np.random.uniform(value_range, size=shape).astype(dtype)为每一个输入自动
生成输入数据。

其中value_range使用默认值[0.1, 1.0]，shape和dtype的取值为“params”中的
每一个输入。value_range也可以通过参数指定，如下所示：
{
    "shape": (32, 64),
    "ori_shape": (32, 64),
    "format": "ND",
    "ori_format": "ND",
    "dtype": "float16",
    "param_type": "input",
    "value_range": [2.0, 3.0]
}

也可以指定输入的值，如下所示：
{
    "shape": (32, 64),
    "ori_shape": (32, 64),
    "format": "ND",
    "ori_format": "ND",
    "dtype": "float16",
    "param_type": "input",
    "value": np.zeros((32, 64), np.float16)
}

示例2：

自定义精度标准示例如下：
from op_test_frame.common import precision_info
from op_test_frame.ut import OpUT

ut_case = OpUT("Add")
ut_case.add_precision_case(case={
    "params": [
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
            "ori_format": "ND",
            "dtype": "float16",
            "param_type": "input"
        },
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
            "ori_format": "ND",
            "dtype": "float16",
            "param_type": "input"
        },
        {
            "shape": (32, 64),
            "ori_shape": (32, 64),
            "format": "ND",
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            "ori_format": "ND",
            "dtype": "float16",
            "param_type": "output"
        }
    ],
    "case_name": "test_add_case_1",
    "calc_expect_func": np_add,
    "precision_standard": precision_info.PrecisionStandard(0.1, 0.1) # 使用精度标准双十分之一，与期望
数据进行比对
})

run 接口

● 函数原型

OpUT.run(soc, case_name=None, simulator_mode=None,
simulator_lib_path=None)

● 功能说明

执行测试用例。

● 参数说明

– soc：执行测试用例的昇腾AI处理器，昇腾AI处理器的取值范围可从Ascend-
cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。

– case_name：指定执行的case，配置为add_case接口及add_precision_case
接口中的“case_name”

– simulator_mode: 默认为None，如果仅跑算子编译的测试用例，不需要指
定。在添加了精度测试用例的时候，需要指定仿真的模式，使用"ca"或者
"pv"。 如果指定"tm"将仅输出打点图，不进行精度比对。

– simulator_lib_path: 仿真库所在的路径。

该路径结构如下所示：

simulator_lib_path/
  Ascend910/
      lib/
          libpv_model.so
          ...
  Ascend310/
      lib/
          libpv_model.so
          ...

须知

使用MindStudio运行UT测试用例时，无需用户手工调用OpUT.run接口。

7.7.6.2 BroadcastOpUT

概述

BroadcastOpUT继承了OpUT，包含了OpUT的能力。
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BroadcastOpUT主要供双输入单输出的Broadcast类型的算子进行测试用例的定义，例
如Add、Mul等算子。BroadcastOpUT为这类算子提供了更加便利的接口，例如，创建
算子编译用例时，对于一些简单场景无需输入format等信息。

BroadcastOpUT 测试类定义
● 函数原型

BroadcastOpUT(op_type, op_module_name=None, op_func_name=None)
● 参数说明

– op_type: 算子的类型。

– op_module_name: 算子的module名称（即算子的实现文件名称和路径），
例如：impl.add （文件路径为：impl/add.py）。默认值为None，可根据
op_type自动生成，op_type到算子实现文件名称的转换规则可参见步骤4，例
如BiasAdd算子自动生成module名称"impl.bias_add"。

– op_func_name: 算子的接口名称，算子实现文件中的算子接口名。默认值为
None，可根据op_type自动生成，op_type到算子实现文件中接口名称的转换
规则可参见步骤4，例如Add算子，则需要在 impl/add.py 中存在add接口，
接口定义如下所示：
@check_op_params(REQUIRED_INPUT, REQUIRED_INPUT, REQUIRED_OUTPUT, KERNEL_NAME)
def add(input_x, input_y, output_z, kernel_name="add"):

add_broadcast_case 接口
● 函数原型

BroadcastOpUT.add_broadcast_case(self, soc, input_1_info, input_2_info,
output_info=None,expect=op_status.SUCCESS, case_name=None)

● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从“compiler/data/platform_config”目录下查看，对应“*.ini”文件的名字
即为可配置的昇腾AI处理器类型。support_soc支持的数据类型为str、tuple
或者list，tuple或者list表示可以支持多个SoC。若配置为“all”或者
“None”，表示支持所有的SoC。

– input_1_info：算子的第一个输入的信息，有两种形式：

▪ [dtype, shape, format, ori_shape, ori_format]

▪ [dtype, shape, format]：此种形式下，ori_shape与ori_format的取值与
shape、format的取值相同。

– input_2_info: 算子的第二个输入的信息，与input_1_info含义相同。

– output_info：默认为None，不需要填写。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

示例：
ut_case.add_broadcast_case("all", ["float16", (32, 32), "ND"], ["float16", (32, 32), "ND"])

ut_case.add_broadcast_case("all", ["float16", (32, 32), "ND", (32, 32), "ND"], ["float16", (32, 32), 
"ND", (32, 32), "ND"])
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# 期望异常的用例
ut_case.add_broadcast_case("all", ["float16", (31, 32), "ND"], ["float16", (32, 32), "ND"], 
expect=RuntimeError)

add_broadcast_case_simple 接口
● 函数原型

BroadcastOpUT.add_broadcast_case_simple(self, soc, dtypes, shape1,
shape2, expect=op_status.SUCCESS, case_name=None)

● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。此
接口较add_broadcast_case更加简化。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从Ascend-cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。若配置为“all”或者“None”，表示支持所有的
SoC。

– dtypes：需要测试的数据类型，填写多个数据，相当于一次添加了多个测试
用例。

– shape1: 算子的第一个输入的shape。

– shape2：算子的第二个输入的shape。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

此接口较add_broadcast_case接口，相当于将输入的所有format配置为“ND”。

示例：
ut_case.add_broadcast_case_simple(["Ascend910", "Ascend310"], ["float16", "float32"], (32, 32), (32, 
32))

以上用例与调用如下add_case接口的用例实现功能相同：
ut_case.add_case(support_soc=["Ascend910", "Ascend310"], case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }]
})

ut_case.add_case(support_soc=["Ascend910", "Ascend310"], case={
    "params": [{
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        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }]
})

7.7.6.3 ElementwiseOpUT

概述

ElementwiseOpUT继承了OpUT，包含了OpUT的能力。

ElementwiseOpUT主要供单输入单输出的Elementwise类型的算子进行测试用例的定
义，例如Abs, Square等算子。

ElementwiseOpUT为这类算子提供了更加便利的接口，例如，创建算子编译用例时，
对于一些简单场景无需输入format等信息。

ElementwiseOpUT 测试类定义
● 函数原型

ElementwiseOpUT(op_type, op_module_name=None,
op_func_name=None)

● 参数说明

– op_type: 算子的类型。

– op_module_name: 算子的module名称（即算子的实现文件名称和路径），
例如：impl.add （文件路径为：impl/add.py）。默认值为None，可根据
op_type自动生成，op_type到算子实现文件名称的转换规则可参见步骤4，例
如MaximumGrad算子自动生成module名称"impl.maximum_grad"。

– op_func_name: 算子的接口名称，算子实现文件中的算子接口名。默认值为
None，可根据op_type自动生成，op_type到算子实现文件中接口名称的转换
规则可参见步骤4，例如Add算子，则需要在 impl/add.py 中存在add接口，
接口定义如下所示：
@check_op_params(REQUIRED_INPUT, REQUIRED_INPUT, REQUIRED_OUTPUT, KERNEL_NAME)
def add(input_x, input_y, output_z, kernel_name="add"):

add_elewise_case 接口
● 函数原型

ElementwiseOpUT.add_elewise_case(self, soc, param_info,
expect=op_status.SUCCESS, case_name=None)

● 功能说明
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添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从Ascend-cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。若配置为“all”或者“None”，表示支持所有的
SoC。

– param_info：算子的输入信息，有两种形式：

▪ [dtype, shape, format, ori_shape, ori_format]

▪ [dtype, shape, format]：此种形式下，ori_shape与ori_format的取值与
shape、format的取值相同。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

示例：
ut_case.add_elewise_case("Ascend910", ["float16", (32, 32), "ND"])

以上用例与调用如下add_case接口的用例实现功能相同：
ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }]
})

add_elewise_case_simple 接口
● 函数原型

ElementwiseOpUT.add_elewise_case_simple(self, soc, dtypes, shape,
expect=op_status.SUCCESS, case_name=None)

● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从Ascend-cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。若配置为“all”或者“None”，表示支持所有的
SoC。

– dtypes：需要测试的数据类型，填写多个数据，相当于一次添加了多个测试
用例。
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– shape：算子输入的shape。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

此接口较add_elewise_case接口，相当于将输入的所有format配置为“ND”。

示例：
ut_case.add_elewise_case_simple("Ascend910", ["float16", "float32"], [32, 32])

以上用例与调用如下add_case接口的用例实现功能相同：
ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }]
})

ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }, {
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }]
})

7.7.6.4 ReduceOpUT

概述

ReduceOpUT继承了OpUT，包含了OpUT的能力。

ReduceOpUT主要供Reduce类型的算子进行测试用例的定义，例如ReduceSum,
ReduceMean等算子。ReduceOpUT为这类算子提供了更加便利的接口，例如，创建
算子编译用例时，对于一些简单场景无需输入format等信息。

ReduceOpUT 测试类定义
● 函数原型

ReduceOpUT(op_type, op_module_name=None, op_func_name=None)
● 参数说明

– op_type: 算子的类型。

– op_module_name: 算子的module名称（即算子的实现文件名称和路径），
例如：impl.add （文件路径为：impl/add.py）。默认值为None，可根据
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op_type自动生成，op_type到算子实现文件名称的转换规则可参见步骤4，例
如ReduceSum算子自动生成module名称"impl.reduce_sum"。

– op_func_name: 算子的接口名称，算子实现文件中的算子接口名。默认值为
None，可根据op_type自动生成，op_type到算子实现文件中接口名称的转换
规则可参见步骤4，例如Add算子，则需要在 impl/add.py 中存在add接口，
接口定义如下所示：
@check_op_params(REQUIRED_INPUT, REQUIRED_INPUT, REQUIRED_OUTPUT, KERNEL_NAME)
def add(input_x, input_y, output_z, kernel_name="add"):

add_reduce_case 接口

● 函数原型

ReduceOpUT.add_reduce_case(self, soc, input_info, axes, keep_dim=False,
expect=op_status.SUCCESS, case_name=None)

● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从Ascend-cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。若配置为“all”或者“None”，表示支持所有的
SoC。

– input_info：算子的输入信息，有两种形式：

▪ [dtype, shape, format, ori_shape, ori_format]

▪ [dtype, shape, format]：此种形式下，ori_shape与ori_format的取值与
shape、format的取值相同。

– axes: reduce的轴信息。

– keep_dims: 是否保持reduce的轴为1。True：是；False：否。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

示例：
ut_case.add_reduce_case("Ascend910", ["float16", (32, 32), "ND"], [0,], False)

以上用例与调用如下add_case接口的用例实现功能相同：
ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32,),
        "ori_shape": (32,),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, [0,], False]
})
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add_reduce_case_simple 接口
● 函数原型

ReduceOpUT.add_reduce_case_simple(self, soc, dtypes, shape, axes,
keep_dim=False, expect=op_status.SUCCESS, case_name=None)

● 功能说明

添加算子编译的测试用例，测试算子是否支持相关规格，编译出“.o”文件。

● 参数说明

– soc：测试该用例是否支持对应的昇腾AI处理器，昇腾AI处理器的取值范围可
从Ascend-cann-toolkit安装目录/ascend-toolkit/latest/compiler/data/
platform_config目录下查看，对应“*.ini”文件的名字即为可配置的昇腾AI
处理器类型。support_soc支持的数据类型为str、tuple或者list，tuple或者
list表示可以支持多个SoC。若配置为“all”或者“None”，表示支持所有的
SoC。

– dtypes：需要测试的数据类型，填写多个数据，相当于一次添加了多个测试
用例。

– shape：算子输入的shape。

– axes: reduce的轴信息。

– keep_dims: 是否保持reduce的轴为1。True：是；False：否。

– expect： 期望是否编译成功，默认为“op_status.SUCCESS”，当测试异常
场景时，期望的结果可配置为RuntimeError。

– case_name: 默认为None，测试框架会自动生成测试用例的名称。

此接口较add_reduce_case接口，相当于将输入的所有format配置为“ND”。

示例：
ut_case.add_reduce_case_simple("Ascend910", ["float16", "float32"], [32, 32], [1,], True)

以上用例与调用如下add_case接口的用例实现功能相同：
ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, {
        "shape": (32, 1),
        "ori_shape": (32, 1),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float16"
    }, [1,], True]
})

ut_case.add_case(support_soc="Ascend910", case={
    "params": [{
        "shape": (32, 32),
        "ori_shape": (32, 32),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
    }, {
        "shape": (32, 1),
        "ori_shape": (32, 1),
        "format": "ND",
        "ori_format": "ND",
        "dtype": "float32"
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    }, [1,], True]
})

7.7.7 ST 测试其他功能

其他功能扩展
● 支持Design和Text界面视图的切换

– 双击“testcases/st/OpType/{SoC Version}”或“testcases/st/OpType/
aicpu_kernel”文件夹下的算子测试用例定义文件或者右键该文件选择"
OpType_case_timestamp.json"，会打开下图界面，该界面中的Design和Text
均为json文件的一个视图。

– 在Design视图中的更改，若该视图不存在错误配置信息，切换到Text视图
时，更改会自动同步到Text视图中；同理，在Text视图中的更改，切换到
Design视图时，更改也会同步到Design视图中。

● 新增测试用例

在算子测试用例定义界面单击“Add”按钮，弹出如下图所示弹框，提示用户输
入“Case Name”。

“Case Name”为由数字、字母、下划线组成的字符串。

单击“OK”后，会在Design Cases页面的尾部新增创建好的Case，新增Case的各
个字段值为空，需要用户进行配置，配置规则可参见TBE算子测试用例定义文件
参数解释。

● 删除测试用例

在算子测试用例定义界面，单击相应Case右侧的 图标，即可删除该Case。
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● 复制和新增算子输入

在算子测试用例定义界面，单击相应Input[xx]右侧的 图标，即可复制该

Input[xx]成为新的Input[xx]。或者单击 新增算子输入。用户根据根据实际情
况进行修改参数项。

说明

如果算子ST工程支持动态多shape算子时，当复制x1的算子输入，此时“Name”参数应该
按照x10，x11，x12，...，的格式进行命名，当复制x2的算子输入，此时“Name”参数应
该按照x20，x21，x22，...，的格式进行命名。

● 删除算子输入

在算子测试用例定义界面，单击相应Input[xx]右侧的 图标，即可删除该
Input[xx]。

● 选择单个或多个测试用例运行

在算子测试用例定义界面，勾选其中一个或多个Case，单击“Run”，即可运行
选中的Case。
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● 支持修改和运行ST测试源码。

a. 源码生成

ST测试运行成功后，在./testcases/st/out/OpName/src目录中生成ST测试源
码。

b. 源码修改

用户根据需要可以修改源码内容，实现自定义需求及功能。

c. 源码运行

右键单击./testcases/st/out/<operator name>，选择“Run St Source”，即
可运行修改后的源码。

说明

若从其他入口运行ST测试，修改后的源码会被覆盖，请提前备份。

7.8 参考

7.8.1 IR 定义配置说明

● Excel文件配置参数说明

表 7-24 IR 原型定义参数说明

列名称 含义 是否必
选

Op 算子的Operator Type 是

Classify 算子相关参数的类别，包含：

● 输入：Input
● 动态输入：DYNAMIC_INPUT
● 输出：Output
● 动态输出：DYNAMIC_OUTPUT
● 属性：Attr

是

Name 算子参数的名称。 是
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列名称 含义 是否必
选

Type 算子参数的类型。

包含如下取值：

tensor、int、bool、float、ListInt、
ListFloat等

是

TypeRange 针对类型为tensor的参数，需要配置tensor
支持的类型。

包含如下取值：

fp16,fp32,double,int8,int16,int32,int64,ui
nt8,uint16,uint32,uint64,bool等。

框架为MindSpore时，需要将tensor的类型
值转换为MindSpore所支持的值：

I8_Default,I16_Default,I32_Default,I64_D
efault,U8_Default,U16_Default,U32_Defa
ult,U64_Default,BOOL_Default等。

否

Required 是否必须输入，有如下取值：

● TRUE
● FALSE

是

Doc 对应参数的描述。 否

Attr_Default_value 属性的默认值。 否

Format 针对类型为tensor的参数，配置为tensor支
持的数据排布格式。

包含如下取值：

ND,NHWC,NCHW,HWCN,NC1HWC0,FRA
CTAL_Z等

否

 
● json IR 文件配置参数说明

创建算子工程的json IR 文件配置请参见表7-25。

表 7-25 json 文件配置参数说明

配置字段 类型 含义 是否必选

Op Type - 字符
串

算子的Operator
Type

是

Input[xx] - 列表 输入参数描述 否

Name 字符
串

算子输入参数的名
称。

是
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配置字段 类型 含义 是否必选

Format 字符
串或
列表

针对类型为tensor的
参数，配置为tensor
支持的数据排布格
式。如果tensor支持
多个数据排布格式，
请使用列表。例如
["ND","NHWC"]。
包含如下取值：

ND,NHWC,NCHW,H
WCN,NC1HWC0,FR
ACTAL_Z等。

否

Type 字符
串或
列表

针对类型为tensor的
参数，配置为tensor
支持的数据排布格
式。

包含如下取值：

ND,NHWC,NCHW,H
WCN,NC1HWC0,FR
ACTAL_Z等。

若为MindStudio框架
包含如下取值：

I8_Default,I16_Defa
ult,I32_Default,I64_
Default,U8_Default,
U16_Default,U32_D
efault,U64_Default,
BOOL_Default等。

是

Param Type - 参数类型：

● Required
● Optional
● Dynamic
未配置默认为
Required。

是

Output[x
x]

- 列表 输出参数描述。 是

Name 字符
串

算子输出参数的名
称。

是
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配置字段 类型 含义 是否必选

Format 字符
串或
列表

针对类型为tensor的
参数，配置为tensor
支持的数据排布格
式。

包含如下取值：

ND,NHWC,NCHW,H
WCN,NC1HWC0,FR
ACTAL_Z等。

否

Type 字符
串或
列表

针对类型为tensor的
参数，配置为tensor
支持的数据排布格
式。

包含如下取值：

ND,NHWC,NCHW,H
WCN,NC1HWC0,FR
ACTAL_Z等。

若为MindStudio框架
包含如下取值：

I8_Default,I16_Defa
ult,I32_Default,I64_
Default,U8_Default,
U16_Default,U32_D
efault,U64_Default,
BOOL_Default等。

是

Param Type - 参数类型：

● Required
● Optional
● Dynamic
未配置默认为
Required

是

Attribute[
xx]

- 列表 属性描述 否

Name 字符
串

算子属性参数的名
称。

是
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配置字段 类型 含义 是否必选

Type 字符
串或
列表

算子参数的类型。

包含如下取值：

int、bool、float、
string、list_int、
list_float等。

若为MindStudio框架
包含如下取值：

I8_Default,I16_Defa
ult,I32_Default,I64_
Default,U8_Default,
U16_Default,U32_D
efault,U64_Default,
BOOL_Default等

是

Default
Value

- 默认值 否

Param Type - 参数类型：

● Required
● Optional
未配置默认为
Required。

是

 

说明

IR Template可以配置多个算子。点击Add按钮增加算子

● 若存在Op Type同名算子，会以后一算子创建算子工程。

● 若Input[xx]或Output[xx]中的Name参数相同，则后一个会覆盖前一参数。

● Input[xx]，Output[xx]中的Type与Format需一一对应匹配，如果没有配置Format，自
动以“ND”按Type的个数一一对应补齐

示例：

Op Type - Reshape

Input[01] - -

Name x

Format ["ND"]

Type ["float","fp16","
double","int8","i
nt16","uint8","u
int32","uint16",
"uint64"]

Param Type Required
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Input[02] - -

Name shape

Format -

Type ["int32","int64"
]

Param Type Optional

Output[01] - -

Name y

Format ["ND"]

Type ["float","fp16","
double","int8","i
nt16","uint8","u
int32","uint16",
"uint64"]

Param Type Dynamic

Attribute[01] - -

Name axis

Type int

Default Value 0

Param Type Optional

Attribute[02] - -

Name num_axes

Type int

Default Value -1

Param Type Optional

 

7.8.2 TBE 算子测试用例定义文件参数解释

表 7-26 算子测试用例定义 json 文件

参数 说明

Test_xxx_xx - 必选。string类型。

测试用例的名称。
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参数 说明

Input[xx] - 必选。

算子的输入。

须知
一个算子所有Input中参数取值的个数都要一致，否
则测试用例生成会失败。

例如：Input[01]的format支持的类型个数2，则
Input[02]的format支持的类型个数也需要为2。

同理，所有Input[xx]中的type、shape、
data_distribute和value_range的取值个数也需要保
持一致。

- Name 算子输入的名称，string类型。
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参数 说明

- Format 必选。

String或者String的一维数组。

输入tensor数据的排布格式，不允许为空。

支持如下数据排布格式：

● NCHW
● NHWC
● ND：表示支持任意格式。

● NC1HWC0：华为自研的5维数据格式。其
中，C0与微架构强相关，该值等于cube单元
的size，例如16；C1是将C维度按照C0切
分：C1=C/C0， 若结果不整除， 后一份数
据需要padding到C0。

● FRACTAL_Z：卷积的权重的格式。

● FRACTAL_NZ：华为自研的分形格式，在
cube单元计算时，输出矩阵的数据格式为
NW1H1H0W0。整个矩阵被分为
（H1*W1）个分形，按照column major排
布，形状如N字形；每个分形内部有
（H0*W0）个元素，按照row major排布，
形状如z字形。考虑到数据排布格式，将
NW1H1H0W0数据格式称为Nz格式。其
中，H0,W0表示一个分形的大小，示意图如
下所示：

● RESERVED：预留，当Format配置为该值，
则type必须配置为“UNDEFINED”，代表
算子的此输入可选。

- OriginFormat 可选。Tensor的原始format。
不带此字段时，默认Tensor的实现format与原
始format一致。
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参数 说明

- ShapeRange 可选。Shape为动态时，unknow shape的取值
范围。默认为[1, -1]。
例如，若Shape取值为[16, -1, 16, -1]，其中
的-1表示unknow shape。ShapeRange取值为
[[1, 128], [1, -1]]，[1, 128]表示Shape中第一
个-1取值范围为1到128，[1, -1]表示Shape中
第二个-1的取值范围为1到无穷大。

- TypicalShape 固定shape，用来生成可用的测试数据。

- Type 必选。

String或者String的一维数组。

输入数据支持的数据类型。

● bool
● int8
● uint8
● int16
● uint16
● int32
● int64
● uint32
● uint64
● float16
● float
● UNDEFINED：表示输入类型为可选。

- Shape 必选。

int类型，一维或者二维数组。

输入tensor支持的形状。

例如：

[8, 3, 256, 256]或[[1, 3, 256, 256], [8, 3, 256,
256]]。
若输入非法的形状会报错，例如：[0]。

- OriginShape 可选。Tensor的原始shape。

不带此字段时，默认Tensor的实现shape与原始
shape一致。

- ValueRange 必选。

int类型或者float类型，一维或者二维数组。

取值范围，不能为空。

为[min_value, max_value]且min_value
<=max_value。
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参数 说明

- DataDistribute 必选。

String或者String的一维数组。

使用哪种数据分布方式生成测试数据，支持的
分布方式有：

● uniform：返回均 分布随机值

● normal：返回正态分布（高斯分布）随机值

● beta：返回Beta分布随机值

● laplace：返回拉普拉斯分布随机值

● triangular：返回三角形分布随机值

● relu：返回均 分布+Relu激活后的随机值

● sigmoid：返回均 分布 + sigmoid激活后的
随机值

● softmax：返回均 分布 + softmax激活后
的随机值

● tanh：返回均 分布 + tanh激活后的随机
值

- Value 可选。

路径String或者Tensor数组。

若用户需要指定输入数据时，可通过增加
“Value”字段进行配置。有如下两种配置方
式：

● 直接输入tensor数据，如tensor的值为
[1,2,3,4]。
"Value": [1,2,3,4]

● 输入二进制数据文件的路径，如数据文件为
test.bin时。
"Value": "home/HiHwAiUser/projects/
test.bin"

二进制数据bin文件需用户自己准备。可以输入
绝对路径。

若用户添加了“Value”字段，
“DataDistribute”和“ValueRange”字段将
会被隐藏。同时需要保证“Format”,"Type"，
"Shape"字段的值与“Value”数据一致。

- isConst 可选。

bool类型，默认为false。

● true：若用户需要配置常量输入的用例，则
配置该字段，并且其值为true。

● false：若该字段值为false，则需要配置张量
输入用例。
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参数 说明

Output[xx] - 必选。

算子输出。

须知
Output中参数取值的个数都要与Input一致，否则测
试用例生成会失败。

例如：Input的format支持的类型个数2，则Output
的format支持的类型个数也需要为2。

- Format 必选。

String或者String的一维数组。

输出tensor数据的排布格式，不允许为空。

支持如下数据排布格式：

● NCHW
● NHWC
● ND：表示支持任意格式。

● NC1HWC0：华为自研的5维数据格式。其
中，C0与微架构强相关，该值等于cube单元
的size，例如16；C1是将C维度按照C0切
分：C1=C/C0， 若结果不整除， 后一份数
据需要padding到C0。

● FRACTAL_Z：卷积的权重的格式。

● FRACTAL_NZ：华为自研的分形格式，在
cube单元计算时，输出矩阵的数据格式为
NW1H1H0W0。整个矩阵被分为
（H1*W1）个分形，按照column major排
布，形状如N字形；每个分形内部有
（H0*W0）个元素，按照row major排布，
形状如z字形。考虑到数据排布格式，将
NW1H1H0W0数据格式称为Nz格式。其
中，H0,W0表示一个分形的大小，示意图如
下所示：

- OriginFormat 可选。Tensor的原始format。
不带此字段时，默认Tensor的实现format与原
始format一致。
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参数 说明

- Type 必选。

String或者String的一维数组。

输出数据支持的数据类型：

● bool
● int8
● uint8
● int16
● uint16
● int32
● int64
● uint32
● uint64
● float16
● float

- Shape 必选。

int类型，一维或者二维数组。

输入tensor支持的形状。

例如：

[8, 3, 256, 256]或[[1, 3, 256, 256], [8, 3, 256,
256]]。
若输入非法的形状会报错，例如：[0]。

- OriginShape 可选。Tensor的原始shape。

不带此字段时，默认Tensor的实现shape与原始
shape一致。

Attr - 可选。

- Name 若配置attr，则为必选。

string类型。

属性的名称，不为空。
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参数 说明

- Type 若配置attr，则为必选属性支持的类型。

string类型。

输出数据支持的数据类型：

● bool
● int
● float
● string
● list_bool
● list_int
● list_float
● list_string
● list_list_int

- Value 若配置attr，则为必选，且不允许为null。
string类型。

属性值，根据type的不同，属性值不同。

● bool: true/false
● int: 10
● float: 1.0
● string: “NCHW”

● list_bool: [false, true]
● list_int: [1, 224, 224, 3]
● list_float: [1.0, 0.0]
● list_string: [“str1”, “str2”]
● list_list_int: [[1, 3, 5, 7], [2, 4, 6, 8]]

Expected Result
Verification

- 可选。

- Script Path 可选。

路径String类型。

算子期望数据生成函数路径。

- Script Function 可选。

String类型。

算子期望数据生成函数名称。

K-Level Test Cases - 可选。
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参数 说明

- Fuzz Script Path 可选。

路径String类型。

fuzz生成测试参数的脚本路径的绝对路径或者
相对路径。

- Fuzz Case Num 可选。

int类型。

利用fuzz脚本生成测试用例数量，范围为
1-2000。

- Fuzz Function 可选。

String类型。

fuzz脚本中生成fuzz输入的函数名，默认为：
“fuzz_branch”。

 

说明

● 当算子信息定义文件（*.ini）中inputx.paramType=optional时，生成的算子测试用例中
inputx的"format"需配置为"UNDEFINED"或"RESERVED"，"type"为"UNDEFINED"。

● 若配置的Shape某个维度为-1或者Shape为[-2]时(某维度为-1，如[200, -1] 说明第二个轴长
度未知， [-2]场景表示维度未知），生成的算子测试用例中新增ShapeRange字段和
TypicalShape字段。ShapeRange字段值为: [[1,-1]]，表示Shape字段可以取任何值。用户
需要在TypicalShape字段给出固定shape值，用于实际测试。

● 算子信息定义文件（*.ini）Tensor的实现format中包含华为自研数据格式，且Tensor的实现
format与原始format不同时，用户需在"OriginFormat"和"OriginShape"中填入原始format
和shape，将OriginFormat与OriginShape转成离线模型需要的format与shape。

● "OriginFormat"输入为原始算子支持的数据格式，个数必须与"Format"个数保持一
致。

● "OriginShape"的输入值必须与"Shape"一一对应，且与"Format"和"OriginFormat"格
式相匹配。

● Input[xx]、Output[xx]、Attr中除了name和Attr的Type以外的所有参数均支持fuzz输入。

7.8.3 AI CPU 算子测试用例定义文件参数解释

表 7-27 算子测试用例定义 json 文件

参数 说明

Test_xxx_xx - 必选。string类型。

测试用例的名称。
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参数 说明

Input[xx] - 必选。

算子的输入。

须知
一个算子所有Input中参数取值的个数都要
一致，否则测试用例生成会失败。

例如：Input[01]的format支持的类型个数
2，则Input[02]的format支持的类型个数
也需要为2。

同理，所有Input[xx]中的type、shape、
data_distribute和value_range的取值个数
也需要保持一致。
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参数 说明

- Format 必选。

String或者String的一维数组。

输入tensor数据的排布格式，不允许为
空。

支持如下数据排布格式：

● NCHW
● NHWC
● ND：表示支持任意格式。

● NC1HWC0：华为自研的5维数据格
式。其中，C0与微架构强相关，该
值等于cube单元的size，例如16；
C1是将C维度按照C0切分：
C1=C/C0， 若结果不整除， 后一
份数据需要padding到C0。

● FRACTAL_Z：卷积的权重的格式。

● FRACTAL_NZ：华为自研的分形格
式，在cube单元计算时，输出矩阵
的数据格式为NW1H1H0W0。整个
矩阵被分为（H1*W1）个分形，按
照column major排布，形状如N字
形；每个分形内部有（H0*W0）个
元素，按照row major排布，形状
如z字形。考虑到数据排布格式，将
NW1H1H0W0数据格式称为Nz格
式。其中，H0,W0表示一个分形的
大小，示意图如下所示：

● RESERVED：预留，当Format配置
为该值，则type必须配置为
“UNDEFINED”，代表算子的此
输入可选。

- OriginFormat 可选。Tensor的原始format。
不带此字段时，默认Tensor的实现
format与原始format一致。
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参数 说明

- Type 必选。

String或者String的一维数组。

输入数据支持的数据类型。

● bool
● int8
● uint8
● int16
● uint16
● int32
● int64
● uint32
● uint64
● float16
● float
● UNDEFINED：当输入类型为可选

时。

- Shape 必选。

int类型，一维或者二维数组。

输入tensor支持的形状。

例如：

[8, 3, 256, 256]或[[1, 3, 256, 256],
[8, 3, 256, 256]]。
若输入非法的形状会报错，例如：
[0]。

- OriginShape 可选。Tensor的原始shape。

不带此字段时，默认Tensor的实现
shape与原始shape一致。

- ValueRange 必选。

int类型或者float类型，一维或者二维
数组。

取值范围，不能为空。

为[min_value, max_value]且
min_value <=max_value。
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参数 说明

- DataDistribute 必选。

String或者String的一维数组。

使用哪种数据分布方式生成测试数
据，支持的分布方式有：

● uniform：返回均 分布随机值

● normal：返回正态分布（高斯分
布）随机值

● beta：返回Beta分布随机值

● laplace：返回拉普拉斯分布随机值

● triangular：返回三角形分布随机值

● relu：返回均 分布+Relu激活后的
随机值

● sigmoid：返回均 分布 + sigmoid
激活后的随机值

● softmax：返回均 分布 + softmax
激活后的随机值

● tanh：返回均 分布 + tanh激活后
的随机值

- Value 可选。

路径String或者Tensor数组。

若用户需要指定输入数据时，可通过
增加“Value”字段进行配置。有如下
两种配置方式：

直接输入tensor数据，如tensor的值为
[1,2,3,4]。
"Value": [1,2,3,4]
输入二进制数据文件的路径，如数据
文件为test.bin时。

"Value": "home/HiHwAiUser/
projects/test.bin"
二进制数据bin文件需用户自己准备。
可以输入绝对路径。若用户添加了
“Value”字段，“DataDistribute”
和“ValueRange”字段将会被隐藏。
同时需要保证“Format”,"Type"，
"Shape"字段的值与“Value”数据一
致。
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参数 说明

Output[xx] - 必选。

算子输出。

须知
Output中参数取值的个数都要与Input一
致，否则测试用例生成会失败。

例如：Input的format支持的类型个数2，
则Output的format支持的类型个数也需要
为2。

- Format 必选。

String或者String的一维数组。

输出tensor数据的排布格式，不允许为
空。

支持如下数据排布格式：

● NCHW
● NHWC
● ND：表示支持任意格式。

● NC1HWC0：华为自研的5维数据格
式。其中，C0与微架构强相关，该
值等于cube单元的size，例如16；
C1是将C维度按照C0切分：
C1=C/C0， 若结果不整除， 后一
份数据需要padding到C0。

● FRACTAL_Z：卷积的权重的格式。

● FRACTAL_NZ：华为自研的分形格
式，在cube单元计算时，输出矩阵
的数据格式为NW1H1H0W0。整个
矩阵被分为（H1*W1）个分形，按
照column major排布，形状如N字
形；每个分形内部有（H0*W0）个
元素，按照row major排布，形状
如z字形。考虑到数据排布格式，将
NW1H1H0W0数据格式称为Nz格
式。其中，H0,W0表示一个分形的
大小，示意图如下所示：
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参数 说明

- OriginFormat 可选。Tensor的原始format。
不带此字段时，默认Tensor的实现
format与原始format一致。

- Type 必选。

String或者String的一维数组。

输出数据支持的数据类型：

● bool
● int8
● uint8
● int16
● uint16
● int32
● int64
● uint32
● uint64
● float16
● float

- Shape 必选。

int类型，一维或者二维数组。

输入tensor支持的形状。

例如：

[8, 3, 256, 256]或[[1, 3, 256, 256],
[8, 3, 256, 256]]。
若输入非法的形状会报错，例如：
[0]。

- OriginShape 可选。Tensor的原始shape。

不带此字段时，默认Tensor的实现
shape与原始shape一致。

Attr - 可选。

- Name 若配置attr，则为必选。

string类型。

属性的名称，不为空。
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参数 说明

- Type 若配置attr，则为必选属性支持的类
型。

string类型。

输出数据支持的数据类型：

● bool
● int
● float
● string
● list_bool
● list_int
● list_float
● list_string
● list_list_int

- Value 若配置attr，则为必选，且不允许为
null。
string类型。

属性值，根据type的不同，属性值不
同。

● bool: true/false
● int: 10
● float: 1.0
● string: “NCHW”

● list_bool: [false, true]
● list_int: [1, 224, 224, 3]
● list_float: [1.0, 0.0]
● list_string: [“str1”, “str2”]
● list_list_int: [[1, 3, 5, 7], [2, 4, 6,

8]]

Expected Result
Verification

- 可选。

- Script Path 算子期望数据生成函数路径。

- Script Function 算子期望数据生成函数名称。

K-Level Test Cases - 可选。

- Fuzz Script Path 可选。

路径String类型。

fuzz生成测试参数的脚本路径的绝对
路径或者相对路径。
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参数 说明

- Fuzz Case Num 可选。

int类型。

利用fuzz脚本生成测试用例数量，范
围为1-2000。

- Fuzz Function 可选。

String类型。

fuzz脚本中生成fuzz输入的函数名，默
认为：“fuzz_branch”。

 

说明

● 当算子信息定义文件（*.ini）中inputx.paramType=optional时，生成的算子测试用例中
inputx的"format"需配置为"UNDEFINED"或"RESERVED"，"type"为"UNDEFINED"。

● 算子信息定义文件（*.ini）Tensor的实现format中包含华为自研数据格式，且Tensor的实现
format与原始format不同时，用户需在"OriginFormat"和"OriginShape"中填入原始format
和shape，将OriginFormat与OriginShape转成离线模型需要的format与shape。

● "OriginFormat"输入为原始算子支持的数据格式，个数必须与"Format"个数保持一
致。

● "OriginShape"的输入值必须与"Shape"一一对应，且与"Format"和"OriginFormat"格
式相匹配。

● Input[xx]、Output[xx]、Attr中除了name和Attr的Type以外的所有参数均支持fuzz输入。
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8 精度比对

8.1 简介

8.2 环境准备

8.3 约束说明

8.4 比对数据准备

8.5 Vector比对

8.6 FAQ

8.1 简介
自有实现的算子在昇腾AI处理器上的运算结果与业界标准算子（如Caffe、ONNX、
TensorFlow、PyTorch）的运算结果可能存在差异：

● 在模型转换过程中对模型进行了优化，包括算子消除、算子融合、算子拆分，这
些动作可能会造成自有实现的算子运算结果与业界标准算子（如Caffe、
TensorFlow、ONNX）运算结果存在偏差。

● 用户原始网络可以迁移到昇腾910 AI处理器上执行训练，网络迁移可能会造成自
有实现的算子运算结果与用业界标准算子（如TensorFlow、PyTorch）运算结果存
在偏差。

为了帮助开发人员快速解决算子精度问题，需要提供比对自有实现的算子运算结果与
业界标准算子运算结果之间差距的工具。

精度比对工具提供Vector比对能力，包含余弦相似度、 大绝对误差、累积相对误
差、欧氏相对距离、KL散度、标准差、平均绝对误差、均方根误差、 大相对误差、
平均相对误差的算法比对维度。

8.2 环境准备
● 请参见《CANN 软件安装指南》手册完成开发或运行环境搭建。

● Python版本支持情况请参见《CANN 软件安装指南》中的“安装开发环境>安装
OS依赖>依赖列表”章节。

MindStudio
用户指南 8 精度比对

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 327

https://www.hiascend.com/document/detail/zh/canncommercial/51RC1/envdeployment/instg/instg_000002.html
https://www.hiascend.com/document/detail/zh/canncommercial/51RC1/envdeployment/instg/instg_000002.html


8.3 约束说明
● 精度比对功能不支持打开多个工程同时进行比对，可以先完成一个比对程序后再

进行下一个。

● 精度比对支持的dump数据的类型：

– FLOAT

– FLOAT16

– DT_INT8

– DT_UINT8

– DT_INT16

– DT_UINT16

– DT_INT32

– DT_INT64

– DT_UINT32

– DT_UINT64

– DT_BOOL

– DT_DOUBLE

8.4 比对数据准备

8.4.1 数据格式要求

当前版本支持多种比对方式，因此dump、npy数据文件命名需满足以下要求：

表 8-1 数据文件命名规则

数据类型 数据命名格式 备注

非量化离线模型在昇腾
AI处理器上运行生成的
dump数据

{op_type}.{op_name}.
{task_id}.{stream_id}.
{timestamp}

命名格式说明：op_type、
op_name对应的名称需满
足“A-Za-z0-9_-”正则表
达式规则，timestamp为
16位时间戳，
output_index、task_id、
stream_id为0~9数字组
成。

量化离线模型在昇腾AI
处理器上运行生成的
dump数据

npy数据（Caffe、
TensorFlow或ONNX）

{op_name}.
{output_index}.
{timestamp}.npy

 

8.4.2 推理场景数据准备
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8.4.2.1 准备离线模型 dump 数据

本节介绍通过MindStudio提供的dump功能，生成离线模型的dump数据。启动dump
前，需要完成应用工程的开发、编译和运行，确保具备可执行的应用工程。

您可以参考以下步骤生成dump数据：

步骤1 打开MindStudio，选择“Ascend > Dump Configuration”菜单，弹出“Select
Offline Model”窗口，如图8-1所示。

说明

您也可以通过打开工程文件，然后右键单击.om模型文件，选择“Dump Configuration”菜单
的方式配置dump。

图 8-1 选择.om 模型文件

步骤2 选择.om模型文件，单击“OK”，展示模型文件结构，设置dump开关。如图8-2所
示。

MindStudio
用户指南 8 精度比对

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 329



说明

● 如果涉及多个模型需要dump数据，则需要分别设置各个模型文件的dump配置项。

● 当使用相同系列网络模型时，可能会存在因模型的Model Name值相同，造成生成的acl.json
文件中dump配置混淆。

例如，先使用yolov2进行了dump配置，然后又使用yolov3，此时虽然未对yolov3配置，但
acl.json文件中已经记录了yolov2的dump配置，又因为yolov2与yolov3的Model Name值相
同，这样就会出现yolov3继承了yolov2的配置。

因此，当存在因使用相同系列网络模型造成Model Name相同时，可以通过修改Caffe模型文
件prototxt中的name字段值并重新进行模型转换，使得系列模型的name字段值不同；也可
以在dump配置时先选择None进行清理之前的配置，再次重新进行dump配置。

图 8-2 设置 dump

通过窗口右侧配置项，设置.om模型文件的dump配置项。

● Dump Option：配置dump范围。

– ALL：所有算子开启dump。

说明

不具有输出的TBE算子、AI CPU算子，如StreamActive、NetOutput、Send、Recv、
const等不会生成dump数据。

– Several：自定义部分算子开启dump。

选择该项后，需要右键单击待dump数据的算子并选择“Enable Dump”。
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说明

▪ 对于关联的算子需要同时开启或关闭dump：通过ATC解析om模型文件得到算子
之间的映射关系，识别出是新增算子、一对多、多对一、多对多、L1 Batch等关
系。

▪ const算子不支持开启dump。

▪ 采用dump部分算子场景下，因data算子不会在AI CPU或AI Core上执行，如果用
户dump data节点算子，需要一并选择dump data节点算子的后继节点，才能
dump出data节点算子数据。

▪ 不具有输出的TBE算子、AI CPU算子，如StreamActive、Send、Recv、const等不
会生成dump数据；编译后的模型中部分算子并不会在AI CPU或AI Core执行，如
concatD类型算子，则无法生成dump数据。

– None：所有算子不开启dump。

● Dump Mode：dump数据模式。

– Input：dump算子的输入数据。

– Output：dump算子的输出数据。

– All：同时dump算子的输入、输出数据。

● Dump Path：配置保存dump数据文件的路径，默认为：{project_path}/dump。
如果Dump Path设置为其他路径，需要确保MindStudio安装用户对该路径具有读
写权限。

● AclConfig File：Acl配置文件，在dump操作中该文件保存算子的dump配置信
息。一般路径为{project_path}/src/acl.json，实际路径可以在
{project_path}/.project文件中查找。格式如图8-3或图8-4所示。当选择整个模型
dump时，不含layer字段。

图 8-3 整网所有算子开启 dump
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图 8-4 部分算子开启 dump

步骤3 设置dump完成后，分别单击MindStudio界面“Build”和“Run”菜单，重新编译和
运行应用工程。

说明

建议先检查工程文件代码，确保正确引用了设置dump配置的.om模型文件。例如检查
aclmdlLoadFromFile()函数或aclmdlLoadFromFileWithMem()函数。

工程运行完毕后，可以在{project_path}/dump路径下查看到生成的dump数据文件。
生成的路径及格式说明：

time/device_id/model_name/model_id/data_index/dump文件

● time：dump数据回传落盘时间。格式为：YYYYMMDDhhmmss。

● device_id：Device设备ID号。

● model_name：模型名称。

● model_id：模型ID号。

● data_index：针对每个Task ID执行的次数维护一个序号，从0开始计数，该Task
每dump一次数据，序号递增1。

● dump文件：命名规则如{op_type}.{op_name}.{taskid}.{timestamp}。

如果model_name、op_type、op_name出现了“.”、“/”、“\”、空格时，转换为
下划线表示。

----结束

8.4.2.2 准备 Caffe 模型 npy 数据文件

本版本不提供Caffe模型npy数据生成功能，请自行安装Caffe环境并提前准备Caffe原
始数据“*.npy”文件。本文仅提供生成符合精度比对要求的numpy格式Caffe原始数据
“*.npy”文件的样例参考。
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说明

● 如何准备原始caffe模型npy数据，您可以参考论坛发帖算子精度比对工具标杆数据生成环境
搭建指导（Caffe + TensorFlow）或者自行获取其他方法。该贴仅供参考。

● 如果您需要使用二进制格式dump文件进行比对，请参考如何进行dump数据文件与numpy
文件格式互转完成npy文件转换成dump文件。

Caffe原始数据文件要求：

● 文件内容以 numpy格式保存。

● 文件命名以{op_name}.{output_index}.{timestamp}.npy形式命名。设置numpy
数据文件名包括output_index字段且值为0，确保转换生成的dump数据的
output_index为0。因为，精度比对时默认从第一个output_index为0的数据开
始，否则无比对结果。

● 为确保生成符合命名要求的.npy文件，需要对原始的Caffe模型文件去除in-
place，生成新的.prototxt模型文件用于生成.npy文件（例如：如果有未去除in-
place的A、B、C、D四个融合算子，进行dump数据，输出的结果为D算子的结
果，但命名却是A算子开头，就会导致比对时找不到文件）。针对量化场景，需要
先在环境上安装昇腾模型压缩工具再执行去除in-place命令，安装方法请参考
《AMCT工具（Caffe）》。

进入Ascend-cann-toolkit安装目录/ascend-toolkit/latest/toolkit/tools/
operator_cmp/compare目录，执行命令去除in-place，命令行举例如下：

python3 inplace_layer_process.pyc -i /home/HwHiAiUser/
resnet50.prototxt
执行命令后，在/home/HwHiAiUser目录下生成去除in-place的
new_resnet50.prototxt文件。

● 针对量化场景：为确保精度误差，需要执行Caffe模型推理时预处理数据与Caffe
模型小型化时预处理数据一致。

为输出符合精度比对要求的“*.npy”数据文件，需在推理结束后的代码中增加以下类
似代码：

    #read prototxt file
    net_param = caffe_pb2.NetParameter()        
    with open(self.model_file_path, 'rb') as model_file:
        google.protobuf.text_format.Parse(model_file.read(), net_param)

        # save data to numpy file
        for layer in net_param.layer: 
            name = layer.name.replace("/", "_").replace(".", "_")
            index = 0
            for top in layer.top: 
                data = net.blobs[top].data[...]
                file_name = name + "." + str(index) + "." + str( 
                    round(time.time() * 1000000)) + ".npy"
                output_dump_path = os.path.join(self.output_path, file_name)
                np.save(output_dump_path, data)
                os.chmod(output_dump_path, FILE_PERMISSION_FLAG)
                print('The dump data of "' + layer.name
                      + '" has been saved to "' + output_dump_path + '".')
                index += 1

增加上述代码后，运行Caffe模型的应用工程，即可生成符合要求的“*.npy”数据文
件。
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8.4.2.3 准备 TensorFlow 模型 npy 数据文件

本版本不提供TensorFlow模型npy数据生成功能，请自行安装TensorFlow环境并提前
准备npy数据。本文仅提供生成numpy格式TensorFlow原始数据“*.npy”文件的样例
参考。

说明

如果您需要使用二进制格式dump文件进行比对，请参考如何进行dump数据文件与numpy文件
格式互转完成npy文件转换成dump文件。

在进行TensorFlow模型生成npy数据前，您需要已经有一套完整的、可执行的、标准的
TensorFlow模型应用工程。然后利用TensorFlow官方提供的debug工具tfdbg调试程
序，从而生成npy文件。主要操作示例如下，请根据自己的应用工程适配操作：

步骤1 修改TensorFlow推理脚本，添加debug选项设置。代码中增加如下代码：

estimator模式：

from tensorflow.python import debug as tf_debug

training_hooks = [train_helper.PrefillStagingAreaHook(),
tf_debug.LocalCLIDebugHook()]

session.run模式：

from tensorflow.python import debug as tf_debug

sess = tf_debug.LocalCLIDebugWrapperSession(sess, ui_type="readline")
● Estimator模式，如图8-5所示示例，添加tfdbg的hook。

图 8-5 Estimator 模式

● Session.run模式，如图8-6所示示例，在run之前设置tfdbg装饰器。
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图 8-6 Session.run 模式

步骤2 执行运行脚本。

进入调试命令行交互模式后，输入run命令。

步骤3 收集npy文件。

执行run命令完成后，在命令行交互界面，可以通过lt查询已存储的张量，通过pt可以
查看已存储的张量内容，可以保存数据为numpy格式文件。

因为tfdbg一次命令只能dump一个tensor，为了自动生成收集所有数据，可以按以下
几个步骤操作：

1. 执行lt > tensor_name将所有tensor的名称暂存到文件里。

2. 退出tfdbg命令行，在linux命令行下执行下述命令，用以生成在tfdbg命令行执行
的命令。

timestamp=$[$(date +%s%N)/1000] ; cat tensor_name | awk '{print "pt",
$4,$4}' | awk '{gsub("/", "_", $3);gsub(":", ".", $3);print($1,$2,"-n 0 -w
"$3".""'$timestamp'"".npy")}'

说明

● 该示例生成符合精度比对需要的npy文件名称格式。其中，tensor_name为自定义tensor列表
对应的文件名，timestamp需满足[0-9]{1,255}正则表达式。

● 本步骤也可以不退出tfdbg命令行，重新开启一个命令窗口，在新的窗口中执行。

3. 回到tfdbg命令行，输入run执行脚本后，将上一步生成的所有tensor存储的命令
粘贴执行，即可存储所有npy文件。

npy文件默认是以numpy.save()形式存储的，上述命令会将“/与:”用下划线_替
换。

说明

如果命令行界面无法粘贴文件内容，可以在tfdbg命令行中输入“mouse off”指令关闭鼠
标模式后再进行粘贴。
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4. 检查生成的npy文件命名是否符合规则，如图8-7所示。

说明

– npy文件命名规则：{op_name}.{output_index}.{timestamp}.npy，其中op_name字段
需满足“A-Za-z0-9_-”正则表达式规则，timestamp需满足[0-9]{1,255}正则表达式，
output_index为0~9数字组成。

– 如果因算子名较长，造成按命名规则生成的npy文件名超过255字符而产生文件名异
常，这类算子不支持精度比对。

– 因tfdbg自身原因或运行环境原因，可能存在部分生成的npy文件名不符合精度比对要
求，请按命名规则手工重命名。如果不符合要求的npy文件较多，请参考如何批量处理
生成的npy文件名异常情况重新生成npy文件。

图 8-7 查询.npy 文件

----结束

8.4.2.4 准备 ONNX 模型 npy 数据文件

本版本不提供ONNX模型npy数据生成功能，请自行安装ONNX环境并提前准备ONNX
原始数据“*.npy”文件。本文仅提供生成符合精度比对要求的numpy格式ONNX原始
数据“*.npy”文件的样例参考。

ONNX 原始数据文件准备要求
● 文件内容以 numpy格式保存。

● 文件命名以{op_name}.{output_index}.{timestamp}.npy形式命名。设置numpy
数据文件名包括output_index字段且值为0，确保转换生成的dump数据的
output_index为0。因为，精度比对时默认从第一个output_index为0的数据开
始，否则无比对结果。

● 需要确保每个算子节点有名称，否则无法生成正确的文件名。没有名称的算子节
点需要先生成名称。

● 本参考示例以每个节点只有一个输出为例，多个输出的需要在文件名生成处适配
output_index的获取。

代码参考示例

为输出符合精度比对要求的“*.npy”数据文件，需在推理结束后的代码中增加以下类
似代码：

import onnx
import onnxruntime
import numpy as np
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import time

from skl2onnx.helpers.onnx_helper import enumerate_model_node_outputs
from skl2onnx.helpers.onnx_helper import select_model_inputs_outputs
from skl2onnx.helpers.onnx_helper import save_onnx_model

#修改模型，增加输出节点
model_onnx = onnx.load("./resnet50.onnx")
output = []
for out in enumerate_model_node_outputs(model_onnx):
    output.append(out)

num_onnx = select_model_inputs_outputs(model_onnx,outputs=output)
save_onnx_model(num_onnx, "resnet50_dump.onnx")

#推理得到输出，本示例中采用随机数作为输入
input_data = np.random.random((1,3,224,224)).astype(np.float32)
input_data.tofile("test_data.bin")
sess = onnxruntime.InferenceSession("resnet50_dump.onnx")
input_name = sess.get_inputs()[0].name
output_name = [node.name for node in sess.get_outputs()]
res = sess.run(output_name, {input_name: input_data})

#获得输出名称，确保每个算子节点有对应名称
node_name = [node.name for node in model_onnx.graph.node]

#保存数据，针对多个输出的节点要适配output_index的循环
for idx,data in enumerate(res):
    file_name = node_name[idx] + "." + str(0) + "." + str( 
                        round(time.time() * 1000000)) + ".npy"
    output_dump_path = "./onnx_dump/"+file_name
    np.save(output_dump_path, data.astype(np.float16))

8.4.3 训练场景数据准备（TensorFlow1.15）

8.4.3.1 准备基于 GPU 运行生成的 TensorFlow1.15 原始训练网络 npy 数据文件

前提条件

● 在进行TensorFlow1.15原始训练网络生成npy或dump数据前，您需要已经有一套
完整的、可执行的标准的TensorFlow模型训练工程。GPU训练环境准备可以参考
在ECS上快速创建GPU训练环境，链接内容仅供参考，请以实际训练场景为准。

● 不论采用Estimator模式或Session.run模式，首先要把脚本中所有的随机全都关
掉，包括但不限于对数据集的shuffle，参数的随机初始化，以及某些算子的隐形
随机初始化（比如dense算子），确认自己脚本内所有参数都不是随机初始化的。

说明

精度比对支持基于昇腾AI处理器运行生成的dump数据与基于GPU/CPU运行生成的npy或dump
数据比对，因此，您可以只准备npy文件即可。如果您需要使用基于GPU/CPU运行生成的dump
数据比对，请参考如何进行dump数据文件与numpy文件格式互转完成npy文件转换成dump文
件。

准备 npy 文件

利用TensorFlow官方提供的debug工具tfdbg生成npy文件。详细的操作方法如下：

步骤1 修改tf训练脚本，添加debug选项设置。

● 如果采用Estimator模式，采用如下方式添加tfdbg的hook。
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a. 新增from tensorflow.python import debug as tf_debug导入debug模
块。

b. 在生成EstimatorSpec对象实例的时候，也就是构造网络结构的时候，新增代
码training_hooks=[tf_debug.LocalCLIDebugHook()]。

图 8-8 Estimator 模式

● 如果采用Session.run模式，采用如下方式在run之前设置tfdbg装饰器。

a. 新增from tensorflow.python import debug as tf_debug导入debug模
块。

b. 在session初始化结束后，新增sess =
tf_debug.LocalCLIDebugWrapperSession(sess, ui_type="readline")。

图 8-9 Session.run 模式
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步骤2 执行训练脚本，训练任务停止后，在命令行输入run，训练会往下执行一个step。
For more details, see help..
tfdbg> run

步骤3 收集npy文件。

执行run命令完成后，获取第一个step的训练结果参数，可以通过lt查询已存储的张
量，通过pt可以查看已存储的张量内容，可以保存数据为numpy格式文件。因为tfdbg
一次命令只能dump一个tensor，为了自动生成收集所有数据，可以按以下几个步骤操
作：

1. 执行lt > gpu_dump命令将所有tensor的名称暂存到自定义名称的gpu_dump文件
里。命令行中会有如下回显。
Wrote output to tensor_name

2. 退出tfdbg命令行，在linux命令行下进入gpu_dump文件所在目录，执行下述命
令，用以生成在tfdbg命令行执行的命令。
timestamp=$[$(date +%s%N)/1000] ; cat gpu_dump | awk '{print "pt",$4,$4}' | awk '{gsub("/", "_", 
$3);gsub(":", ".", $3);print($1,$2,"-n 0 -w "$3".""'$timestamp'"".npy")}'

3. 将上一步生成的所有tensor存储的命令复制（所有以“pt”开头的命令），回到
tfdbg命令行（刚才执行训练脚本的控制台）粘贴执行，即可存储所有npy文件。
存储路径为训练脚本所在目录。

npy文件默认是以numpy.save()形式存储的，上述命令会将“/与:”用下划线_替
换。

说明

如果命令行界面无法粘贴文件内容，可以在tfdbg命令行中输入“mouse off”指令关闭鼠
标模式后再进行粘贴。

4. 检查生成的npy文件命名是否符合规则，如图8-10所示。

说明

– npy文件命名规则：{op_name}.{output_index}.{timestamp}.npy，其中op_name字段
需满足“A-Za-z0-9_-”正则表达式规则，timestamp需满足[0-9]{1,255}正则表达式，
output_index为0~9数字组成。

– 如果因算子名较长，造成按命名规则生成的npy文件名超过255字符而产生文件名异
常，这类算子不支持精度比对。

– 因tfdbg自身原因或运行环境原因，可能存在部分生成的npy文件名不符合精度比对要
求，请按命名规则手工重命名。如果不符合要求的npy文件较多，请参考如何批量处理
生成的npy文件名异常情况重新生成npy文件。

图 8-10 查询.npy 文件

----结束
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8.4.3.2 准备基于昇腾 AI 处理器运行生成的训练网络 dump 数据和计算图文件

前提条件

在进行迁移后的训练网络dump数据前，您需要完成训练网络开发、编译和运行，确保
具备可执行的训练工程。

说明

● 如果训练网络包含了随机因子，请在执行生成dump数据前去除。

● 确保你的代码在网络结构上、算子、优化器的选择上，以及参数的初始化策略等方面跟GPU
上训练的代码完全一致，否则比较起来也是没有意义的。

● 不要在一个训练脚本中既做训练又做验证，也就是不要把train和evaluate放到同一个脚本
中，否则会生成两组dump数据，导致分不清用哪个。

● 目前仅支持AI CPU和AI Core算子进行dump数据，不支持HCCL等算子dump数据。

Dump 参数配置

步骤1 为了让训练脚本能够dump出计算图，我们在训练脚本中的包引用区域引入os，并在构
建模型前设置DUMP_GE_GRAPH参数。这样，在训练过程中，计算图文件会保存在训
练脚本所在目录中。
import os
...
def main():
    ...
    os.environ['DUMP_GE_GRAPH'] = '2'

步骤2 修改训练脚本，开启dump功能。在相应代码中，增加如下的加粗字体信息。

● Estimator模式：通过NPURunConfig中的dump_config采集dump数据，在创建
NPURunConfig之前，实例化一个DumpConfig类进行dump的配置（包括配置
dump路径、dump哪些迭代的数据、dump算子的输入还是输出数据等）。关于
DumpConfig类的构造函数中每个字段的详细解释，请参见《TensorFlow网络模
型迁移和训练指南》手册。
from npu_bridge.estimator.npu.npu_config import DumpConfig

# dump_path：dump数据存放路径，该参数指定的目录需要在启动训练的环境上（容器或Host侧）提前创
建且确保安装时配置的运行用户具有读写权限
# enable_dump：是否开启Data Dump功能
# dump_step：指定采集哪些迭代的Data Dump数据
# dump_mode：Data Dump模式，取值：input/output/all
dump_config = DumpConfig(enable_dump=True, dump_path = "/home/HwHiAiUser/output", 
dump_step="0|5|10", dump_mode="all")

config = NPURunConfig(
  dump_config=dump_config, 
  session_config=session_config
  )

● sess.run模式：通过session配置项enable_dump、dump_path、dump_step、
dump_mode配置dump参数。
config = tf.ConfigProto()

custom_op =  config.graph_options.rewrite_options.custom_optimizers.add()
custom_op.name =  "NpuOptimizer"
custom_op.parameter_map["use_off_line"].b = True

# enable_dump：是否开启Data Dump功能
custom_op.parameter_map["enable_dump"].b = True
# dump_path：dump数据存放路径，该参数指定的目录需要在启动训练的环境上（容器或Host侧）提前创
建且确保安装时配置的运行用户具有读写权限
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custom_op.parameter_map["dump_path"].s = tf.compat.as_bytes("/home/HwHiAiUser/output") 
# dump_step：指的是想要dump出第几个step的结果，多个step之间用“|”隔开，连续多个step可以用诸
如“5-10”来表达。
custom_op.parameter_map["dump_step"].s = tf.compat.as_bytes("0|5|10")
# dump_mode：Data Dump模式，取值：input/output/all
custom_op.parameter_map["dump_mode"].s = tf.compat.as_bytes("all") 
config.graph_options.rewrite_options.remapping = RewriterConfig.OFF

with tf.Session(config=config) as sess:
  print(sess.run(cost))

表 8-2 参数详细说明

参数名 描述

enable_dump 是否开启Data Dump功能，默认值：False。

– True：开启Data Dump功能，从dump_path读
取Dump文件保存路径。

– False：关闭Data Dump功能。

dump_path Dump文件保存路径。enable_dump为True时，该
参数必须配置。

该参数指定的目录需要在启动训练的环境上（容器
或Host侧）提前创建且确保安装时配置的运行用户
具有读写权限，支持配置绝对路径或相对路径（相
对执行命令行时的当前路径）。

– 绝对路径配置以“/”开头，例如：/home/
HwHiAiUser/output。

– 相对路径配置直接以目录名开始，例如：
output。

dump_step 指定采集哪些迭代的Data Dump数据。默认值：
None，表示所有迭代都会产生dump数据。

多个迭代用“|”分割，例如：0|5|10；也可以用
"-"指定迭代范围，例如：0|3-5|10。

dump_mode Data Dump模式，用于指定dump算子输入还是输
出数据。取值如下：

– input：仅dump算子输入数据

– output：仅dump算子输出数据，默认为output
– all：dump算子输入和输出数据

 

----结束

执行训练生成 Dump 数据

步骤1 执行训练脚本，生成dump数据文件和计算图文件。

● 计算图文件：以“ge”开头的文件，是设置“DUMP_GE_GRAPH=2”生成的计算
图文件，存储在训练脚本所在目录。

● dump数据文件：生成在dump_path指定的目录下，即{dump_path}/{time}/
{deviceid}/{model_name}/{model_id}/{data_index}目录下，以{dump_path}配

MindStudio
用户指南 8 精度比对

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 341



置/home/HwHiAiUser/output为例，例如存放在“/home/HwHiAiUser/output/
20200808163566/0/ge_default_20200808163719_121/11/0”目录下。

表 8-3 dump 数据文件路径格式说明

路径key 说明 备注

dump_path 步骤2中设置的dump_path路径
（如果设置的是相对路径，则为拼
接后的全路径）

--

time dump数据文件落盘的时间 格式为：
YYYYMMDDHHMMSS

deviceid Device设备ID号 --

model_na
me

子图名称 model_name层可能存在多个文
件夹，dump数据取计算图名称
对应目录下的数据。

如果model_name出现了
“.”、“/”、“\”、空格
时，转换为下划线表示。

model_id 子图ID号 --

data_index 迭代数，用于保存对应迭代的
dump数据

如果指定了dump_step，则
data_index和dump_step一
致；如果不指定dump_step，
则data_index序号从0开始计
数，每dump一个迭代的数据，
序号递增1。

dump文件 命名规则格式为{op_type}.
{op_name}.{taskid}.{stream_id}.
{timestamp}。如果按命名规则定
义的文件名称长度超过了OS文件名
称长度限制（一般是255个字
符），则会将该dump文件重命名
为一串随机数字，映射关系可查看
同目录下的mapping.csv。

如果op_type、op_name出现了
“.”、“/”、“\”、空格
时，转换为下划线表示。

 

说明

● 每次迭代都会产生dump数据，在训练数据集较大的情况下，每次迭代的dump数据量很大
（约几十G，甚至更多），建议控制迭代次数，一般仅执行一次迭代。

● 多p环境下，因训练脚本中多device进程调起时间有差异会导致落盘时产生多个时间戳目录。

● 在docker内执行时，生成的数据存在docker里。

步骤2 选取计算图文件。
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说明

由于“ge”开头的dump图文件非常多，而且dump数据文件中的model_name层可能存在多个
文件夹，事实上，我们仅需要找到计算图文件，且仅需要model_name为计算图名称的文件夹。
以下提供两种方法帮助用户快速找到对应的文件。

● 方法一：在所有以“_Build.txt”为结尾的dump图文件中，查找“Iterator”这个
关键词。记住查找出的计算图文件名称，用于后续精度比对。
grep Iterator *_Build.txt

如上图所示，“ge_proto_00292_Build.txt”文件即是我们需要找到的计算图文
件。

● 方法二：将tensorflow模型保存为pb文件，然后查看该模型，选取其中一个计算
类算子的名字作为关键字，找包含该关键字的计算图文件。计算图名称取计算图
文件graph下的name字段值。

步骤3 选取dump数据文件。

1. 打开步骤2中找到的计算图文件，记录下第一个graph中的name字段值。如下示
例中，记录下“ge_default_20201209083353_71”。
graph {
  name: "ge_default_20201209083353_71"
  op {
    name: "atomic_addr_clean0_71"
    type: "AtomicAddrClean"
    attr {
      key: "_fe_imply_type"
      value {
        i: 6
      }
}

2. 进入以时间戳命名的dump文件存放路径下，我们会看到该目录下存在几个文件
夹：

3. 找到刚记录的名称为name值的文件夹，例如ge_default_20201209083353_71，
这些文件即为需要的dump数据文件。
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----结束

8.5 Vector 比对

8.5.1 比对场景

执行Vector比对前，请根据您将要进行Vector比对的场景按照表8-4要求准备好比对数
据文件。

说明

NPU Dump离线模型文件与量化融合规则文件使用场景说明：

● 模型文件：使用昇腾AI处理器运行生成的dump数据与Ground Truth比对，选择该模型文
件。

● 量化融合规则文件：只要涉及量化与非量化数据比对，则必须选择该文件。

表 8-4 Vector 比对前数据准备

序
号

待比对数据

（NPU Dump）

标准数据

（Ground Truth）

模型文件/融合规则文
件

推理场景

1 非量化离线模型在昇腾AI处
理器上运行生成的dump数
据

非量化原始模型的npy文
件(Caffe)

非量化离线模型文件
（*.om）

2 非量化离线模型在昇腾AI处
理器上运行生成的dump数
据

非量化原始模型的npy文
件(TensorFlow)

非量化离线模型文件
（*.om）

3 非量化离线模型在昇腾AI处
理器上运行生成的dump数
据

非量化原始模型的npy文
件(ONNX)

非量化离线模型文件
（*.om）
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序
号

待比对数据

（NPU Dump）

标准数据

（Ground Truth）

模型文件/融合规则文
件

4 量化离线模型在昇腾AI处理
器上运行生成的dump数据

非量化原始模型的npy文
件(Caffe)

● 量化离线模型文件
（*.om）

● 昇腾模型压缩后的
量化融合规则文件
（.json）

5 量化离线模型在昇腾AI处理
器上运行生成的dump数据

量化原始模型的npy文件
(Caffe)

量化离线模型文件
（*.om）

6 量化离线模型在昇腾AI处理
器上运行生成的dump数据

量化离线模型在昇腾AI
处理器上运行生成的
dump数据

本场景推荐使用不同
CANN软件版本、同
一模型的不同版本或
优化前后的模型数据
进行比对，一般情况
下不需要指定模型文
件/融合规则文件，而
进行离线模型转换开
启算子融合功能前后
的dump数据精度比
对时，需要指定开融
合的算子映射文件
（.json）或离线模型
文件（*.om）和关融
合的算子映射文件
（.json）或离线模型
文件（*.om）

非量化离线模型在昇腾AI处
理器上运行生成的dump数
据

非量化离线模型在昇腾
AI处理器上运行生成的
dump数据

训练场景

1 通过昇腾AI处理器运行生成
的训练网络dump数据

TensorFlow原始训练网
络npy文件

计算图文件（*.txt）

注：场景6不支持单算子比对，只支持整网比对。

 

8.5.2 比对操作

约束
● 需要确保My Output模型的数据文件与Ground Truth模型的数据文件为相同模型

的数据。如果不是相同模型的数据，但模型中有相同的算子名称，也可以进行比
较，但结果数据只显示匹配到的相同算子的比对结果。

● 如果在图编译过程中，原图的算子发生了融合，导致算子的output在编译后的模
型中找不到对应的output时，该算子无法进行比对。

● 如果在图编译阶段对图做了结构性修改（如stride切分、L1 fusion、L2 fusion）
的场景，会造成算子的input或output无法比对。

● 如果比对数据两边相同算子有dump数据，但算子的shape不一致（离线模型算子
shape变小）或format不支持转换，该算子无法进行比对。
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● 量化模型里做了量化处理的算子无法比对，必须是反量化的输出才能比对，量化
模型里未做量化处理的算子不受影响。例如，量化模型里AscendQuant算子的
output无法比对。

● 本节中使用到的文件的存放路径不能包含中文字符、特殊字符等，仅支持双引号
中的字符组成的路径：“./\:_- 0-9a-zA-Z”。

说明
● 针对FastRCNN网络场景，ProposalD算子及之后的算子，算子精度不达标属于正

常情况， 终结果以FSRDetectionOutput 算子的比对结果精度为准。

● 当模型转换对输入数据做了额外的预处理，造成原始模型的输入与离线模型的
data算子输入格式不同时（比如AIPP场景下data输入为YUV），data算子比对结
果异常、不具备参考意义。

● 使用精度比对工具，请确保硬件环境满足要求：CPU 8核 2.6Ghz，内存16GB，否
则有可能会造成比对缓慢。

● 使用量化离线模型在昇腾AI处理器上运行生成的dump数据作为待比对数据时，由
于量化与反量化算子之间存在影响精度的中间算子，在比对时会与源数据产生较
大的精度损失，所以精度比对时会过滤掉中间算子进行比对，此时输出的结果将
不包含整网的所有算子。

比对步骤

Vector比对操作步骤：

步骤1 在MindStudio界面菜单栏选择“Ascend > Model Accuracy Analyzer > New Task”菜
单，进入比对界面，如下图所示。
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图 8-11 New Task（Remote Run）
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图 8-12 New Task（Local Run）

步骤2 根据实际需求配置比对参数。各参数详细配置说明请参见表8-5。

表 8-5 精度比对 New Task 参数说明

参数 说明

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Windows使用场景下仅支持Remote Run，该参数不展示。

Deployment 运行配置，选择Remote Run模式时可见，必选配置。通过
Deployment功能，详细请参见Deployment，可以将指定项目中
的文件、文件夹同步到远程指定机器的指定目录。
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参数 说明

Remote Toolkit
Path

远端运行环境toolkit软件包安装路径，选择Remote Run模式时可
见，必选配置。例如配置为${HOME}/Ascend/ascend-
toolkit/xxx/toolkit。
与Deployment参数为绑定关系，单击“Start”后参数值将被保
存。再次配置时，如连接已配置过的Deployment，则参数自动填
充，可手动修改。

Environment
Variables

环境变量配置，选择Remote Run模式时可见，可以直接在框中

输入也可以单击 后在出的弹窗内单击 填写。

可选配置，当Model File指定文件为离线模型文件（*.om）时，
需要配置环境变量，否则工具将无法为离线模型文件（*.om）进
行ATC转换导致比对失败。

与Deployment参数为绑定关系，单击“Start”后参数值将被保
存。再次配置时，如连接已配置过的Deployment，则参数自动填
充，可手动修改。

Output Path 比对数据结果存放路径，必选配置。无论选择Remote Run模式
还是Local Run模式，均需要指定为本端路径。

Analysis Mode 精度比对分析模式，必选配置。可选择模式为：

● NPU vs NPU：表示两个比对文件均为昇腾AI处理器上运行生
成的dump数据文件。此时Model File参数可选。一般用于分
析开启和关闭融合规则时进行模型转换后的dump数据文件之
间的精度差。模型转换开启和关闭融合规则的详细介绍请参见
模型转换。

● NPU vs GPU/CPU：表示昇腾AI处理器上运行生成的dump数
据文件与原始模型的npy文件进行比对。此时展示Framework
必选参数。

Framework 比对数据所属的框架类型，必选配置。Analysis Mode为NPU vs
GPU/CPU时可见。可选类型为：

● TensorFlow：TensorFlow框架模型dump数据的精度比对，支
持推理、训练场景，Model File参数必选。

● ONNX：ONNX框架模型dump数据的精度比对，支持推理场
景，Model File参数必选。

● Caffe：Caffe框架模型dump数据的精度比对，支持推理场
景，Model File参数必选。

NPU Dump 昇腾AI处理器上运行生成的dump数据文件目录，必选配置。

在远端执行比对时（Remote Run），须指定远端设备上的dump
数据文件目录。
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参数 说明

Model File 模型文件或融合规则文件。

● Analysis Mode为NPU vs NPU时，进行离线模型转换开启算
子融合功能前后的dump数据精度比对，需要指定开融合的算
子映射文件（.json）或离线模型文件（*.om）和关融合的算子
映射文件（.json）或离线模型文件（*.om）。

● Analysis Mode为NPU vs GPU/CPU时，根据Framework选择
的框架类型选择不同的文件：

– TensorFlow：推理场景选择昇腾模型压缩后的量化融合规
则文件（json文件）或离线模型文件（*.om）；训练场景
选择计算图文件（*.txt）。

– ONNX：选择昇腾模型压缩后的量化融合规则文件（json文
件）或离线模型文件（*.om）。

– Caffe：选择昇腾模型压缩后的量化融合规则文件（json文
件）或离线模型文件（*.om）。

具体选择文件请参见比对场景。

Quantization
Rule File
（.json）

量化算子映射关系文件（昇腾模型压缩输出的的json文件），可
选配置。仅Framework为Caffe时展示。

Ground Truth 原始模型的npy文件目录，必选配置。

在远端执行比对时（Remote Run），须指定远端设备上的原始
模型的npy文件目录。

Algorithm 比对算法维度。取值为：

● Cosine Similarity：余弦相似度算法。

● Max Absolute Error： 大绝对误差算法。

● Mean Absolute Error：平均绝对误差。

● Root Mean Square Error：均方根误差。

● Kullback Leibler Divergence：KL散度算法。

● Relative Euclidean Distance：欧氏相对距离算法。

● Max Relative Error： 大相对误差。

● Mean Relative Error：平均相对误差。

● Standard Deviation：标准差算法。

● Accumulated Relative Error：累积相对误差算法。

与Customized Algorithm自定义算法之间至少勾选一种算法。

默认勾选Cosine Similarity、Max Absolute Error、Mean
Absolute Error、Root Mean Square Error和Relative Euclidean
Distance五个维度。

Advance
Options

扩展选项。包括Customized Algorithm和Operator Range。
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参数 说明

Customized
Algorithm

自定义算法文件路径。

与Algorithm内置算法之间至少勾选一种算法。

需用户自行准备自定义算法.py文件，所在目录格式为
“algorithm”，指定该目录下的自定义算法.py文件，生成自定
义算法。自定义算法.py文件相关要求参见《精度比对工具使用指
南》附录中的“准备自定义算法.py文件”章节。

Operator
Range

设定算子比对范围。有两种设置方式：

● 方式一：单击“Select”按钮，在弹出框内勾选需要比对的算
子。

● 方式二：根据Start、End、Step参数配置比对算子的范围

– start：第一个比对的算子，取值范围为[1, 参与计算的算子
个数]，默认值为1。

– end： 后一个比对的算子，取值范围为-1或[start, 参与计
算的算子个数]，默认值为-1（动态获取网络模型中 后一
个参与计算的算子）。

– step：第start+step*n个比对的算子，step取值范围为[1, 参
与计算的算子个数)，默认值为1，n为从1开始的正整数。

– 配置格式为：“start,end,step”。比如：-r 1,101,20，表
示算子1,21,41,61,81,101的Tensor参与比对。

不配置本参数时，比对网络模型中的所有参与计算的算子。

Analysis Mode为NPU vs NPU和在远端执行比对时（Remote
Run）不支持。

 

须知

不建议调用与当前用户不一致的其它用户目录下的自定义算法文件（Customized
Path）和OM模型文件，避免提权风险。当选择其他用户下的文件时，系统将提示风
险。如图8-13所示。

图 8-13 提权风险提示

步骤3 单击“Start”按钮。
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结果说明请参考结果展示（整网比对结果）。

----结束

结果展示（整网比对结果）

Vector比对结果及说明。

图 8-14 Vector 比对结果

如图8-14所示将Vector比对结果界面分为八个区域分别进行介绍。其中1~5区域为整网
比对结果，详细介绍如下；6~8区域为单算子比对功能及结果展示，详细介绍请参见单
算子比对。

1区域：菜单栏。从从左到右分别为Open…、New Project、Refresh、Help四项功
能。Open…为打开并展示比对结果csv文件；New Project为创建新的比对任务；
Refresh用于读取并刷新File Manager中管理的文件；单击Help弹出小窗，可展示精度
比对工具的使用限制（Restrictions）、使用建议、在线教程链接等。

2区域：历史数据管理。显示用户指定文件夹以及文件夹下生成的整网比对的csv文件
以及显示通过Open…单独打开的csv文件；对文件夹和csv，提供历史数据管理功能，
包括打开、删除、另存为；在文件夹处右键删除；在空白处右键创建新比对任务
（New Task）、刷新（Refresh）和Open…（打开并展示比对结果csv文件）。

说明

历史数据管理功能暂不支持数据老化，即当磁盘空间不足时系统无法自动删除多余的历史文件，
请用户自行删除多余的文件以保证比对程序的运行。

3区域：展示打开的比对结果csv文件页签，单击对应页签则显示对应文件的结果。

4区域：整网比对各算子的比对结果。默认仅显示有结果的算子。可单击列名，进行排
序。各列字段含义如下：

● Index：网络模型中算子的ID。

● LeftOp：表示NPU Dump侧数据的算子名。光标悬浮时，可显示具体算子所在的
文件路径。

● RightOp：表示Ground Truth侧数据的算子名。光标悬浮时，可显示具体算子所
在的文件路径。
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● TensorIndex：表示NPU Dump侧算子的Input ID和Output ID。

● Shape：比对的Tensor的Shape。

● CosineSimilarity：进行余弦相似度算法比对出来的结果。取值范围为[-1,1]，比
对的结果如果越接近1，表示两者的值越相近，越接近-1意味着两者的值越相反。

● MaxAbsoluteError：进行 大绝对误差算法比对出来的结果。取值范围为0到无穷
大，值越接近于0，表明越相近，值越大，表明差距越大。

● KullbackLeiblerDivergence：进行KL散度算法比对出来的结果。取值范围为0到无
穷大。KL散度越小，真实分布与近似分布之间的匹配越好。

● RootMeanSquareError：表示均方根误差。取值范围为0到无穷大，
MeanAbsoluteError趋于0，RootMeanSquareError趋于0，说明测量值与真实值
越近似；MeanAbsoluteError趋于0，RootMeanSquareError越大，说明存在局部
过大的异常值；MeanAbsoluteError越大，RootMeanSquareError等于或近似
MeanAbsoluteError，说明整体偏差越集中；MeanAbsoluteError越大，
RootMeanSquareError越大于MeanAbsoluteError，说明存在整体偏差，且整体
偏差分布分散；不存在以上情况的例外情况，因为RMSE ≥ MAE恒成立。

● MaxRelativeError：表示 大相对误差。取值范围为0到无穷大，值越接近于0，
表明越相近，值越大，表明差距越大。

● RelativeEuclideanDistance：进行欧氏相对距离算法比对出来的结果。取值范围
为0到无穷大，值越接近于0，表明越相近，值越大，表明差距越大。

● StandardDeviation：进行标准差算法比对出来的结果。取值范围为0到无穷大。
标准差越小，离散度越小，表明越接近平均值。该列显示NPU Dump和Ground
Truth两组数据的均值和标准差，第一组展示NPU Dump模型dump数据的数值(均
值;标准差)，第二组展示Ground Truth模型dump数据的数值(均值;标准差)。

● AccumulatedRelativeError：进行累积相对误差算法比对出来的结果。取值范围为
0到无穷大，值越接近于0，表明越相近，值越大，表明差距越大。

● MeanAbsoluteError：表示平均绝对误差。取值范围为0到无穷大，
MeanAbsoluteError趋于0，RootMeanSquareError趋于0，说明测量值与真实值
越近似；MeanAbsoluteError趋于0，RootMeanSquareError越大，说明存在局部
过大的异常值；MeanAbsoluteError越大，RootMeanSquareError等于或近似
MeanAbsoluteError，说明整体偏差越集中；MeanAbsoluteError越大，
RootMeanSquareError越大于MeanAbsoluteError，说明存在整体偏差，且整体
偏差分布分散；不存在以上情况的例外情况，因为RMSE ≥ MAE恒成立。

● MeanRelativeError：表示平均相对误差。取值范围为0到无穷大，值越接近于0，
表明越相近，值越大，表明差距越大。

● CompareFailReason：算子无法比对的原因。若余弦相似度为1，则查看该算子的
输入或输出shape是否为空或全部为1，若为空或全部为1则算子的输入或输出为
标量，提示：this tensor is scalar。

说明

● 余弦相似度和KL散度比较结果为NaN，其他算法有比较数据，则表明左侧或右侧数据为0；
KL散度比较结果为inf，表明右侧数据有一个为0；比对结果为nan，表示dump数据有nan。

● 鼠标悬浮在表头可以看到对应的参数详细解释。

● 若配置了自定义算法比对，则在比对结果的内置算法后增加对应自定义算法列。

5区域：各项算法指标的散点分布图。其中，横坐标表示算子的执行顺序，纵坐标为算
法指标在对应Tensor上的实际取值。字段含义如下：

● Algorithm：选择展示对应比对算法结果的散点分布图，不支持展示
StandardDeviation、KullbackLeiblerDivergence和AccumulatedRelativeError。
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● Tensor：过滤显示Input、Output结果散点分布图。

● Highlight：对算子Tensor散点进行高亮。通过拖拉游标在对应算法指标的
[min,max]间滑动来设置算法指标（纵坐标）的阈值，高于或等于阈值的点显示为
蓝色，低于阈值的点显示为红色。如针对余弦相似度，图中设置阈值为0.98，小
于0.98的算子Tensor被标记为红色。

说明

● 鼠标移动到对应Tensor点上时，浮窗显示Tensor信息。信息包括：Index（Tensor对应算子的
Index）、Op Name（算子名称）、Tensor Index（Tensor类型（input/output））以及
Value（在当前算法维度下的Tensor数值）。

● 支持对散点图进行缩放。

单算子比对

单算子比对功能是在结果展示（整网比对结果）的基础上选择具体算子并根据需要指
定参数进行比对的。界面展示为图8-14的6区域、7区域和8区域，如图8-15。

图 8-15 单算子比对

详细介绍如下：

6区域：单算子比对功能。下发单算子比对命令。需进行如下操作：

步骤1 基于已经读取到的Tensor信息，通过Operator下拉框选择要比对的算子和对应Tensor
（output/input）。

步骤2 通过Metric选择比对算子的Absolute Error（绝对误差）或Relative Error（相对误
差）。

步骤3 配置输出该指标的TopN个Tensor元素。

步骤4 单击“Compare”按钮进行单算子比对。

生成的TopN结果csv文件保存在Output文本框的显示的路径中，便于用户了解和掌控
文件输出。TopN结果显示在7区域中。

----结束

7区域：单算子比对TopN结果。各列字段解释如下：

● Index：算子比对的条数。

● N C H W：数据格式。
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● Left：NPU Dump侧算子的dump值。

● Right：Ground Truth侧算子的dump值。

● Absolute Error：绝对误差，NPU Dump侧算子的dump值减Ground Truth侧算子
的dump值取绝对值比对出来的结果。小数点后 多6位。

● Relative Error：相对误差，Absolute Error值除以Ground Truth侧算子的dump值
比对出来的结果。当Ground Truth侧算子的dump值为0时，该处显示为“-”。小
数点后 多6位。

8区域：对于TopN Tensor元素，绘制的误差累积分布折线图。

● “A % of tensor elements (B elements) have an absolute error greater than
C.”含义为：当前算子比对的所有tensor元素的绝对误差结果中有A %的tensor也
就是B个元素的绝对误差超过了C。其中absolute error根据6区域配置的Metric取
值变化可以为relative error；右侧滑块控制C的取值，范围由7区域AbsoluteError
或RelativeError的 大 小值决定。

● 误差累积分布折线图横坐标为7区域的AbsoluteError或RelativeError，取值范围由
AbsoluteError或RelativeError的 大 小值决定；纵坐标为累积百分占比，含义
为AbsoluteError或RelativeError到达某个阈值时，小于等于该阈值的所有tensor
元素在整体tensor元素中的占比。

说明

鼠标移动到对应Tensor点上时，浮窗显示Tensor信息。信息包括：Index（算子比对的条数）、
Absolute Error/Relative Error（绝对/相对误差）、Cumulative Percentage（累积百分占比）。

8.5.3 子模型导出与比对

简介

在使用昇腾AI处理器的推理功能时，可能存在推理结果和原始模型推理结果不一致的
情况，使用精度比对工具可以定位到某个或者某些非用户自定义层出现精度下降的问
题，此时需要用户将怀疑有问题的局部网络的相关数据截取出来进行局部结构精度比
对，将问题模型 小化后提供给华为工程师定位，在该背景下，MindStudio提供Caffe
和TensorFlow原始网络模型的子模型导出功能方便用户获取数据，导出原理如图8-16
所示。

说明

对于Linux系统，若需使用TensorFlow框架的子模型导出功能则需要安装TensorFlow1.15 AI框
架；对于Windows系统，需要安装TensorFlow1.15 AI框架和Python3。
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图 8-16 子模型导出原理

1. 使用ATC工具，将原始模型转换成适配昇腾AI处理器的离线模型，详情请参见模型
转换。

2. 使用转换后的离线模型进行推理。

3. 如果推理结果和原始模型推理结果不一致，则通过精度比对，将怀疑有问题的原
始网络模型的局部网络模型相关数据导出，详情请参见导出步骤。重复进行子模
型导出与子模型的精度比对，将问题定位至 小模型。

4. 将导出后的数据发给华为工程师定位。

如果问题解决，则重新进行模型转换，然后进行模型推理。

导出入口

在MindStudio界面，依次单击菜单栏“Ascend > Dump Network”，进入子模型导出
界面。
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导出步骤

步骤1 在MindStudio界面菜单栏选择“Ascend > Dump Network”进入子模型导出界面，如
图8-17所示。

图 8-17 子模型导出界面

表 8-6 界面参数以及按钮说明

参数 说明

Dump Data Path 精度比对界面“My Output”区域“Dump Path”中
配置的离线模型对应的dump数据，进入“Dump
Network”界面后，该参数自行传入Dump Data
Path。用户也可以单击右侧的 自行选择dump文
件。

Offline Model File 精度比对界面“Model File”中配置的离线模型文
件，进入“Dump Network”界面后，该参数自行传

入Offline Model File。用户也可以单击右侧的 自
行选择离线模型文件。

Deploy Model ● 原始网络模型文件，单击右侧的 选择
MindStudio安装服务器相应文件。

● 如果为昇腾模型压缩工具量化后的模型文件，则
此处需要选择量化后可在昇腾AI处理器部署的模型
文件。
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参数 说明

Deploy Weight ● 原始网络模型权重文件，若模型文件与权重文件
在MindStudio安装服务器相同位置，选择模型文
件后，权重文件会自动填充，否则需要用户单击

右侧的 自行选择。

● 如果为昇腾模型压缩工具量化后的权重文件，则
此处需要选择量化后可在昇腾AI处理器部署的权重
文件。

说明
只有原始网络模型文件为Caffe模型时，才会显示并需要
添加Caffe模型权重文件（*.caffemodel）。

Dump Output Path 子模型导出目录，单击右侧的 选择导出目录，若没
有目录，请先自行创建。

Show Result 单击该按钮，会解析原始模型文件，并将解析后的结
果以图的形式呈现在右侧空白区域。

Dump 子模型导出按钮。

 

步骤2 配置好参数后，单击“Show Result”，解析原始网络模型。

如果模型转换后导出的.om模型文件中的原模型“Model Name”取值与Caffe原始网
络模型文件（*.prototxt）或者TensorFlow原始网络模型文件（*.pb）中的“Model
Name”取值不同时，解析网络模型时会弹出如图8-18所示界面。

● 单击“Yes”继续解析，进入图8-19。

● 单击“No”，返回子模型导出界面。

图 8-18 Model Name 取值不同

解析成功的原始网络模型如图8-19所示。
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图 8-19 解析成功结果

其中：

● 红色节点表示进行Vector算法精度比对时，余弦相似度结果小于阈值的算子。

● 若某个节点包含多个算子，单击该节点后，该节点会出现绿色选中框，图8-19中
的中间部分会展示该节点所包含的所有算子。

– 查看算子信息

单击图8-19中间区域框上方的 展开算子的所有参数信息，用户也可以逐层

单击相关参数左侧的展开按钮 ，查看参数的详细信息；单击 折叠所有的
算子信息。

– 查看算子输出shape信息

图8-19还展示了每一层算子输出的维度和shape信息，如每一层算子连接线
中间的NCHW，1,3,224,224等信息。

– 搜索算子

在图8-19所示界面，中间下方为搜索区域。

搜索区域中给出了该模型所用到的所有算子，您可以在搜索区域对话框中输
入算子名称，下方搜索区域会列出相关的算子。选择其中一个算子，左侧网
络拓扑结构中相应算子会显示绿色选中框，中间区域框上方会展示该层算子
的详细信息，包括算子名称、算子输入、输出等信息。

– 搜索算子内部信息

选中某层算子，单击图8-19中间区域框上方的 展开按钮，下方区域框会展

示该层所包括所有算子的信息，然后单击 或在中间区域使用“Ctrl+F”快
捷键，弹出图8-20所示搜索界面，其中：

▪ Case sensitive：大小写敏感。

▪ Wrap Search：循环搜索。

▪ Backward：反向搜索。

用户在输入框中输入想要查询的信息，比如算子的输入输出、属性等信息，
然后在图8-20界面中勾选搜索特性，单击“Find”进行查找，如果匹配到相
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关信息，则中间区域框中相关信息会高亮显示，否则会提示“Value not
found”。单击Close退出搜索。

图 8-20 搜索算子内部信息

步骤3 选中怀疑有问题的局部网络模型第一个节点（输入节点），右击选择“Start
Layer”，该节点变成黄色；选中 后一个节点（输出节点）右击选择“End
Layer”，该节点变成紫色，“Start Layer”与“End Layer”中间的节点出现蓝色选
中框，表示选中的局部网络，如图8-19选中的节点所示。

说明

当开始节点和结束节点选择不合法时，两个节点外框会变红，出现相应信息提示不合法原因，同
时“Dump”按钮置灰，不可导出dump。可根据提示信息对开始节点和结束节点重新选择。

● 选中了输入和输出节点后，如果想更换输入或输出节点，则在新的节点上右击选
择相应的属性即可，新的节点颜色随之变化，原有节点恢复原始颜色。

● 如果输入节点和输出节点为同一个，在当前节点右击选择“Start Layer”或“End
Layer”，节点颜色随之变成黄色或紫色，同时弹出图8-21所示界面，单击
“OK”，然后执行步骤4即可导出单个节点的子模型。

图 8-21 输入输出共节点

步骤4 确定输入节点和输出节点后，单击“Dump”导出子模型。

MindStudio后台会在原始网络模型中寻找子模型，然后将子模型导出。界面右下角会
有导出进度提示，单击该进度条可以查看详细进度。

● 若出现图8-22所示信息，则说明导出成功。

图 8-22 导出成功提示

● 如果子模型导出时，找不到子模型某个算子输入层的shape信息时，会提示图
8-23所示信息。该场景下，需要用户根据提示信息，查看原始模型后，自行输入
相应算子输入层的shape信息，shape取值以英文冒号分隔。
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例如图8-23所示，提示res2a_branch1算子的输入pool1层算子的shape信息无法
获取，查看原始模型后，pool1层算子的输出shape为“1:64:56:56”，则此处填
写的shape信息为“1:64:56:56”（具体取值请根据实际情况进行修改）。

图 8-23 找不到子模型某个算子输入层的 shape 信息

步骤5 导出成功后：

1. 进入MindStudio安装服务器“Dump Output Path”所在目录可以看到以时间戳
命名的文件夹dump_result_xxxx_xx_xx_xx_xx_xx，其中：

– dump.prototxt：导出的Caffe子模型文件。

– dump.pb：导出的TensorFlow子模型文件。

– dump.caffemodel：导出的子模型权重文件（Caffe模型特有）。

– dump_data：选中的“Start Layer”与“End Layer”中间，子模型所包括的
所有算子的dump数据信息。

该文件夹中不仅包括导出子模型所包括的所有算子的dump信息，还包括子模
型“Start Layer”层的输入数据，用于子模型推理时作为输入数据使用。

用户可以将导出的子模型再次进行精度比对或发给华为工程师定位，如果问题解
决则进入下一步验证。

2. MindStudio界面“Output”窗口可以看到导出日志（如下日志中的所有数据都为
样例数据，请以实际导出模型为准）：
//导出过程中会为子模型添加输入信息
2020-05-22 16:27:57  Add Layer Into Prototxt:
name: "pool1_input_0"
type: "Input"
top: "conv1"
input_param {
  shape {
    dim: 1
    dim: 64
    dim: 112
    dim: 112
  }
}

//导出子模型的所有算子的dump数据信息
2020-05-22 16:27:57  Output Dump Path:/home/hisiso/dumpdate/dumpresult/ir6/
dump_result_2020_05_22_16_27_44/dump_data

//Start Layer与End Layer中间某层算子的dump信息，其中Output File表示Dump Layer层算子对应离线
模型中相应算子的输出dump数据，Input File表示Dump Layer层算子对应的离线模型中相应算子的输入
dump数据
2020-05-22 16:27:58  Dump Layer:[res2a_branch2c, bn2a_branch2c, scale2a_branch2c]
Output File:Conv2D.res2a_branch2cres2ares2a_relu.151.1585884515795667
Input File:Conv2D.res2a_branch2bres2a_branch2b_relu.149.1585884515771632
...

//Start Layer与End Layer中间所有算子的dump信息
2020-05-22 16:27:58  Export 
Layer:pool1,res2a_branch1,bn2a_branch1,scale2a_branch1,res2a_branch2a,bn2a_branch2a,scale2a_bra
nch2a,res2a_branch2a_relu,res2a_branch2b,bn2a_branch2b,scale2a_branch2b,res2a_branch2b_relu,res2
a_branch2c,bn2a_branch2c,scale2a_branch2c,res2a,res2a_relu
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步骤6 导出子模型重新执行推理。

1. 将步骤5.1导出的子模型，参见模型转换转换成.om离线模型文件。

如果导出的子模型不包括输入的data层节点，则转换.om离线模型时，请关闭
AIPP预处理参数。

2. 将步骤5.1导出的子模型Start Layer层的输入数据，转换成bin格式，用户执行推
理时，作为离线模型的输入数据使用。

a. 查找Start Layer层的输入数据。

输入数据为子模型导出时“Dump Layer”为“Start Layer”层算子对应的
Input File文件，根据此信息，在MindStudio安装服务器“dump_data”目录
下查找同名Input File文件，即为Start Layer层的输入数据。

b. pb格式输入数据转成numpy格式

进入MindStudio安装服务器，切换到Ascend-cann-toolkit安装目录/
ascend-toolkit/latest/toolkit/tools/operator_cmp/compare路径，执行
如下命令将pb格式的输入数据转换成numpy格式：

python3 shape_conversion.pyc -i pb格式输入数据绝对路径 -format NCHW -o 转换为numpy格式
数据的存放路径

上述命令中的路径请根据实际情况进行替换，转换完成后，可以在numpy格
式数据的存放路径看到.npy格式的输入数据。

c. numpy格式输入数据转成bin格式。

将如下脚本中的数据路径替换为实际路径，然后将脚本另存为.py格式，例如
submodeldataprocess.py。

import numpy as np

# 将numpy二进制格式转换为原始二进制格式
conv1_relu_0 = np.load(
    "/home/hisisoc/dumpdate/subModelData/xxx.npy")  # .npy格式的输入数据的绝对路径
conv1_relu_0 = conv1_relu_0.astype(np.float16)
conv1_relu_0.tofile(
    "/home/hisisoc/dumpdate/subModelData/xxx.bin")  # 转换为bin格式数据的存放路径

将submodeldataprocess.py脚本上传到MindStudio安装服务器任意路径，然
后执行如下命令将.npy格式的输入数据转换成bin格式：

python3 submodeldataprocess.py

进入bin格式数据的存放路径，可以看到.npy格式的输入数据已经转换成bin格
式。

3. 将导出的原始网络子模型在原始环境中执行推理业务，然后将步骤6.1和步骤6.2
中的离线模型和输入数据在SoC板端环境执行推理业务，查看两者推理结果是否有
差异。如果仍有差异，则参见精度比对使用步骤5.1中导出的原始网络子模型与步
骤6.1原始网络子模型转换后的离线模型重新和原始模型标杆数据进行精度比对。

4. 重复执行子模型导出与子模型精度比对，把问题定位到 小模型，将导出后的数
据发给华为工程师定位。

----结束

8.5.4 精度问题分析流程

精度比对完成后若存在精度问题，则需要进行问题分析并找出解决方案，图8-24以
Caffe推理应用场景为例提供精度问题分析基本思路参考。
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图 8-24 精度问题分析基本思路

8.6 FAQ

8.6.1 Vector 比对报错：The data in dump file have zero.

故障现象

执行Vector比对时，界面弹出报错窗口，如图8-25所示。
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图 8-25 Vector 比对报错信息：dump 数据文件包含 0

故障原因

导致该故障的可能原因是“Ouput”栏显示的dump数据文件中包含0，导致无法计
算。

处理方法

删除“Output”栏显示的dump数据文件后，再执行Vector精度比对。

8.6.2 Vector 比对报错：ModuleNotFoundError: No module
named 'google'

故障现象

执行Vector比对时，界面弹出报错窗口，如图8-26所示。

图 8-26 Vector 比对报错信息：未安装 protobuf

output栏的打印信息如下：

2020-01-21 09:38:17 Error: Traceback (most recent call last): File "/home/phisik3/vb_workspace/work_code/
toolchain/operator_cmp/compare/CompareVector.py", line 17, in <module> File
 "/home/phisik3/vb_workspace/work_code/toolchain/operator_cmp/compare/AccumulatedRelativeError.py", 
line 3, in <module> File 
"/home/phisik3/vb_workspace/work_code/toolchain/operator_cmp/compare/
VectorComparisonCommon.py", line 4, in <module> File 
"/home/phisik3/vb_workspace/work_code/toolchain/operator_cmp/net_inference/caffe/DumpData_pb2.py", 
line 6, in <module> ModuleNotFoundError: No module named 'google'

故障原因

操作系统未安装protobuf导致解析Caffe模型的dump数据出错。

处理方法

针对该问题现象，可以先使用以下命令安装protobuf后再进行精度比对：
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使用MindStudio安装用户登录MindStudio服务器，执行命令pip3.7.5 install
protobuf --user。

8.6.3 如何进行 dump 数据文件与 numpy 文件格式互转

数据转换脚本说明

本版本提供dump_data_conversion.pyc脚本，实现dump数据文件与numpy文件格式
互转功能，具体命令行格式如下：

python3.7.5 dump_data_conversion.pyc -type TYPE -target TARGET -i INPUT_PATH -o OUTPUT_PATH

● -type：数据类型，必选参数 。参数值选项：

– quant：量化Caffe模型数据。

– tf：非量化TensorFlow模型数据。

– caffe：非量化Caffe模型数据。

– offline：离线模型数据。

● -target：数据转换目标格式，参考值选项：numpy和dump。必选参数 。
– numpy：dump文件转换为numpy文件。

– dump：numpy文件转换为dump文件。

● -i：数据文件路径（可以是文件夹或者文件），必选参数 。
– numpy文件转dump文件：

如果“i”参数输入是文件夹，则格式要求如下：文件夹下的文件必须是
op_name.output_index.timestamp.npy 形式文件。

如果“i”输入参数是文件名，则输入的文件名需满足
“op_name.output_index.timestamp.npy ”格式要求。每次仅支持输入1个
文件。

其中op_name对应的名称需满足“A-Za-z0-9_-”正则表达式规则，
output_index为0~9数字组成，timestamp需满足[0-9]{1,255}正则表达式。

– dump文件转numpy文件：

如果“i”参数输入是文件夹，文件夹下的文件格式必须满足数据格式要求章
节要求；如果“i”输入参数是文件名，则输入的文件名也必须满足数据格式
要求章节要求。

● -o：转换后输出文件路径。必选参数。

说明

dump_data_conversion.pyc脚本存放位置：Ascend-cann-toolkit安装目录/ascend-toolkit/
latest/toolkit/tools/operator_cmp/compare。

该脚本执行需依赖numpy、protobuf、scipy库，需要执行命令pip install numpy protobuf
scipy --user进行安装。如果安装MindStudio时已安装，则不需要执行。

使用该脚本进行数据转换，确保主机内存大小不低于15GB；如果待转换的dump数据单个文件
大小超过441MB，则建议使用更大内存主机。

转换 Caffe 原始数据 npy 文件为 dump 数据文件

获取到Caffe原始数据后，将npy文件传到MindStudio服务器上，通过
dump_data_conversion.pyc脚本进行数据转换，输出二进制格式的dump文件。

Caffe原始数据npy文件转dump命令举例：
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python3.7.5 dump_data_conversion.pyc -type caffe -target dump -i /home/
HwHiAiUser/caffenpyfile -o /home/HwHiAiUser/caffedump

说明

● /home/HwHiAiUser/caffenpyfile：npy文件所在路径。

● /home/HwHiAiUser/caffedump：生成的dump文件存放路径。

转换 TensorFlow 原始数据 npy 文件为 dump 数据文件

获取到原始数据后，将npy文件传到MindStudio服务器上，通过
dump_data_conversion.pyc脚本进行数据转换，输出二进制格式的dump文件。

TensorFlow原始数据npy文件转dump命令举例：

python3.7 dump_data_conversion.pyc -type tf -target dump -i /home/
HwHiAiUser/tfnpyfile -o /home/HwHiAiUser/tfdump

说明

● /home/HwHiAiUser/tfnpyfile：npy文件所在路径。

● /home/HwHiAiUser/tfdump：生成的dump文件存放路径。

8.6.4 如何查看 dump 数据文件
dump文件无法通过文本工具直接查看其内容，为了查看dump文件内容，本文提供以
下脚本将dump文件转换为numpy格式文件后，再通过numpy官方提供的能力转为txt
文档进行查看：

步骤1 使用安装用户登录开发环境。

步骤2 进入/home/HwHiAiUser/Ascend/ascend-toolkit/latest/toolkit/tools/operator_cmp/
compare目录。

步骤3 执行dump_data_conversion.pyc脚本，转换dump文件为numpy文件。举例：

python3.7.5 dump_data_conversion.pyc -target numpy -type offline -i /home/
HwHiAiUser/dump -o /home/HwHiAiUser/dumptonumpy

说明

dump_data_conversion.pyc脚本的各个输入参数使用方法，请参考如何进行dump数据文件与
numpy文件格式互转

步骤4 调用Python，转换numpy文件为txt文件。

$ python3

Python 3 (default, Mar  5 2020, 16:07:54)[GCC 5.4.0 20160609] on linuxType "help", "copyright", "credits" 
or "license" for more information.

>>> import numpy as np

>>> a = np.load("/home/HwHiAiUser/dumptonumpy/
Pooling.pool1.1147.1589195081588018.output.0.npy")

>>> b = a.flatten()

>>> np.savetxt("/home/HwHiAiUser/dumptonumpy/
Pooling.pool1.1147.1589195081588018.output.0.txt", b)
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转换为.txt格式文件后，维度信息、Dtype均不存在。详细的使用方法请参考numpy官
网介绍。

----结束

8.6.5 如何批量处理生成的 npy 文件名异常情况
TensorFlow模型生成dump数据时，因tfdbg自身原因或运行环境原因，会出现tfdbg截
断算子名，导致生成的npy文件名与预期不符，造成转换dump数据文件异常。此时需
要参考以下方法重新生成npy文件，使得npy文件名符合精度比对要求。

说明

● 本文中脚本名称、路径等均为举例，请根据实际替换。

● 批量处理后，如果遇到某算子的dump文件存在，但是比对结果为NaN，需要检查该算子的
dump文件名中的{op_name}是否与TensorFlow算子名称一致，如果不一致需要手动修改
dump文件名中的算子字段与TensorFlow算子名称一致。其中如果出现"/"请修改为"_"。

步骤1 执行TensorFlow工程。

进入调试命令行交互模式后，输入run命令。

步骤2 执行lt > tensor_name命令将所有tensor的名称暂存到文件里。

步骤3 创建可执行脚本，如pt_cmd.sh，获取tensor_name文件中tensor_name对应的
tensor_index。

脚本内容如下：

#!/bin/bash
timestamp=$[$(date +%s%N)/1000]
index=1
while read -r line
do
  tensor_index=`echo $line | awk '{print $4}'`
  echo "pt "$tensor_index" -n 0 -w "$((index++))"."$timestamp".npy" >> $2
done < $1

赋予pt_cmd.sh可执行权限并执行脚本。

chmod +x pt_cmd.sh

bash pt_cmd.sh tensor_name tensor_name.txt

步骤4 回到tfdbg命令行，输入run命令后，将上一步生成的tensor_name.txt文件内容粘贴执
行，生成npy文件。

步骤5 将生成的npy文件，移动到新的文件夹，如npy_dir。

步骤6 创建可执行脚本，如index_to_tensorname.sh，并执行脚本批量修改npy文件名。

脚本内容如下：

#!/bin/bash
timestamp=$[$(date +%s%N)/1000]
while read -r line
do
  tensor_index=`echo $line | awk '{print $2}'`
  real_file=`echo $line | awk '{print $6}'`
  changed1_tensor_index=${tensor_index//\//_}
  changed2_tensor_index=${changed1_tensor_index//:/.}
  echo $2/$real_file $2/$changed2_tensor_index"."$timestamp".npy"
  if [ -r $2/$real_file ]
  then
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    mv $2/$real_file $2/$changed2_tensor_index"."$timestamp".npy"
  fi
done < $1

赋予index_to_tensorname.sh可执行权限并执行脚本。

chmod +x index_to_tensorname.sh

bash index_to_tensorname.sh tensor_name.txt npy_dir

----结束

8.6.6 1 如何解决分屏显示两个 MindStudio 工程时，目标工程打开
精度比对功能窗口显示在另一个工程上

问题描述

同时打开两个MindStudio工程并分屏显示，在其中一个工程中打开精度比对功能窗口
时，精度比对窗口显示在另一个工程上。

解决方法

先单击目标工程名称以聚焦此工程，再打开精度比对功能窗口，如图8-27所示。

图 8-27 精度比对
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9 Profiling 性能分析

9.1 简介

9.2 使用约束

9.3 使用前准备

9.4 Profiling数据采集

9.5 Profiling工程管理

9.6 Profiling数据展示

9.7 Profiling性能分析样例参考

9.1 简介
Profiling实现了Host+Device侧丰富的性能数据采集能力和全景Timeline交互分析能
力，展示Host+Device侧各项性能指标，帮助用户快速发现和定位AI应用、芯片及算子
的性能瓶颈。包括资源瓶颈导致的AI算法短板，指导算法性能提升和系统资源利用率
的优化。Profiling支持Host+Device侧的资源利用可视化统计分析，具体包括Host侧
CPU、Memory、Disk、Network利用率和Device侧APP工程的硬件和软件性能数据。

Profiling提供针对硬件和软件性能数据采集、分析、汇总展示。总体流程如下：

1. 运行Profiling采集。

用户在配置界面开启Profiling开关（推理场景需确保APP工程可正常执行；训练场
景直接执行采集）。

a. Profiling采集性能数据。

MindStudio编译当前工程生成可执行文件，并将可执行文件拷贝到设备侧，
MindStudio向Profiling工具下发数据采集指令，由Profiling工具完成Device
侧和Host侧数据采集任务，采集结束后，将生成的数据文件拷贝到
MindStudio侧。

b. MindStudio查询并解析数据。

Profiling采集结束后，MindStudio调用Profiling工具接口查询数据，并将数
据以json格式存储在“.mindstudio/profiler/data/profiling_out/PROF_XXX”
目录下。

c. MindStudio展示性能数据。

MindStudio
用户指南 9 Profiling 性能分析

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 369



MindStudio通过对json文件做数据处理，生成前端展示视图数据。

9.2 使用约束
● Profiling不支持同时从MindStudio安装侧发起2个基于相同结果目录的Profiling。

● Profiling功能与Dump功能不建议同时使用，即启动Profiling前，请关闭数据
Dump。原因：如果同时开启，由于Dump操作会影响系统性能，会造成Profiling
采集的性能数据指标不准确。如何关闭数据Dump数据请参见步骤2设置Dump
Option为None。

● Profiling工具在采集Host侧数据时仅适用于开发和测试环境，供开发者使用，禁
止在生产环境使用。如果使用在生产环境，存在sudo提权风险。

● Profiling工具不支持采集Ascend RC场景下的Host侧数据。

● 当Profiling数据展示时，单击MindStudio视图界面菜单栏“Ascend > System

Profiler > Open”或在Profiling报告展示界面左上角的 图标或直接在Profiling
报告展示界面选择打开历史报告时，由于当前版本与历史版本Profiling数据不兼
容，不建议选择历史版本Profiling数据报告。

9.3 使用前准备
推理场景请参见应用开发完成工程文件开发，并通过MindStudio编译、运行，确保
APP工程正常运行。

请参见《Profiling工具使用指南》的“附录 > 安装perf、iotop、ltrace工具”章节完
成服务端Profiling工具的依赖安装。

9.4 Profiling 数据采集
通过以下操作方法启动Profiling：

步骤1 在欢迎界面的左侧导航栏单击“Projects”，单击选择并打开已编译完成的工程。

步骤2 单击菜单栏“Ascend > System Profiler > New Project”，弹出Profiling配置窗口 。

步骤3 进入Profiling配置窗口，如图9-1。配置“Project Properties”，配置工程名称
“Project Name”和选择工程路径“Project Location”。单击“Next”进入下一步。
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图 9-1 Project Properties 配置

参数 说明

Project Name Profiling工程名称，用户自定义。

Project Location AI工程路径。推理场景时，指定推理应用工程路径；
训练场景时，指定训练工程路径。

 

说明

1. 执行训练工程Profiling前，用户需自行准备训练工程。

2. 用户通过训练工程采集数据，需要在训练工程的环境变量脚本文件env_*.sh内添加
PROFILING_OPTIONS字段的配置信息，示例如下：
export PROFILING_MODE=true
export PROFILING_OPTIONS='{"output":"/tmp/profiling","storage_limit": 
"xxMB","training_trace":"on","l2":"on","task_trace":"on","aicpu":"on","fp_point":"","bp_point":
"","aic_metrics":"MemoryL0"}'

PROFILING_OPTIONS字段为配置Profiling的采集项，请根据实际情况选择需要的参数。有
关训练工程的脚本中添加Profiling配置的参数详细介绍请参见《Profiling工具使用指南》的
“附录>Profiling options参数解释”。
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步骤4 进入“Executable Properties”配置界面，可选择Remote Run和Local Run两种模
式，并根据指定的工程目录（App Projet Path）识别对应的工程类型。如下各图所
示。

图 9-2 Remote Run（推理应用工程）
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图 9-3 Remote Run（推理算子工程）
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图 9-4 Remote Run（训练工程）

说明

配置完成后，Deployment和对应的Environment Variables、Remote Toolkit Path参数为绑定
关系，单击“Next”后参数值将被保存。再次配置时，如连接已配置过的Deployment，则
Environment Variables、Remote Toolkit Path参数自动填充，可手动修改。
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图 9-5 Local Run（推理应用工程）
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图 9-6 Local Run（推理算子工程）
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图 9-7 Local Run（训练工程）

表 9-1 Executable Properties 参数说明

参数 说明

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Windows使用场景下仅支持Remote Run。

Deployment 运行配置，选择Remote Run模式时可见，必选配置。
通过Deployment功能，详细请参见Deployment，可
以将指定项目中的文件、文件夹同步到远程指定机器
的指定目录。
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参数 说明

App Project Path 执行Profiling目标工程目录，必选配置。

可根据指定的目标工程识别工程类型为：

● Ascend App：表示指定的目标工程为推理应用工
程。

● Ascend Operator：表示指定的目标工程为推理算
子工程。

● Ascend Training：表示指定的目标工程为训练工
程，此时可直接单击“start”按钮启动Profiling。

Executable File 执行Profiling目标工程的可执行文件目录，必选配
置。

需指定为App Project Path的子目录。

支持指定二进制脚本文件、Python脚本文件和Shell脚
本文件。

指定Python脚本文件时由于msprof工具的限制有如下
要求：

● pyacl工程中的Python脚本中的路径信息必须为绝
对路径。

● 不支持异步接口（接口名以async结尾）的调用。

● 不支持Profiling的Remote Run模式进行采集。

指定Shell脚本文件由用户自行提供，且无需指定为
App Project Path的子目录。

Command Arguments 用户APP的执行参数，由用户自行配置，参数之间用空
格分隔，默认为空。

Environment Variables 环境变量配置。可以直接在框中输入也可以单击 后

在出的弹窗内单击 填写。可选配置。

Remote Toolkit Path 远端运行环境toolkit软件包安装路径，选择Remote
Run模式时可见，必选配置。例如配置为/home/
HwHiAiUser/Ascend/ascend-toolkit/latest/toolkit。

CANN Version 指定CANN软件包版本，在启动MindStudio创建工程
时指定，若未指定则需单击Change按钮指定对应
CANN软件包安装路径。

 

步骤5 进入“Profiling Options”配置界面，其中配置AI Core Profiling时分为Task-based和
Sample-based场景。如图9-8和图9-9所示。

MindStudio
用户指南 9 Profiling 性能分析

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 378



图 9-8 Task-based 场景
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图 9-9 Sample-based 场景

表 9-2 Profiling Options 参数说明

参数 说明

AI Core
Profiling

Task-Based AI Core采集开关，以task为粒度进行性能数据采集。

● Pipeline Utilization：采集计算单元和搬运单元耗
时占比。

● Arithmetic Utilization：cube和vector的指令类型
耗时占比。

● UB/L1/L2/Main Memory Bandwidth：UB/L1/L2/
主存储器采集内存读写带宽速率。

● L0A/L0B/L0C Memory Bandwidth： L0A/L0B/L0C
采集内存读写带宽速率。

● UB Memory Bandwidth：mte/vector/scalar采集
ub读写带宽速率。
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参数 说明

Sample-Based AI Core采集开关，以固定的时间周期（AI Core-
Sampling Interval）进行性能数据采集。

● Pipeline Utilization：采集计算单元和搬运单元耗
时占比。

● Arithmetic Utilization：cube和vector的指令类型
耗时占比。

● UB/L1/L2/Main Memory Bandwidth：UB/L1/L2/
主存储器采集内存读写带宽速率。

● L0A/L0B/L0C Memory Bandwidth： L0A/L0B/L0C
采集内存读写带宽速率。

● UB Memory Bandwidth：mte/vector/scalar采集
ub读写带宽速率。

● Frequency(hz)：采集频率，默认值为100，单位
hz。

MsprofT
X

MsprofTX 控制msproftx用户和上层框架程序输出性能数据采集
的开关。

API
Trace

Ascend API AscendCL(Ascend Compute Language)采集开关，采
集接口流水信息。可选配置，默认勾选。

Runtime API Runtime采集开关，采集运行管理器接口流水信息。
可选配置，默认勾选。

OS Runtime
API

系统运行时函数库API和Pthreads API的调用。可选配
置，默认勾选。

说明
采集OS Runtime API调用数据需要安装第三方开源工具perf
和ltrace，使用开源工具ltrace采集OS Runtime API调用数据
会导致CPU占用率过高，其与应用工程的pthread加解锁相
关，会影响进程运行速度。

Graph Engine
(GE)

Graph Engine采集开关，采集模型图引擎调度流水信
息。可选配置。

AICPU
Operators

AI CPU采集开关，采集aicpu数据增强的Profiling数
据。

Device
System
Samplin
g

DDR 采集DDR数据。可选配置，默认勾选。

可以更改采样频率Frequency(hz)，默认频率为
50Hz。

Host
System
Samplin
g

CPU 采集Host侧CPU资源利用率信息。可选配置，默认勾
选。

Memory 采集Host侧Memory资源利用率信息。可选配置。

Disk 采集Host侧Disk资源利用率信息。可选配置。

Network 采集Host侧Network资源利用率信息。可选配置。
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参数 说明

HCCL HCCL 控制HCCL数据采集开关。当前采集完成HCCL数据后
默认仅导出 小模型号（Model ID）的第一轮迭代数
据。

 

步骤6 完成上述配置后单击窗口右下角的“Start”按钮，启动Profiling。

工程执行完成后，MindStudio窗口下方自动展示Profiling结果视图。

----结束

9.5 Profiling 工程管理
展示创建的Profiling工程和生成的Profiling报告。

创建新 Profiling 工程

步骤1 单击选择并打开已编译完成的工程。

步骤2 单击菜单栏“Ascend > System Profiler > New Project”或者在Profiling报告界面左上

角单击 图标。

步骤3 参见步骤3到步骤6完成创建。

----结束

打开未展示的 Profiling 报告

步骤1 单击选择并打开已编译完成的工程。

步骤2 单击菜单栏“Ascend > System Profiler > Open”或在Profiling报告展示界面左上角的

图标找到并打开未展示的Profiling报告。

----结束

打开报告

说明

Profiling执行成功后，自动打开Profiling报告展示Profiling数据结果。

步骤1 报告界面左侧导航栏对应报告文件右键弹出菜单。

步骤2 单击“Open Report”。

----结束

另存报告

步骤1 报告界面左侧导航栏对应报告文件右键弹出菜单。

步骤2 单击“Save As”。
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步骤3 选择目标路径，单击“Save”保存报告。

----结束

删除报告

步骤1 报告界面左侧导航栏对应报告文件右键弹出菜单。

步骤2 单击“ Delete Report”。

步骤3 在弹出的对话框中单击“Yes”。

----结束

刷新导航栏

单击报告界面左上角的 图标。刷新后可以将导航栏状态刷新到 新状态，所有已经
展开的工程目录会收起。

9.6 Profiling 数据展示

9.6.1 展示视图介绍
Profiling执行成功后，自动展示Profiling数据结果，如图9-10所示。

图 9-10 Profiling 视图窗口（推理）
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图 9-11 Profiling 视图窗口（训练）

说明

● 鼠标悬浮在视图上的各个时间线上时，可显示对应接口的运行信息，包括接口的启动时间
（Start Time）、停止时间（End Time）、执行持续时间（Duration）和接口名（Name）
等。有关更多接口的字段含义请参见《Profiling工具使用指南》中的“Profiling数据说明”
章节。

● Profiling采集后生成的.json数据文件命名格式为report_<时间戳>_<Device_ID>。

● 训练场景采集迭代轨迹数据、AI Core数据和算子数据等，不配置步骤5步骤，即不进行
“Profiling Options”各项数据采集，因此图9-11界面展示的数据为图9-10界面展示数据的
子集。

Profiling视图窗口分为如下四个区域：

1区域：菜单栏。从从左到右分别为Open…（打开未展示的Profiling报告）、New
Project（创建新Profiling工程）、TimeLine Color（打开Timeline颜色配置）、
Refresh（刷新导航栏）四项功能。详细介绍请参见Profiling工程管理和Timeline颜色
配置。

2区域：展示打开的.json文件页签，单击对应页签则显示对应文件的结果。

3区域：以视图方式展示Profiling采集结果，包括：TimeLine View、Analysis
Summary、Memory Chart（仅推理）、Baseline Comparison。

4区域：导航栏。显示用户指定的.json文件。提供历史数据管理功能，包括：Open
Report（打开报告）、Save As（另存为）、Delete Report（删除报告）等；支持在
空白处右键Open…（打开未展示的Profiling报告）、New Project（创建新Profiling工
程）、Refresh（刷新导航栏）。详细介绍请参见Profiling工程管理。

Profiling支持Task-Based和Sample-Based两种不同方式的AI Core采集方式，因此会出
现Profiling各页签展示结果不同。
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表 9-3 AI Core 采集方式视图差异

视图 Task-Based Sample-Based

AI Core Utilization
（Analysis Summary）

不展示 展示

Timeline View 展示 展示

CPU 展示 展示

Memory 展示 展示

Disk 展示 展示

Network 展示 展示

OS Runtime API 展示 展示

ACL API 展示 展示

Runtime API 展示 展示

GE 展示 展示

MsprofTX 展示 展示

step trace 展示 展示

AI core task 展示 不展示

AI CPU task 展示 展示

System task 展示 不展示

HCCL 展示 展示

 

9.6.2 Merge Reports
本功能的作用是对于Profiling采集后的性能原始数据通过MindStudio界面进行解析并
展示。配置步骤如下：

步骤1 单击菜单栏“Ascend > System Profiler > Merge Reports”，弹出Merge Reports配
置窗口 。

步骤2 配置Merge Reports的数据源输入路径、数据输出路径以及输出展示的Json文件名。如
图9-12所示。
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图 9-12 Merge Reports 配置

表 9-4 Merge Reports 参数说明

参数 说明

Input directory 数据源输入路径。指定为msprof命令指定
的数据输出路径。

Output directory 数据输出路径。

Output Json name 输出展示的Json文件名。

 

说明

● 有关msprof命令的详细使用请参见《Profiling工具使用指南》的“采集并解析Profiling数据
（msprof命令行方式）”章节。

● msprof命令在多device的环境下执行时，数据输出路径下会生成对应device数量的
PROF_XXX文件。

● msprof命令在相同路径下执行多次Profiling采集后，数据输出路径下会生成多个PROF_XXX
文件，当前Merge Reports仅支持指定PROF_XXX文件的上一层文件生成Json文件进行展示，
故请保证路径下仅存在执行一次msprof命令所生成的PROF_XXX文件。

----结束

9.6.3 TimeLine View

9.6.3.1 Timeline 颜色配置

在MindStudio菜单栏选择“Ascend > System Profiler > Timeline Color”，或者在打

开的Project Explorer界面上单击左上角的 图标。Timeline颜色配置窗口如图9-13所
示。
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图 9-13 Timeline 颜色配置

可以根据API执行时间自定义配置Timeline中的颜色显示比例，显示格式为：绿色 a%
≤ 黄色 < b% ≤ 红色，此设置的数值表示在Profiling采集过程中接口运行时间的耗时占
比。

例如图9-13中所示，为默认配置，绿色 5% ≤ 黄色 < 10% ≤ 红色，则耗时占比小于等
于5%的时间线显示为绿色，耗时占比在5%~10%的时间线显示为黄色，耗时占比超过
10%的时间线显示为红色。

说明

配置颜色比例的数值 多可精确到小数点后两位。

9.6.3.2 TimeLine 视图

TimeLine View包含左侧导航窗格、右侧图形化窗格和下方数据窗格。导航窗格显示各
个Timeline的名称，以及各个Timeline之间的从属关系；图形化窗格对应导航窗格，逐
行对Timeline进行图形化展现；数据窗格以表格的形式呈现Profiling采集之后的各项数
据，分为Event View、Statistics和AI Core Metrics。

说明

● Profiling数据中涉及到的时间节点（非Timestamp）为系统单调时间只与系统有关，非真实
时间。

● “Start Time”和“End Time”表示本次性能采集数据的展示时间范围。

● “Current Time”表示鼠标所在时间块的开始时间。

● 将鼠标移动到具体采样点，可以查看对应采样点具体分析数据。

● 在左侧导航窗格中右键标签名，选择“Show in Event View”，可以在Event View界面中看
到对应选项Timeline的顺序执行信息。

● 在TimeLine中可以查看对应的API或操作的名称。

● 同一线程中有多个OS Runtime API同时执行时会分行显示。

● 同一Stream中有多个AI Core task同时执行时会分行显示。

● 当选中TimeLine中某个时间点时，按住Ctrl键并向上/下滚动鼠标滑轮或点击视图右上角的

/ ，实现Timeline视图的放大/缩小。点击视图右上角的 实现视图复位。

● 当选中TimeLine中某个时间点时，可通过左右拖拉鼠标选择时间长度。以Current Time(us)
为界点，鼠标向右拖动时间段显示为正，向左拖动时间段显示为负。

在Profiling运行完成后，以时序图的呈现方式为用户提供全流程推理/训练过程中的运
行情况，按照调度流程OS Runtime、ACL API、Runtime API、Graph Engine(GE)、A
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ICPU task、AI Core task和System task来呈现整体的运行状况。实际展示情况与
Profiling采集时的所选项以及设备有关，请以设备实际情况为准。

● OS Runtime：展示每个线程调用OS Runtime的时序信息。

● ACL API：展示模型、算子、Runtime API等耗时数据。如果没有某一类数据则不
显示。

● Runtime API：展示每个线程调用runtime API的时序信息。

● GE：展示模型的数据输入、推理、数据输出耗时。

● Step Trace：迭代轨迹数据，每轮迭代的耗时。

● AI Core task：展示每个Stream的AI Core task时序信息。

● System task：展示每个Stream的System task时序信息。

9.6.3.3 Event 视图

在TimeLine View界面的左侧导航窗格中右键标签名，选择“Show in Event View”，
可以在下方数据窗格的Event View中看到对应选项Timeline的顺序执行信息，操作如
图9-14所示。

图 9-14 Show in Event View
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可查看项目包括：

● Process > Thread > Os Runtime
● Process > Thread > ACL API（model/runtime）

● Process > Thread > Runtime API
● NPU 0> Stream > AI Core task

ACL API（model/runtime）

图 9-15 ACL API（model/runtime）

表 9-5 字段说明（model/runtime）

字段名 字段解释

ID ACL API的ID。

Name ACL API的名称。

Start Time(us) ACL API的开始运行时间，单位为us。

End Time(us) ACL API的结束运行时间，单位为us。

Duration(us) ACL API的运行耗时，单位为us。

Process ID ACL API对应进程ID。

Thread ID ACL API对应线程ID。
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Runtime API

图 9-16 Runtime API

表 9-6 字段说明

字段名 字段解释

ID Runtime API的ID。

Name Runtime API的名称。

Start Time(us) Runtime API的开始运行时间，单位为us。

End Time(us) Runtime API的结束运行时间，单位为us。

Duration(us) Runtime API的运行耗时，单位为us。

Process ID Runtime API对应进程ID。

Thread ID Runtime API对应线程ID。

 

Os Runtime

图 9-17 Os Runtime
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表 9-7 字段说明

字段名 字段解释

ID Os Runtime的ID。

Name Os Runtime的名称。

Start Time(us) Os Runtime的开始运行时间，单位为us。

End Time(us) Os Runtime的结束运行时间，单位为us。

Duration(us) Os Runtime的运行耗时，单位为us。

Process ID Os Runtime对应进程ID。

Thread ID Os Runtime对应线程ID。

 

AI Core task

图 9-18 AI Core task

表 9-8 字段说明

字段名 字段解释

ID AI Core task的ID。

Device ID AI Core task运行所在设备ID。

Op Name AI Core task的算子名称。

Start Time(us) AI Core task的开始运行时间，单位为us。

End Time(us) AI Core task的结束运行时间，单位为us。

Duration(us) AI Core task的运行耗时，单位为us。

Status AI Core task的运行状态。

Task Type AI Core task的任务类型。

Stream ID AI Core task的stream ID。

Task ID AI Core task的task ID。
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9.6.3.4 Statistics 视图

单击下方数据窗格的Statistics，通过左上角下拉框选择不同类别的数据，可以查看ACL
API、OS Runtime API、Runtime API、OPs和Op Info调用情况数据。

ACL API 和 OS Runtime API

图 9-19 ACL API

图 9-20 OS Runtime API

表 9-9 字段说明

字段名 字段解释

Name 对应调用API名称。

Type（仅ACL API） 调用ACL API的类型。

Time(%) 对应调用API总时间占比。

Time(us) 对应调用API时间长度，单位为us。
可以点击字段旁边的三角号根据此项进行降序或升序
排列。

Count 对应API调用次数。

Avg(us) 对应API单次调用平均时间，单位为us。

Min(us) 对应API单次调用 短时间，单位为us。

Max(us) 对应API单次调用 长时间，单位为us。

Process ID 对应调用API所在进程ID。

Thread ID 对应调用API所在线程ID。
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Runtime API

图 9-21 Runtime API

表 9-10 字段说明

字段名 字段解释

Name 对应调用API名称。

Stream ID Stream ID，用于识别stream。

Time(%) 对应调用API总时间占比。

Time(ns) 对应调用API时间长度，单位为ns。
可以点击字段旁边的三角号根据此项进行降序或升序
排列。

Calls 调用Runtime API的呼叫次数。

Avg(ns) 对应API单次调用平均时间，单位为ns。

Min(ns) 对应API单次调用 短时间，单位为ns。

Max(ns) 对应API单次调用 长时间，单位为ns。

Process ID 对应调用API所在进程ID。

Thread ID 对应调用API所在线程ID。

 

OPs

图 9-22 OPs（昇腾 310 AI 处理器）
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表 9-11 字段说明

字段名 字段解释

Time(%) 对应调用API总时间占比。

Time(us) 对应调用API时间长度，单位为us。
可以点击字段旁边的三角号根据此项进行降序或升序
排列。

Count 对应的Task被执行的次数。

Avg(us) 对应Task平均执行时间，单位为us。

Min(us) 对应Task 短执行时间，单位为us。

Max(us) 对应Task 长执行时间，单位为us。

Waiting(us) 对应Task总计waiting时间，单位为us。

Running Man(us) 对应Task总计running时间，单位为us。表示Task的实
际运行时间，过长的Task运行时间可能意味着算子实
现存在问题。

Pending(us) 对应Task总计pending时间，单位为us。

Type 对应Task的类型。

API 调用的接口。

Task ID Task ID，用于识别task。

Op Name 算子名称。

Stream ID Stream ID，用于识别stream。

 

图 9-23 OPs（昇腾 710 与昇腾 910 AI 处理器）

表 9-12 字段说明

字段名 字段解释

Kernel
Name

kernel的名称。
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字段名 字段解释

Kernel Type kernel的类型。

Stream Id Stream的ID号。

Task Id Task的ID号。

Task
Time(us)

Task总耗时，单位为us。

Task
Start(ns)

Task开始时间，单位为ns。

Task
Stop(ns)

Task结束时间，单位为ns。

 

Op Info

图 9-24 Op Info

表 9-13 字段说明

字段名 字段解释

Model Name 模型名称。

推理应用中存在离线模型调用时（ACL函数接口：
aclModelExecute），本参数展示；不存在离线模型调用
时，本参数不展示。

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称。

Op Type 算子类型。

Task Start Time Task的开始运行时间。

Task Duration(us) Task的运行耗时，单位为us。

Task Wait Time(us) 上一个Task的结束时间与当前Task的开始时间间隔，单
位为us。
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字段名 字段解释

Block Dim Task运行时所在的核。

Input Shapes 算子的输入维度。

Input Data Types 算子输入的数据类型。

Input Formats 算子输入格式。

Output Shapes 算子的输出维度。

Output Data Types 算子输出的数据类型。

Output Formats 算子输出格式。

Aicore Time(us)（仅采
集方式为Task-Based时展
示）

AI Core运行时间，单位为us。

Total Cycles（仅采集方
式为Task-Based时展示）

该Task的所有指令的cycle总数。

 

9.6.3.5 AI Core Metrics 视图

单击下方数据窗格的AI Core Metrics，可以查看AI Core Metrics数据。

图 9-25 AI Core Metrics

表 9-14 字段说明

字段名 字段解释

Task-based：Pipeline Utilization

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Task Start Time 任务启动时间。

Task Duration(us) 任务运行持续时间，单位为us。
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字段名 字段解释

Task Wait
Time(us)

任务等待时间，单位为us。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

vec_time(us) vec类型指令（向量类运算指令）耗时，单位为us。

vec_ratio vector类型指令（向量类运算指令）的cycle数在所有指令的
cycle数中的占用比。

mac_time(us) cube类型指令（矩阵类运算指令）耗时，单位为us。

mac_ratio cube类型指令（矩阵类运算指令）的cycle数在所有指令的
cycle数中的占用比。

scalar_time(us) scalar类型指令（标量类运算指令）耗时，单位为us。

scalar_ratio scalar类型指令（标量类运算指令）的cycle数在所有指令 的
cycle数中的占用比。

mte1_time(us) mte1类型指令（L1->L0A/L0B搬运类指令）耗时，单位为us。

mte1_ratio mte1类型指令（L1->L0A/L0B搬运类指令）的cycle数在所 有
指令的cycle数中的占用比。

mte2_time(us) mte2类型指令（DDR->AI Core搬运类指令）耗时，单位为
us。

mte2_ratio mte2类型指令（DDR->AI Core搬运类指令）的cycle数在 所有
指令的cycle数中的占用比。

mte3_time(us) mte3类型指令（AI Core->DDR搬运类指令）耗时，单位为
us。

mte3_ratio mte3类型指令（AI Core->DDR搬运类指令）的cycle数在 所有
指令的cycle数中的占用比。

icache_miss_rate icache缺失率，即未命中icache，数值越小越好。

memory_bound 用于识别AI Core执行算子计算过程是否存在Memory瓶颈，由
Mte2 Ratio/max(Mac Ratio, Vec Ratio)计算得出。计算结果
小于1， 表示没有Memory瓶颈；计算结果大于1 则表示有
Memory瓶颈，且数值越大越瓶颈严重。

Task-based：Arithmetic Utilization

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Task Start Time 任务启动时间。
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字段名 字段解释

Task Duration(us) 任务运行持续时间，单位为us。

Task Wait
Time(us)

任务等待时间，单位为us。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

mac_fp16_ratio cube fp16类型指令的cycle数在所有指令的cycle数中的占用
比。

mac_int8_ratio cube int8类型指令的cycle数在所有指令的cycle数中的占用
比。

vec_fp32_ratio vec fp32类型指令的cycle数在所有指令的cycle数中的占用比。

vec_fp16_ratio vec fp16类型指令的cycle数在所有指令的cycle数中的占用比。

vec_int32_ratio vec int32类型指令的cycle数在所有指令的cycle数中的占用
比。

vec_misc_ratio vec misc类型指令的cycle数在所有指令的cycle数中的占用比。

cube_fops cube类型每秒浮点运算次数。

vector_fops vector类型每秒浮点运算次数。

Task-based：UB/L1/L2/Main Memory Bandwidth

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Task Start Time 任务启动时间。

Task Duration(us) 任务运行持续时间，单位为us。

Task Wait
Time(us)

任务等待时间，单位为us。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

ub_read_bw(GB/s) Ub读带宽速率，单位为GB/s。

ub_write_bw(GB/s
)

Ub写带宽速率，单位为GB/s。

l1_read_bw(GB/s) L1读带宽速率，单位为GB/s。

l1_write_bw(GB/s) L1写带宽速率，单位为GB/s。
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字段名 字段解释

l2_read_bw(GB/s) L2读带宽速率，单位为GB/s。

l2_write_bw(GB/s) L2写带宽速率，单位为GB/s。

main_mem_read_
bw(GB/s)

主存储器读带宽速率，单位为GB/s。

main_mem_write_
bw(GB/s)

主存储器写带宽速率，单位为GB/s。

Task-based：L0A/L0B/L0C Memory Bandwidth

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Task Start Time 任务启动时间。

Task Duration(us) 任务运行持续时间，单位为us。

Task Wait
Time(us)

任务等待时间，单位为us。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

scalar_ld_ratio scalar access ub类型读指令的cycle数在所有指令的cycle数中
的占用比。

scalar_st_ratio scalar access ub类型写指令的cycle数在所有指令的cycle数中
的占用比。

l0a_read_bw(GB/s
)

L0a读带宽速率，单位为GB/s。

l0a_write_bw(GB/
s)

L0a写带宽速率，单位为GB/s。

l0b_read_bw(GB/s
)

L0b读带宽速率，单位为GB/s。

l0b_write_bw(GB/
s)

L0b写带宽速率，单位为GB/s。

l0c_read_bw(GB/s
)

L0c读带宽速率，单位为GB/s。

l0c_write_bw(GB/
s)

L0c写带宽速率，单位为GB/s。

Task-based：UB Memory Bandwidth
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字段名 字段解释

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Task Start Time 任务启动时间。

Task Duration(us) 任务运行持续时间，单位为us。

Task Wait
Time(us)

任务等待时间，单位为us。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

ub_read_bw_mte(
GB/s)

mte从ub读带宽速率，单位为GB/s。昇腾310 AI处理器支持。

ub_write_bw_mt
e(GB/s)

mte向ub写带宽速率，单位为GB/s。昇腾310 AI处理器支持。

ub_read_bw_vecto
r(GB/s)

vector从ub读带宽速率，单位为GB/s。

ub_write_bw_vect
or(GB/s)

vector向ub写带宽速率，单位为GB/s。

ub_read_bw_scala
r(GB/s)

scalar从ub读带宽速率，单位为GB/s。

ub_write_bw_scal
ar(GB/s)

scalar向ub写带宽速率，单位为GB/s。

Sample-based：Pipeline Utilization

Core ID AI Core ID，用于识别AI Core。

vec_ratio vector类型指令（向量类运算指令）的cycle数在所有指令的
cycle数中的占用比。

mac_ratio cube类型指令（矩阵类运算指令）的cycle数在所有指令的
cycle数中的占用比。

scalar_ratio scalar类型指令（标量类运算指令）的cycle数在所有指令的
cycle数中的占用比。

mte1_ratio mte1类型指令（L1->L0A/L0B搬运类指令）的cycle数在所有
指令的cycle数中的占用比。

mte2_ratio mte2类型指令（DDR->AI Core搬运类指令）的cycle数在所有
指令的cycle数中的占用比。
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字段名 字段解释

mte3_ratio mte3类型指令（AI Core->DDR搬运类指令）的cycle数在所有
指令的cycle数中的占用比。

icache_miss_rate icache缺失率，即未命中icache，数值越小越好。

memory_bound 用于识别AI Core执行算子计算过程是否存在内存瓶颈，由
mte2_ratio/max(mac_ratio, vec_ratio)计算得出。计算结果小
于1表示没有内存瓶颈；计算结果大于1表示有内存瓶颈，且数
值越大瓶颈越严重。

Sample-based：Arithmetic Utilization

Core ID AI Core ID，用于识别AI Core。

mac_fp16_ratio cube fp16类型指令的cycle数在所有指令的cycle数中的占用
比。

mac_int8_ratio cube int8类型指令的cycle数在所有指令的cycle数中的占用
比。

vec_fp32_ratio vec fp32类型指令的cycle数在所有指令的cycle数中的占用比。

vec_fp16_ratio vec fp16类型指令的cycle数在所有指令的cycle数中的占用比。

vec_int32_ratio vec int32类型指令的cycle数在所有指令的cycle数中的占用
比。

vec_misc_ratio vec misc类型指令的cycle数在所有指令的cycle数中的占用比。

cube_fops Cube类型每秒浮点运算次数。

vector_fops Vector类型每秒浮点运算次数。

Sample-based：UB/L1/L2/Main Memory Bandwidth

Core ID AI Core ID，用于识别AI Core。

ub_read_bw(GB/s) Ub读带宽速率，单位为GB/s。

ub_write_bw(GB/s
)

Ub写带宽速率，单位为GB/s。

l1_read_bw(GB/s) L1读带宽速率，单位为GB/s。

l1_write_bw(GB/s) L1写带宽速率，单位为GB/s。

l2_read_bw(GB/s) L2读带宽速率，单位为GB/s。

l2_write_bw(GB/s) L2写带宽速率，单位为GB/s。

main_mem_read_
bw(GB/s)

主存储器读带宽速率，单位为GB/s。

main_mem_write_
bw(GB/s)

主存储器写带宽速率，单位为GB/s。

Sample-based：L0A/L0B/L0C Memory Bandwidth
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字段名 字段解释

Core ID AI Core ID，用于识别AI Core。

l0a_read_bw(GB/s
)

L0a读带宽速率，单位为GB/s。

l0a_write_bw(GB/
s)

L0a写带宽速率，单位为GB/s。

l0b_read_bw(GB/s
)

L0b读带宽速率，单位为GB/s。

l0b_write_bw(GB/
s)

L0b写带宽速率，单位为GB/s。

l0c_read_bw(GB/s
)

L0c读带宽速率，单位为GB/s。

l0c_write_bw(GB/
s)

L0c写带宽速率，单位为GB/s。

Sample-based：UB Memory Bandwidth

Core ID AI Core ID，用于识别AI Core。

ub_read_bw_vecto
r(GB/s)

vector从ub读带宽速率，单位为GB/s。

ub_write_bw_vect
or(GB/s)

vector向ub写带宽速率，单位为GB/s。

ub_read_bw_scala
r(GB/s)

scalar从ub读带宽速率，单位为GB/s。

ub_write_bw_scal
ar(GB/s)

scalar向ub写带宽速率，单位为GB/s。

ub_read_bw_mte(
GB/s)

mte从ub读带宽速率，单位为GB/s。昇腾310 AI处理器支持。

ub_write_bw_mt
e(GB/s)

mte向ub写带宽速率，单位为GB/s。昇腾310 AI处理器支持。

 

9.6.4 Analysis Summary
在“Analysis Summary”模块中，选择需要查看的Device ID后，可以查看对应device
的详细性能分析信息。
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图 9-26 Analysis Summary 视图

Profiling Info

表 9-15 收集信息

字段名 字段解释

Result Size 结果文件大小。

Profiling Elapsed Time 信息采集持续的时间。

 

Host System Info

表 9-16 Host 系统信息

字段名 字段解释

Cpu Num CPU数量。

Host Operating System Host侧操作系统信息。

Host Computer Name Host侧电脑名称。
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Host CPU Info

表 9-17 Host 侧 CPU 信息

字段名 字段解释

CPU ID CPU ID。

Name CPU名称。

Type CPU型号。

Frequency CPU频率。

部分系统由于不存在调用频率的接口，
故不展示此参数，本参数展示情况请以
实际情况为准。

Logical CPU Count 逻辑CPU数量。

 

Device Info

表 9-18 Device 信息

字段名 字段解释

AI Core Number AI Core 数量。

AI CPU Number AI CPU数量。

Control CPU Number Control CPU数量。

Control CPU Type Control CPU型号。

Device Id 当前页面关联的Device ID

TS CPU Number TS CPU数量。

 

DDR

表 9-19 DDR 参数说明

字段名 字段解释

Metric BandWidth，单位为MB/s。

Read(MB/s) 读带宽，单位为MB/s。

Write(MB/s) 写带宽，单位为MB/s。
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AI Core Utilization

AI Core利用率通过折线图方式呈现（AI Core Utilization参数选择Sample-based才会
展示）。

9.6.5 Memory Chart
Memory Chart视图通过将AI Core Metrics所展示的数据与对应硬件的组织结构图产生
联动，使用户更加清晰理解Memory间关系及数据流向。

如图9-27在Profiling报告中选择Memory Chart视图。

图 9-27 Memory Chart 视图

Memory Chart视图只展示计算单元和内存单元的读写速率和数据流向。

● 当AI Core采集开关为Pipeline Utilization和Arithmetic Utilization时，则无该视图
展示。

● 当AI Core采集开关为UB/L1/L2/Main Memory Bandwidth时，单击UB/L1/L2/
Main Memory单元则高亮显示对应单元及其数据流向箭头并且鼠标停靠显示该单
元的采集数据，如图9-28。

图 9-28 UB/L1/L2/Main Memory

图9-28中的AI Core Metrics字段解释请参见表9-14。

● 当AI Core采集开关为L0A/L0B/L0C Memory Bandwidth时，单击L0A/L0B/L0C
Memory单元则高亮显示对应单元及其数据流向并且鼠标停靠显示该单元的采集
数据，如图9-29。
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图 9-29 L0A/L0B/L0C Memory

图9-29中的AI Core Metrics字段解释请参见表9-14。

● 当AI Core采集开关为UB Memory Bandwidth时，单击Unified Buffer单元则高亮
显示对应单元及其数据流向并且鼠标停靠显示该单元的采集数据，如图9-30。

图 9-30 UB Memory

图9-30仅为Task-based采集方式下的数据，Sample-based和Task-based采集方
式下所有字段解释如下表。

表 9-20 字段说明

字段名 字段解释

Sample-based
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字段名 字段解释

Core ID AI Core ID，用于识别AI Core。

ub_read_bw_vect
or(GB/s)

vector从ub读带宽速率，单位为GB/s。

ub_write_bw_vec
tor(GB/s)

vector向ub写带宽速率，单位为GB/s。

ub_read_bw_scal
ar(GB/s)

scalar从ub读带宽速率，单位为GB/s。

ub_write_bw_sca
lar(GB/s)

scalar向ub写带宽速率，单位为GB/s。

ub_read_bw_mt
e(GB/s)

mte从ub读带宽速率，单位为GB/s。昇腾310 AI处理器支
持。

ub_write_bw_mt
e(GB/s)

mte向ub写带宽速率，单位为GB/s。昇腾310 AI处理器支
持。

Task-based：UB Memory Bandwidth

Task ID Task ID，用于识别task。

Stream ID Stream ID，用于识别stream。

Op Name 算子名称，用于识别算子。

OP Type 算子类型。

Aicore Time(us) AI Core运行时间，单位为us。

Total Cycles 该Task的所有指令的cycle总数。

ub_read_bw_mt
e(GB/s)

mte从ub读带宽速率，单位为GB/s。昇腾310 AI处理器支
持。

ub_write_bw_mt
e(GB/s)

mte向ub写带宽速率，单位为GB/s。昇腾310 AI处理器支
持。

ub_read_bw_vect
or(GB/s)

vector从ub读带宽速率，单位为GB/s。

ub_write_bw_vec
tor(GB/s)

vector向ub写带宽速率，单位为GB/s。

ub_read_bw_scal
ar(GB/s)

scalar从ub读带宽速率，单位为GB/s。

ub_write_bw_sca
lar(GB/s)

scalar向ub写带宽速率，单位为GB/s。
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9.6.6 Baseline Comparison
Profiling报告可以通过对比功能将两份报告的结果数据进行比对，并在Baseline
Comparison（基准分析）视图展示。方便在重复执行Profiling之后产生多个报告后，
对比相同情况下多次采集的数据之间的变化情况。

如图9-31在打开的Profiling报告中选择Baseline Comparison视图，单击Baseline file
path右侧文件夹按钮，如图9-32选择需要与当前报告比对的基线数据报告（.json文
件）。

图 9-31 Baseline Comparison 视图

图 9-32 选择基线数据报告

两份报告比对结果如图9-33和图9-34，以Baseline file path所选报告的数据为基础，
比对当前报告的数值以增减相应差值展示。
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图 9-33 Task-based 场景比对结果

图 9-34 Sample-based 场景比对结果

说明

● Baseline Comparison仅比对OPs和AI Core Metrics的结果数据。

● Baseline Comparison仅支持相同Device ID的Profiling结果数据对比。

● 结果数据比对的差值保留小数点后两位。

● Profiling elapsed time表示当前Device下本次Profiling执行采集的时间。

● 一般情况下两份报告之间须在相同设备、模型以及采集参数下的两次Profiling生成的数据，
否则结果数据不匹配无法比较，并给出相应告警提示；但如果两个不同设备或模型采集的数
据完全相同，也可以进行比较。

● Sample-based场景展示AI Core Utilization的折线图比对结果。
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9.7 Profiling 性能分析样例参考

9.7.1 网络应用中的函数计算性能优化分析样例

背景介绍

使用PyTorch网络应用在昇腾平台执行推理过程中，发现整体执行时间较长。为了找出
原因，使用Profiling性能分析工具对该网络应用执行推理耗时分析，分析结果显示运
行的接口aclmdlExecute执行耗时数值较高，进一步分析结果发现Conv算子执行时间
长。因此我们打开PyTorch网络转换成的om模型查询Conv算子，发现该算子是多个计
算单元组成，这样会造成极大的推理开销。由于Conv算子所在函数为Mish激活函数，
而当前昇腾平台支持的激活函数只有：Relu、Leakyrelu、Prelu、Elu、Srelu，Mish函
数暂时不在支持范围内，因此造成模型转换后的Mish函数被分解成了多个计算单元。

问题解决：我们通过将om模型中的Mish函数替换昇腾平台的激活函数，尝试降低推理
耗时，以Leakyrelu替换Mish函数为例，重新执行Profiling性能分析，结果发现推理耗
时明显降低。

说明

● 本文仅介绍Profiling性能分析工具的操作及分析过程，对于om模型的算子分析以及函数替换
等操作此处不做阐述。

● 有关PyTorch模型转换为om模型的详细介绍请参见《PyTorch 1.5.0 网络模型移植&训练指
南》或《PyTorch 1.8.1 网络模型移植&训练指南》中的“模型保存与转换”章节。

Profiling 性能分析操作

通过以下操作方法启动Profiling：

步骤1 启动MindStudio，单击选择并打开已编译完成的工程。如图9-35所示。

图 9-35 打开已编译完成的工程
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有关应用工程的创建和编译操作请参见应用开发。

步骤2 单击菜单栏“Ascend > System Profiler > New Project”，弹出Profiling配置窗口 。

步骤3 进入Profiling配置窗口，如图9-36。配置Profiling的工程名称“Project Name”和选
择Profiling工程的结果路径“Project Location”。单击“Next”进入下一步。

图 9-36 Project Properties 配置

步骤4 进入“Executable Properties”配置界面，选择Local Run模式。指定执行Profiling目
标工程的可执行文件目录。如图9-37所示。mian
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图 9-37 Local Run

步骤5 进入“Profiling Options”配置界面，选择Task-based场景。如图9-38所示。

MindStudio
用户指南 9 Profiling 性能分析

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 412



图 9-38 Task-based 场景

步骤6 完成上述配置后单击窗口右下角的“Start”按钮，启动Profiling。

工程执行完成后，MindStudio自动展示Profiling结果视图。如图9-39所示。

图 9-39 Profiling 分析结果

----结束
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问题分析

步骤1 根据Profiling Timeline视图的字段解释，展示模型、算子的耗时数据体现在ACL API
字段。

我们通过设置Timeline颜色配置调色板，设置显色比例为20%<=黄色<50%<=红色，
如图9-40所示。

图 9-40 Merge Reports 设置

得到新的Timeline比例并放大视图。如图9-41所示。此时我们可以直观的看到耗时
长的时间线有两段，分别为aclmdlLoadFromFileWithMem和aclmdlExcute接口。

图 9-41 ACL API Timeline

步骤2 我们接着在ACL API字段上右键点击Show in Event View并将Duration列按从大到小排
序。如图9-42所示。

图 9-42 Event View

步骤3 可以看到耗时 高的两个ACL接口为aclmdlLoadFromFileWithMem和aclmdlExcute。
我们继续查看ACL API的Statistics视图并按接口调用耗时占比从高到底排序。如图
9-43所示。
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图 9-43 ACL API Statistics

到这里我们基本可以断定执行应用推理过程中耗时 高的两个接口就是
aclmdlLoadFromFileWithMem和aclmdlExcute。

参见《应用软件开发指南（C&C++）》中的“AscendCL API参考”章节查找
aclmdlLoadFromFileWithMem接口的作用为“从文件加载离线模型数据”，可以分析
该接口耗时取决于加载离线模型的时间，加载时间我们暂时无法进行调优。

步骤4 继续查找aclmdlExecute接口的作用为“执行应用推理，直到返回推理结果，同步接
口”。

我们可以发现该接口是执行接口，也就是说应用在执行推理的过程中确实存在耗时长
的问题。而模型中所有算子执行的时间总和就是执行耗时。

那么我们查看Profiling结果的AI Core Metrics视图中的算子执行耗时并按Task
Duration算子执行任务的时间从高到低排列。如图9-44所示。

图 9-44 AI Core Metrics

可以看到第一个Conv算子的执行时间为3170.625远高于同进程下其他算子的执行时
间。可以判断该函数拖慢了整体的执行效率。

到此Profiling性能分析工具的任务已经完成。

步骤5 接下来我们可以通过模型可视化工具打开PyTorch网络转换成的om模型查询Conv算
子，发现该算子是多个计算单元组成，如图9-45所示，这样会造成极大的推理开销。
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图 9-45 PyTorch 网络 om 模型

步骤6 我们通过查询代码发现计算单元中的Softplus、Tanh和Mul是属于Mish激活函数的计
算公式，如图9-46所示。而当前昇腾平台支持的激活函数只有：Relu、Leakyrelu、
Prelu、Elu和Srelu，Mish函数不在支持范围内，因此造成模型转换后的Mish函数被分
解成了多个计算单元。

图 9-46 Mish 激活函数

解决该问题 简单的办法就是找到效率更高的替代函数。

----结束

问题解决

尝试以昇腾官方提供的Leaky Relu激活函数作为替换函数。函数替换操作请用户自行
处理，此处不作阐述。完成函数替换后重新执行Profiling性能分析操作得到新的结果
中AI Core Metrics视图下Leaky Relu函数的第一个Conv算子的执行时间Task Duration
为1415.182us比之前Mish函数的第一个Conv算子的执行时间3170.625降低了一半，同
时Leaky Relu函数的精度比Mish函数要小1%，Leaky Relu函数精度更高。如图9-47所
示。
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图 9-47 应用推理 Leaky Relu 函数算子运行结果

结论

通过Profiling性能分析工具前后两次对网络应用推理的运行时间进行分析，并对比两
次执行时间可以得出结论，替换Leaky Relu激活函数后，降低了Conv算子在应用推理
的运行时间，提升了推理效率。

9.7.2 网络模型优劣选择分析样例

背景介绍

以Ghostnet网络模型为例，Ghostnet网络模型宣称为轻量化网络模型，在网络应用推
理效率上高于传统卷积的网络模型。因此使用Profiling性能分析工具对网络应用执行
推理耗时分析，分析结果显示推理耗时数值较高。通过对该模型的卷积操作进行分
析，发现Ghostnet网络模型的Conv操作进行了多次拆分整合，该操作严重影响了运行
效率，并不如普通网络模型的推理效率高。如图9-48所示。

图 9-48 Ghostnet 网络与传统卷积的网络模型的卷积操作对比

得出结论：Ghostnet网络模型不是优选的网络模型。

Profiling 性能分析操作

通过以下操作方法启动Profiling：

步骤1 启动MindStudio，单击选择并打开已编译完成的工程。如图9-49所示。
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图 9-49 打开已编译完成的工程

步骤2 单击菜单栏“Ascend > System Profiler > New Project”，弹出Profiling配置窗口 。

步骤3 进入Profiling配置窗口，如图9-50。配置Profiling的工程名称“Project Name”和选
择Profiling工程的结果路径“Project Location”。单击“Next”进入下一步。
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图 9-50 Project Properties 配置

步骤4 进入“Executable Properties”配置界面，选择Local Run模式。指定执行Profiling目
标工程的可执行文件目录。如图9-51所示。
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图 9-51 Local Run

步骤5 进入“Profiling Options”配置界面，选择Task-based场景。如图9-52所示。
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图 9-52 Task-based 场景

步骤6 完成上述配置后单击窗口右下角的“Start”按钮，启动Profiling。

工程执行完成后，MindStudio窗口下方自动展示Profiling结果视图。单击Timeline视
图下方数据窗格的Statistics视图中aclmdExecute接口体现网络整体运行时间达到了
66352.469us，单击AI Core Metrics视图，查看AI Core Metrics数据中Ghostnet网络模
型中执行了大量的Concat操作，并且运行耗时均较长。如图9-53和图9-54所示。

图 9-53 Ghostnet 网络应用推理运行结果_Statistics
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图 9-54 Ghostnet 网络应用推理运行结果_AI Core Metrics

----结束

问题分析

根据图9-54所示的结果，Ghostnet网络模型因为执行了大量的Concat操作导致了整体
的运行时间大大增加。

问题解决

使用普通网络模型重新执行Profiling性能分析操作得到新的结果Statistics视图中
aclmdExecute接口体现网络整体运行时间只有14202.312us。如图9-55所示。

图 9-55 普通网络模型运行结果

结论

通过Profiling性能分析工具前后两次对网络应用推理的运行时间进行分析，并对比两
次执行时间可以得出结论，Ghostnet网络应推理效率并不比传统卷积的网络应用推理
效率高，可以不作为优先选择的网络模型。

MindStudio
用户指南 9 Profiling 性能分析

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 422



9.7.3 自定义算子性能优化分析样例

背景介绍

算子是组成模型的基本单元，而自定义算子往往存在优化空间。为了验证自定义算子
Vadd_sample的性能，基于向量加法构建了复杂样例算子Vadd_sample，并使用
Profiling工具对其性能进行分析。由于Vadd_sample是在向量加法基础上，构建的一
个复杂算子，只在Vector上执行，因此算子的性能指标可通过AI Core Metrics视图下
的vec_ratio（向量类运算指令的cycle数在所有指令的cycle数中的占用比）字段来判
断。查看分析结果中Vadd_sample算子的vec_ratio指标，发现数值较低，未达到 优
性能。

得出结论：自定义算子Vadd_sample未达到 优性能，存在优化空间。

说明

● 本文仅介绍Profiling性能分析工具的操作及分析过程，对于自定义算子的详细优化编程此处
不做阐述。

● 有关自定义算子的详细介绍请参见自定义算子开发。

Profiling 性能分析操作

通过以下操作方法启动Profiling：

步骤1 启动MindStudio，单击选择并打开已编译完成的工程。如图9-56所示。

图 9-56 打开已编译完成的工程

步骤2 单击菜单栏“Ascend > System Profiler > New Project”，弹出Profiling配置窗口 。

步骤3 进入Profiling配置窗口，如图9-57。配置Profiling的工程名称“Project Name”和选
择Profiling工程的结果路径“Project Location”。单击“Next”进入下一步。
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图 9-57 Project Properties 配置

步骤4 进入“Executable Properties”配置界面，选择Local Run模式。指定执行Profiling目
标工程的可执行文件目录。如图9-58所示。
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图 9-58 Local Run

步骤5 进入“Profiling Options”配置界面，选择Task-based场景。如图9-59所示。
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图 9-59 Task-based 场景

步骤6 完成上述配置后单击窗口右下角的“Start”按钮，启动Profiling。

工程执行完成后，MindStudio窗口下方自动展示Profiling结果视图。如图9-60所示。
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图 9-60 Profiling 分析结果

----结束

问题分析

在调优过程中，用户可首先通过观察Timeline，感知应用的整体运行情况。结合调色
盘功能，可方便地标记和发现耗时超标的API/算子。结合API/算子的统计表格
（Statistics）可初步定位潜在瓶颈。进一步，通过观测算子的AI Core Metrics（分析
算子是否存在性能不足和优化空间），从而 终确定优化切入点。

在本例中，由于只有一个算子对大量数据做处理，因而可直接切入分析AI Core
Metrics。Vadd_sample是一个计算密集的Vector算子，因此需要关注vec_ratio（向量
类运算指令的cycle数在所有指令的cycle数中的占用比，代表着资源利用率）是否达标
（不同算子类型需要关注不同指标，如重搬运轻计算的算子，则更应关注访存性能，
根据实际情况分析即可）。如AI Core Metrics视图所示。

图 9-61 AI Core Metrics

可以看到AI Core Metrics视图中，Vadd_sample的vec_ratio 大仅达到0.639，而
vec_ratio指标取值越接近1资源利用率越高，故此可以判断Vadd_sample算子存在可优
化空间。

到此Profiling性能分析工具的任务完成。
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问题解决

为了优化Vadd_sample算子，考虑结合“TIK优化指南”对Vadd_sample算子采取双核
并行、double buffer等优化方式，提升Vadd_sample的Vector计算资源利用率， 终
减少算子执行耗时。

具体编程操作请开发者自行完成。

完成Vadd_sample算子的优化后，对推理应用重新执行Profiling性能分析操作得到新
的结果，再次查看AI Core Metrics视图，如图9-62所示。

图 9-62 AI Core Metrics

可以看到优化后AI Core Metrics视图中的vec_ratio指标平均达到0.83左右，说明
Vadd_sample的Vector计算资源利用率得到了提升。

结论

通过Profiling性能分析工具前后两次对网络应用推理的资源利用率进行分析，并对比
前后算子优化结果可以得出结论，自定义算子Vadd_sample未达到 优性能，存在优
化空间。
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10 AI Core Error 分析工具

10.1 功能介绍

10.2 总体流程

10.3 数据准备

10.4 通过工具生成解析数据

10.5 问题分析和定位

10.6 定位案例指南

10.7 错误码参考

10.1 功能介绍
在执行训练和推理发现AI Core Error问题时，使用AI Core Error Analyzer工具可以自
动快速准确地收集定位AI Core Error问题所需的关键信息，提升开发者对AI Core Error
的排查效率。

说明

● 该工具当前不支持在容器中部署使用。

● Linux部署该工具支持本地分析和远端分析；Windows当前部署该工具仅支持远端分析。

● 在推理场景下，默认使用root用户运行AI Core Error分析工具，如需使用普通用户运行，请
参见《日志参考》手册中的“附录 > msnpureport工具使用”章节，使用root用户修改目录
属性，并且给普通用户添加执行msnpureport工具的权限。
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10.2 总体流程

推理场景

图 10-1 推理流程

步骤1 执行推理时，发现了AI Core Error问题。

步骤2 配置支持AI Core Error分析工具相关参数，包括支持异常算子代码行号映射的
op_debug_level参数以及debug_dir参数。

步骤3 重新执行模型转换，生成指令映射文件。

步骤4 使用AI Core Error分析工具解析问题。

----结束
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训练场景

图 10-2 训练流程

步骤1 进行模型训练时，发现了AI Core Error问题。

步骤2 配置支持AI Core Error分析工具相关参数，包括如下参数：

● 支持异常算子代码行号映射的op_debug_level参数。

● 支持dump异常算子信息的enable_exception_dump参数。

步骤3 重新执行模型训练脚本，生成指令映射文件和异常算子的dump文件。

步骤4 使用AI Core Error分析工具解析问题。

----结束

10.3 数据准备

训练场景

1. 当训练过程中发现AI Core Error问题时，用户可参考如下步骤配置
op_debug_level和enable_exception_dump参数。

– Estimator模式下，开启op_debug_level和enable_exception_dump：
from npu_bridge.estimator.npu.npu_config import NPURunConfig
from npu_bridge.estimator.npu.npu_config import DumpConfig

session_config=tf.ConfigProto()

config = NPURunConfig(
  op_debug_level = 2,            //开启算子debug功能。
  session_config=session_config,
  enable_exception_dump=1       //Dump AI Core Error算子的输入和输出信息，dump信息生成
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在当前脚本执行目录。不支持dump动态shape算子。
  )

– sess.run模式下，开启op_debug_level和enable_exception_dump：
import tensorflow as tf
from npu_bridge.estimator import npu_ops
from tensorflow.core.protobuf.rewriter_config_pb2 import RewriterConfig

config = tf.ConfigProto()

custom_op =  config.graph_options.rewrite_options.custom_optimizers.add()
custom_op.name =  "NpuOptimizer" 
custom_op.parameter_map["use_off_line"].b = True
custom_op.parameter_map["enable_exception_dump"].i = 1  //Dump AI Core Error算子的输
入和输出信息，dump信息生成在当前脚本执行目录。不支持dump动态shape算子。
custom_op.parameter_map["op_debug_level"].i = 2         //开启算子debug功能。
config.graph_options.rewrite_options.remapping = RewriterConfig.OFF  #关闭remap开关

with tf.Session(config=config) as sess:
  print(sess.run(cost))

2. 重新执行训练后，会在训练执行目录下生成指令映射文件和异常算子dump文件。

推理场景

需要在模型转换时，完成op_debug_level和debug_dir参数配置。流程如下：

步骤1 启动Model Converter。

步骤2 单击Advanced Options下拉框。

步骤3 将Additional Arguments置于开启状态，填入“op_debug_level”参数（例如：--
op_debug_level=2）和“debug_dir”参数（生成debug文件的路径，该路径为工程下
的指定路径，其中路径下的“compile_path_infer”文件夹须自行创建）。如图10-3所
示。
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图 10-3 配置参数

说明

Windows环境下暂不支持开启Additional Arguments填入“op_debug_level”参数和
“debug_dir”参数进行转换，可在关闭Additional Arguments情况下直接启动转换。

----结束

op_debug_level 参数说明

表 10-1 op_debug_level 参数取值说明

取
值

说明

0 不开启算子debug功能，默认为0。

1 开启算子debug功能，在训练脚本执行目录下的kernel_meta文件夹中生成TBE
指令映射文件（算子cce文件*.cce、python-cce映射文件*_loc.json、.o和.json
文件），用于后续工具进行AI Core Error问题定位。

2 开启算子debug功能，在训练脚本执行目录下的kernel_meta文件夹中生成TBE
指令映射文件（算子cce文件*.cce、python-cce映射文件*_loc.json、.o和.json
文件），并关闭编译优化开关（开启ccec编译器选项-O0-g），用于后续工具
进行AI Core Error问题定位，可定位到出错算子的代码行号。
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10.4 通过工具生成解析数据

启动工具

AI Core Error Analyzer默认提取EP场景的落盘日志进行分析，若需要对RC场景进行分
析，则执行分析之前需要将应用工程中的.project文件中的target_id属性修改为“RC”
（如图10-4所示），保证提取的分析数据的路径为RC场景的落盘日志路径。有关EP和
RC场景的落盘日志路径信息请参见《日志参考》。

图 10-4 .project 文件

步骤1 单击工具栏菜单“Ascend > AI Core Error Analyzer”，启动AI Core Error Analyzer。

步骤2 AI Core Error Analyzer参数配置。

Compile Path：推理场景为模型转换生成的debug文件路径，请参见“数据准备”章
节中的步骤3。训练场景为脚本执行路径。用于存储算子编译中间生成的输出件和
pbtxt，一般为“kernel_meta”文件的父路径（例如：~/model_convert）。

图 10-5 参数配置

步骤3 单击“Analyze”，在“Output”窗口查看分析结果。
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说明

分析过程中若报错“TOOLCHAIN_HOME is empty”，请参见《CANN 软件安装指南》的“安
装后配置章节”中安装toolkit包时配置$HOME/ascend-toolkit/set_env.sh脚本配置
TOOLCHAIN_HOME环境变量。

----结束

生成结果文件

所有AI Core Error Analyzer生成的文件会保存在当前IDE路径下，当前IDE路径格式一
般为“info_timeline”（例如“info_20200903114406”）。生成的结果文件请以实
际情况为准，以下示例仅供参考。

● 推理场景（示例）：

– Ascend EP场景：
├── aicore_error  
│   ├──aicerr_out
│        ├──info_xxxxx  
│             ├──aicerror_xxxxx  //AI Core Error分析工具生成文件   
│                  ├──info.txt    //AI Core Error工具解析结果汇总文件
│                  ├──te_transdata_xxxx.o  
│                  ├──te_transdata_xxxx.o.txt   //反编译文件
│             ├──collection    //异常算子涉及文件
│                  ├──compil
│                       ├──kernel_meta
│                            ├──cce文件
│                            ├──json文件
│                            ├──loc.json文件
│                            ├──.o文件                            
│                       ├──ge_proto_xxxx_Build.txt
│                  ├──dump    //搬运的dump文件
│                  ├──log    //Host侧日志
│                  ├──xxxxx   //时间信息    
│             ├──error.log    //收集了日志目录下所有ERROR级别日志信息
│             ├──README.txt
│   ├──npu_report    
│        ├──xxxxx   //时间信息
│             ├──hisi_logs    //黑匣子错误信息
│             ├──message    //Device侧操作系统日志
│             ├──slog  
│             ├──stackcore                

– Ascend RC场景：
├── aicore_error  
│   ├──aicerr_out
│        ├──info_xxxxx  
│             ├──aicerror_xxxxx  //AI Core Error分析工具生成文件   
│                  ├──info.txt    //AI Core Error工具解析结果汇总文件
│                  ├──te_transdata_xxxx.o  
│                  ├──te_transdata_xxxx.o.txt   //反编译文件
│             ├──collection    //异常算子涉及文件
│                  ├──compil
│                       ├──kernel_meta
│                            ├──cce文件
│                            ├──json文件
│                            ├──loc.json文件
│                            ├──.o文件                            
│                       ├──ge_proto_xxxx_Build.txt
│                  ├──dump    //搬运的dump文件
│                  ├──xxxxx       
│             ├──error.log    //收集了日志目录下所有ERROR级别日志信息
│             ├──README.txt           

● 训练场景（示例）：
├── aicore_error  
│   ├──aicerr_out
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│        ├──info_xxxxx  
│             ├──collection    //异常算子涉及文件
│                  ├──log    //Host侧日志
│                       ├──xxxx    //进程ID
│                  ├──xxxx    //时间信息
│                       ├──hisi_logs    //黑匣子错误信息
│                       ├──slog
│   ├──npu_report    
│        ├──xxxxx    //时间信息
│             ├──hisi_logs    //黑匣子错误信息
│             ├──message    //Device侧操作系统日志
│             ├──slog  
│             ├──stackcore                   

10.5 问题分析和定位
用户可以直接通过run窗口的日志进行问题分析和定位。关键信息说明：

********************Root cause conclusion*********************
#符合已知故障模式的问题会列出对问题根因的判断。

***********************1. Basic information********************
#AI Core error发生时设备的基本信息。
#kernel name：算子名称。
#op address: 算子代码在ddr内存的地址。
#args address：算子参数在ddr内存的地址。
error time   : 2020-08-26-11:24:07
device id    : 0
core id      : 0
task id      : 60
stream id    : 517
node name    : trans_TransData_167
kernel name  : te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb
op address   : 0x101000120000
args address : 0X101000053000

***********************2. AICERROR code***********************
#AI Core error错误码及解释。
code  : 0x10

CCU_ERR_INFO: 0xb166486200070074
    ccu_err_addr bit[22:8]=000011100000000  meaning:CCU Error Address [17:3]  approximate:0x3800

***********************3. Instructions************************
#异常指令。
start   pc   : 0x101000120000
current pc   : 0x1010001201e0

Error occured most likely at line: 1d0
                
/{当前IDE路径}/aicerror_xxxx/te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.o.txt:1d0
/{当前IDE路径}/collection/compile/kernel_meta/te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.cce:
32    //出错算子的cce代码行号
/{python脚本文件路径}/nz_2_nd.py:4486     //出错算子的python代码行号

related instructions (error occured before the mark *):

     1bc: <not available>
     1c0: <not available>
     1c4: <not available>
     1c8: <not available>
     1cc: <not available>
     1d0: <not available>
     1d4: <not available>
     1d8: <not available>
     1dc: <not available>
*    1e0: <not available>  
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For complete instructions, please view /{当前IDE路径}/aicerror_xxxx/
te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.o.txt

****************4. Input and output of node*******************
#输入输出信息。
#从GE的IMAS日志中解析出输入输出地址，从build图中解析出size。
#如果有内存零拷贝情况，日志中可以解析出新地址new addr。
#如果地址不在RTS申请日志的记录范围内，会给出 OVERFLOW 标记。
#如果收集了device内存数据，会检测数据中是否有 NaN/INF ，但只有在device挂起后收集到的数据才是准确
的。
#如果检测到kernel函数中输入输出个数与此处个数不相等，会给出 WARNING，很有可能发生了GE给的参数与
算子处理的参数错位问题。
input[0]  addr: 0x100801126600  size: 32288      
output[0]  addr: 0x100801157c00  size: 2048      

***********************5. Op in graph*************************
#出错算子信息。
#从build图中截取op信息，方便查看。

***********************6. Dump info***************************
#异常算子dump文件信息。
#训练场景独有。

10.6 定位案例指南

10.6.1 定位步骤概述

步骤1 定位问题根本原因。

AI Core Error一定是某个task运行时抛出的，但并不一定是该task执行异常导致的，其
它并行的task异常终止、task依赖的输入或者运行环境等异常都会导致 终以AI Core
Error的形式抛出来，尤其是遇到其它并行的任务异常导致的问题。直接按照AI Core
Error的定位套路往往会被带偏，因此应该先排查在AI Core Error之前是否有错误信
息。

步骤2 定位异常算子。

根据1. Basic Information模块中的device id、core id、task id、stream id、node
name、kernel name、算子地址等信息找到对应的出错算子。

步骤3 定位异常指令。

联系华为工程师，根据3. Instructions中给出的start pc与current pc，两者做差得到
异常终止运行的指令节点，进入反编译文件.o.txt文件中找到对应指令，查看对应指令
进行了什么数据存储操作。

步骤4 定位错误类型。

查看AI Core Error报错的错误码，联系华为工程师定位报错类型。

步骤5 定位具体问题。

表 10-2 问题排查说明

问题分类 排查方法 具体说明

算子功能 单算子网络复现 基于网络中的规格和数据构造单算子网络
尝试复现问题。如果能复现，基本可锁定
是当前算子节点的问题。
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问题分类 排查方法 具体说明

节点信息排查 排查计算图中报错节点的信息，重点排查
节点的shape推导，format、内存申请大
小等信息，内存访问越界类的问题，要首
先看下GE申请的内存size大小是否符合预
期。

cce代码排查 先分析cce代码逻辑的正确性，重点检查
offset、mask、burst_lenth等参数取值是
否正确，有些报错例如除零、指令遇到
inf/NAN等更可能是输入数据问题。

寄存器数据排查 寄存器数据可辅助做cce代码正确性排
查，尤其是offset，mask等信息，可根据
反汇编指令，获取指令中对应寄存器中的
数据，来反推cce代码的正确性。寄存器
数据可以从黑匣子日志中获取。

溢出问题 输入输出数据排查 出错节点的输入输出数据一般无法
dump，可以先排查出错的上游节点是否
存在溢出数据，如果附近节点无溢出数
据，全量排查网络比较耗时，可以使用放
开增加溢出判断的调测版本全网排查首次
出现溢出的节点。

单算子网络比对 基于网络中的数据比对NPU/CPU的计算
结果。

中间计算结果排查 读取UB、HBM等对应位置上的过程数
据。通过调测版本，一般可快速定位到发
生溢出或引入inf/NAN数据的算子。

向上溯源 ● 放开中断屏蔽，排查上游节点。

● 打开溢出检测，排查出现溢出的节
点。

 

----结束

10.6.2 错误码 0x4

定位思路
***********************2. AICERROR code***********************
#AI Core error错误码及解释。
code  : 0x4

该错误码含义是函数调用深度超过设置值，cce算子函数之间的调用层次超过了阈值，
而这个阈值是由一个寄存器来控制的，关于阈值说明如下。

说明

【5:2】：T，调用栈溢出阈值，超过T+1的嵌套调用都会上报可屏蔽错误，由于UB作为调用栈，
其大小是有限的，现在我们假设每个函数调用占用4KB堆栈，而UB保留16KB作为总堆栈，所以
初始复位值为3。
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默认值V100 ISA是3（现在V200 ISA默认值改成了2），只要嵌套不超过4层就不会有
问题，所以推测有如下两种情况：

● cce代码中有超过4层的算子调用。

● cce代码中有修改该寄存器的操作，将阈值修改变小了。

定位步骤

步骤1 查看日志1. Basic Information模块中的device id、core id、task id、stream id、
node name、kernel name、算子地址等信息找到对应的出错算子。
***********************1. Basic information********************
#AI Core error发生时设备的基本信息。
#kernel name：算子名称。
#op address: 算子代码在ddr内存的地址。
#args address：算子参数在ddr内存的地址。
error time   : 2020-08-26-11:24:07
device id    : 0
core id      : 0
task id      : 60
stream id    : 517
node name    : trans_TransData_167
kernel name  : te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb
op address   : 0x101000120000
args address : 0X101000053000

步骤2 检查对应算子是否有超过4层的调用。

● 如果有则已经完成问题定位。

● 如果没有则执行步骤3。

步骤3 检查cce代码中是否有直接设置或修改寄存器的场景。

● 如果有则已经完成问题定位。

● 如果没有请联系华为工程师进一步定位问题。

----结束

设置 CTRL 指令参考

对于要实现atomic_add的场景，设置CTRL指令参考如下，以FP32为例。

uint64_t ctrl_reg = get_ctrl();
uint64_t config_reg = (ctrl_reg | ((uint64_t)1 << 60)) ;    // uint64_t configReg = (ctrlReg | ((uint64_t)1 << 
60)) & (~((uint64_t)0 << 61));这个更标准一些
set_ctrl(config_reg);
set_ctrl(ctrl_reg);    // 指令还原

10.6.3 错误码 0x10

定位思路
***********************2. AICERROR code***********************
#AI Core error错误码及解释。
code  : 0x10

该错误码含义是指令非法，一般因为UB地址不对齐或者一些scalar指令不合法导致，
既然是指令非法，只要找到对应的算子指令进行分析即可。
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定位步骤

步骤1 查看日志1. Basic Information模块中的device id、core id、task id、stream id、
node name、kernel name、算子地址等信息找到对应的出错算子。
***********************1. Basic information********************
#AI Core error发生时设备的基本信息。
#kernel name：算子名称。
#op address: 算子代码在ddr内存的地址。
#args address：算子参数在ddr内存的地址。
error time   : 2020-08-26-11:24:07
device id    : 0
core id      : 0
task id      : 60
stream id    : 517
node name    : trans_TransData_167
kernel name  : te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb
op address   : 0x101000120000
args address : 0X101000053000

步骤2 查看日志3. Instructions模块中出错算子的python代码行号到对应文件中定位问题，
如果问题定位失败请联系华为工程师执行后续步骤。
***********************3. Instructions************************
#异常指令。
start   pc   : 0x101000120000
current pc   : 0x1010001201e0

Error occured most likely at line: 1d0
                
/{当前IDE路径}/aicerror_xxxx/te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.o.txt:1d0
/{当前IDE路径}/collection/compile/kernel_meta/te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.cce:
32    //出错算子的cce代码行号
/{python脚本文件路径}/nz_2_nd.py:4486     //出错算子的python代码行号

related instructions (error occured before the mark *):

     1bc: <not available>
     1c0: <not available>
     1c4: <not available>
     1c8: <not available>
     1cc: <not available>
     1d0: <not available>
     1d4: <not available>
     1d8: <not available>
     1dc: <not available>
*    1e0: <not available>  

For complete instructions, please view /{当前IDE路径}/aicerror_xxxx/
te_transdata_16b6e15e2a5cc7f70_33e5fb7ae8478ddb.o.txt

步骤3 查看日志3. Instructions中给出的start pc与current pc，两者做差得到异常终止运行
的指令节点，进入反编译文件.o.txt文件中找到对应指令，查看对应指令进行了什么数
据存储操作。

步骤4 检索其他含有相同地址操作的指令，排查每个指令中的值是否存在UB越界。例如，在
mini环境上，没有单独的scalar buffer，是在UB上划了一块空间作为scalar buffer，所
以编译出来的.o必定是在UB的256范围内；但是在cloud中，scalar buffer是单独的
buffer，可以超过256K，所以怀疑是不是这个算子编译的.o是cloud版本。

步骤5 无论是TBE算子还是TIK算子，都是通过ccec.py来编译生成.o、.json以及.cce文件。修
改ccec.py，打印编译信息，重新执行后查看打印内容中的--cce-aicore-arch字段发现
之前的算子编译都是mini版本，但到了某个算子之后变成了cloud版本。
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步骤6 查看引起版本转换的算子，发现该算子是TIK实现的，只支持cloud版本，不支持mini
版本。执行完该算子之后将变一版本修改为了cloud版本，导致后续编译算子均为
cloud版本，引起了mini环境UB越界造成的非法指令。

----结束

10.6.4 错误码 0x800000

10.6.4.1 概述

MTE流水错误，这个一般是copy_ub_to_gm或者copy_gm_to_ub两个指令报错，出错
的原因一般是atomic数据溢出或者地址不对。

● 访问out内存越界，常见原因：算子在特定shape下计算内存偏移量不正确，
infershape推导不正确导致算子实际使用内存和GE分配的内存大小不一致，传给
kernel函数的地址无法访问。

● 数据溢出问题，导致atomic报错，一般非当前算子的问题，这种问题目前 多，
需要使用放开中断屏蔽的版本排查，定位到引入inf/NAN数据的算子。需要排查溢
出或引入inf/nan数据的算子，由于大部分网络结构都比较复杂，正向排查比较困
难，需要将中断屏蔽放开去排查

10.6.4.2 DeepFM 推理（报错节点的问题）

步骤1 定位异常算子与指令。

定位排查到报错算子为gather_v2，根据对应的报错指令进行问题排查(current_pc指向
1ac，向上找到 近的vec指令)。

步骤2 结合cce分析指令的入参（offset、burst_length等）未发现问题，初步排除是算子逻辑
问题。

步骤3 定位分析。

读取寄存器与UB数据，根据反编译文件，获取X6寄存器的值，并以此为起始地址读取
UB中数据，发现数据非法，gather_v2算子的第二个输入为索引，根据该索引值取第
一个输入对应位置的数据，实际获取的索引值已经超过了第一个输入的 大位置，导
致offset访问越界。

----结束

10.6.4.3 Bert 训练（非报错节点问题，向上溯源）

步骤1 定位异常算子与指令。

排查到报错算子为sum算子，分析算子反编译文件与CCE文件后，未发现逻辑问题，排
除算子自身问题；考虑到sum算子涉及atomic add操作，怀疑数据中包含nan导致
atomic溢出。

步骤2 使用放开屏蔽版本重新跑网络，发现报除零AIC_ERROR:0X10000000000000，错误算
子为truediv，由此推测是除零引入的NAN。

步骤3 排查除零发生的原因。

读取UB数据，trudiv的第二个输入中确实存在部分为0的数据，从原始模型的算法看，
无法保证不除零，但通过great+select可以保证不使用除零的结果，也就是即便发生除
零，inf/NAN不会往下传递。进一步排查inf/NAN被错误向下传递的原因。
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步骤4 怀疑是great+select算子实现问题，导致数据中存在NAN时未被过滤掉，排查算子实
现，发现select算子通过vmin vmul一系列组合指令间接实现的select功能，当输入数
据中存在NAN时，不管condition是true还是false，都会输出NAN，没有得到算法原始
想要的结果。

步骤5 根本原因。

select算子实现问题，导致网络中针对除零做的保护失效，将除零结果NAN向下传递，
终导致atomic累加溢出。

----结束

10.6.4.4 Resnet50 云上报错（计算溢出）

步骤1 定位异常算子。

使用放开中断屏蔽的版本排查，定位到引入inf/NAN数据的算子，出错算子为
MaxPoolGrad算子报0x40000000000000错误。

步骤2 定位异常指令。

通过反编译.o，以及PC Start和Current PC，以及cce文件定位到出错的cce代码行，出
错指令为vsub。

步骤3 分析原因。

排查vsub指令的参数取值，与搬入的数据量进行比对，发现源操作和vector计算量存
在差异：搬入的数据是 49*32B，但是计算的数据量是8*128，两者不等。但是有没有
mask操作，以及不对齐的部分没有填充缺省值，这样不对齐部分的数据完全是不可预
期的，可能是之前算子计算的数据的数据类型都是int32，这样数据类型不匹配解析成
NAN，导致AI Core报错。

----结束

10.6.5 查询寄存器信息指令参考
以查看1980ctrl寄存器为例（0x020000000000000C是正常情况）。

# devmem 0xb0000078 64 0x19101920    // 开锁
# devmem 0xb0000050 64 0x4000000000001000    // 开debug 总线
# devmem 0xb0000108 64 0x3    // 0x3为要读取的起始地址，一般为某个寄存器的值
# devmem 0xb0000100 64 2    // 2是读模式
# devmem 0xb0000110 64    // 每次读取64位数据，如果需要读取更多，将上面起始地址+8，然后继续读取
0x020000000000000C

10.7 错误码参考

表 10-3 错误码参考

序
号

错误码 处理建议

0 biu_l2_read_oob L2访问读越界，BIU_ERR_INFO中的
biu_err_addr记录了越界的地址

1 biu_l2_write_oob L2访问写越界，BIU_ERR_INFO中的
biu_err_addr记录了越界的地址
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序
号

错误码 处理建议

2 ccu_call_depth_ovrflw 函数调用深度超过设置值

3 ccu_div0 scalar出现除0错误

4 ccu_illegal_instr 非法执行：1.指令的binary错误 2.指令
地址非对齐

5 ccu_loop_cnt_err loop循环次数设置为0

6 ccu_loop_err 有程序jump，从其他地方跳到loop
body中

7 ccu_neg_sqrt sqrt指令出现被开方数为负数

8 ccu_ub_ecc ecc error，硬件问题

9 cube_invld_input cube指令的输入（L0A/L0B/L0C）数据
含有NaN或者Inf，包含L0C累加场景

10 cube_l0a_ecc ecc error，硬件问题

11 cube_l0a_rdwr_cflt L0A读写同地址冲突，比如L0AD 3D指
令写L0A地址与MMAD指令读L0A地址
相同，MTE_ERR_INFO中的
mte_err_addr记录了冲突的地址

12 cube_l0a_wrap_around cube指令自动计算L0A地址时发生越
界，X或者VA寄存器已经越界的情况不
报此错误

13 cube_l0b_ecc ecc error，硬件问题

14 cube_l0b_rdwr_cflt L0B读写同地址冲突，比如L0AD 3D指
令写L0B地址与MMAD指令读L0B地址
相同，CUBE_ERR_INFO中的
cube_err_addr记录了冲突的地址

15 cube_l0b_wrap_around cube指令自动计算L0B地址时发生越
界，X或者VA寄存器已经越界的情况不
报此错误

16 cube_l0c_ecc ecc error，硬件问题

17 cube_l0c_rdwr_cflt L0C读写同地址冲突，比如MMAD指令
写L0C地址与MOV指令读L0C地址相
同，CUBE_ERR_INFO中的
cube_err_addr记录了冲突的地址

18 cube_l0c_self_rdwr_cflt 前后两条指令的L0C地址相同，可能同
时出现对相同的L0C地址同时读写的场
景，CUBE_ERR_INFO中的
cube_err_addr记录了冲突的地址
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序
号

错误码 处理建议

19 cube_l0c_wrap_around cube指令自动计算L0C地址时发生越
界，X或者VA寄存器已经越界的情况不
报此错误

20 ifu_bus_err BIU返回bus error给IFU，意味着从out
取指令错误，IFU_ERR_INFO中的
ifu_err_type记录了异常类型，
ifu_err_addr记录了错误的地址

21 mte_aipp_illegal_param AIPP指令aipp_spr寄存器配置有误，
MTE_ERR_INFO中的mte_err_type记录
了异常类型：

3'b000: aipp_mte_ex_round : 表示访问
外部存储绕回

3'b001: aipp_mte_l1_round : 表示访问
L1 buffer绕回

3'b010: aipp_mte_inerr : 表示配置AIPP
SPR相关的fp16为INF或者NAN

22 mte_bas_raddr_obound L0AD 3D指令base read addr（Xn）越
界

23 mte_biu_rdwr_resp 通过BIU读写out数据错误，
MTE_ERR_INFO中的mte_err_type记录
了异常类型，mte_err_addr记录了发生
错误的地址（是触发问题的另一面的地
址，比如out -> L1读错误，记的是L1地
址，又如ub -> out写错误，记的是ub
地址）

24 mte_cidx_overflow L0AD 3D指令c0 index L1 overflow

25 mte_decomp FMD指令异常，load index entry的数
量和它后面 近的一个load
decompressed data要解压的数据块数
量不一致，MTE_ERR_INFO中的
mte_err_type记录了异常类型：

000 fmd_write_over_turn_err
001 fmd_blk_num_zero_err
010 fmd_blk_num_noequal_err
011 fmd_header_err
100 fmd_decompress_err

26 mte_f1wpos_larger_fsize L0AD 3D指令1st filter window
position大于Feature map size – Filter
size

27 mte_fmap_less_kernel L0AD 3D指令feature map size小于
kernel size
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序
号

错误码 处理建议

28 mte_fmapwh_larger_l1size L0AD 3D指令w*h*c大于L1 size

29 mte_fpos_larger_fsize L0AD 3D指令fetch position in filter 大
于 filter size

30 mte_gdma_illegal_burst_len DMA MOV指令burst_len不合法，不能
为0

31 mte_gdma_illegal_burst_num DMA MOV指令burst_num不合法，不
能为0

32 mte_gdma_read_overflow DMA MOV指令读越界

33 mte_gdma_write_overflow DMA MOV指令写越界

34 mte_comp FMC指令异常，当前index未处理完又
下发新的index table，MTE_ERR_INFO
中的mte_err_type记录了异常类型：

000 fmc_read_over_turn_err
001 fmc_blk_num_zero_err
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序
号

错误码 处理建议

35 mte_illegal_fm_size L0AD 3D指令feature map size配置错
误，有关的一些限制如下：

1. Feature_map_size_w(after
padding)>Filter_size_w(after dilation)
Feature_map_size_h(after
padding)>=Filter_size_h(after
dilation)
2. 1st filter window position <=
Feature map size (with padding) –
Filter size (after dilation).
3. Stride size <= Feature map size
(with padding) – Filter size (after
dilation).This formula fit for the entire
feature map in convolution. In terms
of a single 3D Load instruction, the
feature map may be partial. Then in
w dimension, the formula is tenable;
In H dimension, it should be ignored.
4. Due to L1 Buffer size is 1MB,
Feature map size (without padding)
and C dimension index should meet:
FeatureMapW * FeatureMapH *
(CIndex +1) <= 32768
When repeat mode=0, the C index
increment should be consider(Cincr
denote the increment of C0 index
during repeat):
FeatureMapW * FeatureMapH *
(CIndex +Cincr+1) <= 32768
When set L1 3D size is valid
FeatureMapW * FeatureMapH *
(CIndex +Cincr+1) <= L1_3D_size

36 mte_illegal_l1_3d_size L0AD 3D指令L1_3D_SIZE配置错误，有
关的一些限制如下：

FeatureMapW * FeatureMapH *
(CIndex +Cincr+1) <= L1_3D_size
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序
号

错误码 处理建议

37 mte_illegal_stride L0AD 3D指令stride配置错误，有关的
一些限制如下：

1. Stride size, W dimension ∈[1, 63]
(Bit width[5:0]), H dimension ∈[1,
63](Bit width[5:0])
2. Stride size <= Feature map size
(with padding) – Filter size (after
dilation).This formula fit for the entire
feature map in convolution. In terms
of a single 3D Load instruction, the
feature map may be partial. Then in
w dimension, the formula is tenable;
In H dimension, it should be ignored.

38 mte_l0a_rdwr_cflt L0A读写同地址冲突，比如L0AD 3D指
令写L0A地址与MMAD指令读L0A地址
相同，MTE_ERR_INFO中的
mte_err_addr记录了冲突的地址

39 mte_l0b_rdwr_cflt L0B读写同地址冲突，比如L0AD 3D指
令写L0B地址与MMAD指令读L0B地址
相同，CUBE_ERR_INFO中的
cube_err_addr记录了冲突的地址

40 mte_l1_ecc ecc error，硬件问题

41 mte_padding_cfg LOAD 3D指令padding配置错误，和
padding有关的一些限制如下：

1. Feature_map_size_w(after
padding)>Filter_size_w(after dilation)
2. Feature_map_size_h(after
padding)>=Filter_size_h(after
dilation)
3. 1st filter window position <=
Feature map size (with padding) –
Filter size (after dilation)
4. Stride size <= Feature map size
(with padding) – Filter size (after
dilation).This formula fit for the entire
feature map in convolution. In terms
of a single 3D Load instruction, the
feature map may be partial. Then in
w dimension, the formula is tenable;
In H dimension, it should be ignored.

42 mte_read_overflow LOAD 2D读地址越界

43 mte_rob_ecc ecc error，硬件问题

44 mte_tlu_ecc ecc error，硬件问题
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序
号

错误码 处理建议

45 mte_ub_ecc ecc error，硬件问题

46 mte_unzip unzip指令异常，MTE_ERR_INFO中的
mte_err_type记录了异常类型：

000 uzp_write_over_turn_err
001 uzp_blk_num_zero_err
010 uzp_index_noenough_err
011 uzp_index_err
100 uzp_decompress_err

47 mte_write_3d_overflow LOAD 3D写地址越界

48 mte_write_overflow LOAD 2D写地址越界

49 vec_data_excp_ccu scalar指令访问的UB地址，超过了
DATA_EXP寄存器设置的UB访问地址范
围

50 vec_data_excp_mte mte指令访问的UB地址，超过了
DATA_EXP寄存器设置的UB访问地址范
围

51 vec_data_excp_vec vector指令访问的UB地址，超过了
DATA_EXP寄存器设置的UB访问地址范
围

52 vec_div0 VREC指令发生除0错误，
VEC_ERR_INFO中的vec_err_rcnt记录了
出错的repeat

53 vec_illegal_mask vector指令MASK域段为全0，
VEC_ERR_INFO中的vec_err_rcnt记录了
出错的repeat

54 vec_inf_nan vector指令的操作数为Inf或者NaN，
VEC_ERR_INFO中的vec_err_rcnt记录了
出错的repeat

55 vec_l0c_ecc ecc error，硬件问题

56 vec_l0c_rdwr_cflt L0C读写同地址冲突，比如MMAD指令
写L0C地址与MOV指令读L0C地址相
同，CUBE_ERR_INFO中的
cube_err_addr记录了冲突的地址

57 vec_neg_ln VLN指令的操作数为负数，
VEC_ERR_INFO中的vec_err_rcnt记录了
出错的repeat

58 vec_neg_sqrt VSQRT指令被开方数为负数，
VEC_ERR_INFO中的vec_err_rcnt记录了
出错的repeat
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序
号

错误码 处理建议

59 vec_same_blk_addr vector指令在同一个repeat写了相同的
block，代码不会写出这样的指令，一
般为硬件问题；VEC_ERR_INFO中的
vec_err_rcnt记录了出错的repeat

60 vec_ub_ecc ecc error，硬件问题

61 vec_ub_self_rdwr_cflt vector指令同时读写了UB的同一个地
址，仅针对lite平台

62 vec_ub_wrap_around vector指令自动计算UB地址时发生越
界，X或者VA寄存器已经越界的情况不
报此错误

63 biu_dfx_err BIU模块返回了一个综合型错误，把所
有的错误类型或在一起
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11 AutoML 工具（Beta）

11.1 概述

11.2 环境准备

11.3 集群管理

11.4 安装部署

11.5 模型自动生成

11.6 模型自动调优

11.7 超参数优化

11.8 大模型微调

11.9 任务管理

11.10 参考信息

11.11 FAQ

11.1 概述
AutoML（Auto Machine Learning）包括模型自动性能调优、模型自动生成和训练工
程超参数自动调优、HPO（Hyper parameter optimization）和大模型微调四个模
块。昇腾模型开发用户可以通过模型自动性能调优功能找到性能更好的模型。AI初学
者可以通过AutoML工具结合数据集，自动生成满足需求的模型，也可以对训练超参进
行自动调优。用户还可以通过大模型微调对紫东太初模型五个下游任务进行微调。

● 模型自动调优包含剪枝和量化算法，支持对昇腾910或GPU搜索训练，覆盖
MindSpore，PyTorch框架，能对CV领域分类、检测和分割等常用模型进行自动性
能调优。支持的场景有：基于脚本定义的模型自动性能调优（可以是训练脚本迁
移后的模型，也可以是训练工程里定义的模型）和基于离线模型的自动性能调
优。

● 模型自动生成工具以昇腾910的搜索训练，昇腾310推理验证为前提，覆盖
MindSpore，PyTorch，Tensorflow框架，面向分类、检测、分割、超分、NLP等
场景实现昇腾亲和模型的自动生成。这个场景主要功能是基于数据集自动生成网
络和基于预训练模型进行微调后自动生成模型。
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● 训练工程超参数优化，HPO（Hyperparameter Optimization），支持对昇腾910
搜索训练，覆盖MindSpore，PyTorch，Tensorflow框架，用自动化的算法来优化
超参数，从而提升模型的精度、性能等指标。

● 紫东太初模型是中科院自动化所在探索通用人工智能路上的重要成果，能够实现
三模态图文音的统一语义表达，大幅提升文本、语音、图像和视频等领域的基础
任务性能。目前MindStudio模型微调工具支持紫东太初模型跨模态检索、文本生
成、语音生成、图像生成、VQA（Visual Question Answering）五个下游任务在
单机单卡上进行微调。

AutoML当前支持昇腾910训练服务器在Ubuntu18.04-x86_64、Ubuntu18.04-
aarch64、Ubuntu20.04-x86_64和EulerOS2.8-aarch64系统上使用AutoML工具；昇腾
310推理服务器在CentOS7.6-x86_64、Ubuntu18.04-x86_64和Ubuntu18.04-aarch64
系统上使用AutoML工具。AutoML的使用流程如图11-1所示。

图 11-1 AutoML 业务流程

11.2 环境准备
● 使用非root用户运行任务时，需要以root用户将运行用户加入驱动运行用户组

HwHiAiUser中，保证普通用户对run包的lib库有读权限。

● 用户需要获取noah_vega安装whl包，可在下载地址下载1.8.3版本的noah_vega-
{version}-py3-none-any.whl安装包并放至IDE运行的服务器工作路径中，以便安
装部署时选用该路径，对应使用说明可参考说明网址。

● noah_vega提供安全通信特性，相关配置请参照安全配置说明，用户在AutoML安
装完成后需要参照该说明正确配置vega之后才能以通信安全的方式运行训练任
务。如果使用1.8版本的安全特性noah_vega包，启动任务时需要在命令末端增加
“-s”参数。
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注意

AutoML工具推荐使用的noah_vega包为第三方开源软件，用户应自行承担因使用
本软件所产生的任何风险，自行关注该软件在官网上披露的安全漏洞并及时更新
到 新版本以减少安全风险。

● 如果训练或推理服务器在EulerOS2.8-aarch64系统中使用AutoML工具，请将以下
whl包放在noah_vega-{version}-py3-none-any.whl包同一路径下，该路径为运行
MindStudio的操作系统的文件夹，请确保该文件夹中没有其他版本的noah_vega
包。

表 11-1 依赖列表

依赖 说明

numpy-{version}-
cp37-cp37m-
linux_aarch64.whl

请从官网（pypi）下载，其中numpy和pillow的版本要
求如下，其他依赖可安装 新版本。

● numpy>=1.16.5
● pillow < 7.0.0Cython-{version}-

cp37-cp37m-
linux_aarch64.whl

opencv_python-
{version}-cp37-
cp37m-
linux_aarch64.whl

pandas-{version}-
cp37-cp37m-
linux_aarch64.whl

h5py-{version}-cp37-
cp37m-
linux_aarch64.whl

psutil-{version}-cp37-
cp37m-
linux_aarch64.whl

grpcio-{version}-
cp37-cp37m-
linux_aarch64.whl

scikit_learn-{version}-
cp37-cp37m-
linux_aarch64.whl

Pillow-{version}-
cp37-cp37m-
linux_aarch64.whl

PyYAML-{version}-
cp37-cp37m-
linux_aarch64.whl
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依赖 说明

scipy-{version}-cp37-
cp37m-
linux_aarch64.whl

npu_bridge-{version}-
py3-none-any.whl

从{CANN安装路径}/tfplugin/latest/{arch}-linux/
lib64/目录获取。

te-{version}-py3-
none-any.whl

从{CANN安装路径}/ascend-toolkit/latest/{arch}-
linux/compiler/lib64/目录获取。

topi-{version}-py3-
none-any.whl

从{CANN安装路径}/ascend-toolkit/latest/{arch}-
linux/compiler/lib64/目录获取。

 

训练服务器
● 需安装好训练环境，详细操作请参见《CANN 软件安装指南》。

● python版本为3.6.0或以上的版本，所有训练服务器的python版本需要保持一致。

● pip源可用，确保pip3 install --user --upgrade pip能执行成功。

● 已安装3.13.0版本的protobuf依赖包。

● 已安装sshd。

● 在各个训练服务器上的~/.bashrc文件中配置如下环境变量：
source {Driver包安装路径}/driver/bin/setenv.bash
source {CANN包安装路径}/ascend-toolkit/set_env.sh
source {CANN包安装路径}/tfplugin/set_env.sh
export install_path={CANN包安装路径}/ascend-toolkit/latest

export LD_LIBRARY_PATH=${install_path}/compiler/lib64/:$LD_LIBRARY_PATH
export TBE_IMPL_PATH=${install_path}/opp/op_impl/built-in/ai_core/tbe

export JOB_ID=10087  #该项不建议改动
export DEVICE_ID=0  #单卡训练使用的device_id

#以下6项为多卡训练时的配置，请根据实际环境和需求改动
export RANK_ID=0
export RANK_SIZE=8
export BATCH_TASK_INDEX=0
export RANK_TABLE_FILE=多卡环境组网信息json文件所在路径  #从多卡环境组网信息json文件中选择要
使用的device_id
export NPU_VISIBLE_DEVICES=0,1,2,3,4,5,6,7  #从多卡环境组网信息json文件中选择要使用的device_id
export TF_CPP_MIN_LOG_LEVEL=3  #该项可控制TF框架本身日志级别的打印，0-DEBUG，1-INFO，2-
WARNING，3-ERROR

说明

如果训练服务器中没有多卡环境组网信息json文件，请参见配置分布式环境变量在训练服
务器上生成多卡环境组网信息json文件。当运行任务的用户为普通用户时，需要保证普通
用户对该文件有可读权限。

推理服务器
● 需安装好推理环境，详细操作请参见《CANN 软件安装指南》。

● python版本需为3.6.0或以上的版本。

● pip源可用，确保pip3 install --user --upgrade pip能执行成功。
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● 在推理服务器上的~/.bashrc文件中配置如下环境变量：
source {CANN包安装路径}/ascend-toolkit/set_env.sh

export install_path={CANN包安装路径}/ascend-toolkit/latest
export DDK_PATH=${install_path}
export PATH=${install_path}/compiler/bin:${install_path}/compiler/ccec_compiler/bin:${PATH}
export LD_LIBRARY_PATH=${install_path}/lib64:/usr/local/Ascend/driver/lib64:/usr/local/Ascend/driver/
lib64/stub:${LD_LIBRARY_PATH}
export PYTHONPATH=${install_path}/python/site-packages:${install_path}/compiler/python/site-
packages:${install_path}/compiler/python/site-packages/auto_tune.egg:${install_path}/compiler/
python/site-packages/schedule_search.egg:${install_path}/opp/op_impl/built-in/ai_core/tbe:$
{PYTHONPATH}
export ASCEND_OPP_PATH=${install_path}/opp
export SOC_VERSION=Ascend310
export NPU_HOST_LIB=${install_path}/acllib/lib64/stub/

export JOB_ID=10087  #该项不建议改动

11.3 集群管理

创建新集群

步骤1 在菜单栏选择“Ascend > AutoML > Cluster Manager”。

进入“Cluster Manager”界面。

步骤2 单击“+New Cluster”。

进入“Add Cluster”界面，如图11-2所示。界面参数说明如表11-2所示。

图 11-2 Add Cluster
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表 11-2 参数说明

参数 说明

Cluster Name 集群名称，在所有集群里具有唯一性。只支持英文字母、数字
或者下划线，以英文字母开头，且长度不超过32个字符。例
如：Cluster_01。

Evaluation Service 评估服务，通过下拉框选择已通过SSH配置好的远端环境。

Evaluation Service
Port

评估服务器端口，仅支持输入1~65535之间的数字，默认值为
8888。

Training Service 训练服务器，通过下拉框选择已通过SSH配置好的远端训练环
境。

Primary 训练服务集群主节点，通过下拉框选择已通过SSH配置好的远
端训练环境。

Add 添加训练服务。单击选择此项后，“Secondary”、“Data
Sharing Service”和“NFS Server Path”参数才会在界面体
现。

Secondary 训练服务集群从节点，通过下拉框选择已通过SSH配置好的远

端训练环境。单击 可以删除从节点。

Data Sharing
Service

数据共享服务器，通过下拉框选择已通过SSH配置好的远端环
境。

NFS Server Path NFS服务器路径。例如：/home/test/nfs_cache。

Workspace 所有训练服务器的工作路径。例如：/home/test/nfs_folder。

 

说明

● “Primary”、“Secondary”和“Data Sharing Service”的用户名要保持一致。

● 所有训练服务器和数据共享服务器通过SSH配置好的远端环境必须是连通的。建议在同网段
内，如训练服务器和评估服务器都在10网段：10.xxx.xxx.xxx。

● 同一个集群配置中，训练服务器仅支持同架构的OS。

● 所有集群中训练服务器的IP地址具有唯一性。

● 单个集群里训练服务器的个数不超过200个。

● NFS Server Path和Workspace路径需要在/home/username（当训练服务器和数据共享服
务器的SSH链接的用户名为普通用户时）下或/root下（当训练服务器和数据共享服务器的
SSH链接的用户名为root时）。

步骤3 单击“OK”，完成新集群创建。

----结束

删除集群

步骤1 在菜单栏选择“Ascend > AutoML > Cluster Manager”。

进入“Cluster Manager”界面。
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步骤2 单击需要删除的集群后方的 ，如图11-3所示。

图 11-3 删除集群

----结束

11.4 安装部署
步骤1 在菜单栏选择“Ascend > AutoML > Install AutoML”。

进入“Install AutoML”界面，如图11-4所示。
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图 11-4 Install AutoML

● Compute Nodes Cluster：选择已创建好的集群。创建集群请参见创建新集群。

● Installation Package Path：如果目标训练服务器的系统是EulerOS2.8-aarch64，
该项配置的是noah_vega包及其依赖的whl包等所在的文件夹路径，具体请参见
vega包及其依赖的whl包的存放路径；其他系统服务器配置的是noah_vega包所
在路径。

说明

该路径为运行MindStudio的操作系统的文件夹，而不是目标训练服务器的文件夹。

步骤2 单击“Next”，进入安装界面，如图11-5所示。
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图 11-5 Installing

如若安装失败，可单击 ，重新执行当前安装部署流程。

说明

展开“Details”查看详细信息，如果出现进度条乱码的情况，请参见如何解决中文显示乱码和
界面显示不全不规整问题处理。

步骤3 显示安装完成后，根据实际情况执行以下步骤。

● 单机场景

单击“Finish”，完成安装部署。

● 集群场景

a. 单击“Next”，配置SSH互信，如图11-6所示。

说明

SSH互信建立用于集群的训练服务器之间免密登录，传输AutoML相关指令和结果数
据，从而更方便地运行AutoML。若选择了由安装程序自动配置，可能存在一定的安
全风险，用户须确保集群位于可信域内，允许AutoML在集群的训练服务器之间建立
SSH互信。
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图 11-6 选择配置 SSH 互信方式界面

▪ Manual configuration：手动配置SSH互信。选择该项后，单击
“Cancel”或者“Finish”，用户需自己在训练服务器之间配置SSH互
信，操作结束。

▪ Automatic configuration：自动配置SSH互信。选择该项后，选择该项
后，主节点服务器可以不需要密码访问从节点服务器，单击“Next”，
将弹出如图11-7进行二次确认。

图 11-7 Warning 窗口

○ Cancel and Reconfirm：取消自动配置SSH互信。

○ I Konw the Risks：表示已知风险并进行下一步。

b. 单击“I Konw the Risks”，进入图11-8。
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图 11-8 配置主节点服务器公钥界面

通过右侧文件夹图标选择主节点服务器公钥文件，选择后会自动校验公钥文
件格式。

说明

▪ 公钥文件建议选择~/.ssh/id_rsa.pub，~/.ssh/id_dsa.pub，~/.ssh/id_ecdsa.pub或
~/.ssh/id_ecdsa.pub。如果需要选择其他名字的公钥，需要通过ssh-add命令添加
为默认密钥。

▪ 通过以下算法生成的密钥应符合相应的密钥长度：

○ RSA：大于或等于3072 。

○ DSA：大于或等于3072。

○ ECDSA：大于或等于256 。

○ Ed25519：大于或等于256。

▪ 公钥文件不能是软链接，公钥文件属主应为当前用户，文件权限建议是600。

c. 单击“Install”，由安装程序自动配置，如图11-9所示。
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图 11-9 自动配置 SSH 互信

步骤4 （可选）如果需要在多机多卡场景下使用AutoML工具。需要确保已安装NFS服务器，
并且在训练服务器及数据共享服务器配置/etc/sudoers文件。同时用户对数据共享服
务器的/etc/exports文件有读权限。

● 在数据共享服务器上配置：
username ALL=(root) NOPASSWD:/usr/bin/tee -a /etc/exports, /usr/bin/chmod -R 777 数据共享文件目
录（如/home/username/nfs_cache）, /usr/bin/mount -t nfs NFS服务器IP\:数据共享文件目录（如/
home/username/nfs_cache） 工作路径（如/home/username/nfs_folder）,/usr/bin/umount -lf 工作
路径（如/home/username/nfs_folder）, /usr/bin/systemctl restart rpcbind, /usr/bin/systemctl restart 
nfs

● 在其他训练服务器上配置：
username ALL=(root) NOPASSWD: /usr/bin/mount  -t nfs NFS服务器IP\:数据共享文件目录（如/home/
username/nfs_cache） 工作路径（如/home/username/nfs_folder）, /usr/bin/umount -lf  工作路径
（如/home/username/nfs_folder）, /usr/bin/systemctl restart nfs

步骤5 （可选）如果需要在多机多卡场景下使用AutoML工具，请参考以下步骤配置NFS服
务。

● 对数据共享服务器。

a. 在配置NFS服务器前，需要确保当前用户在各个训练服务器上的UID和GID相
同。若UID和GID不相同，会无法访问NFS共享目录，需要调整当前用户的
UID和GID为同一个数值，同时要避免和其他用户的UID冲突。

查询当前用户的UID和GID：
id username

修改当前用的UID：
sudo usermod username -u newUID

b. 创建NFS服务器共享目录。

查看界面配置的NFS Server Path，如果数据共享服务器上此路径不存在，就
新建一个，如果存在，跳过此步。

下面以创建NFS Server Path为nfs_cache为例：
cd ~
mkdir -p ./nfs_cache
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c. 将共享目录写入数据共享服务器的配置文件/etc/exports中。
sudo bash -c "echo '/home/username/nfs_cache 
*(rw,sync,no_subtree_check,all_squash,anongid=GID,anonuid=UID)' >> /etc/exports"

其中，GID和UID根据实际情况进行修改。

d. 将步骤5.c中共享目录下的目录权限设置为700，共享目录下文件权限设置为
600，保证用户对共享目录下的文件具有读写权限。
chmod 700 /home/username/nfs_cache

e. 修改目录和文件权限可参考如下命令：

▪ 切到共享目录：
cd /home/username/nfs_cache

▪ 对目录：
find . -type d | xargs -i chmod 700 {}

▪ 对文件：
find . -type f | xargs -i chmod 600 {}

f. 重启NFS服务器。
sudo service rpcbind start
sudo service nfs restart
sudo service nfs-server status

● 对集群中所有训练服务器，分别执行：

a. 创建本地挂载目录。查看用户在界面配置的workspace路径，如果workspace
路径不存在，就新建一个，如果存在，跳过此步。下面以workspace为/
home/username/nfs_folder为例。
cd ~
mkdir nfs_folder

b. 挂载共享目录。
sudo mount -t nfs {数据共享服务器ip}:{数据共享目录}（如/home/username/nfs_cache） 工作路
径（如/home/username/nfs_folder）

c. 挂载完成后，工作路径（如/home/username/nfs_folder）就是多机集群的
工作目录。

----结束
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说明

● 保留上述配置有提权风险，请在操作完成后立即取消sudo权限。取消方法为删除对应普通用
户的所有白名单权限命令。

● 安装完成后，请根据需要参照安全配置说明正确完成noah_vega安全通讯特性的的相关配
置，以通信安全的方式运行训练任务。

● 用户根据需要自行安装以下AI框架包：

● Tensorflow：

请参考《CANN 软件安装指南》安装Tensorflow框架。

● Mindspore：

请参考MindSpore官网安装MindSpore框架。

● Pytorch：

● 请参考《PyTorch 1.5.0 安装指南》编译安装Pytorch1.5.0框架。

● 安装Torchvision依赖，可参考以下方法进行安装：

● 在x86架构下安装Torchvision包：
pip3 install --user torchvision==0.6.0

● 在arm架构下先从azureology/torchvision下载源码，执行以下命令安装
0.6.0版本的Torchvision包：
python setup.py install

● 若Pytorch下需要统计模型的参数量信息，则需要安装依赖thop：
pip3 install --user thop

其中，MindSpore和Pytorch的版本需要和CANN版本配套。MindSpore的版本配套关系请参
见Ascend配套软件（MindSpore），PyTorch的版本配套关系请参见Ascend配套软件
（PyTorch）。

启动推理服务

启动任务之前需要编译推理程序并启动推理服务。

步骤1 编译推理程序步骤请参见编译推理程序。

步骤2 启动推理服务。

在推理服务器上运行命令vega-evaluate-service -i {your_ip_adress} -w
{your_work_path} -p {port}启动。其中-i参数指定当前使用的服务器的ip地址。-w
参数指定工作路径，程序运行时的中间文件将存储在该目录下，请使用绝对路径。-p
参数指定推理服务器端口，启动推理服务器端口需要与创建集群时指定的端口一致，
默认指定8888端口。其他参数的设置可查看该命令的帮助信息，一般情况下建议采用
默认值。

----结束

11.5 模型自动生成
模型自动生成工具以昇腾910的搜索训练，昇腾310推理验证为前提，覆盖
MindSpore，PyTorch，Tensorflow框架，面向分类、检测、分割、超分、NLP等场景
实现昇腾亲和模型的自动生成。这个场景主要功能是基于数据集自动生成网络和基于
预训练模型进行微调后自动生成模型。

执行操作

步骤1 在菜单栏选择，“Ascend > AutoML > Start Task”，进入Basic Info页签，如图
11-10所示。
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图 11-10 Basic Info

表 11-3 参数说明

参数 说明

Task Name 任务名称，具有唯一性，必填。格式中包含英文字母、数
字或者下划线，例如Task_01。

AI Framework AI框架，目前支持Tensorflow、PyTorch和MindSpore。

说明
MindSpore和PyTorch框架不支持运行有模型场景下的任务。

Hardware Plaform 硬件框架，目前仅支持Ascend。

Compute Nodes
Cluster 计算节点集群，通过下拉框可选择已有集群，单击 可

直接跳转到集群管理页面。

 

步骤2 单击“Next”，进入Model Config页签。

● 进入Model Config页签，默认执行的为无模型场景下的Nas任务（Offline Model
开关关闭），如图11-11所示；配置无模型场景下的Fine-tune任务如图11-12 所
示。
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图 11-11 Model Config（配置无模型场景下的 Nas 任务）

图 11-12 Model Config（配置无模型场景下的 Fine-tune 任务）

表 11-4 参数说明

参数 说明

Application Field 模型领域，当前仅支持CV领域的模型。

Application
Scenarios

应用场景，当前仅支持Classification。
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参数 说明

Offline Model 是否有模型场景，打开表示有模型场景，关闭表示无模型
场景，默认为无模型场景。

– 关闭该参数项后，“Optimizing Method”默认选择
Nas，“Algorithm”、“Batch Size”在界面体现。若
“Optimizing Method”选择Fine-tune，界面会新增
“Pretrained Model”。

– 打开该参数项后，“Model File Path”、“Depth”和
“Batch Size”在界面体现。

Optimizing
Method

优化方式，可以选择下面两种方式，默认为Nas。
– Fine-tune：在预训练模型基础上进行微调。选择该参

数项，页面显示“Pretrained Model”参数项。

– Nas：网络搜索，基于数据集搜索出性能较好的网络，
然后进行fully train。

Algorithm – Optimizing Method参数选择Fine-tune时，算法当前
只支持dnet，页面会出现“Pretrained Model”参数。

– Optimizing Method参数选择Nas时，算法当前只支持
backbone_nas。

Batch Size 训练过程中数据集的批量大小。

Pretrained Model 用户根据需要在参数选择预训练模型，现支持DNet426、
DNet1156、DNet1549模型。用户需要在训练服务器工作
路径（即Workspace）下的pretrained_models文件夹里提
前存放好DNet426、DNet1156和DNet1549模型的.pth文
件并设置文件访问权限为400。模型下载可参考：下载链
接。

 

注意

用户需要从可信的官网上下载pretrained model文件，以确保该文件的安全性，
否则可能会存在反序列化安全风险。

● 当需要执行有模型场景下的任务时，打开“Offline Model”参数项，配置页面如
图11-13所示。
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图 11-13 Model Config（配置有模型场景下的任务）

表 11-5 参数说明

参数 说明

Application Field 模型领域，当前仅支持CV领域的模型。

Application
Scenarios

应用场景，当前仅支持Classification。

Offline Model 是否有模型场景，打开表示有模型场景，关闭表示无模型
场景，默认为无模型场景。

– 关闭该参数项后，“Optimizing Method”默认选择
Nas，“Algorithm”、“Batch Size”在界面体现。若
“Optimizing Method”选择Fine-tune，界面会新增
“Pretrained Model”。

– 打开该参数项后，“Model File Path”、“Depth”和
“Batch Size”在界面体现。

Model File Path 用户需要提供的模型权重文件路径，即在训练服务器
“Workspace”目录下的模型文件存放路径，单击文本框
后的图标进行选择，当前仅支持Resnet系列的.ckpt格式模
型文件。用户需要将自己的模型权重文件放在训练服务器
工作路径（即Workspace）下的自定义目录。

Depth 模型深度。如resnet50的模型深度为50。

Batch Size 训练过程中数据集的批量大小。

 

步骤3 单击“Next”，系统将对Model Config页签的配置进行安全校验。

无模型场景下，执行Fine-tune任务时，将弹出如下图11-14，用户需要对模型的安全
性和一致性进行二次确认。执行Nas任务时不存在该项校验。
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图 11-14 Fine-tune 任务安全确认窗口

步骤4 安全校验完成后，进入Dataset Config页签。

数据集类型为自定义数据集的配置界面如图11-15所示；数据集类型为cifar10、
cifar100或Imagenet的配置界面如图11-16所示。

图 11-15 Dataset Config（数据集类型为自定义数据集时）

图 11-16 Dataset Config（数据集类型为 cifar10/cifar100/Imagenet）
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表 11-6 参数说明

参数 说明

Devices 训练服务器上的设备编号。需手动输入，参数范围为0，1，
2，3，4，5，6，7。多卡时，卡号之间用英文分号隔开，以
4、5卡为例，输入形式为“4;5”。

说明
Fine-tune场景目前只支持单机单卡。

Dataset Type 数据集类型，有以下选项：

● Cifar10
● Cifar100
● ImageNet
● ClassificationDataset：自定义数据集。

说明

● Cifar10和Cifar100数据集只支持Python格式。

● 自定义数据集的要求可参考自定义数据集参考。

● ImageNet数据集需要用户去Imagenet官网注册下载，并遵从
License要求。

Dataset Path 手动输入或单击文本框后的图标选择数据集路径，该目录需
先预置于“Compute Nodes Cluster”的共享目录下，即
“Workspace”目录下。应在“Workspace”目录下新建文件
夹，把数据集放置于该文件夹，再选择该新建文件夹。

Class Nums 仅当选择“ClassificationDataset”时，界面才会显示该参
数，需要手动输入数据集分类数量，为正整数。

Image Size 仅当选择“ClassificationDataset”时，界面才会显示该参
数，需要手动输入图片大小，为正整数。

 

步骤5 单击“Finish”，启动任务。

任务启动后，用户可实时查看任务进度，界面介绍具体可参考查看可视化任务。如果
任务创建失败，可从后台进入集群Workspace路径下指定任务文件夹获取日志查看详
细信息。

----结束

11.6 模型自动调优

前提条件

已下载并安装好Ascend-cann-toolkit包。运行以下命令设置对应环境变量：
source {CANN包安装路径}/ascend-toolkit/set_env.sh

11.6.1 基于训练脚本的模型自动调优
该特性支持以用户的模型训练脚本作为输入，支持自动解析模型结构，对模型进行剪
枝以达到性能调优的目的，可以用于分类、检测分割模型的剪枝压缩，支持以params
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（参数量）或latency（推理时延）为主要目标的模型压缩。在精度无损的情况下，能
够有效地提升模型性能。

模型剪枝调优过程

调优过程分为以下两个阶段：

● 微调阶段（fine_tune）

● 剪枝阶段（nas）

a. 采样剪枝模型。

b. 微调训练剪枝模型，评估模型精度。

c. 重复1~2，经过N次采样和学习，剪枝结束，选取若干个top精度的剪枝模型
作为输出结果，进行下一步训练。

● 剪枝后训练阶段（fully_train）

训练剪枝后的模型。

图像分类模型调优（以 Pytorch 框架的 resnext50 样例为例）

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification中的pytorch目录中配置网络定义文件。

如果pytorch样例工程中没有网络定义文件需要先新建一个网络定义文件，在该网络定
义文件添加get_model()方法，分以下两种情况：

● 原训练脚本网络是直接从torchvision获取，在网络定义文件中添加get_model()方
法，返回该网络定义的实例，如resnext50.py：
from torchvision import models

def get_model():
    return models.__dict__["resnext50_32x4d"]() 

● 若原训练脚本网络是用户自定义的，则将该网络定义代码复制到网络定义文件
中，并添加get_model()方法，返回该网络定义的实例，以自定义MobileNetV1网
络为例，MobileNetV1.py内容如下：
import …

class MobileNetV1(nn.Module):
…
def get_model():
    return MobileNetV1()

说明

如果选用mindspore框架的样例，需进入mindspore目录，从ModelZoo下载对应的网络定义文
件，添加get_model()方法，以新建resnet18.py，数据集为Cifar10为例：

import …

class resnet18(class_num=10):
…
def get_model():
    return resnet18(10)

步骤2 {CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification/pytorch/resnext50目录下如果没有resnext50_dag.yml，新建
resnext50_dag.yml，把alexnet/alexnet_dag.yml的内容拷贝到该文件，修改如下：

● fine_tune阶段主要修改以下加粗字段：
finetune:
  pipe_step:
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    type: TrainPipeStep
  model:
    pretrained_model_file: ""  # 模型的预训练权重文件，如无权重文件，可以注释掉。若配置预训练权重
文件为pth文件，需确保文件的安全性，否则会有反序列化风险。
    model_desc:
      type: Script2Vega
      path: ""  # 网络定义文件位置。
      image_size: 224

● nas阶段主要修改以下加粗字段：
nas:
    pipe_step:
        type: SearchPipeStep
    search_algorithm:
        type: RandomSearch
        objective_keys: ['accuracy', 'params']   #剪枝搜索的取样指标，这里以准确率和时延作为指标。
        policy:
            num_sample: 64    #剪枝搜索的取样个数，这里会尝试搜索出64个剪枝模型，依据
objective_keys 评选出 终优化出的模型。
    search_space:
        type: MsPruneDAGSearchSpace
    model:
        model_desc_file:  "{local_base_path}/output/fine_tune/desc_0.json"
        pretrained_model_file: "{local_base_path}/output/fine_tune/model_0.ckpt"

● fully_train阶段无特殊修改字段。

● 此外，在每个阶段中，均提供了dataset、trainer、evaluator字段配置，可以根据
需要对数据处理、训练参数、优化器、推理指标做详细配置，以下以Cifar10数据
集为例：

– dataset中主要修改以下加粗字段：
dataset:
  type: Cifar10                            #数据集类型
  common:
    data_path: ""                         # 数据集路径
    batch_size: 128                       #一次训练所选取的数据样本数量
  train:
    transforms:
      - type: Resize
        size: [224, 224]
      - type: ToTensor
      - type: Normalize
        mean: [0.4914, 0.4822, 0.4465]
        std: [0.2023, 0.1994, 0.2010]
  val:
    transforms:
      - type: Resize
        size: [224, 224]
      - type: ToTensor
      - type: Normalize
        mean: [0.4914, 0.4822, 0.4465]
        std: [0.2023, 0.1994, 0.2010]
  test:
    transforms:
      - type: Resize
        size: [224, 224]
      - type: ToTensor
      - type: Normalize
        mean: [0.4914, 0.4822, 0.4465]
        std: [0.2023, 0.1994, 0.2010]

– trainer中主要修改以下加粗字段：
trainer:
  type: Trainer
  epochs: 1                             #训练次数
  with_train: True
  model_statistics: False
  mixup: False
  optimizer:
    type: SGD
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    params:
      lr: 0.01                          #基础学习率
      momentum: 0.9                    #动量
      weight_decay: !!float 1e-4       #权重衰减
  lr_scheduler:
    type: MultiStepLR
    params:
      milestones: [30,60,90]
      gamma: 0.1                        #学习率衰减
  loss:
    type: CrossEntropyLoss

– evaluator主要有两种类别：

▪ 在训练服务器进行评估，evaluator类型为HostEvaluator：
evaluator:
  type: Evaluator
  host_evaluator:
    type: HostEvaluator
    metric:
      type: accuracy 

▪ 在推理服务器上进行评估，evaluator类型为DeviceEvaluator：
evaluator:
  type: Evaluator
  device_evaluator:
    type: DeviceEvaluator
    hardware: "Davinci"
    remote_host: "http://x.x.x.x:xxxx"
    #远端推理服务器URL，后四位为端口号，需要与创建集群时的端口号一致。如果在推理服
务器中执行“vega-config -q sec”的返回值为“True”，请将“http”更改为“https”。

– 也可以复用其他阶段的配置，下面以复用fine_tune阶段的dataset字段为例：
dataset:
  ref: fine_tune.dataset

说明

– 基于mindspore框架的训练脚本现在仅支持在910上做推理，即mindspore框架的yml文
件中的evaluator类型只支持HostEvaluator。

– 其他参数配置可参考vega官网。

– 如果需要用到非cifar10数据集，字段模板可参考vega官网。

步骤3 启动AutoML调优任务：
vega  CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/classification/pytorch/
resnext50/resnext50_dag.yml –d NPU

若需要在GPU上启动调优任务，将以上命令中“ -d NPU”去掉即可。

----结束

检测分割模型调优（以 YOLOv5 样例为例）

YOLOv5模型性能调优的具体操作步骤可以参考{CANN包安装路径}/ascend-toolkit/
latest/tools/ascend_automl/examples/detection/中的use_original_trainer.md文件指
导。

调优后模型获取
● onnx格式模型输出（仅支持PyTorch框架）

基于训练脚本的模型自动调优支持输出调优后模型的onnx格式，操作参考如下
（以PyTorch框架的resnext50样例为例）：
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a. 在resnext50_dag.yml文件中nas阶段的trainer字段中配置callbacks字段：
callbacks:OnnxModelExportCallback

b. 启动AutoML调优任务。

任务结束后会在{task_id}/output/nas/路径下输出model_{worker_id}.onnx文
件。

若用户需将onnx文件转换成PyTorch脚本定义的模型，具体步骤可参考
https://github.com/fumihwh/onnx-pytorch。

● 支持用户在训练脚本中加载调优后模型（支持PyTorch框架和MindSpore框架）

调优后的网络描述以json文件格式保存，用户可在自己的训练工程中，依据此文
件加载优化后的网络及权重。AutoML工具提供load函数，此函数以ori_net（原网
络）、desc_path（调优后网络描述文件）、weight_path（调优后网络权重文
件）作为输入。

操作参考如下：

a. 生成load函数，有以下两种方式：

▪ 在yml文件的trainer.callbacks中进行配置。

1) 在yml文件中nas阶段的trainer字段中配置callbacks字段：
callbacks:NetworkLoaderCreateCallback

2) 启动AutoML调优任务。

任务结束后会在{task_id}/output/nas/network_loader_scripts路径
下生成deserialization_user.py、network_loader_user.py（包含
load函数）和utils_user.py文件。

▪ 执行以下命令。
python3 -m ascend_automl.tools.create_network_loader output_dir backend

其中output_dir为生成的代码文件所在目录，须为存在目录且路径下没有
名为“network_loader_scripts”文件夹。backend为框架，须为pytorch
或mindspore，运行结束后，会在output_dir /network_loader_scripts生
成三个文件deserialization_user.py、network_loader_user.py和
utils_user.py。

b. 使用load函数加载调优后模型。

用户需在训练工程中添加代码，参考示例如下，运行前需将
network_loader_scripts文件夹所在路径配置在PYTHONPATH中：

from network_loader_scripts.network_loader_user import load     # 从network_loader_user导
入load函数
from network import Net  #  假设此处为用户原网络的导入

net = Net()        #  假设net为用户原网络

desc = '{task_id}/output/fully_train/desc_2.json'      # 调优后网络描述文件，请根据实际路径替换
weight = '{tast_id}/output/fully_train/model_2.pth'    # 调优后网络权重文件，请根据实际路径替
换
pruned_net = load(net, desc, weight)         # 获取优化后网络（加载权重）
# pruned_net = load(net, desc)               # 获取优化后网络（不加载权重）

pruned_net为加载到的调优后模型。

说明

对模型进行剪枝调优后，若调优结果仍达不到预期，可通过量化过程进一步调优，操作步
骤可参考20.6.5-模型剪枝后量化操作步骤（以MindSpore框架的YOLOV5为例）。
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11.6.2 基于离线模型的自动调优
该特性支持将onnx模型作为输入，用户无需修改任何代码，直接对onnx模型进行自动
调优。可以用于分类模型的剪枝压缩，支持以params（参数量）或latency（推理时
延）为主要目标的模型压缩。在精度无损的情况下，能够有效地提升模型性能。

模型调优过程

调优过程分为以下三个阶段：

● 微调阶段（fine_tune）

获取待调优模型的基线（包括参数量，精度，时延等）。

● 剪枝阶段（nas）

a. 随机搜索剪枝模型。

b. 微调训练剪枝模型，评估模型精度。

c. 根据评估精度计算反馈值，更新帕累托前沿。

d. 重复1~3，经过N次采样和学习，剪枝结束，选取若干个top精度的剪枝模型
作为输出结果，进行下一步训练。

● 剪枝后训练阶段（fully_train）

训练剪枝后的模型。

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification/onnx/路径，在resnet50_onnx.yml文件中根据实际情况配置以下加粗部
分：
…
finetune:
  …
  model:
    model_desc:
      type: Onnx2DAG
      src_onnx_file: ""  # 待调优的onnx模型文件

  …

  dataset:
    type: Cifar10
    common:
      data_path: ""  # 训练数据集路径
      batch_size: 128
    …

#在训练服务器进行评估，evaluator类型为HostEvaluator：
  evaluator:
    type: Evaluator
    host_evaluator:
      type: HostEvaluator
      metric:
        type: accuracy 

#如果在推理服务器上进行评估，evaluator类型为DeviceEvaluator：
  evaluator:
    type: Evaluator
    device_evaluator:
      type: DeviceEvaluator
      hardware: "Davinci"
      remote_host: "http://x.x.x.x:xxxx"
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      #远端推理服务器URL，后四位为端口号，需要与创建集群时的端口号一致。如果在推理服务器中执行
“vega-config -q sec”的返回值为“True”，请将“http”更改为“https”。

说明

● 如果需要提供训练好的模型权重pth文件进行基于离线模型的自动调优，可参考{CANN包安
装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/classification/
onnx_prune.yml进行修改。

● 由于pth文件存在反序列化风险问题，用户需要确保其来源可信。

步骤2 执行以下命令启动调优任务
  vega resnet50_onnx.yml的路径 –d NPU

----结束

11.6.3 基于强化学习的模型剪枝调优

基于强化学习的模型剪枝调优包含自动化模型结构解析和基于强化学习的剪枝算法，
可以用于分类、目标检测、语义分割模型的剪枝压缩，支持以flops（计算量）或
params（参数量）或latency（推理时延）为主要目标的模型压缩。在精度无损的情况
下，能够有效地提升模型性能。目前支持图像分类网络模型ResNet50、MobileNetV2
和分割网络模型DeepLabV3。

前提条件

请执行以下命令安装graphviz和fvcore包。

pip3 install graphviz --user
pip3 install fvcore --user

基于强化学习的模型剪枝调优过程

调优过程分为以下两个阶段：

● 剪枝阶段（nas）

a. 强化学习代理器采样剪枝模型。

b. 微调训练剪枝模型，评估模型精度。

c. 根据评估精度计算反馈值，强化学习更新代理器。

d. 重复1~3，经过N次采样和学习，剪枝结束，选取若干个top精度的剪枝模型
作为输出结果，进行下一步训练。

● 剪枝后训练阶段（fully_train）

训练剪枝后的模型。

剪枝阶段搜索算法配置

剪枝阶段也称为search阶段。强化学习采样剪枝模型，根据采样模型学习每一层的剪
枝率，经过多次采样和学习， 终收敛到高精度的剪枝模型。

剪枝算法配置参数含义如下表所示：
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表 11-7 剪枝算法配置参数说明

参数 说明

keep_pareto_top_k 选取若干个top精度的剪枝模型作为输出结果。

plot_train_curve 是否画出剪枝算法学习曲线，如果为True，将画出学习曲
线并存在output目录下。

plot_graph_save_folder 指定模型graph图像存储目录。

train_episode 剪枝算法采样个数。

lbound_preserve_ratio 0~1的小数，表示剪枝率的下限，算法直接跳过低于该阈
值的采样模型。

reward_type 剪枝任务的目标，acc_flops搜索高精度低flops模型；
acc_params搜索高精度低参数量模型；acc_latency搜索
高精度低时延模型；acc_abs_latency搜索贴近目标时延的
高精度模型。

target_latency 当选择时延作为优化目标的时候，需要配置期望的时延，
单位ms。

channel_round 模型通道数的 小公倍数。

lbound 每一层通道数保留比例的下限。

rbound 每一层通道数保留比例的上限。

seed 随机种子，可以设置不同随机种子得到不同的采样模型，
会产生不同的收敛速度和结果。

networkparser 自动化模型结构解析的配置参数。

1. replace_bn_list：默认~。是一个字符串list，如果模型
中有自定义归一化算子，将该算子的类名以字符串形
式写入list。例如：torchvision的fasterrcnn模型中有
FrozenBatchNorm2d，该参数设置为
['FrozenBatchNorm2d']。

2. replace_conv_list：默认~。是一个字符串list，如果模
型中有自定义卷积算子，将该算子的类名以字符串形
式写入list。
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参数 说明

agent 强化学习agent参数。

1. warmup：剪枝算法warmup阶段采样个数。

2. warmup_lbound：warmup阶段，模型每一层通道保
留率下限。

3. warmup_rbound：warmup阶段，模型每一层的通道
保留率上限。

4. warmup_specific_bound：warmup阶段，指定某些层
的通道保留率下限、上限，格式{mid: [this_lbound,
this_rbound]}，默认{}。

5. reward_scale：强化学习reward参数，默认1。计算公
式参见class PruneAM的calc_reward函数。

6. reward_gamma：强化学习reward参数，默认1。计算
公式参见class PruneAM的calc_reward函数。

specific_bound 指定某些层的通道保留率的上限和下限，格式{mid:
[lbound, rbound]}，默认{}。如果lbound等于rbound，
即指定当前层剪枝率为固定值。

user_skip_module_id 用户指定某些层不剪。是一个mid list，默认[]。

 

多卡训练

多卡训练请注意以下几点：

● 环境变量需要增加如下配置：
export RANK_TABLE_FILE=/example/hccl_4p_0123_127.0.0.1.json          # hccl多卡训练所需devices信息
文件，指定的json文件可通过hccl_tools工具生成：https://gitee.com/mindspore/models/tree/master/
utils/hccl_tools
export HCCL_WHITELIST_DISABLE=1
export NPU_VISIBLE_DEVICES=0,1,2,3     # 配置可被使用的NPU
export ORIGIN_RANK_SIZE=8            # 服务器总卡数
export BACKEND_TYPE=NPU
export WORLD_SIZE=4                # 单机多卡训练下，训练使用的卡数
export RANK_SIZE=4                # 单机多卡训练下，训练使用的卡数
export BATCH_TASK_INDEX=0
export RANK_ID=0
export DEVICE_ID=0

● fully_train.pipe_step.type 需要改成HcclTrainStep
  pipe_step:
    type: HcclTrainStep       # 单卡使用TrainPipeStep
    ......

● 数据集配置中的batch_size是指单张卡的batch_size。比如，使用4卡、
512batchsize训练模型，yaml文件中的batch_size设置为128。

自定义模型注册

如果需剪枝调优自定义的模型，需要先在vega框架注册该模型，然后在yaml配置使用
该模型。目前ResNet50和MobileNetV2在剪枝调优前需要进行自定义模型注册，
DeepLabV3不需要。在vega框架注册模型方法如下。

1. 从 ModelZoo中查找下载模型脚本并放置合适的路径。
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2. 在模型定义所在脚本文件中使用vega.common.ClassFactory.register
（ClassType.NETWORK）将网络定义类注册到vega中，并可能需要对构造函数做
一些适配性修改。

– 对于Resnet50模型，需要在DistributedResnet50/image_classification/
resnet.py中添加vega注册代码，并修改类 ResNet的构造函数、入参及部分
变量初始化部分。
from vega.common import ClassFactory, ClassType

@ClassFactory.register(ClassType.NETWORK)
class ResNet_ModelZoo(nn.Module):
    # def __init__(self, builder, block, expansion, layers, widths, num_classes=1000):
    def __init__(self, version = 'resnet50', config = 'classic', num_classes=1000):
        self.inplanes = 64
        super(ResNet_ModelZoo, self).__init__()
        version = resnet_versions[version.lower()]
        config = resnet_configs[config.lower()]
        builder = ResNetBuilder(version, config)
        block = version['block']
        expansion = version['expansion']
        layers = version['layers']
        widths = version['widths']
        ......

– 对于MobileNetV2模型，需要在train/mobilenet.py中添加vega注册代码。
from vega.common import ClassFactory, ClassType

@ClassFactory.register(ClassType.NETWORK)
class MobileNetV2_ModelZoo(nn.Module):
      ......

3. 对Resnet50模型进行剪枝调优时，将resnet.py中引用到ResNet类的地方改为
“ResNet_ModelZoo”。对MobileNetV2模型进行剪枝调优时，将mobilenet.py
中引用到MobileNetV2类的地方改为“MobileNetV2_ModelZoo”。

4. 将模型定义所在脚本文件配置到 USER_AUTOML_MODULES 环境变量中。

– 对Resnet50模型进行剪枝调优时，将resnet.py配置到
USER_AUTOML_MODULES 环境变量中。
 export USER_AUTOML_MODULES={resnet.py实际存放路径}

– 对MobileNetV2模型进行剪枝调优时，将resnet.py配置到
USER_AUTOML_MODULES 环境变量中。
 export USER_AUTOML_MODULES={mobilenet.py实际存放路径}

操作步骤（以 ResNet50 为例）

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification/pytorch/resnet50/路径，在resnet50_amc.yml（以时延为优化目标的
yml文件为resnet50_amc_latency.yml）文件中根据实际情况配置以下加粗字段（以下
代码以resnet50_amc.yml文件为例）。
nas:
  pipe_step:
    type: SearchPipeStep
  model:
    model_desc:
      modules: ["backbone"]
      backbone:
        type: ResNet_ModelZoo    #该模型的定义方法需参照自定义模型注册
        version: resnet50
      image_size: &image_size 224       # 表示模型的输入图像大小
    # Warning: pretrained_model_file is possible to construct malicious pickle data which will execute 
arbitrary code during unpickling pytorch model file.
    pretrained_model_file: /path/to/pretrained_models/Resnet50.pth   # 原模型权重文件，需确保文件的安
全性
  dataset:
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    type: Imagenet
    train:
      batch_size: 64      #注意，在配置成HcclTrainStep多卡训练时，数据集的batch_size指单张卡的
batch_size。例如，使用4卡、512batchsize训练模型，配置中的batch_size设置为128
      num_workers: 4
      drop_last: False
      shuffle: True
      data_path: &dataset_path /path/.../datasets/imagenet/ILSVRC/Data/CLS-LOC     # 数据集路径
      ...

  search_algorithm:
    type: PruneAMC
    objective_keys: 'accuracy'
    keep_pareto_top_k: 1
    plot_train_curve: True
    plot_graph_save_folder: '/tmp/debug_amc'    # 临时目录，存储训练过程折线图
    # search configs
    train_episode: 1000
    lbound_preserve_ratio: 0.3
    reward_type: acc_flops       #剪枝任务的目标。acc_flops搜索高精度低flops模型；acc_params搜索高精度
低参数量模型；acc_latency搜索高精度低时延模型；acc_abs_latency搜索贴近目标时延的高精度模型。
    ...
 
  trainer:
    type: Trainer
    ...
    optimizer:
      type: SGD
      params:
        lr: 0.001         # 根据实际训练任务设置微调学习率，是正常训练模型的初始学习率的1/10或1/100
        momentum: 0.9

cls_fulltrain:
  pipe_step:
    type: TrainPipeStep       # 单卡使用TrainPipeStep，多卡使用HcclTrainStep
    # type: HcclTrainStep
    models_folder: '{local_base_path}/output/nas_amc'

说明

● 对图像分类网络模型MobileNetV2进行剪枝压缩时，需要配置的yml文件为{CANN包安装路
径}/ascend-toolkit/latest/tools/ascend_automl/examples/classification/pytorch/
mobilenetv2/mobilenetv2_amc.yml（以时延为优化目标的yml文件为
mobilenetv2_amc_latency.yml）。

● 对分割网络模型DeepLabV3进行剪枝压缩时，需要配置的yml文件为{CANN包安装路径}/
ascend-toolkit/latest/tools/ascend_automl/examples/segmentation/pytorch/deeplabv3/
deeplabv3_amc.yml。

步骤2 启动模型剪枝压缩任务。
vega resnet50_amc.yml -d NPU

----结束

剪枝阶段意外中断，恢复剪枝搜索

当剪枝阶段出现意外中断的情况，可以通过配置yaml文件从中断前剪枝任务的文件夹
恢复剪枝搜索过程。

● search_algorithm.workers_folder：配置为中断的剪枝任务的workers目录，形
如：task/workers/step_name

● search_algorithm.resume_steps（选填项）: 如果只需恢复部分结果，可以通过配
置resume_steps决定恢复多少个采样的样本数

yaml修改部分参考如下：
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search_algorithm:
    type: PruneAMC
    ......
    resume_folder: /home/prune/task_id/workers/nas # optional
    resume_steps: 100
    ......

模型前向传播不是单个 tensor 特殊配置

剪枝过程需要通过前向传播获取相关信息，默认模型输入是一个tensor。实际模型可
能是多个变量，或一个dict，如下代码所示。

# 模型forward有多个输入
def forward(self, x, y, z):
    pass
# 模型forward输入是一个dict
def forward(self, {'x':x, 'y':y, 'z':z}):
    pass

这种情况下，需要通过torch.save(data, save_path)存下[x, y, z]列表或{'x':x, 'y':y, 'z':z}
字典（batchsize为2），存为.pkl后 的文件。该pickle文件地址记为pkl_data_path。

● search_algorithm.input_pickle_path：配置为pkl_data_path。

● trainer.input_pickle_path（选填项）: 当待训练模型需要加载预训练模型权重，且
预训练模型结构与待训练模型结构不同时，需要配置为pkl_data_path。

11.6.4 模型量化压缩

模型量化压缩主要解决边侧推理设备及算力存在多样性、模型优化缺少硬件感知及自
动优化过程的问题，根据边缘部署精度、算力、时延、内存不同约束目标，实现自动
化压缩和量化训练模型。

目前支持对表11-8中的模型进行模型量化压缩，操作步骤可参考模型量化操作步骤
（以PyTorch框架的ResNet50为例）和模型量化操作步骤（以MindSpore框架的
YOLOV5为例）。

表 11-8 模型支持列表

类型 名称 框架

图像分
类

ResNet50 MindSpore、PyTorch

MobileNetV2 MindSpore、PyTorch

分割类 DeepLabV3 MindSpore、PyTorch

检测类 FasterRCNN MindSpore

YOLOV5 MindSpore

YOLOV3 MindSpore

YOLOV3-Tiny MindSpore

SSD MindSpore
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用户参考基于训练脚本的模型自动调优对模型进行剪枝调优后，若调优结果仍达不到
预期，可通过量化过程进一步调优，操作步骤可参考模型剪枝后量化操作步骤（以
MindSpore框架的YOLOV5为例）。

前提条件

请执行以下命令安装fvcore包。

pip3 install fvcore --user

基于强化学习的模型量化调优过程

量化调优过程（nas）包括以下6个步骤：

1. 读取输入模型构建Graph IR,用于量化算子定位、图结构优化、算子特征提取。

2. 进行模型特征提取，提取算子Kernel参数、Shape参数、算子上下文结构等信息。

3. 通过强化学习算法进行量化位宽搜索，构建候选量化位宽策略。

4. 针对候选量化位宽策略构建量化后的模型结构及其Graph IR。

5. 通过量化算法进行图结构优化、权重和激活值的量化算子参数标定和校正。

6. 生成可部署量化模型，进行在环测评，并将测评结果反馈到位宽搜索算法。

7. 重复3~6步，直到搜索出满足指定精度、压缩率和时延指标的量化模型。

模型量化操作步骤（以 PyTorch 框架的 ResNet50 为例）

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification/pytorch/quant/路径，在quant_rl_resnet.yml文件中根据实际情况配置
以下加粗字段。
general:
    backend: pytorch  # pytorch | tensorflow
    device_category: NPU
    task:
      local_base_path: /path/of/workdir       #工作路径
      task_id: "quant_resnet50_pytorch"
    device_evaluate_before_train: False

pipeline: [nas]

nas:
    pipe_step:
        type: SearchPipeStep
    model:
        model_desc:
            type: ResNet_ModelZoo   #该模型的定义方法需参照自定义模型注册
            version: resnet50
            config: classic
        input_shape: [ 1, 3, 224, 224 ]
    dataset:
        type:  Imagenet
        common:
            data_path: /path/of/dataset      #数据集路径
            drop_last: False
            shuffer: False
        …

    search_algorithm:
        …

        #choice: acc_first | compress_first
        reward_type: 'acc_first' #模型量化压缩优先指标。acc_first：精度优先；compress_first：压缩率优先。
        custom_reward: False
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        latency_acc_ratio:   0.5 # ratio of latency to accuracy in reward.
                                 # If custom_reward if false,this value doesn't need to be configured.
                                 # Besides, if custom_reward is true,you can set latency_acc_ratio to 0 so that latency 
is not used in reward.
                                 # Otherwise,this value is recommended to be greater than 0.1.
        stop_early: False   #是否找到同时满足acc_threshold、latency_threshold、compress_threshold三项指
标即停止任务
        acc_threshold: 0.5  #精度损失阈值百分比
        latency_threshold: 5   #时延降低百分比
        compress_threshold: 40   #压缩率阈值百分比
    search_space:
        type: SearchSpace
        hyperparameters:
            -   key: network.bit_candidates
                type: CATEGORY
                range: [8, 32]
    trainer:
        type: Trainer
        epochs: 1
        seed: 234
        callbacks: [QuantPTQCallback, ConvertOnnxCallback]
        pretrained_model_file: /path/of/pretrain/model/file #ResNet50预训练权重文件
        …

    evaluator:
        type: Evaluator
        device_evaluator:
            type: DeviceEvaluator
            custom: QuantCustomEvaluator
            remote_host: http://xxx.xxx.xxx.xxx:port/  #远端推理服务器URL，后四位为端口号，需要与创建集群
时的端口号一致。如果在推理服务器中执行“vega-config -q sec”的返回值为“True”，请将“http”更改为
“https”。
            backend: 'pytorch'
            om_input_shape: '1,3,224,224'
            delete_eval_model: True  #是否删除搜索出的量化模型

说明

● 对图像分类网络模型进行模型量化压缩时，以PyTorch框架的MobileNetV2为例，需要配置
的yml文件为{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
classification/pytorch/quant/quant_mobilenetv2.yml。

● 对分割网络模型进行模型量化压缩时，以PyTorch框架的DeepLabV3为例，需要配置的yml文
件为{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
segmentation/pytorch/quant/quant_rl_deeplab_npu.yml。

步骤2 启动模型量化压缩任务。
vega quant_rl_resnet.yml -d NPU

任务结束后会在指定工作路径的log文件夹中输出搜索日志。如果在评估服务evaluator
中，device_evaluator的delete_eval_model字段配置成“False”，将在指定的工作路
径的output/nas文件夹中输出每个搜索结果对应的模型。

----结束

模型量化操作步骤（以 MindSpore 框架的 YOLOV5 为例）

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
detection/mindspore/quant/路径，在yolov5.yml文件中根据实际情况配置以下加粗字
段。
general:
    backend: mindspore  # pytorch | mindspore
    device_category: NPU
    task:
      local_base_path: ./tasks/
      task_id: "quant_yolov5"
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    device_evaluate_before_train: False
    parallel_search: True
    logger:
      level: info
    worker:
      timeout: 720000000
pipeline: [nas]

nas:
    pipe_step:
        type: SearchPipeStep
    model:
        model_desc:
          type: PruneModel
          model_file_path: /home/examples/yolov5/src/yolo.py  #模型脚本，该脚本内需提供一个get_model
方法返回需要量化的模型实例。
          pkg_path: /home/examples/yolov5 #当前yolov5脚本所在的路径
        pretrained_model_file: "/home/examples/yolov5/pre_train/0-300_274800.1130.ckpt"
        input_shape:
          - type: fp32
            tensor: True
            shape: [ 1,12,320,320 ]
          - type: int32
            tensor: False
            shape: [ 640,640 ]

    search_algorithm:
        type: MsQuantRL
        codec: QuantRLCodec
        policy:
            max_episode: 30   # Max eposide, recommended value>100, bigger is better, but it takes longer to 
learn.
                              # If this value cannot be determined, please set this value to a large value, and then /
                              # set a quantitative target and stop learning early to avoid the setting of this value.
            num_warmup: 10    # time without training but only filling the replay memory, recommended:10-20
        objective_keys: [ 'accuracy','compress_ratio','latency' ]

        #choice: acc_first | compress_first
        reward_type: 'compress_first'  #模型量化压缩优先指标。acc_first：精度优先；compress_first：压缩率
优先。

        custom_reward: False
        latency_acc_ratio: 0.5  # ratio of latency to accuracy in reward.
                             # If custom_reward if false,this value doesn't need to be configured.
                             # Besides, if custom_reward is true,you can set latency_acc_ratio to 0 so that latency is 
not used in reward.
                             # Otherwise,this value is recommended to be greater than 0.1.
        stop_early: False#是否找到同时满足acc_threshold、latency_threshold、compress_threshold三项指
标即停止任务
        acc_threshold: 0.5  #精度损失阈值百分比
        latency_threshold: 5  #时延降低百分比
        compress_threshold: 40  #压缩率阈值百分比

    search_space:
        type: SearchSpace
        hyperparameters:
            -   key: network.bit_candidates
                type: CATEGORY
                range: [ 8, 32]

    trainer:
      type: OriTrainer
      seed: 234
      callbacks: [MsQuantPTQCallback, CustomMetricCallback, CustomExportCallback]
      calib_portion: 0.01
      custom_calib:    #前向校正，校正量化因子
        pkg_path: /home/examples/yolov5/    #calib_func接口所在包路径
        path: /home/examples/yolov5/train.py    #接口所在路径
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        func: calib_func     
#对检测类模型，需要提供校正接口，校正方法可参考该{CANN包安装路径}/ascend-toolkit/latest/tools/
ascend_automl/example/classification/pytorch/quant/resnet_custom_func.py脚本
      custom_eval:     #评估精度
        pkg_path: /home/examples/yolov5/          #eval_func接口所在包路径
        path: /home/examples/yolov5/eval.py       #接口所在路径
        func: run_eval     #对检测类模型，需要提供验证接口，验证方法可参考{CANN包安装路径}/ascend-
toolkit/latest/tools/ascend_automl/example/classification/pytorch/quant/resnet_custom_func.py脚本
        metric_name: "mAP"     #需要优化的指标

    evaluator:
        type: Evaluator
        device_evaluator:
          type: DeviceEvaluator
          custom: QuantCustomEvaluator
          om_input_shape: 'input_0:1,12,320,320'
          backend: mindspore
          delete_eval_model: False  #是否删除搜索出的量化模型
          hardware: "Davinci"
          remote_host: "http://x.x.x.x:xxxx"  #远端推理服务器URL，后四位为端口号，需要与创建集群时的端口
号一致。如果在推理服务器中执行“vega-config -q sec”的返回值为“True”，请将“http”更改为
“https”。
          repeat_times: 1
          muti_input: True
          save_intermediate_file: True

对于检测类模型需要提供一个校正接口，需要利用训练数据集做前向计算，校正量化
参数。不需要做反向计算，反向传播相关的代码可以去掉，比如学习率，loss，优化
器，校正接口具体配置可参考OriTrainer的custom_calib字段。

对于检测类模型需要提供一个评估接口，计算模型精度指标，需要返回dict类型的评估
结果，评估接口具体配置可参考OriTrainer的custom_eval字段。其中，
metric_name是返回的评估结果中的一个key值。

步骤2 启动模型量化压缩任务。
vega yolov5.yml -d NPU

任务结束后会在指定工作路径的log文件夹中输出搜索日志。如果在评估服务evaluator
中，device_evaluator的delete_eval_model字段配置成“False”，将在指定的工作路
径的output/nas文件夹中输出每个搜索结果对应的模型。

----结束

模型剪枝后量化操作步骤（以 MindSpore 框架的 YOLOV5 为例）

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/
detection/mindspore/quant/路径，在ms_quant_yolov5_prune.yml文件中根据实际情
况配置以下加粗字段。
general:
    backend: mindspore  # pytorch | mindspore
    device_category: NPU
    parallel_search: True
    task:
      local_base_path: ./tasks/
      task_id: "quant_prune_yolov5"
    device_evaluate_before_train: False
    logger:
      level: info
pipeline: [nas]

nas:
    pipe_step:
        type: SearchPipeStep
    model:
        model_desc:
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          type: PruneModel
          is_training: False
          model_desc_file: "/tasks/output/fully_train/desc_1.json" #剪枝后模型描述文件路径
        pretrained_model_file: "/tasks/output/fully_train/model_1.ckpt" #剪枝后模型权重文件路径
        input_shape:
          - type: fp32
            tensor: True
            shape: [ 1,12,320,320 ]
          - type: int32
            tensor: False
            shape: [ 640,640 ]

    search_algorithm:
        type: MsQuantRL
        codec: QuantRLCodec
        policy:
            max_episode: 30   # Max eposide, recommended value>100, bigger is better, but it takes longer to 
learn.
                              # If this value cannot be determined, please set this value to a large value, and then /
                              # set a quantitative target and stop learning early to avoid the setting of this value.
            num_warmup: 10    # time without training but only filling the replay memory, recommended:10-20
        objective_keys: [ 'accuracy','compress_ratio','latency' ]

        #choice: acc_first | compress_first
        reward_type: 'compress_first'

        custom_reward: False
        latency_acc_ratio: 0.5  # ratio of latency to accuracy in reward.
                             # If custom_reward is false,this value doesn't need to be configured.
                             # Besides, if custom_reward is true,you can set latency_acc_ratio to 0 so that latency is 
not used in reward.
                             # Otherwise,this value is recommended to be greater than 0.1.
        stop_early: False
        acc_threshold: 0.5  
        latency_threshold: 5
        compress_threshold: 40

    search_space:
        type: SearchSpace
        hyperparameters:
            -   key: network.bit_candidates
                type: CATEGORY
                range: [ 8, 32]

    trainer:
      type: OriTrainer
      seed: 234
      callbacks: [MsQuantPTQCallback, CustomMetricCallback, CustomExportCallback]
      calib_portion: 0.01
      custom_calib:   #前向校正，校正量化因子
        pkg_path: /automl/yolov5/   #calib_func接口所在包路径
        path: /automl/yolov5/train.py  #接口所在路径   
        func: calib_func    #对检测类模型，需要提供校正接口，校正方法可参考{CANN包安装路径}/ascend-
toolkit/latest/tools/ascend_automl/example/classification/pytorch/quant/resnet_custom_func.py脚本
      custom_eval:   #评估精度
        pkg_path: /automl/yolov5/    #run_eval接口所在包路径
        path: /automl/yolov5/eval.py   #接口所在路径
        func: run_eval       #对检测类模型，需要提供验证接口，验证方法可参考{CANN包安装路径}/ascend-
toolkit/latest/tools/ascend_automl/example/classification/pytorch/quant/resnet_custom_func.py脚本 
        metric_name: "mAP"  #接口所在路径

    evaluator:
        type: Evaluator
        device_evaluator:
          type: DeviceEvaluator
          custom: CustomEvaluator
          hardware: "Davinci"
          remote_host: "http://x.x.x.x:8888"  #远端推理服务器URL，后四位为端口号，需要与创建集群时的端口
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号一致。如果在推理服务器中执行“vega-config -q sec”的返回值为“True”，请将“http”更改为
“https”。
          repeat_times: 1

对于检测类模型需要提供一个校正接口，需要利用训练数据集做前向计算，校正量化
参数。不需要做反向计算，反向传播相关的代码可以去掉，比如学习率，loss，优化
器，校正接口具体配置可参考OriTrainer的custom_calib字段。

对于检测类模型需要提供一个评估接口，计算模型精度指标，需要返回dict类型的评估
结果，评估接口具体配置可参考OriTrainer的custom_eval字段。其中，
metric_name是返回的评估结果中的一个key值。

步骤2 启动模型量化任务。
vega ms_quant_yolov5_prune.yml -d NPU

任务结束后会在指定工作路径的log文件夹中输出搜索日志。如果在评估服务evaluator
中，device_evaluator的delete_eval_model字段配置成“False”，将在指定的工作路
径的output/nas文件夹中输出每个搜索结果对应的模型。

----结束

11.6.5 vega 命令常用参数
启动模型自动调优任务依赖于开源模型调优框架VEGA，常用的vega命令参数如下表所
示。

表 11-9 vega 命令常用参数

参数 参数说明

-b
--backend

指定AI框架类型。取值如下。

● p：PyTorch框架

● t：TensorFlow框架

● m：MindSpore框架

-d
--device

自动调优任务在指定设备上运行。取值如下。

● NPU：在NPU上运行调优任务。

● GPU：在GPU上运行调优任务。

若不指定该参数，默认在GPU上启动调优任务。

-r
--resume

恢复已中断的nas搜索或训练阶段任务。还需要通过-t/--
task_id指定需要恢复的任务id。

● 对于恢复训练阶段的任务，当前仅支持PyTorch框架。

● 对于恢复nas搜索阶段的任务，当前仅支持随机搜索的采
样方式，且pipe_step字段的type值配置为
ResumeAbleSearchPipeStep。
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11.7 超参数优化

概述

在机器学习、深度学习中，有两类参数，一类需要从数据中学习和估计得到，称为模
型参数（Parameter）；另一类需要人为设定，称为超参数（Hyperparameter），例
如学习率、正则化系数等。

超参数优化，HPO（Hyperparameter Optimization），是指用自动化的算法来优化
超参数，从而提升模型的精度、性能等指标。使用HPO能力，可以快速高效地在超参
数空间中测试选择 佳的超参数组合，节省大量人力和时间。

当前MindStudio提供的HPO能力支持Random、ASHA、BOHB、BOSS、PBT等HPO算
法，适用于常见的深度神经网络的超参数优化，包括单目标优化和随机帕累托的多目
标超参选择。

前提条件

已安装1.1.3版本的pandas依赖包。

操作步骤

步骤1 修改用户模型训练脚本，添加dump_objective函数，并在此脚本中调用此函数，保存
待优化指标。
import json
def dump_objective(objective_key, objective_value):
    json_path = './{}.json'.format(objective_key)
    with open(json_path, 'w') as fw:
        json.dump({objective_key: objective_value}, fw)

用户可参考{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/
algorithms/script_hpo/hpo_ui_sample.py进行操作，此样例使用以下语句保存平均耗
时和精度指标。

dump_objective("avg_time", avg_time)
dump_objective("accuracy", accuracy)

其中dump_objective函数的入参objective_key要与步骤2中General Config页签中填
写的Objectives优化目标一致，objective_value为用户脚本中优化目标值。

HPO功能在用户指定的搜索空间内，进行超参数采样，并对每一组超参数调起一个用
户模型的训练任务。通过以上修改，用户脚本可在模型训练任务完成后，将超参数对
应的精度、性能等信息传递给HPO主进程，以便后续选出 优超参。

步骤2 在菜单栏选择“Ascend > AutoML > HPO”，进入General Config页签，如图
General Config所示。
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图 11-17 General Config

表 11-10 参数说明

参数 说明

Compute Nodes
Cluster

计算集群选择。

Parallel Search 多卡或者单卡配置按钮，按钮开状态为多卡，关闭为单卡。

Total Epochs 搜索epoch配额。在HPO过程中，每个训练任务会消耗一定数
量的epochs，所有训练任务的epoch总和小于此Total Epochs
项。用户可参考Total Epochs*time_per_epoch /
num_of_device来估算时间。

Task Work Path 当前运行用户目录下的工作路径，HPO过程的输出路径。需
用户选定或者输入存在且有读权限路径，且文件路径中不包
含非法字符。

Search
Alogorithom Type

搜索算法，目前仅支持AshaHpo算法。

Objectives 优化目标，单击右侧“+”图标可添加需要优化的目标。在文
本框中输入优化目标，例如平均精度、训练迭代耗时等。

● Max：表示期望优化目标 大化。

● Min：表示期望优化目标 小化。

单击右侧 删除图标可以删除对应的优化目标参数项。

 

步骤3 单击“Next”，进入Train Config页签，如图11-18所示。
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图 11-18 Train Config

表 11-11 参数说明

参数 说明

Train Script 步骤一中的用户的模型训练脚本，需为存在的可读python脚
本，不包含非法字符。在HPO调优过程中会调用该脚本。

Env Variables 环境变量。单击右侧 按钮添加环境变量。

● 当General Config页签开启Parallel Search参数时，需配置
以下环境变量：

– NPU_VISIBLE_DEVICES：可用的device。

– RANK_SIZE：device列表长度。

– RANK_TABLE_FILE：组网信息文件（若在前提条件已配
置该环境变量，则不用在此处进行配置）。用户需要先
配置组网信息文件，具体可参考https://
www.mindspore.cn/tutorial/training/zh-CN/r1.2/
advanced_use/distributed_training_ascend.html。

– BATCH_TASK_INDEX：任务编号，一般配置为0。

● 当General Config页签关闭Parallel Search参数时，需配置
DEVICE_ID实现在指定卡上运行。
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参数 说明

Search Space 搜索空间，单击右侧的“+”按钮可以添加以下搜索内容。

● Key：搜索关键字，需要优化的用户脚本输入参数名，这
里需要优化的是“lr”和“momentum”参数，因此填
“--lr”和“--momentum”，必填项。

● Type：搜索类型。支持CATEGORY、BOOL、INT、
INT_EXP、FLOAT、FLOAT_EXP，必填项。

● Range：当前Key的搜索范围。需手动输入，内容用英文逗
号分隔，必填项。

单击 删除图标可以删除对应的搜索空间。

说明
搜索类型可选以下六种：

● CATEGORY 分组类型，用户在Range中给出可选的取值，可以为
任意的数据类型，如：[18, 34, 50, 101]，[0.3, 0.7, 0.9]，
['Adam', 'SGD']，[[1, 0, 1]，[0, 0, 1]]

● BOOL 布尔类型，对应Range取值为[True, False]

● INT 整数类型，对应Range设置 小值和 大值，均 采样，如：
[10, 100]

● INT_EXP 整数类型，对应Range设置 小值和 大值，指数采
样，如：[1, 100000]

● FLOAT 浮点数类型，对应Range设置 小值和 大值，均 采
样，如：[0.1, 0.9]

● FLOAT_EXP 浮点数类型，对应Range设置 小值和 大值，指数
采样，如：[0.1, 100000.0]

Other Options 其他参数项，单击右侧的“+”按钮可以添加不需要优化的参
数。

● Key：不需要优化的用户脚本入参名，可选项。示例中不
需要优化的有“--weight_decay”参数，因此填入“--
weight_decay”

● Value：用户指定的入参值，选填项。

单击 删除图标可以删除对应的其他参数项。

Epoch Name 在HPO的不同阶段，对网络训练不同的epoch，这一epoch值
由HPO进程给出，不需用户指定。因此，用户需将脚本入参
中，代表epoch的参数名称，填入此栏，以便HPO过程中将
HPO算法给出的epoch值传入用户脚本。

例如：步骤一中示例，此项应填“--epochs ”
说明

如果待优化的训练脚本不能传入epoch参数，需要用户将训练脚本修
改为能传入epoch参数的形式。
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参数 说明

Device Name 在HPO过程中，启动多个训练任务，使用不同的超参数进行
网络训练。不同的训练任务使用不同的AI芯片，AI芯片ID由
HPO进程给出，不需用户指定。因此，用户需将脚本入参
中，代表AI芯片ID的参数名称，填入此栏，以便HPO过程中
将这一参数自动传入用户脚本。

例如：步骤一中示例，此项应填“--device”

说明

● 如果待优化的训练脚本不能传入该device参数，需要用户将训练脚
本修改为能传入device参数的形式。

● 传入的device值的格式为“npu:x”，其中x可能为0，1，2，3，
4，5，6，7。

 

步骤4 单击“Next”，进入Preview页签，如图11-19所示。

图 11-19 Preview

基于前面的两个配置界面，可以生成配置文件config.yml，接口文件train.py，启动文
件run.sh，并发送到远端服务器，调起HPO任务。此页面提供命令行命令的预览。单
击“Finish”之后运行HPO任务。

说明

可使用vega-process查询正在运行的任务，使用vega-kill -p PID或vega-kill -t task_id结束正在
运行的vega任务。

步骤5 过程和结果获取。

任务开始后，HPO窗口关闭，Output窗口中将提示可到远端查看HPO任务运行过程和
结果，如图11-20所示。
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图 11-20 过程和结果获取

在Output窗口所示路径下会生成tasks文件夹，tasks文件夹下有名为{task_id}的文件
夹，此文件下有文件夹logs、output和workers。

├── tasks 
│   ├── {task_id} 
│   │   ├──logs
│   │   │   ├──hpo_worker_{worker_id}。log      // 第worker_id个worker上进行hpo的日志文件
│   │   │   ├──pipeline.log                     // 整个hpo任务日志文件
│   │   ├──output
│   │   │   ├──config.yml                       // 配置文件
│   │   │   ├──report.json                      // hpo任务的报告文件
│   │   │   ├──hpo
│   │   │   │   ├──hps_{worker_id}.json           //搜索出的 佳超参值
│   │   │   │   ├──performance_{worker_id}.json   //搜索出的 佳优化指标值
│   │   │   │   ├──output.csv                     //优化指标值汇总文件
│   │   ├──workers
│   │   │   ├──hpo
│   │   │   │   ├──{worker_id}
│   │   │   │   │   ├──hps_{worker_id}.json           //超参值
│   │   │   │   │   ├──performance_{worker_id}.json   //优化目标值

----结束

11.8 大模型微调
紫东太初模型是中科院自动化所在探索通用人工智能路上的重要成果，能够实现三模
态图文音的统一语义表达，大幅提升文本、语音、图像和视频等领域的基础任务性
能。目前MindStudio模型微调工具支持紫东太初模型跨模态检索、文本生成、语音生
成、图像生成、VQA五个下游任务在单机单卡上进行微调。

11.8.1 紫东太初模型
● 下载紫东太初模型的训练脚本并放置合适路径。

● 已安装unidecode、inflect、ipdb、pathlib2、lmdb、cytoolz及requirements.txt
中的依赖。

● 针对文本生成下游任务，需要访问AIChallenger/AI_Challenger_2017，下载
Evaluation仓库并放置合适路径，并将该仓库的Evaluation/caption_eval加入
PYTHONPATH环境变量中。
export PYTHONPATH=$PYTHONPATH:{Evaluation存放地址}/Evaluation/caption_eval

● 准备数据集。

11.8.1.1 文本生成下游任务

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/mm/
路径，在opt_caption_finetune.yml文件中根据实际情况配置以下加粗字段。
general:
  backend: mindspore

MindStudio
用户指南 11 AutoML 工具（Beta）

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 492

https://gitee.com/mindspore/models/tree/master/research/mm/opt
https://github.com/AIChallenger/AI_Challenger_2017


  parallel_search: False
  ms_execute_mode: 0
  dataset_sink_mode: False
  worker:
    timeout: 7200000

register:
  pkg_path: [ "/example/caption/source" ]  #紫东太初源码路径
  modules:
    - module: "pretrain_three_caption_local" # 模块导入
      opt-network:
        name_filter: "opt_*_network"      # 只支持*通配符，所有名字符合条件，并符合接口规则，都会register，
与name配置是并集，不冲突
        name_list: [ "opt_caption_model" ]    # 直接通过名字注册进来
      opt-dataset: [ "opt_caption_dataset" ]          # 简写，相当于只有 name 属性

    - module: "pretrain_three_caption_eval"
      opt-dataset: [ "opt_caption_dataset_eval" ]          # 简写，相当于只有 name 属性
      opt-network: [ "opt_caption_model_eval" ]
      opt-forward_wrapper: [ "caption_eval_model_input" ]
      opt-ckpt_loader: "opt_*_ckpt_loader"    # 简写，相当于只有 name_filter 属性
      opt-metric: "*Metric"

pipeline: [ finetune ]

finetune:
  pipe_step:
    type: TrainPipeStep
  model:
    pretrained_model_file: /example/caption/ckpt/OPT_caption-3875_40.ckpt  # 模型权重路径
    model_desc:
      type: OptNetworkGen
      common:
        network:
          type: opt_caption_model
        ckpt_loader: opt_caption_ckpt_loader
      eval:
        network:
          type: opt_caption_model_eval
          net_wrapper: caption_eval_model_input
      config:
        file_config: &opt_config_file /example/caption/source/config/
ftcap_coco_bu_zh_lr5e-5_vega2.json    # 文本生成配置文件路径
        audio_dim: 512
        img_dim: 2048
        use_txt_out: False
        use_video: False
        full_batch: False
        use_moe: False
        decay_steps: 120000
        init_loss_scale: 65536
        loss_scale_factor: 2
        scale_window: 1000
        start_learning_rate: 5.0e-5
        end_learning_rate: 1.0e-7

  dataset:
    type: OptDataset
    common:
      opt_dataset:
        type: opt_caption_dataset
        config:
          file_config: /example/caption/source/config/ftcap_coco_bu_zh_lr5e-5_vega.json # 文本生成配置文
件路径
          full_batch: False
          use_video: False
          data_type: 2
          name_txt: id2len_three_1000.json
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          name_img: img2len_three_1000.json
          name_audio: audio2len_three_1000.json
          use_mask_fix: True
          use_data_fix: True
    test:
      opt_dataset:
        type: opt_caption_dataset_eval
        config:
          file_config: *opt_config_file
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True

  trainer:
    type: OptTrainer
    with_train: True
    is_net_with_optimizer: True
    is_net_with_loss: True
    epochs: 2
    callbacks: ['FreezeCallback']  # 如果需要冻结网络中的block，则要添加该Callback
    freeze:
      #freeze_backbone: True      # 冻结网络中所有以backbone为前 的block
      freeze_block: ['layer1']    # 自定义网络中需要冻结的block

  evaluator:
    type: Evaluator
    host_evaluator:
      type: OptHostEvaluator
      metric:
        type: CaptionMetric
        config:
          file_config: *opt_config_file
          caption_gt_eval: /example/caption/dataset/coco_trans_captions.json # 文本生成评估信息路

步骤2 配置环境变量。
export NPU_VISIBLE_DEVICES=i  #i为选择要使用的device_id
export DEVICE_ID=i           #i为选择要使用的device_id

步骤3 启动文本生成下游任务。
vega opt_caption_finetune.yml -d NPU

----结束

11.8.1.2 音频生成下游任务

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/mm/
路径，在opt_audio_finetune.yml文件中根据实际情况配置以下加粗字段。
general:
  backend: mindspore
  parallel_search: False
  ms_execute_mode: 1
  dataset_sink_mode: False
  worker:
    timeout: 7200000

register:
  pkg_path: [ "/example/audio/source" ]  #紫东太初源码路径
  modules:
    - module: "pretrain_three_audio_local" # 模块导入
      opt-network:
        name_filter: "opt_*_network"      # 只支持*通配符，所有名字符合条件，并符合接口规则，都会register，
与name配置是并集，不冲突
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        name_list: [ "opt_audio_model" ]    # 直接通过名字注册进来
      opt-ckpt_loader: "opt_*_ckpt_loader"    # 简写，相当于只有 name_filter 属性
      opt-dataset: [ "opt_audio_dataset" ]          # 简写，相当于只有 name 属性

    - module: "pretrain_three_audio_local_eval"
      opt-dataset: [ "opt_audio_dataset_eval" ]          # 简写，相当于只有 name 属性
      opt-network: [ "opt_audio_model_eval" ]
      opt-forward_wrapper: [ "audio_eval_model_input" ]
      opt-metric: "*Metric"

pipeline: [ finetune ]

finetune:
  pipe_step:
    type: TrainPipeStep
  dataset:
    type: OptDataset
    common:
      opt_dataset:
        type: opt_audio_dataset
        config:
          file_config: &opt_config_file /example/audio/source/config/
pretrain_three_modal_audio_local_config_copy.json  # 音频生成配置文件路径
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True
          train_batch_size: 2560
          val_batch_size: 10
          name_txt: id2len_three.json
          name_img: img2len_three.json
          name_audio: audio2len_three.json
    test:
      opt_dataset:
        type: opt_audio_dataset_eval
        config:
          file_config: *opt_config_file
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True
          train_batch_size: 2560
          val_batch_size: 10
          name_txt: id2len_three.json
          name_img: img2len_three.json
          name_audio: audio2len_three.json
  model:
    pretrained_model_file: /example/audio/ckpt/OPT_audio_3-339500_2.ckpt  # 模型权重路径
    model_desc:
      type: OptNetworkGen
      common:
        network:
          type: opt_audio_model
        ckpt_loader: opt_audio_ckpt_loader
      eval:
        network:
          type: opt_audio_model_eval
          net_wrapper: audio_eval_model_input
      config:
        file_config: *opt_config_file
        use_txt_out: False
        use_video: False

        audio_dim: 1024
        img_dim: 2048
        full_batch: False
        use_moe: False
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        decay_steps: 120000
        init_loss_scale: 65536
        loss_scale_factor: 2
        scale_window: 1000
        start_learning_rate: 5.0e-5
        end_learning_rate: 1.0e-7

  trainer:
    type: OptTrainer
    with_train: True
    is_net_with_optimizer: True
    is_net_with_loss: True
    epochs: 2
    callbacks: ['FreezeCallback']  # 如果需要冻结网络中的block，则要添加该Callback
    freeze:
      #freeze_backbone: True      # 冻结网络中所有以backbone为前 的block
      freeze_block: ['layer1']    # 自定义网络中需要冻结的block

  evaluator:
    type: Evaluator
    host_evaluator:
      type: OptHostEvaluator
      max_val_steps: 2
      metric:
        type: AudioMetric
        config:
          file_config: *opt_config_file

步骤2 配置环境变量。
export NPU_VISIBLE_DEVICES=i  #i为选择要使用的device_id
export DEVICE_ID=i           #i为选择要使用的device_id

步骤3 启动文本生成下游任务。
vega opt_audio_finetune.yml -d NPU

----结束

11.8.1.3 跨模态检索下游任务

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/mm/
路径，在opt_itm_finetune.yml文件中根据实际情况配置以下加粗字段。
general:
  backend: mindspore
  parallel_search: False
  ms_execute_mode: 0
  dataset_sink_mode: False
  worker:
    timeout: 7200000

register:
  pkg_path: [ "/example/itm/source" ]  #紫东太初源码路径
  modules:
    - module: "vega_local_finetune_itm_three" # 模块导入
      opt-network:
        name_filter: "opt_*_network"      # 只支持*通配符，所有名字符合条件，并符合接口规则，都会register，
与name配置是并集，不冲突
        name_list: [ "opt_itm_model" ]    # 直接通过名字注册进来
      opt-ckpt_loader: "opt_*_ckpt_loader"    # 简写，相当于只有 name_filter 属性
      opt-dataset: [ "opt_dataset" ]          # 简写，相当于只有 name 属性

    - module: "pretrain_three_retrieval"
      opt-network: [ "opt_itm_model_eval" ]
      opt-forward_wrapper: [ "itm_eval_model_input" ]
      opt-metric: "*Metric"
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pipeline: [ finetune ]

finetune:
  pipe_step:
    type: TrainPipeStep
  dataset:
    type: OptDataset
    common:
      opt_dataset:
        type: opt_dataset
        config:
          file_config: &opt_config_file /example/itm/source/config/vega_test_ch_retft.json # 跨模态配置文
件路径
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True
          train_batch_size: 2
          val_batch_size: 2
          is_eval: False
    test:
      to_dict_iter: True
      opt_dataset:
        type: opt_dataset
        config:
          file_config: *opt_config_file
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True
          train_batch_size: 2
          val_batch_size: 2
          is_eval: True
  model:
    pretrained_model_file: /example/itm/ckpt/OPTseq50lr5e-51405_1.ckpt # 模型权重路径
    model_desc:
      type: OptNetworkGen
      common:
        network:
          type: opt_itm_model
        ckpt_loader: opt_itm_train_ckpt_loader
      eval:
        network:
          type: opt_itm_model_eval
          net_wrapper: itm_eval_model_input
      config:
        file_config: *opt_config_file
        model_config: /example/itm/source/config/cross_modal_encoder_config.json # 模型定义配置文件路
径
        audio_dim: 1024
        img_dim: 2048
        use_txt_out: False
        use_video: False
        full_batch: False
        use_moe: False
        decay_steps: 120000
        init_loss_scale: 65536
        loss_scale_factor: 2
        scale_window: 1000
        start_learning_rate: 5.0e-5
        end_learning_rate: 1.0e-7

  trainer:
    type: OptTrainer
    with_train: True
    is_net_with_optimizer: True
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    is_net_with_loss: True
    epochs: 2
    callbacks: ['FreezeCallback']  # 如果需要冻结网络中的block，则要添加该Callback
    freeze:
      #freeze_backbone: True      # 冻结网络中所有以backbone为前 的block
      freeze_block: ['layer1']    # 自定义网络中需要冻结的block

  evaluator:
    type: Evaluator
    host_evaluator:
      type: OptHostEvaluator
      max_val_steps: 64
      metric:
        type: ITMMetric
        config:
          file_config: *opt_config_file

步骤2 配置环境变量。
export NPU_VISIBLE_DEVICES=i  #i为选择要使用的device_id
export DEVICE_ID=i           #i为选择要使用的device_id

步骤3 启动文本生成下游任务。
vega opt_itm_finetune.yml -d NPU

----结束

11.8.1.4 视觉问答下游任务

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/mm/
路径，在opt_vqa_finetune.yml文件中根据实际情况配置以下加粗字段。
general:
  backend: mindspore
  parallel_search: False
  ms_execute_mode: 0
  dataset_sink_mode: False
  logger:
    level: debug
  worker:
    timeout: 7200000

register:
  pkg_path: [ "/example/automl/uniter3" ]   #紫东太初源码路径
  modules:
    - module: "finetune_tool_vqa_new" # 模块导入
      opt-network:
        name_filter: "opt_*_network"      # 只支持*通配符，所有名字符合条件，并符合接口规则，都会register，
与name配置是并集，不冲突
        name_list: [ "opt_vqa_model" ]    # 直接通过名字注册进来
      opt-ckpt_loader: "opt_*_ckpt_loader"    # 简写，相当于只有 name_filter 属性
      opt-dataset: [ "opt_vqa_dataset" ]          # 简写，相当于只有 name 属性
#
    - module: "finetune_tool_vqa_new"
      opt-dataset: [ "opt_vqa_dataset_eval" ]          # 简写，相当于只有 name 属性
      opt-network: [ "opt_vqa_model_eval" ]
      opt-forward_wrapper: [ "vqa_eval_model_input" ]
      opt-metric: "*Metric"

pipeline: [ finetune ]

finetune:
  pipe_step:
    type: TrainPipeStep
  model:
    pretrained_model_file: /example/OPT_5-23850_2.ckpt # 模型权重路径
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    model_desc:
      type: OptNetworkGen
      common:
        network:
          type: opt_vqa_model
        ckpt_loader: opt_vqa_train_ckpt_loader
      eval:
        network:
          type: opt_vqa_model_eval
          net_wrapper: vqa_eval_model_input
        ckpt_loader: opt_vqa_eval_ckpt_loader
      config:
        file_config: &opt_train_config_file /example/automl/uniter3/config/
ft_vqagen_coco_bu_zh_lr5e-5.json # 视觉问答训练配置文件路径
        audio_dim: 1024
        img_dim: 2048
        use_txt_out: False
        use_video: False
        full_batch: False
        use_moe: False
        decay_steps: 100000
        init_loss_scale: 65536
        loss_scale_factor: 2
        scale_window: 1000
        start_learning_rate: 5.0e-5
        end_learning_rate: 1.0e-7

  dataset:
    type: OptDataset
    common:
      opt_dataset:
        type: opt_vqa_dataset
        config:
          file_config: *opt_train_config_file
          full_batch: False
          use_video: False
          data_type: 2
          name_txt: FM-IQA.json
          name_img: img2len_two.json
          name_audio: audio2len.json
          use_mask_fix: True
          use_data_fix: True
    test:
      opt_dataset:
        type: opt_vqa_dataset_eval
        config:
          file_config: &opt_eval_config_file /example/automl/uniter3/config/
ft_vgagen_coco_bu_zh_lr5e-5_eval.json # 视觉问答评估配置文件路径
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True

  trainer:
    type: OptTrainer
    with_train: True
    is_net_with_optimizer: True
    is_net_with_loss: True
    epochs: 2
    callbacks: ['FreezeCallback']  # 如果需要冻结网络中的block，则要添加该Callback
    freeze:
      #freeze_backbone: True      # 冻结网络中所有以backbone为前 的block
      freeze_block: ['layer1']    # 自定义网络中需要冻结的block

  evaluator:
    type: Evaluator
    host_evaluator:
      type: OptHostEvaluator
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      metric:
        type: VqaMetric
        config:
          file_config: *opt_eval_config_file
          caption_gt_eval: /store0/dzhao/uniter3/vqa_data/FM-IQA.json # 视觉问答评估信息路径 

步骤2 配置环境变量。
export NPU_VISIBLE_DEVICES=i  #i为选择要使用的device_id
export DEVICE_ID=i           #i为选择要使用的device_id

步骤3 启动视觉问答生成下游任务。
vega opt_vqa_finetune.yml -d NPU

说明

启动视觉问答下游任务时，若出现“' NoneType' object has no atribute 'shape'. ”报错，请参
见对紫东太初模型的视觉问答任务进行微调时，出现“' NoneType' object has no atribute
'shape'. ”

----结束

11.8.1.5 图像生成下游任务

操作步骤

步骤1 进入{CANN包安装路径}/ascend-toolkit/latest/tools/ascend_automl/examples/mm/
路径，在opt_img_finetune.yml文件中根据实际情况配置以下加粗字段。
general:
  backend: mindspore
  parallel_search: False
  ms_execute_mode: 0
  dataset_sink_mode: False
  logger:
    level: debug
  worker:
    timeout: 7200000

register:
  pkg_path: [ "/example/automl/uniter3_img/" ]  #紫东太初源码路径
  modules:
    - module: "finetune_tool_img_new" # 模块导入
      opt-network:
        name_filter: "opt_*_network"      # 只支持*通配符，所有名字符合条件，并符合接口规则，都会register，
与name配置是并集，不冲突
        name_list: [ "opt_img_model" ]    # 直接通过名字注册进来
      opt-ckpt_loader: "opt_*_ckpt_loader"    # 简写，相当于只有 name_filter 属性
      opt-dataset: [ "opt_img_dataset" ]          # 简写，相当于只有 name 属性

    - module: "finetune_tool_img_new"
      opt-dataset: [ "opt_img_dataset_eval" ]          # 简写，相当于只有 name 属性
      opt-network: [ "opt_img_model_eval" ]
      opt-forward_wrapper: [ "img_eval_model_input" ]
      opt-metric: "*Metric"

pipeline: [ finetune ]

finetune:
  pipe_step:
    type: TrainPipeStep
  model:
    pretrained_model_file: /example/OPT_txt2img-127_1000.ckpt #模型权重文件
    model_desc:
      type: OptNetworkGen
      common:
        network:
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          type: opt_img_model
        ckpt_loader: opt_img_train_ckpt_loader
      eval:
        network:
          type: opt_img_model_eval
          net_wrapper: img_eval_model_input
        ckpt_loader: opt_img_eval_ckpt_loader
      config:
        file_config: &opt_config_file /example/automl/uniter3/config/ftt2i_coco_bu_zh_lr5e-5.json  #图像
生成配置文件路径
        audio_dim: 512
        img_dim: 2048
        use_txt_out: False
        use_video: False
        full_batch: False
        use_moe: False
        decay_steps: 100000
        init_loss_scale: 65536
        loss_scale_factor: 2
        scale_window: 1000
        start_learning_rate: 5.0e-5
        end_learning_rate: 1.0e-7

  dataset:
    type: OptDataset
    common:
      opt_dataset:
        type: opt_img_dataset
        config:
          file_config: *opt_config_file
          full_batch: False
          use_video: False
          data_type: 2
          name_txt: id2len_two_mscoco.json
          name_img: img2len_two.json
          name_audio: audio2len.json
          use_mask_fix: True
          use_data_fix: True
          use_vit: False
    test:
      opt_dataset:
        type: opt_img_dataset_eval
        config:
          file_config: *opt_config_file
          full_batch: False
          use_video: False
          data_type: 2
          use_mask_fix: True
          use_data_fix: True

  trainer:
    type: OptTrainer
    with_train: True
    is_net_with_optimizer: True
    is_net_with_loss: True
    epochs: 2
    callbacks: ['FreezeCallback']  # 如果需要冻结网络中的block，则要添加该Callback
    freeze:
      #freeze_backbone: True      # 冻结网络中所有以backbone为前 的block
      freeze_block: ['layer1']    # 自定义网络中需要冻结的block

  evaluator:
    type: Evaluator
    host_evaluator:
      type: OptHostEvaluator
      metric:
        type: ImgMetric
        config:
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          file_config: *opt_config_file
          caption_gt_eval: /store0/dataset/coco_data/captions_test5k.json  # 图像生成评估信息路径

步骤2 配置环境变量。
export NPU_VISIBLE_DEVICES=i  #i为选择要使用的device_id
export DEVICE_ID=i           #i为选择要使用的device_id

步骤3 启动文本生成下游任务。
vega opt_vqa_finetune.yml -d NPU

----结束

11.8.2 大模型微调工具

概述

大模型微调工具通过对紫东太初模型下游任务的启动进行优化，简化了下游任务启动
时的配置文件，同时还支持了下游任务运行过程中的冻结策略配置，方便用户自定义
运行不同配置的下游任务。

参数说明

表 11-12 参数说明

参数 说明

-m/--model
model

输入模型。必填。目前只支持紫东太初模型，取值为“taichu”。

-c/--
config_file

配置文件.yml的路径。必填。用户需要参考{CANN包安装路径}/
ascend-toolkit/latest/tools/mxOps/examples/mm/taichu.yml写好
配置文件。可直接使用“downstream_task_type”字段指定了下游
任务的类型，下游任务的类型包括：“caption”、“audio”、
“img”、“itm”、“vqa”。

指定后该字段后需要根据实际情况指定预训练权重、模型本身的
json配置文件等内容，通常情况下，用户只需修改这些 基本的参
数即可，如果需要自定义配置更多下游任务参数，可参考紫东太初
模型中对应下游任务的yml配置文件修改步骤。

-d/--device 模型微调任务在指定设备上运行。选填。取值如下。

● NPU：在NPU上运行调优任务。

● GPU：在GPU上运行调优任务。

若不指定该参数，默认在GPU上启动调优任务。

–h/--help 显示帮助信息。选填。

 

执行微调任务
mxOps finetune -m taichu -c 配置文件路径 [-d 指定设备]
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11.9 任务管理
运行模型自动生成任务后，会自动添加可视化任务，可以参考查看可视化任务直接查
看。如果使用模型自动调优，则需要参考新建可视化任务新建可视化任务。

11.9.1 查看可视化任务

步骤1 进入Automl Tasks界面。

可通过以下两种方式进入Automl Tasks界面。

● 在菜单栏选择“View > Tool Windows > Automl Tasks”。

● 单击如图工程目录树左侧“Automl Tasks”选项。

图 11-21 “Automl Tasks”选项

进入Automl Tasks界面单击左侧任务列表，可以查看各个任务的详细情况，如图
11-22所示。
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图 11-22 Automl Tasks

表 11-13 界面图标说明

图标 说明

表示任务已经结束。

MindStudio
用户指南 11 AutoML 工具（Beta）

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 504



图标 说明

表示任务正在进行。

表示任务的其他状态，例如失败。

单击此按钮可删除该项任务。

单击此按钮可停止正在进行的任务。

 

步骤2 单击左侧任务列表中任务的名称或者在搜索栏中输入任务名称关键字查找，右侧展示
栏显示该任务的具体详细信息。

● Task Information：任务信息

参数 说明

Name 任务名称

Status 任务当前状态

Path 任务路径

Start Time 任务开始时间

End Time 任务结束时间

 

● Datasets Information：数据集信息

参数 说明

Type 数据集类型

Data Path 数据路径

Batch Size 批量大小

 

● Evaluater Information：评估服务器信息
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参数 说明

Type 类型

Hardware 硬件架构

Remote Host 远程服务器地址

 
● Parallel Search Information：并行搜索设置

参数 说明

Parallel Search 是否并行搜索

Parallel Fully Train Fully Train是否并行搜索

Cluster 集群名称

 
● Common Information：公共信息

参数 说明

Flops 浮点计算量。

Latency 基线时延，数值越高表示时延越大。

Params 网络的参数量。

Baseline Accuracy 基线精确度

 

说明

对于没有fine_tune阶段的场景，Common Information页签中参数值不更新，默认值为0。

● fine_tune页面
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参数 说明

epoch（轮训次数）

AccTop1 排名top1的精确率。

AccTop5 排名top5的精确率。

Accuracy 精确度，精确度值为AccTop1的值。

Model Information（模型信息）

Model 模型名称。在以下两种场景显示该信息：

– 在有模型场景

– 无模型场景且非mindspore框架的场景

Modules 模块名称。在无模型场景mindspore框架下显示
该信息。

Backbone 主干链路。在无模型场景mindspore框架下显示
该信息。

Pretrained Model File 预训练模型文件。

Trainer Information（训练设备信息）

Epochs 轮训次数。

Optimizer 优化器。

Ir_scheduler Ir调度器。

Loss 损失函数。

 
● nas页面
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参数 说明

Latency（时延）

Work id 并行任务id。

AccTop1 排名top1的精确率。

AccTop5 排名top5的精确率。

Accuracy 精确度，精确度值为AccTop1的值。

Flops 网络的浮点计算量。

Latency 时延，以ms为单位。

Params 网络的参数量。

Choosed model 算法选出的好的模型。

Search Algorithm Information（搜索算法信息）

Type 算法类型。

Objective Keys 优化目标名称。

Search Space Information（搜索空间信息，仅在无模型场景下显示以下四个
参数信息）

network.backbone.depth 网络深度。

network.backbone.base_chan
nel

初始通道数。

network.backone.doublechan
nel

升通道位置。

network.backbone.downsam
ple

下采样位置。

Trainer Information（训练设备信息）

Epochs 轮训次数。
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参数 说明

Optimizer 优化器。

Ir_scheduler Ir调度器。

Loss 损失函数。

 
● fully_train页面

参数 说明

epoch（轮训次数）

Model id 模型id。

AccTop1 排名top1的精确率。

AccTop5 排名top5的精确率。

Accuracy 精确度，精确度值为AccTop1的值。

Flops 浮点计算量。

Latency 时延，数值越高表示时延越大。

Params 网络的参数量。

Trainer Information（训练设备信息）

Epochs 轮训次数。

Optimizer 优化器。

Ir_scheduler Ir调度器。

Loss 损失函数。

 
● Result页面
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参数 说明

Comparison in D-chips（D芯片的比较信息）

Model id 模型id。

AccTop1 排名top1的精确率。

AccTop5 排名top5的精确率。

Accuracy 精确度，精确度值为AccTop1的值。

说明
启动有模型场景下的automl任务时，精确度值会附
上精确度值与fine-tune跑出来的Accuracy基准值的
差值。

Flops 浮点计算量。

说明
启动有模型场景下的automl任务时，浮点计算量会
附上浮点计算量与fine-tune跑出来的Flops基准值的
差值百分比。

Latency 时延，数值越高表示时延越大。

说明
启动有模型场景下的automl任务时，时延值会附上
时延值与fine-tune跑出来的Latency基准值的差值百
分比。

Params 网络的参数量。

说明
启动有模型场景下的automl任务时，网络的参数量
会附上网络的参数量与fine-tune跑出来的Params基
准值的差值百分比。

Action 可执行操作。

：模型下载功能。
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说明

● 若需可视化界面任务进度条与任务实际运行进度保持一致，请确保启动任务的服务器系统时
间和实际时间一致。

● 关闭Offline Model参数项，Optimizing Method参数选择Fine-tune项时展示栏将显示
fine_tune页面。Optimizing Method参数选择nas项时将显示nas页面、fully_train页面。

● 打开Offline Model参数项时，将显示fine_tune页面、nas页面和fully_train页面。

----结束

11.9.2 新建可视化任务

通过新建可视化任务功能可以查询集群中通过后端命令行执行的正在运行或已结束的
分类网络训练任务的进度，如果是模型自动生成任务，可将其可视化。

步骤1 在菜单栏选择“Ascend > AutoML > New Visual Task”，弹出New Visual Task界
面，如图11-23所示。

图 11-23 New Visual Task

表 11-14 参数说明

参数 说明

SSH Connection SSH连接。在下拉框中选择SSH连接，如果没有配置过SSH连
接，可单击右侧“+”进入SSH页面配置新的SSH连接。

Task Type 任务类型。

● Running：正在运行的任务。

● History：历史任务。
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参数 说明

Task Folder Path 集群工作空间路径下的任务目录，即“Workspace”下的
vega_tasks目录。“Task Type”选择“History”时该项才体
现。可单击右侧文件夹图标进行选择，如home/username/
vega_tasks。

Task List 任务id。在下拉框中可选择SSH连接服务器上的任务。

 

步骤2 单击“OK”，进入可视化任务界面。

如果可视化任务窗口任务栏中存在同名任务，将弹出提示窗口，如图11-24所示。

图 11-24 Task with the Same Name Exists

参数 说明

Override 覆盖任务。单击此按钮，则覆盖原有的同名任务。

Rename 重命名任务名。单击此按钮，则对需要可视化的任务重命
名，并新建新的任务。

 

步骤3 将显示正在运行的任务的信息，具体显示内容可参考任务管理章节步骤2中展示的内
容。

----结束

11.10 参考信息

11.10.1 配置参考

Vega通用配置项名称是general，用于设置公共和通用的一些配置项，如Backend、输
出路径和日志级别等。公共配置项说明具体请参考公共配置项。

11.10.2 日志参考

可从后台进入集群Workspace路径下指定任务文件夹获取日志查看详细信息。如训练
服务器的工作路径Workspace为：/home/test/nfs_folder，将在该目录下生成如下日
志。
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表 11-15 日志说明

日志 说明

pipeline.log 总体日志，记录每个阶段开始结束等

{阶段}_worker_{id}.log 对应阶段的训练日志，如
nas_worker_{id}.log、
finetune_worker_{id}.log

{阶段}_{device/host}_evaluator_{id}.log 对应阶段的评估日志，如
nas_host_evaluator_{id}.log、
nas_device_evaluator_{id}.log

 

11.11 FAQ

11.11.1 对紫东太初模型的视觉问答任务进行微调时，出现“'
NoneType' object has no atribute 'shape'. ”

问题描述

对紫东太初模型的视觉问答任务进行微调时，遇到如图1 报错信息所示报错。

图 11-25 报错信息

原因分析

MindSpore框架默认使用JIT Callback特性。

解决方案

可以通过如下命令关闭JIT Fallback特性。

export MS_DEV_ENABLE_FALLBACK=0

11.11.2 如何配置多 GPU/NPU 支持
若运行Vega的主机环境中有多张GPU/NPU，可通过设置如下配置项支持多GPU/
NPU：

general:
    parallel_search: True
    parallel_fully_train: True
    devices_per_trainer: 1

其中：

● parallel_search：控制是否在模型搜索阶段并行搜索多个模型，其中每个模型使用
一个或多个GPU/NPU。
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● parallel_fully_train: 控制是否在fully train阶段并行训练多个模型，其中每个模型
使用一个或多个GPU/NPU。

● devices_per_trainer: 当如上任一控制项为True是生效，用于控制一个模型对应多
少个GPU/NPU。

注意：CARS和DARTS算法不支持并行搜索。

11.11.3 如何指定 Vega 运行的 GPU 环境
若运行环境中有多张GPU卡，可使用如下命令控制Vega使用哪些GPU：

使用单个GPU：

CUDA_VISIBLE_DEVICES=1 python3 -m vega.pipeline ./nas/backbone_nas/backbone_nas.yml 

使用多个GPU：

CUDA_VISIBLE_DEVICES=2,3 python3 -m vega.pipeline ./nas/backbone_nas/backbone_nas.yml

11.11.4 如何通过修改配置项加载预训练模型
可通过修改配置项加载预训练模型，如下例加载预训练模型simple_cnn.pth：

    model:
        model_desc:
            modules: [backbone]
            backbone:
                type: SimpleCnn
                num_class: 10
                fp16: False
        pretrained_model_file: "./simple_cnn.pth"

11.11.5 如何查看日志，如何设置日志级别
Vega的日志缺省保存在如下位置：

./tasks/<task id>/logs 

若要配置日志级别，可修改：

general:
    logger:
        level: info  # debug|info|warn|error|

11.11.6 如何终止后台运行的 vega 程序
Vega在多个GPU/NPU场景中，会启动dask scheduler、dask worker及训练器，若仅
仅杀死Vega主进程会造成部分进程不会及时的关闭，其占用的资源一直不会被释放。

在安全模式下，可使用如下命令终止Vega应用程序：

# 查询运行中的Vega主程序的进程ID
vega-process -s
# 终止一个Vega主程序及相关进程
vega-kill -s -p <pid>
# 或者一次性的终止所有Vega相关进程
vega-kill -s -a
# 若主程序被非常正常关闭，还存在遗留的相关进程，可使用强制清理
vega-kill -s -f

在普通模式下，使用如下命令：

vega-process
vega-kill -p <pid>
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vega-kill -a
vega-kill -f
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12 Benchmark 工具

说明

CANN 5.1.RC1和MindStudio 5.0.RC1版本不发布benchmark工具，若需要在MindStudio环境下
使用该工具，请安装CANN 5.0.3版本下的benchmark工具以及3.0.3版本的MindStudio。CANN
5.0.3版本的benchmark工具安装请参见《推理Benchmark工具使用指南》，MindStudio 3.0.3
版本的benchmark工具使用请参见《MindStudio 3.0.3 用户指南》的“benchmark工具”章
节。
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13 专家系统工具

13.1 功能介绍

13.2 使用前必读

13.3 操作步骤（专家系统入口）

13.4 操作步骤（算子工程入口）

13.5 专家系统分析样例参考

13.1 功能介绍

简介

专家系统（MindStudio Advisor）是用于聚焦模型和算子的性能调优TOP问题，识别性
能瓶颈Pattern，重点构建瓶颈分析、优化推荐模型，支撑开发效率提升的工具。当前
提供的功能有：基于Roofline模型的算子瓶颈识别与优化建议、基于Timeline的AICPU
算子优化和算子融合推荐、算子优化分析。

基于 Roofline 模型的算子瓶颈识别与优化建议

如图13-1所示，横坐标单位是FLOP/byte，表示计算强度，每搬运1byte数据可以进行
多少次运算，越大表示内存搬运利用率越高。纵坐标单位是FLOP/s，表示运算速度，
越大表示运算越快。

当横坐标很大时，表示每搬运1byte数据可以进行很多的运算，但是每秒的运算次数无
法超过硬件的性能上限π，即图中绿色横线；随着横坐标减小到一定的阈值以下，即图
中蓝点的横坐标Imax，搬运的数据将不支持硬件达到性能上限的算力，此时的纵坐标
性能为β·x，β表示硬件的带宽，即图中红色斜线。

蓝点将Roofline模型分成2个部分，红色部分为Memory Bound，绿色部分为Compute
Bound，且实际工作点越靠近红线或绿线，表示Bound越严重，为主要瓶颈所在。
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图 13-1 roofline 模型介绍

本功能需完成使用前必读后进行操作步骤（专家系统入口）操作。

算子优化分析

在算子开发结束和整网运行出现算子性能不达标两种场景下，需要对算子进行调优。
算子调优对开发者的要求比较高，需要开发者对底层和框架有一定的了解，同时具备
一定的算子调优经验。算子优化分析可以协助开发者迅速找到算子性能瓶颈，并给出
相应的优化手段，能够有效提升开发者算子调优的效率。

通过输入算子仿真生成的dump文件，从向量运算、标量运算和流水打断三个维度进行
分析，并给出分析的数据和相应的优化建议。

本功能需完成使用前必读后进行操作步骤（算子工程入口）操作。

基于 Timeline 的 AI CPU 算子优化

AI CPU是NPU计算单元，因为该CPU计算处理单位自身瓶颈，导致运行在AI CPU上的
算子影响模型的执行时间。AI CPU算子的优化往往是重点关注点和优化对象。

模型开发和模型转换过程中，引入AI CPU算子，出现因为串行等待AI CPU算子执行影
响模型执行。

从时间序列分析，性能瓶颈一般由串行等待算子造成。当前Timeline时序信息以
Stream粒度展示，无法直观发现算子间的串并行关系。

如图13-2，AI CPU Timeline中Task1（PTCopy）存在模型执行串行等待AI CPU算子执
行，瓶颈分析模型需要主动识别这类瓶颈。AI CPU Timeline中Task2计算时间隐藏在
AI Core计算时间中，这类AI CPU算子执行可以忽略。
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图 13-2 AI CPU 算子执行

基于Timeline的AI CPU算子优化以Profiling Task Scheduler任务调度文件数据
（task_time_xxxx.json）以及om模型离线文件作为输入数据，自动识别串行执行AI
CPU算子，给出优化建议，提升模型整体性能。

本功能需完成使用前必读后进行操作步骤（专家系统入口）操作。

算子融合推荐

算子融合推荐包括UB算子融合、首层算子融合和L2融合（动态Batch切分）三个功
能：

UB算子融合

模型转换过程中，由于多种原因，如算子计算的数据超过UB大小 ，当前算子融合规则
未覆盖等，会造成算子融合失败。当OM模型非常复杂时，如包含几千个计算节点时，
靠肉眼定位到可融合算子耗时耗力。模型转换工具规则不能匹配所有场景，融合规则
有遗漏。

UB算子融合推荐以OM模型离线文件作为输入数据，自动发现OM模型中的可融合算
子，发现算子融合遗漏的场景，提供算子融合建议。

首层算子融合

在load3dv2支持输入通道非16/32对齐的场景，可以直接支持4通道卷积的，极大减少
MTE2与cube运算。但是当前该模式存在一个问题：

● 非AIPP场景下，算子首层需要cast和trans_data算子进行图片的数据类型转换和数
据排布格式转换，在C0=4的场景下，trans_data算子性能恶化严重，此时整网性
能恶化严重；

● AIPP场景，此时网络首层会进行AIPP+conv融合或AIPP+conv+maxpooling融合，
由于一般首层16通道卷积的耗时占比整网的10%左右，此时开启small channel模
式会大幅提升整网性能。

首层算子融合以OM模型离线文件作为输入数据，自动发现OM模型中可优化的数据预
处理算子，使能AIPP，提升性能。

L2融合（动态Batch切分）

在整网中，由于某些算子层为L2融合，数据量较大（包含输入和输出数据），超出L2
的空间，会引发DDR（DDR主要统计读写带宽，在Analysis Summary中以表格形式呈
现）写回的操作；而DDR的带宽远小于L2，造成MTE2 bound严重，同时可能进一步
引发流水问题。

以resnet50_int8_8batch为例：

理论上8batch的单算子计算耗时小于等于2倍4batch单算子计算耗时，但如果8batch
各层的算子为L2融合，导致数据量变大，造成L2 cache空间不足，产生DDR写回情
况，引发算子性能恶化。
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表 13-1 8batch_4batch 算子计算性能对比

算子 8batch性能/us 4batch性能/us 8batch/4batch 倍
数

res2a_branch2c 200.63 38.284 5.24

res2b_branch2c 189.97 40.527 4.69

res2c_branch2c 147.84 38.533 3.84

res3a_branch1 74.00 31.109 2.38

整网时间 2031 954 -

整网占比 30.2% 15.5% -

 

如表13-1所示，可以看到8batch的算子计算耗时远超过4batch算子的2倍，算子性能
恶化较严重。

专家系统工具通过分析OM模型中的各层算子，以及读取op_summary.csv数据，识别
并输出L2融合且未达到性能瓶颈的算子。需要对这些算子进行切分以实现每层算子的
数据均不超过L2的范围，防止DDR写回的情况发生。

本功能需完成使用前必读后进行操作步骤（专家系统入口）操作。

TransData 算子识别

模型中格式转换是影响模型性能的一个重要因素。当前格式转换由NPU CUBE单元的
特性引入，在CV网络主要体现大量的4D与5D的转换，而在NLP网络主要体现为大量
4D与NZ的转换。大量的TransData算子会影响模型的性能。

TransData算子识别功能通过分析模型引入TransData的常见场景，识别转化算子性能
瓶颈，从算子层、适配层和模型层三个层面进行分析，选择合适的方案进行优化，减
少模型中TransData的调用次数。

本功能需完成使用前必读后进行操作步骤（专家系统入口）操作。

13.2 使用前必读

前提条件

参见《CANN 软件安装指南》安装Ascend-cann-toolkit开发套件包。

功能说明

专家系统工具支持如下瓶颈识别功能，每个子功能要求的输入数据不同，功能与输入
数据文件的对应关系如下：

● 算子优化分析：算子仿真文件

通过tmmodel仿真得到。参见自定义算子开发完成算子工程的创建和开发，运行
算子UT测试即可，无需手动获取文件。
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● 基于Timeline的AI CPU算子优化：

– om模型离线文件：om模型离线文件可通过多种方式生成，例如ATC工具转
换，参见模型转换。

– Profiling Task Scheduler任务调度文件：启动专家系统功能后自动拉起
Profiling获取数据，无需手动配置。

● 算子融合推荐：

– om模型离线文件：可通过多种方式生成，例如ATC工具转换，参见模型转
换。

– Profiling Summary文件：使用op_Summary.csv文件和l2_cache.csv文件，启
动专家系统功能后自动拉起Profiling获取数据，无需手动配置。

● 基于Roofline模型的算子瓶颈识别与优化建议：

– cce代码：可通过ATC工具添加--op_debug_level=4得到，或用户自行在算子
编译时保存。参见《ATC工具使用指南》。

– Profiling Task Scheduler任务调度文件：启动专家系统功能后自动拉起
Profiling获取数据，无需手动配置。

– om模型离线文件：可通过多种方式生成，例如ATC工具转换，参见模型转
换。

● TransData算子识别：

– om模型离线文件：可通过多种方式生成，例如ATC工具转换，参见模型转
换。

– Profiling Summary文件、Profiling基本信息文件（主要获取文件中当前芯片
版本的基本信息）：参见启动专家系统功能后自动拉起Profiling获取数据，
无需手动配置。

输入数据文件名及保存路径请参见输入数据。

输入数据

专家系统当前功能要求准备的输入数据如表13-2所示，用户可以提供其中一种或多种
数据的组合，每种瓶颈识别模型需要的数据及获取方式见功能说明。

表 13-2 专家系统输入数据

输入数据 存储目录 说明

core0_instr_popped_l
og.dump，算子仿真
文件

core0_instr_log.dump
，算子仿真文件

{project_location}/
out/model/tm/
{opname}/
{casename}

自动识别算子工程中的路径，无需
手动指定。

作用于算子优化分析功能。功能配
置请参见操作步骤（算子工程入
口）

请确保算子仿真文件大小在100MB
以内，否则无法执行专家系统分
析。
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输入数据 存储目录 说明

task_time_xxxx.json，
Profiling Task
Scheduler任务调度文
件

${data_path}/data/
profiling/
PROF_XXX

启动专家系统功能后自动拉起
Profiling获取数据，无需手动配
置。

作用于基于Timeline的AI CPU算
子优化和基于Roofline模型的算子
瓶颈识别与优化建议功能。功能配
置请参见操作步骤（专家系统入
口）。

请确保Profiling Task Scheduler任
务调度文件大小在100MB以内，否
则无法执行专家系统分析。

xxx.csv
Profiling Summary文
件

${data_path}/data/
profiling/
PROF_XXX

启动专家系统功能后自动拉起
Profiling获取数据，无需手动配
置。

算子融合推荐的L2融合和
TransData算子识别功能需准备。
功能配置请参见操作步骤（专家系
统入口）。

请确保Profiling Summary文件大
小在100MB以内，否则无法执行专
家系统分析。

info.json.x
Profiling基本信息文件

${data_path}/data/
profiling/
PROF_XXX

启动专家系统功能后自动拉起
Profiling获取数据，无需手动配
置。

TransData算子识别功能需准备。
功能配置请参见操作步骤（专家系
统入口）。

请确保Profiling基本信息文件大小
在100MB以内，否则无法执行专家
系统分析。

resnet50.om，om模
型离线文件

${data_path}/data/
project

可在操作步骤（专家系统入口）中
指定。

基于Timeline的AI CPU算子优
化、算子融合推荐、基于Roofline
模型的算子瓶颈识别与优化建议和
TransData算子识别功能需准备。

请确保OM文件大小在1GB以内，
否则无法执行专家系统分析。

xxx.cce，cce代码 ${data_path}/data/
project

可在操作步骤（专家系统入口）中
指定。

基于Roofline模型的算子瓶颈识别
与优化建议功能需准备。

请确保CCE文件大小在100MB以
内，否则无法执行专家系统分析。
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输入数据 存储目录 说明

Executable File，执行
专家系统目标工程的
可执行文件

{project_location}/
out

可在操作步骤（专家系统入口）中
指定。

需要对用户应用下的模型进行精准
分析，指定Inference App模式时需
要准备此文件。

获取方式请参见Linux场景编译运
行。

注：${data_path}为数据目录根路径。

 

芯片支持情况

算子优化分析：昇腾310 AI处理器、昇腾710 AI处理器。

基于Timeline的AI CPU算子优化：昇腾310 AI处理器、昇腾710 AI处理器。

算子融合推荐：昇腾310 AI处理器、昇腾710 AI处理器。

基于Roofline模型的算子瓶颈识别与优化建议：昇腾310 AI处理器、昇腾710 AI处理
器。

TransData算子识别：昇腾310 AI处理器、昇腾710 AI处理器。

13.3 操作步骤（专家系统入口）

13.3.1 简介

专家系统功能的配置入口包括专家系统入口和算子工程入口。

本节主要介绍专家系统入口的配置方式，该入口可执行的专家系统分析功能包括：算
子融合推荐、基于Roofline模型的算子瓶颈识别与优化建议、基于Timeline的AICPU
算子优化和TransData算子识别功能。

说明

● 本功能当前支持在Linux和Windows系统下运行。

● 专家系统工具仅提供模型或算子的可优化项并给出优化建议，具体优化方式请开发者自行修
改代码。

13.3.2 配置步骤

通过以下步骤进入专家系统工具进行配置和分析：

步骤1 选择并打开已编译完成的应用工程。

步骤2 单击菜单栏“Ascend > Advisor”，弹出专家系统工具界面 。如图13-3所示。
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图 13-3 专家系统功能界面

步骤3 单击图13-3界面左上角“New Project” 按钮，打开专家系统配置界面，可选择
Remote Run和Local Run模式且每种模式下可选择OM only和Inference App专家系统
分析模式。如下各图所示。

图 13-4 Remote Run OM only（Linux）
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图 13-5 Remote Run Inference App（Linux）

图 13-6 Remote Run OM only（Windows）

MindStudio
用户指南 13 专家系统工具

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 525



图 13-7 Remote Run Inference App（Windows）

说明

● 配置完成后，Deployment和对应的Environment Variables、Remote CANN Path参数为绑
定关系，单击“Start”后参数值将被保存。再次配置时，如连接已配置过的Deployment，
则Environment Variables、Remote CANN Path参数自动填充，可手动修改。

● 配置Deployment映射路径关系（Mappings）时，须指定真实地址，否则无法启动专家系统
分析，界面提示“The specified Deployment Mappings Local Path does not exist.”

图 13-8 Local Run OM only
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图 13-9 Local Run Inference App

说明

● OM only模式下无需指定可执行文件，直接进行内置标准专家系统分析，但分析结果可能不
能完全体现用户应用的实际情况；Inference App模式需指定Executable File参数的可执行
文件main，可针对用户应用下的模型进行精准分析，结果更准确，但需要用户预先完成应用
开发。请根据实际需求选择相应模式。

● 不建议调用与当前用户不一致的其它用户目录下的可执行文件（Executable File）和OM模
型文件，避免提权风险。当选择其他用户下的文件时，系统将提示风险。如图13-10所示。

● Windows环境仅支持Remote Run模式。

图 13-10 提权风险提示

表 13-3 Executable Properties 参数说明

参数 说明

Run Mode ● Remote Run：远程运行。

● Local Run：本地运行。

Windows使用场景下仅支持Remote Run，该参数不展
示。
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参数 说明

Deployment 运行配置，选择Remote Run模式时可见，必选配置。
通过Deployment功能，详细请参见Deployment，可
以将指定项目中的文件、文件夹同步到远程指定机器的
指定目录。

Project Location 分析完成后的.json文件保存目录，默认为${HOME}/
AscendProjects/AscendAdvisor/untitled，必选配置，
可自定义。

Analysis Model 执行分析模式，必选配置，取值为：

● OM only：只对所选的om模型进行分析。该模式下
的可执行文件为内置标准可执行文件，无需手动指
定。

● Inference App：对当前用户的应用下执行OM模型
的分析，需指定Executable File参数的可执行文件
main。

OM only模式只对模型进行标准化分析，若需要对用户
应用下的模型进行精准分析请指定Inference App模
式。

OM Location 指定OM模型文件，获取方式参见功能说明，必选配
置。

CCE Code Location 指定CCE文件保存目录，获取方式参见功能说明，可选
配置。不指定本参数时，专家系统的分析结果精度可能
有所偏差。当前仅基于Roofline模型的算子瓶颈识别与
优化建议功能需要。

Executable File 执行专家系统目标工程的可执行文件目录，获取方式请
参见Linux场景编译运行，仅在指定Inference App模式
时展示，必选配置。须保证Remote Run模式下指定的
可执行文件能够在远端环境下正常编译与执行。

Python工程无需配置此参数。

Command Arguments 用户APP的执行参数，由用户自行配置，参数之间用空
格分隔，默认为空。

SOC Version 设置待分析文件所属设备的芯片版本。当前支持芯片
为：

● ascend310：表示待分析文件所属设备的芯片版本为
ascend310。

● ascend710：表示待分析文件所属设备的芯片版本为
ascend710。

请根据所在环境选择对应的芯片类型。

Environment Variables 环境变量配置。可以直接在框中输入也可以单击 后在

出的弹窗内单击 填写。可选配置。
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参数 说明

Remote CANN Path 远端运行环境CANN软件包安装路径，选择Remote
Run模式时可见，必选配置。例如配置为Ascend-cann-
toolkit安装目录/ascend-toolkit/{version}。

 

说明

● 专家系统分析过程较为复杂，会产生较多的临时文件，因此执行专家系统分析前，需预留足
够大的内存空间，否则可能造成进程终止。须进入服务器查看专家系统数据目录$
{data_path}/data/project所占空间大小，例如数据目录大小为100MB时，则需要预留1GB
的内存空间。

● 分析数据文件：算子仿真文件、Profiling数据文件和CCE文件的每个文件大小均不能超过
100MB；OM模型离线文件大小不能超过1GB。

● 专家系统支持多进程执行，可配置 大进程数，以及单线程 长运行时间。配置方式如下：

1. 进入专家系统工具安装目录下的conf目录，例如：

cd Ascend-cann-toolkit安装目录/ascend-toolkit/latest/tools/msadvisor/conf

2. 编辑目录下的advisor.conf文件，设置max_run_time（单进程 长运行时间，默认值
20s）和max_run_num（ 大进程数，默认值10）参数值。例如：

max_run_time = 20

max_run_num = 10

步骤4 完成配置后单击Start启动分析。完成分析后，展示分析结果如分析结果展示。

----结束

13.3.3 分析结果展示

说明

专家系统工具分析结果根据使用前必读中所准备的文件进行分析，一次分析输出所有功能的结
果，所以如果准备文件路径下未保存对应文件，则对应功能输出结果为空。

概览页

图 13-11 分析结果 Summary 页面（Model Performance Report）

表 13-4 Model Performance Report 字段说明

字段名 字段解释

Model Performance Report 模型性能分析报告。
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字段名 字段解释

Model Performance 性能优劣，取值为Good/Bad。根据总体性能数据汇
总计算得出。

Collection Info 汇总信息。

Cube Throughput Cube吞吐量，单位为GOps。

Vector Throughput Vector吞吐量，单位为GOps。

Aicore Time AI Core执行时间，单位为us。

Task Duration 任务执行时间，单位为us。

Chip Utilization 芯片利用率。数值达到80为优，显示为绿色；小于
80则为差，显示为红色。根据Pipeline Bound的数值
计算得出。

Pipeline Bound 流水利用率。

Cube Ratio Cube利用率。

Vector Ratio Vector利用率。

Scalar Ratio Scalar利用率。

MTE1 Bound MTE1瓶颈。

MTE2 Bound MTE2瓶颈。

MTE3 Bound MTE3瓶颈。

Tiling Strategy 内存读入量的数据切片策略。数值达到80为优，显
示为绿色；小于80则为差，显示为红色。根据
Memory Redundant的数值计算得出。

Memory Redundant 内存冗余量。

Real Memory Input(GB) 真实内存读入量，单位为GB。

Real Memory Output(GB) 真实内存写出量，单位为GB。

Theory Memory Input(GB) 理论内存读入量，单位为GB。

Theory Memory
Output(GB)

理论内存写出量，单位为GB。

Memory Read Redundant 内存读入冗余系数。真实内存读入量/理论内存读入
量。

Memory Write Redundant 内存写出冗余系数。真实内存写出量/理论内存写出
量。
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图 13-12 分析结果 Summary 页面（Computational Graph Optimization_UB Fusion
Recommendation）

表 13-5 Computational Graph Optimization_UB Fusion Recommendation 字段说明

字段名 字段解释

Computational Graph
Optimization

计算图优化。算子融合推荐功能专家系统分析建议。
分行展示可融合的算子。可点击栏目右上角See
More...”查看具体的可融合算子。

UB fusion operators need
to be optimized

需要进行UB融合的算子。

UB Fusion
Recommendation

UB融合推荐。栏目下方展示可融合算子。

Fusion Type 可融合算子类型。

Fusion Operator Detail 可融合算子详细信息，算子名称之间以逗号隔开。

Fusion Operator
Duration(us)

可融合算子的执行时间。单位为us。

 

图 13-13 分析结果 Summary 页面（Computational Graph Optimization_AIPP
Fusion Recommendation）

表 13-6 Computational Graph Optimization_AIPP Fusion Recommendation 字段说
明

字段名 字段解释

Fuse Cast/TransData with
Conv needs to be
optimized

需要进行AIPP首层算子融合的算子。

AIPP Fusion
Recommendation

AIPP融合推荐。栏目下方展示可融合算子。

Fusion Operator Detail 可融合算子详细信息，算子名称之间以逗号隔开。

Fusion Operator
Duration(us)

可融合算子的执行时间。单位为us。
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图 13-14 分析结果 Summary 页面（Computational Graph Optimization_TransData
Fusion Recommendation）

表 13-7 Computational Graph Optimization_TransData Fusion Recommendation 字
段说明

字段名 字段解释

TransData fusion
operators need to be
optimized.
Total time of TransData
task is xx(us), accounted
for xx% of the total task.

TransData算子需要优化。

TransData算子总时长xx(us)，占所有任务时间占比xx
%。

TransData Fusion
Recommendation

推荐消除的TransData算子。栏目下方展示可消除算子
信息。

Reshape_Ops_Interrupts_
Format

Reshape_Ops_Interrupts_Format的优化建议。

Attempt to modify the
model to avoid
discontinuous operations.

在不影响精度的情况下尽量避免非连续的操作。

Modify the model and
use clone and continuous
operations to break the
combination of multiple
non-consecutive
operations.

使用clone、contiguous将多个非连续操作的组合断
开。

Other_Transform Other_Transform的优化建议。

It is a reasonable scenario
that transdata operation
exists, for example, 4D to
5D before Conv2D.

这是TransData合理存在的场景，比如在Conv2D算子
之前，需要把格式由4D转为5D。

Op Name 算子名称

Task Duration(us) 算子执行持续时间。

Input Formats 算子输入格式。

Output Formats 算子输出格式。
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图 13-15 分析结果 Summary 页面（Computational Graph Optimization_L2Cache
Fusion Recommendation）

表 13-8 Computational Graph Optimization_L2Cache Fusion Recommendation 字
段说明

字段名 字段解释

L2 fusion operators need
to be optimized

L2融合算子需要优化。

L2Cache Fusion
Recommendation

L2Cache融合推荐。栏目下方展示可融合算子。

Fusion Operator Detail 可融合算子详细信息，算子名称之间以逗号隔开。

Fusion Operator
Duration(us)

可融合算子的执行时间。单位为us。

 

图 13-16 分析结果 Summary 页面（Roofline）

表 13-9 Roofline 字段说明

字段名 字段解释

Roofline 基于Roofline模型的算子瓶颈识别与优化建议Top3算
子信息。可点击栏目右上角See More...”查看详细结
果信息。

Top Ops 前三个算子。栏目下方展示Roofline模型的前三个可优
化算子基本信息。

Op Name 算子名称。

Aicore Time(us) AI Core运行时间，单位为us。

Bottleneck pathway 瓶颈通路，即工作点 靠近roofline的通路。

Bottleneck Rate 瓶颈率，即工作点占roofline上限的百分比。

Bottleneck Pipeline 占比 高的流水。

Pipeline Rate 流水 高占比。

Bound Type 瓶颈分类。
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字段名 字段解释

Task Duration Ratio(%) Task耗时占比。

 

图 13-17 分析结果 Summary 页面（Model Graph Optimization）

表 13-10 Model Graph Optimization 字段说明

字段名 字段解释

Model Graph
Optimization

模型优化建议。

Top AICPU Ops 算子列表（按耗时从大到小排序）。

Operator name 算子名。

Task Start Time 任务开始时间

Task Duration Task耗时。

Task Duration Ratio Task耗时占比。

Recommendations of
aicpu operations
optimization

AICPU算子优化建议。

 

图 13-18 分析结果 Summary 页面（Operating Environment）

表 13-11 Operating Environment 字段说明

字段名 字段解释

Operating Environment 操作环境。

Host Operating System Host侧操作系统。

Host Computer Name Host侧计算机名称。

CPU Name CPU 名称。

CPU Name Type CPU 名称类型。

MindStudio
用户指南 13 专家系统工具

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 534



字段名 字段解释

Control CPU Type CtrlCPU类型。

Control CPU Number CtrlCPU数量。

TS CPU Number TS CPU数量。

AI CPU Number AI CPU数量。

 

Computational Graph Optimization 页面（算子融合推荐功能输出结果）

Computational Graph Optimization页面输出结果包含算子融合推荐和TransData算
子识别两个功能，本节介绍算子融合推荐功能。

图 13-19 分析结果 Computational Graph Optimization（算子融合推荐功能）

上图中各区域展示信息如下：

● 1区域：展示模型可视化界面，展示模型中所有算子并高亮可融合算子。

● 2区域：展示算子详细信息，需点击可视化界面中某个算子时展示该算子信息。

● 3区域：展示算子搜索栏，以算子名称形式显示模型中所有算子，可以搜索具体的
算子名称，点击搜索栏下放算子名称也可展示对应算子详细信息。

● 4区域：展示分析结果。对应字段解释请参见表13-5、表13-6和表13-8。

– 页签部分展示展示算子融合推荐的UB、AIPP、L2Cache融合功能分析结果页
签，点击可跳转到对应功能的分析结果。

– 列表部分展示可融合算子，一行展示一条可融合信息，各个算子名以逗号隔
开，内容过长的可将鼠标悬浮在对应行上方即可展示详细可融合算子，点击
对应的行则在可视化视图上会跳转到对应算子位置。
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说明

For more case references, please visit here.
有关算子融合推荐功能输出的结果分析可单击链接访问UB算子融合推荐分析样例。

若在结果界面上单击超链接，需要预先在Linux服务器上安装FireFox火狐浏览器。

Computational Graph Optimization 页面（TransData 算子识别功能输出结果）

Computational Graph Optimization页面输出结果包含算子融合推荐和TransData算
子识别两个功能，本节介绍TransData算子识别功能。

图 13-20 分析结果 Computational Graph Optimization（TransData 算子识别功能）

上图中各区域展示信息如下：

● 1区域：展示模型可视化界面，展示模型中所有算子并高亮可消除算子。

● 2区域：展示算子详细信息，需点击可视化界面中某个算子时展示该算子信息。

● 3区域：展示算子搜索栏，以算子名称形式显示模型中所有算子，可以搜索具体的
算子名称，点击搜索栏下放算子名称也可展示对应算子详细信息。

● 4区域：展示分析结果。对应字段解释请参见表13-7
– 页签部分单击TransData Fusion Recommendation展示TransData算子识别

分析结果页签。

– 下拉框部分为不同维度的优化建议。

– 列表部分展示可消除算子，一行展示一条可融合信息，点击对应的行则在可
视化视图上会跳转到对应算子位置。
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Roofline 页面（基于 Roofline 模型的算子瓶颈识别与优化建议功能输出结果）

图 13-21 分析结果 Roofline

上图中各区域展示信息如下：

● 1区域：展示专家系统分析结果Roofline模型的Channel通路。

– 1区域每一项对应3区域中某个工作点信息，勾选表示在3区域中展示，去勾选
表示不展示，默认全部勾选。

– 1区域的Channel通路与4区域工作点及线条颜色对应关系为：

▪ Cube：MTE1-蓝色；MTE2-绿色；MTE3-红色。

▪ Vector：MTE2-绿色；MTE3-红色；PIPE_V-黄色。

● 2区域：展示TopN算子信息，可选择展示Top3、Top5和Top10，支持搜索某个算
子。字段解释请参见表13-9。点击具体算子名可以在3区域展示对该算子专家系统
建议，4区域显示该算子对应的工作点及瓶颈信息。

● 3区域：展示具体存在瓶颈算子的专家系统建议，需要点击2区域的具体算子名。

说明

For more case references, please visit here.

有关算子融合推荐功能输出的结果分析可单击链接访问Roofline模型的优化分析样例。

若在结果界面上单击超链接，需要预先在Linux服务器上安装FireFox火狐浏览器。

● 4区域：展示以坐标轴方式Roofline模型专家系统分析结果。展示算子分别在Cube
和Vector计算单元下的算力情况以及理论算力和带宽。

– 坐标轴中的横坐标单位是Tops/byte，表示计算强度，每搬运1byte数据可以
进行多少次运算，越大表示内存搬运利用率越高。

– 纵坐标单位是FLOP/s，表示运算速度，越大表示运算越快。

– 线条转折部分将Roofline模型分成两个部分，斜线部分为Memory Bound
（内存限制），横线部分为Compute Bound（计算限制），且实际工作点
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（图中的彩色点）越靠近对应颜色的斜线，表示Bound越严重，为主要瓶颈
所在。

– 显示情况由1区域勾选情况决定，其中Multiple roofline overlap的斜线表示
有多条Channel通路输出带宽一致导致线条重合，可通过去勾选1区域中相同
输出带宽值的Channel项来确定对应斜线代表的是哪个Channel。

– 光标悬浮在工作点上方可显示对应工作点信息。

– 工作点按从大到小表示存在瓶颈问题的算子依次为Top1~Top3。

Model Graph Optimization 页面（基于 Timeline 的 AI CPU 算子优化功能输出结
果）

图 13-22 分析结果 Model Graph Optimization

上图中各区域展示信息如下：

● 1区域：展示专家系统基于Timeline的AICPU算子优化功能分析结果Top3AICPU算
子等待串行后的执行时间和优化建议。

● 2区域：展示专家系统AICPU算子优化建议

● 3区域：展示Profiling采集的Timeline视图。

说明

图13-22中2区域第5点建议为：“For more case references, please visit here.”提示有关算子
融合推荐功能输出的结果分析可单击链接访问基于Timeline的AI CPU算子优化分析样例。

若在结果界面上单击超链接，需要预先在Linux服务器上安装FireFox火狐浏览器。

13.4 操作步骤（算子工程入口）

13.4.1 简介
专家系统功能的配置入口包括专家系统入口和算子工程入口。

本节主要介绍算子工程入口的配置方式，该入口可执行的专家系统分析功能为：算子
优化分析。
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说明

● 本功能当前支持在Linux和Windows系统下运行。

● 专家系统工具仅提供模型或算子的可优化项并给出优化建议，具体优化方式请开发者自行修
改代码。

13.4.2 配置步骤
步骤1 参见自定义算子开发完成算子工程的创建和开发，并打开已完成开发的算子工程。

步骤2 单击算子工程界面“Run > Edit Configurations...”或单击图13-23所示菜单，进入运
行UT测试配置界面。

图 13-23 快捷方式进入运行配置界面

步骤3 配置算子参数时勾选“Enable Advisor”。如图13-24所示。

图 13-24 运行配置界面

只有当Test Type参数选择ut_impl，Target参数选择Simulator_TMModel，且Case
Names参数仅勾选一项Case时，才允许勾选“Enable Advisor”开启算子专家系统功
能；当Target选择其他选项或Case Names参数勾选多个case时，“Enable Advisor”
选项不显示。

步骤4 单击“OK”完成算子工程信息的配置。

步骤5 单击算子工程界面“Run >Run”或单击图13-25所示菜单，运行算子UT测试。

图 13-25 快捷方式运行测试
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步骤6 运行完成后专家系统的分析结果将在界面下方的日志打印窗口展示。分析结果如分析
结果展示。

----结束

13.4.3 分析结果展示

维度一：分析向量运算

通过分析仿真dump文件：

1. 算子Vector执行效率偏低时，找出执行效率低的Vector向量指令。

2. mte2搬运粒度较低导致Vector计算的输入数据较少。

3. 是否使能多核资源。

4. 多核场景下，核之间的Vector计算量是否分配均衡。

分析结果如下：

图 13-26 分析结果展示（Vector Bound）

在Vector Instruction展示结果任意一行右键可选择跳转到“TIK Code”或“CCE
Code”中算子对应的位置；当算子为非TIK算子时，无“TIK Code”跳转功能；另外
“CCE Code”代码跳转功能依赖于.cce和.asm文件，当工程目录（默认为
out>bin>kernel_meta）下这两个文件缺少任意一个，无跳转功能。如图13-27所
示。.asm文件在执行算子UT测试后自动生成，.cce文件的生成请参见设置代码跳转功
能进行配置。

图 13-27 跳转选项

表 13-12 Vector Bound 输出字段参数解释

字段 说明

Vector Bound 分析向量运算。

Instruction 指令名称。
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字段 说明

First PC 指令地址，根据取值仿真dump文件中可搜索到对应的重复向
量指令。

Execution Times 向量指令被重复执行的次数。

Repeat 即repeat_times参数，表示一条向量指令的重复迭代次数，取
值范围为(0,255]。

Mask 向量内参与计算的元素，取值范围为[1,128]，单位为bits。每
一个bit位用来表示vector的每个元素是否参与操作，bit位的值
为1表示参与计算，0表示不参与计算。

 

有关该算子优化分析的具体参数应用请参见《TBE自定义算子开发指南》中的“接口参
考>TBE TIK API>矢量计算>单目”章节。

优化建议：

1. Try to optimize vector instructions.

优化Vector指令。

2. Try to optimize out->ub data move instructions.

优化out->ub数据搬运指令。

3. Try to use multi-core resources.

使能多核。

4. Try to reallocate vector calculations to these cores: 0 1.

重新分配Vector计算数据到这些核：0 1

优化Vector指令可以通过修改向量指令参数mask和repeat_times，替代重复执行的向
量指令。

根据字段First PC的值从仿真dump文件中可搜索到对应的重复向量指令，如上图所示
Execution Times取值为64，Repeat取值为1，Mask取值为64，则该指令被重复执行了
10次，而一次执行只进行了一次迭代计算，每次只计算了该向量中的一位元素。那么
为了提高该指令的执行效率，可以通过修改算子代码中的repeat_times参数值为10，

后根据向量位数以及实际需求修改mask的值，修改后该指令只需执行一次即可完成
10次迭代计算并且每次计算都完成向量在场景下要求计算的所有元素，从而提升该条
指令执行的效率。

维度二：分析流水打断

根据仿真dump文件，针对占比 大的流水进行分析，主要从三个维度进行：

1. 其它流水导致的流水不连续。

2. 指令入队列导致的流水不连续。

3. pipe_barrier(PIPE_ALL)导致的流水打断。

根据分析的结果，对上述三个维度造成影响的周期数进行排序，结果展示如下：
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图 13-28 分析结果展示（Pipeline Interruption）

表 13-13 Pipeline Interruptions 输出字段参数解释

字段 说明

Pipeline
Interruption

分析流水打断。

Interruption
Factor

流水打断因素。

Affected Pipeline 受影响的流水。

Interruption
Cycles

流水打断的周期数。

Percentage to
Total

打断周期数占总周期数的百分比。

 

优化建议：

1. Try to use the double buffer for UB.

使用乒乓策略。

2. Reduce strong data dependencies between pipelines.

优化不合理的流水依赖。

3. Eliminate improper instruction syschronization between pipelines.

消除流水间不合理的指令同步。

4. Delete redundant pipe_barrier(PIPE_ALL).

删除冗余pipe_barrier（PIPE_ALL）指令。
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维度三：分析标量运算

根据仿真dump文件，统计Scalar标量指令执行次数和总的执行周期，按总的执行周期
的大小进行排序，选出Top5个Scalar标量指令，分析结果如下：

图 13-29 分析结果展示（Scalar Bound）

表 13-14 Scalar Bound 输出字段参数解释

字段 说明

Scalar Bound 分析标量运算。

Instruction 指令名称。

Execution Times 标量指令被重复执行的次数。

Execution Cycles 标量指令的总执行周期。

 

优化建议：

1. Try to adjust tiling policy.

调整tiling策略。

2. Try to optimize the implementation solution.

优化实现方案。

3. Try to replace instructions with poor performance.

替换性能差的指令。

13.5 专家系统分析样例参考

13.5.1 UB 算子融合推荐分析样例

背景介绍

算子是组成模型的基本单元。模型转换时，会进行算子融合来达到网络性能提升的目
的。当模型中存在算子融合规则未覆盖且可融合的算子时，模型转换完成则无法达到

优性能。本节以YOLOV5模型为例，介绍通过专家系统UB算子融合推荐功能自动发
现并输出模型中可融合的Cube和Vector算子，帮助用户快速定位可融合算子，提升模
型性能。
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说明

● 本文仅介绍专家系统UB算子融合推荐功能的操作及分析过程，对于om模型中算子融合的具
体操作此处不做阐述。

● 有关UB算子融合的详细介绍请参见《图融合和UB融合规则参考》。

● 有关模型转换的详细介绍请参见模型转换。

专家系统操作

步骤1 准备通过模型转换生成的om模型离线文件作为UB算子融合推荐功能的输入文件。

om模型离线文件存放路径为${data_path}数据目录根路径的project目录下。

步骤2 单击选择并打开已编译完成的应用工程。如图13-30所示。

图 13-30 打开已编译完成的工程

步骤3 单击菜单栏“Ascend > Advisor”，弹出专家系统工具界面 。如图13-31所示。

图 13-31 专家系统功能界面
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步骤4 单击图13-31界面左上角第二个图标，打开专家系统配置界面。

图 13-32 OM only

步骤5 如图13-32所示设置对应参数并单击Start执行分析。

步骤6 完成分析后，系统展示分析结果。输出YOLOV5模型内可融合算子如下。

图 13-33 分析结果 Summary 页面（Computational Graph Optimization）

----结束

问题分析

首先查看图13-33可以大致了解可融合算子类型和名称。再通过单击See More，可以
查看可融合算子在模型中的位置和明细，如图13-34所示。
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图 13-34 分析结果 Computational Graph Optimization 展示

问题解决

具体融合操作需开发者自行修改算子代码，完成融合后的模型结构示例如图13-35所
示。

图 13-35 YOLOV5 网络模型结构（局部）

图中以YOLOV5网络模型的Conv2D、Mul和AscendQuart算子融合为Conv2D算子为
例，左侧部分为融合前的YOLOV5网络模型结构，右侧部分为优化后的YOLOV5网络模
型结构，可以看到优化后模型结构得到了简化。

结论

通过专家系统工具对om模型的UB算子融合分析可知专家系统工具可以快速准确定位
到模型中的可融合算子，减少用户的定位时间，提升效率。
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13.5.2 基于 Timeline 的 AI CPU 算子优化分析样例

背景介绍

AI CPU是昇腾AI处理器计算单元，因为该CPU计算处理单位自身瓶颈，导致运行在AI
CPU上的算子影响模型的执行时间。AI CPU算子的优化往往是重点关注点和优化对
象。本节以MLP模型为例，介绍通过专家系统AI CPU识别功能， 自动识别串行执行AI
CPU算子，给出优化建议，提升模型整体性能。

专家系统操作

步骤1 单击选择并打开已编译完成的应用工程。如图13-36所示。

图 13-36 打开已编译完成的工程

步骤2 单击菜单栏“Ascend > Advisor”，弹出专家系统工具界面 。如图13-37所示。

图 13-37 专家系统功能界面

步骤3 单击专家系统功能界面左上角第二个图标，打开专家系统配置界面。
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图 13-38 OM only

步骤4 如图13-38所示设置对应参数并单击Start执行分析。

步骤5 完成分析后，系统展示分析结果。输出MLP模型内的AI CPU算子如下。

图 13-39 分析结果 Summary 页面（Model Graph Optimization）

----结束

问题分析

根据专家系统AI CPU算子识别的推荐结果，发现计算图中两个Cast算子和Equal算子都
在AI CPU上执行，需要考虑将Cast算子和Equal算子在AI CPU上消除。

由于Cast算子的作用是将算子输出结果进行格式转换，且在AI Core上的运算仅支持32
位及以下的数据类型，根据图13-40，可推测下层的Equal算子数据类型应该在32位以
上，所以生成了负责数据格式转换的Cast算子且这两个算子转移到了AI CPU上进行运
算。
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图 13-40 MLP 网络模型结构（局部）

问题解决

根据优化建议3. Change the modelstructure, for example, from INT64 to FP16.（更
改模型结构，如：int64转FP16。）

可将Equal算子数据类型修改为与上层ArgMaxD算子一样的数据类型，即可消除掉Cast
算子并将Equal算子转移回AI Core上运算。

修改Equal算子后再次进行专家系统分析可以发现Cast算子和Equal算子已不在AI CPU
算子优化分析结果中，同时还输出UB融合推荐发现还可以对ArgMaxD和Equal算子进
行融合，进一步提升效率。相关分析方式请参见UB算子融合推荐分析样例。

结论

通过专家系统工具的分析，可以快速找出AI CPU算子。并根据专家系统的提示，结合
实际的网络模型实际特点，对问题分析后得到解决方案。提升了网络性能问题分析效
率。

13.5.3 Roofline 模型的优化分析样例

背景介绍

Davinci芯片架构复杂化，人工基于Profiling数据识别性能瓶颈，门槛高、耗时长。
Roofline模型以运算强度为横轴、每秒浮点运算次数为纵轴画图，描述芯片 佳性能和
实际运行负载特性，反馈优缺点，给出优化方向。

专家系统操作

步骤1 准备模型mobilenetv3，通过Profiling采集生成的profiling文件，ATC转换生成的OM
文件、cce文件作为Roofline功能的输入文件。文件路径为${data_path}数据目录根路
径。
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步骤2 单击选择并打开已编译完成的应用工程。如图13-41所示。

图 13-41 打开已编译完成的工程

步骤3 单击菜单栏“Ascend > Advisor”，弹出专家系统工具界面 。如图13-42所示。

图 13-42 专家系统功能界面

步骤4 单击图13-42界面左上角第二个图标，打开专家系统配置界面。
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图 13-43 OM only

步骤5 如图13-43所示设置对应参数并单击Start执行分析。

步骤6 完成分析后，系统展示分析结果。输出mobilenetv3模型的Roofline分析结果如下。

图 13-44 分析结果 Roofline 展示

----结束

问题分析

1. 命令行结果展示TopN算子信息，字段解释如下。结果按照AICore Time降序排
列，优先解决时间占比高的算子问题。
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Op Name 算子名称。

AICore Time(us) AI Core运行时间，单位为us。

Bottleneck pathway 瓶颈通路，即工作点 靠近roofline的
通路。

Bottleneck Rate 瓶颈率，即工作点占roofline上限的百
分比。

Bottleneck Pipeline 占比 高的流水。

Pipeline Rate 流水 高占比。

Bound Type 瓶颈分类。

 
2. 根据Roofline结果，可以快速获取当前模型的性能瓶颈点以及性能瓶颈通路。其

中，AICore Time与Bottleneck Rate可以综合衡量模型优化收益，如
MobilenetV3/Conv/Conv2D的瓶颈率为25.91%，算子时间为293.7us，若优化后
能提升到80%，收益估计为200us。

3. 以下举例说明几个算子的分析过程：

a. 根据Roofline结果，MobilenetV3/Conv/Conv2D算子为L2->L1 latency
memory bound，bound ratio=25.91%。分析该算子的流水并行度，发现该
算子耗时 大的为MTE2流水，占算子总耗时的91.50%，可知该算子阻塞点
在MTE2流水搬运。可以检查数据搬运粒度是否过小，或存在搬运依赖。

b. MobilenetV3/expanded_conv/depthwise/depthwise 算子为L1->L0A
latency memory bound，bound ratio=35.45%。首先分析该算子的流水并
行度，发现该算子耗时 大的为MTE2流水，占算子总耗时的46.66%，低于
80%, 可知流水并行存在问题。

c. MobilenetV3/expanded_conv_3/squeeze_excite/AvgPool 算子，距离屋顶
近的数据通路为L2->UB，bound ratio=13.86%，算子属于latency bound，
首先进行流水并行度 分析，发现占比 大的Vector Pipeline，占比85.11%，
说明流水并行度较好。但是Vector Pipeline耗时占比 大，在Roofline里面确
实latency bound说明Vector的计算过程存在问题。需要分析Vector问题。

问题解决

1. 不同的算子需要根据算子的具体问题具体制定解决策略，专家系统的算子瓶颈分
析推荐可以参考《算子优化分析样例》的部分，这里不再重复介绍。这一节主要
介绍如何根据专家系统Roofline模型的优化建议，快速识别性能问题。

2. 例子1：分析MobilenetV3/expanded_conv/depthwise/depthwise算子的性能问
题。根据专家系统的分析结果可知，该算子硬件利用率低，且各通路的瓶颈占比
都很低，该算子为流水并行存在问题。根据优化建议“Reduce strong data
dependencies between pipelines”，首先分析该算子各流水之间是否存在同步依
赖。查看算子仿真流水图如下。MTE2流水中间存在很长一段时间的空闲时间，并
且MTE2流水阻塞了MTE1 流水。确实存在流水打断的问题。
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图 13-45 流水打断

3. 原始cce代码中首先使用MTE2搬运很大一部分Featuremap去进行cube计算，在
cube计算结束后进行第二部分 Featuremap的搬运。

因此可以调整第二次Featuremap搬运指令的位置，将第二次Featuremap的搬运
放到第一次搬运后面，这样第一次搬运完成之后可以直接进行第二次搬运。减少
不同指令之间的数据依赖。

4. 另外，根据优化建议“Eliminating improper instruction synchronization
between pipelines”，代码中可能存在不合理的同步指令。分析CCE代码，发现
代码中两条流水之间有pipe_barrier(PIPE_ALL) 指令。可以删除该指令进行优化。

结论

通过专家系统工具的分析，可以快速找出模型的Top瓶颈问题。并根据不同的瓶颈类
型，给出对应的优化建议。根据优化意见，可以有针对性的进行性能分析，提升了模
型调优效率。
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14 操作指南

14.1 SSH连接管理

14.2 Deployment

14.3 CMake编译配置

14.4 工程管理

14.5 运行管理

14.6 设备管理

14.7 CANN管理

14.8 全局环境变量设置

14.9 日志管理

14.10 常用快捷键

14.11 全局依赖的Python SDK设置

14.1 SSH 连接管理

14.1.1 使用约束
为了安全起见，建议对SSH连接到的服务器进行以下加固操作：

● Linux系统用户的口令加密算法，推荐使用SHA256或者SHA512。

● SSH服务端配置文件中，对以下配置项进行加固：

– MACs：指定允许在SSH-2中使用哪些消息摘要算法来进行数据校验，多个算
法之间使用逗号分隔。目前支持算法：hmac-sha2-256、hmac-sha2-512、
hmac-sha2-256-etm@openssh.com以及hmac-sha2-512-
etm@openssh.com。

– Ciphers：指定SSH-2允许使用的加密算法，多个算法之间使用逗号分隔。禁
止CBC模式的加密算法用于SSH2.0协议中（如AES128-CBC、AES256-
CBC）。目前支持算法：aes128-gcm@openssh.com和aes256-
gcm@openssh.com。
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– HostkeyAlgorithms：指定SSH-2允许使用的身份认证公钥算法，多个算法之
间使用逗号分隔。目前支持算法：ssh-ed25519（要求OpenSSH6.5级以上版
本）、rsa-sha2-512以及rsa-sha2-256。其中rsa的长度需大于等于
3072bits。

– KexAlgorithms：指定SSH-2允许使用的密钥加密算法，多个算法之间使用逗
号分隔。目前支持算法：curve25519-sha256、curve25519-
sha256@libssh.org以及diffie-hellman-group-exchange-sha256。
OpenSSH6.7开始支持curve25519密钥交换算法。

– PermitRootLogin：是否允许root登录。建议禁止root用户可以直接登录。

● MindStudio对工程内文件类型不做校验，需要确认上传文件的文件类型正确。

● 为了MindStudio客户端能连接，服务端需要配置如下算法：

ciphers aes128-gcm@openssh.com,aes256-gcm@openssh.com
macs hmac-sha2-256,hmac-sha2-512,hmac-sha2-256-
etm@openssh.com,hmac-sha2-512-etm@openssh.com
hostkeyalgorithms ssh-ed25519,rsa-sha2-512,rsa-sha2-256
kexalgorithms curve25519-sha256,curve25519-sha256@libssh.org,diffie-
hellman-group-exchange-sha256
服务端修改方式参考如下：

a. 执行如下命令编辑配置文件。
vi /etc/ssh/sshd_config

请用户修改文件对应行，如果找不到对应行，则新增即可。

b. 重启ssh服务。

● 请保存好SSH用户名密码，不要共享给不信任的用户，以免造成环境破坏等影
响。

● 为防止SSH暴力破解，建议用户在SSH端设置登录控制策略。

14.1.2 概述

配置入口
● 在菜单栏依次选择File > Settings... > Tools > SSH Configurations进入SSH连接配

置。

● 在欢迎界面依次选择Customize> All Settings... > Tools > SSH Configurations进
入SSH连接配置。
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图 14-1 SSH 配置

说明

SSH连接配置界面左侧展示SSH连接配置项别名，如果没有别名，显示格式为
<username>@<host>:<port>，右键单击可修改别名。单击要查看的SSH连接配置项，可以在右
侧详细面板中查看参数配置。

参数及图标说明

表 14-1 参数及图标说明

参数及图标 说明

Host 连接目标地址（IP或域名）。

Port 连接目标地址的端口号。

User name 登录目标地址的用户名。
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参数及图标 说明

Authentication type 身份验证方式。有两种方式可选：

● PASSWORD：通过密码验证身份。

● KEY_PAIR：通过密钥验证身份，可以自行参考通用方
式申请SSH密钥。

说明

● 对于Euler2.8、2.10 aarch架构、银河麒麟 V10 SP1
aarch架构、OpenEuler、Ubuntu20.04和CentOS8.2，
使用KEY_PAIR方式来通过密钥验证身份时，需要使用
ssh-keygen -m PEM或者ssh-keygen -t rsa -m PEM命
令来申请SSH密钥。

● 申请SSH密钥时，建议设置Passphrase不为空，且符合
以下口令复杂度：

● 口令长度至少8个字符。

● 口令必须包含如下至少两种字符的组合：

● 至少一个小写字母

● 至少一个大写字母

● 至少一个数字

● 至少一个特殊字符：`~!@#$%^&*()-_=+\|
[{}];:'",<.>/? 和空格

● 当选择KEY_PAIR方式时，默认保存配置过的私钥文件。

Password Authentication type选择验证方式为Password时显示，
需要填写对应用户名的密码，勾选Save password复选框
可以保存密码。

说明
如果没勾选save password。那么密码自动会在24小时后清除，
届时再次使用到ssh会弹出密码输入框，需要再次输入密码方能
执行ssh任务。

Private key file Authentication type选择验证方式为KEY_PAIR时显示，
选择本地私钥文件。

Passphrase Authentication type选择验证方式为KEY_PAIR时显示，
需要填写对应密语。勾选Save password复选框可以保存
密语。

Test Connection 单击该按钮测试连接是否成功。

新增SSH连接配置。

删除SSH连接配置，选中需要删除的SSH连接配置，单击
该按钮删除。

OK 保存SSH配置，单击OK按钮保存、应用SSH连接当前配
置，并关闭配置界面。

Cancel 取消当前配置，单击Cancel按钮不保存当前配置，并关
闭配置界面。

Apply 应用SSH配置，单击Apply按钮保存并应用SSH连接当前
配置。
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参数及图标 说明

Lock the current
connection

选项置灰，用户不可操作。如果SSH连接被添加到集群管
理中，则该选项会自动勾选，SSH连接被锁定，不可修改
和删除。

 

14.1.3 新增 SSH 连接

步骤1 参见配置入口进入SSH连接配置界面。

步骤2 单击界面左侧导航栏上方 按钮。

步骤3 根据参数及图标说明配置参数后，单击“OK”或“Apply”。

----结束

14.1.4 删除 SSH 连接

步骤1 参见配置入口进入SSH连接配置界面。

步骤2 选择要删除的SSH连接配置项，单击界面左侧导航栏上方 按钮。

步骤3 单击“OK”或“Apply”。

----结束

14.1.5 SSH 密码保存方式

步骤1 参见配置入口进入SSH连接配置界面。

步骤2 进入密码保存方式界面有如下方式：

● 在左边的导航栏选择“Appearance & Behavior > System Settings >
Passwords”。

● 在搜索栏中输入“Passwords”。
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图 14-2 密码保存方式界面

步骤3 选择密码保存方式。

● In KeePass

● Do not save，forget passwords after restart

说明

两种密码保存方式的详细说明请参见《IntelliJ IDEA使用说明》中的“Passwords”章
节。

步骤4 单击“OK”或“Apply”。

----结束

14.1.6 开启 SSH Remote Terminal 窗口

概述

通过开启SSH Remote Terminal窗口功能，可以在MindStudio IDE界面上对SSH连接
环境进行命令行操作。

前提条件

已有配置好的SSH连接，详细操作请参见新增SSH连接。

操作步骤

步骤1 在菜单栏选择Tools > Start SSH session...。

弹出“Select Host to Connect”弹窗。
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步骤2 单击需要开启Remote Terminal窗口的SSH连接。

在MindStudio IDE界面下方显示远端窗口信息，可直接进行命令行操作。

图 14-3 Remote Terminal

说明

为防止SSH长时间保持会话可能存在的安全风险，建议用户在服务端设置SSH会话超时时间。

----结束

14.2 Deployment
通过Deployment功能可以将指定的文件、文件夹同步到远程指定机器的指定目录。

步骤1 在菜单栏选择File > Settings…。

在左边的导航栏选择“Tools > Deployment”，进入图14-4。

图 14-4 Deployment 界面
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表 14-2 参数及图标说明

参数及图标 说明

新增Deployment同步信息。单击此按钮，将弹出新建服
务器命名窗口，输入服务器名字，单击“OK”，界面将
显示需要配置的“Connetion”、“Mappings”及
“Excluded Path”。

删除Deployment同步信息，选中需要删除的
Deployment同步信息，单击该按钮删除。

指定Deployment同步信息为默认信息，选中
Deployment同步信息，单击该按钮，即可指定远程服务
器信息为默认信息。再单击一次该按钮，即可取消默
认。

OK 保存工具链配置，单击OK按钮，工具链配置生效，并关
闭配置界面。

Cancel 取消当前配置，单击Cancel按钮，不保存当前配置，并
关闭配置界面。

Apply 应用SSH配置，单击Apply按钮保存并应用工具链。

 

步骤2 配置远程服务器连接。

图 14-5 Connection
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表 14-3 参数及图标说明

参数及图标 说明

Type 文件传输协议类型。目前仅支持SFPT。

SSH configuration
SSH远程连接。单击 或 可选择已配置的SSH连

接，如果没有需要的SSH连接，可单击 ，在弹出的窗
口中的 图标配置SSH连接。

Test Connection 单击该按钮测试连接是否成功。

 

步骤3 （必选）配置映射路径关系。

图 14-6 Mappings

表 14-4 参数及图标说明

参数及图标 说明

新增映射路径关系信息。

删除映射路径信息。选中需要删除的路径映射关系信
息，再单击此按钮，即可删除指定的路径映射关系信
息。
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参数及图标 说明

Local Path 本地项目文件夹路径。单击对应文本框，将自动识别已
打开的项目文件夹路径，也可通过在文本框中手动输入
或单击文本框右侧文件夹图标进行配置。

Deployment Path 本地项目文件夹路径映射到远端服务器中的路径。可通
过在文本框中手动输入或单击文本框右侧文件夹图标进
行配置。

 

步骤4 （可选）配置排除路径信息，用户根据需要配置。

图 14-7 Excluded Paths

表 14-5 参数及图标说明

参数及图标 说明

新增排除路径信息。单击此按钮，可选择“Deployment
Path”或“Local Path”，分别对应 和 图标。

删除排除路径信息。选中需要删除的排除路径信息，再
单击此按钮，即可删除指定的路径映射关系信息。

排除远端服务器中的路径。通过在文本框手动输入或单
击文件夹图标进行配置，配置生效后，将排除对该路径
下的所有子目录文件和本目录文件进行上传、下载操
作。
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参数及图标 说明

排除本地路径。通过在文本框手动输入或单击文件夹图
标进行配置，配置生效后，将排除该路径下的所有子目
录文件和本目录文件进行上传、下载操作。

 

步骤5 单击“Apply”，Deployment配置生效。

当在使用run/debug项目时，会触发Deployment同步功能。

如果需要自动触发Deployment功能，可进行如下操作实现：

1. 在菜单栏选择File > Settings… 。
在左边的导航栏选择“Tools > Deployment”进入Deployment界面，将指定远程
服务器信息为默认远程服务器。

2. 在菜单栏选择“Tools > Deployment > Automatic Upload”。

----结束

注意

针对上传过程，deployment会将mapping中的“Local Path”完全映射于对应的
“Deployment Path”，若本地有a、b和c文件，而远端“Deployment Path”中有d
文件，上传的结果是远端对应目录下只有a、b和c文件，d文件会被删除。针对下载过
程，不会使用完全映射过程，如远端有a、b、c文件，本地有d文件，下载的结果是本
地对应目录存在a、b、c和d文件。

14.3 CMake 编译配置
通过Toolchains功能可以快速配置C/C++工程本地和远程编译的功能。

本地编译配置

步骤1 在菜单栏选择File > Settings…。

在左边的导航栏选择“Tools > Toolchains”，进入图14-8。
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图 14-8 配置工具链界面

步骤2 单击“+”按钮，Linux配置工具链为“SYSTEM”，如图14-9所示；Windows配置工
具链为“MinGW”，如图14-10所示。

图 14-9 Linux 配置工具链 SYSTEM
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图 14-10 Windows 配置工具链 MinGW

表 14-6 参数及图标说明

参数及图标 说明

Name Toolchains配置名称。

Environment mingw的路径，配置环境变量后可自动识别，也可通过

手动输入或点击右侧 进行配置。

说明
Linux环境下无此选项。

Cmake 本地服务器中的Cmake路径，也可通过手动输入或点击

右侧 进行配置。

Make 本地服务器中的Make路径，也可通过手动输入或点击右

侧 进行配置。

C Compiler 本地服务器中的C Compiler路径，也可通过手动输入或

点击右侧 进行配置。

C++ Compiler 本地服务器中的C++ Compiler路径，也可通过手动输入

或点击右侧 进行配置。
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参数及图标 说明

Debugger 本地服务器中的Debugger路径，也可通过手动输入或点

击右侧 进行配置。

新增工具链配置。

删除工具链配置，选中需要删除的工具链配置，单击该
按钮删除。

OK 保存工具链配置，单击OK按钮，工具链配置生效，并关
闭配置界面。

Cancel 取消当前配置，单击Cancel按钮，不保存当前配置，并
关闭配置界面。

Apply 应用SSH配置，单击Apply按钮保存并应用工具链。

 

工具链生效后会在左边的导航栏“Tools > Toolchains”中自动生成一条信息，以供编
译配置选择。

----结束

远程编译配置

步骤1 在菜单栏选择File > Settings…。

在左边的导航栏选择“Tools > Toolchains”，进入图14-11。

图 14-11 配置工具链界面
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步骤2 单击“+”按钮，配置工具链“Remote Host”。

图 14-12 配置工具链 Remote Host

表 14-7 参数及图标说明

参数及图标 说明

Name Toolchains配置名称。

Credentials
SSH配置，点击 或 图标选择需要的SSH连接，如
果没有需要的SSH连接，可点击弹出窗口中的 图标进行
SSH连接配置。

Cmake 指定远端服务器中的Cmake路径，配置“Credentials”

后自动识别，也可通过手动输入或点击右侧 进行配
置。

Make 指定远端服务器中的Make路径，配置“Credentials”后

自动识别，也可通过手动输入或点击右侧 进行配置。

C Compiler 指定远端服务器中的C Compiler路径，配置
“Credentials”后自动识别，也可通过手动输入或点击

右侧 进行配置。
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参数及图标 说明

C++ Compiler 指定远端服务器中的C++ Compiler路径，配置
“Credentials”后自动识别，也可通过手动输入或点击

右侧 进行配置。

Debugger 指定远端服务器中的Debugger路径，配置
“Credentials”后自动识别，也可通过手动输入或点击

右侧 进行配置。

新增工具链配置。

删除工具链配置，选中需要删除的工具链配置，单击该
按钮删除。

OK 保存工具链配置，单击OK按钮，工具链配置生效，并关
闭配置界面。

Cancel 取消当前配置，单击Cancel按钮，不保存当前配置，并
关闭配置界面。

Apply 应用SSH配置，单击Apply按钮保存并应用工具链。

 

工具链生效后会在左边的导航栏“Tools > Deployment”中自动生成一条Deployment
信息，如图14-13所示。
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图 14-13 生成 Deployment 信息

----结束

14.4 工程管理

14.4.1 打开/关闭/移除

打开工程

如果用户之前创建过工程，则可以通过如下两种界面方式打开之前创建的工程。

● 在工程打开界面，依次选择"File > Open..."，选择工程所在路径后，弹出图14-14
所示界面。
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图 14-14 打开已有工程

选中相应工程，单击“OK”。

● 在工程欢迎界面，单击“Open”，在弹出界面中选择工程所在路径后，进入图
14-14所示界面，选择相应工程，单击OK。

若首次打开工程，将弹出如图14-15所示界面，表示MindStudio提供的功能可能会执
行此工程中的潜在恶意代码，打开工程前需进行确认。

图 14-15 信任窗口

● Trust projects in {此工程所在的目录}：信任此工程所在的目录下的所有工程。

● Trust Project：信任此工程。

● Preview in Safe Mode：在安全模式下预览此工程。

● Don't Open：不打开此工程。

若弹出如图14-16所示界面，说明已存在工程中的CANN版本与当前MindStudio中的
CANN版本不匹配，请单击OK，然后在弹出的界面中重新选择当前CANN Version即
可，然后单击OK关闭配置窗口。
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图 14-16 工程打开异常提示

打开 近工程

在已经有Project关闭的情况下，可以通过如下两种方式，打开 近使用的工程，方法
如下：

1. 依次单击菜单栏的“File > Open Recent”，在右侧弹出页面中选择想要打开的工
程，如图14-17所示中的工程。

图 14-17 Open Project

单击相应工程后弹出如图14-18所示页面。

图 14-18 工程打开提示

– 选择“This Window”，则直接在当前工作窗口打开选中工程。

– 选择“New Window”，则新建一个工作窗口打开选中的工程。

2. 依次单击菜单栏的 “File > Open Recent > Manage Projects…”，在弹出页面中
选择想要打开的工程，选中后会在新窗口中打开相应工程。

关闭工程

单击File菜单中的“Close Project”，会把当前已经打开的工程关闭。如果关闭的是
后一个工程，系统会弹出如图14-19所示界面。您可以根据需要选择重新打开已关闭工
程、切换到其他工程或者单击“New Project”新建工程。
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图 14-19 欢迎页面

移除工程

工程关闭后，如果您不想继续使用相关工程，可以选择将其移除。移除工程有两种方
法：

● 在图14-19所示界面中，使鼠标悬浮至想移除的工程上，单击右侧的 或者右击选
择“Remove from Recent Projects”。

● 单击File菜单中的“Open Recent > Manage Projects...”，在弹出图14-20页面中
使鼠标悬浮至想移除的工程上，单击右侧的 或者右击选择“Remove from
Recent Projects”。

图 14-20 Recent Projects

14.4.2 新建/删除文件

新建文件

在Projects视图中，选中相应工程，单击鼠标右键选择“New”（或者在File菜单中选
择New），在弹出的子菜单中选择需要创建的文件类型或直接单击File，在打开的对话
框中输入文件名（不需要输入文件类型对应的后 名）。示例：直接单击File后弹出的
页面如图14-21所示。

图 14-21 输入新建文件名
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若已经选择文件类型，则输入文件名后单击“OK”即可；若为图14-21所示新建文
件，输入文件名后回车，会弹出选择文件类型页面，如图14-22所示，用户可以根据需
要选择新建文件的类型。

图 14-22 选择新建文件类型

选择相关类型后，单击“OK”。

删除文件

选中文件，鼠标右键，在弹出的页面中单击“Delete...”，按照提示操作即可。

14.5 运行管理

14.5.1 修改运行配置

步骤1 在MindStudio主界面，在工具栏选择“Edit Configurations...”，如图14-23所示。

图 14-23 配置入口

步骤2 在界面左侧导航栏选择待修改的运行配置信息，并在右侧修改相应的配置信息。

步骤3 单击Apply，保存配置，单击OK关闭配置界面。

步骤4 单击工具栏的运行按钮运行工程，如图14-24所示。
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图 14-24 运行工程

----结束

14.5.2 中断运行和重新运行

如果想中断运行UT/ST测试用例，可以单击图14-25所示的 按钮，从而查看运行日
志打印。

图 14-25 运行中断按钮（任选其一操作）

如果想重新运行UT/ST测试用例，可以单击 按钮。

14.6 设备管理
本章节讲解如何通过MindStudio界面的Device Manager菜单管理设备信息。

设备管理功能提供了已经连接设备的信息展示，方便使用者对设备进行管理。

● 在MindStudio主界面，单击菜单栏“Ascend > Device Manager”，弹出设备管
理窗口。

● 在MindStudio快捷工具栏，单击 图标，弹出设备管理窗口，如图14-26所示。
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图 14-26 Device Manager 窗口

界面参数以及图标解释如表14-8所示。

表 14-8 设备管理界面参数以及图标说明

参数以及图标 说明

Alias 设备的别名，在有多个设备时，方便用户管理设备信息。默认格
式为<username>@<ip>:<port>。

Arch 设备所在系统的架构。

Connectivity MindStudio与设备连接状态：

● Connected：连接成功。

● Disconnected：连接失败。

编辑设备，单击该按钮可跳转到ssh管理界面，可参考SSH连接管
理进行设备连接信息修改。

刷新设备，检查设备连接状态，修改了设备信息后，可以通过单
击该按钮刷新设备显示信息。

 

14.7 CANN 管理

14.7.1 概述
CANN Manager为用户提供了在不重装MindStudio的前提下，切换以及更新Ascend-
cann-toolkit开发套件包版本的功能。使用该功能之前，请确保已经完成MindStudio以
及Ascend-cann-toolkit开发套件包的安装。

CANN管理入口：

● 在MindStudio工程界面菜单栏依次选择“File > Settings... >
Appearance&Behavior > System Settings > CANN”，弹出CANN Manager界
面。

MindStudio
用户指南 14 操作指南

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 576



● 在MindStudio工程界面菜单栏依次选择“Ascend > CANN Manager”，弹出
CANN Manager界面。

● 在MindStudio快捷工具栏，单击如下图标进入CANN Manager界面。

图 14-27 快捷工具栏进入 CANN Manager

● 在MindStudio欢迎页面依次选择“Customize > All settings... >
Appearance&Behavior > System Settings > CANN ”，弹出CANN Manager界
面。

以上4种方式打开的CANN Manager界面如图14-28或图14-29所示。

图 14-28 CANN Manager 界面（Linux 系统）

界面参数以及图标解释如表14-9所示。

表 14-9 CANN Manager 界面参数以及图标说明（Linux 系统）

参数以及图标 说明

CANN Location Ascend-cann-toolkit开发套件包的安装路径，默认为$HOME/
Ascend/ascend-toolkit/{version}，通过单击右侧的 可以进行
多版本CANN切换。

Change CANN 可以进行多版本Ascend-cann-toolkit开发套件包切换。

Package CANN包名称。
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参数以及图标 说明

Component 组件名称。

Version CANN版本号以及各软件包版本号。

Host OS Arch Host侧操作系统以及架构。

Activation 安装的Ascend-cann-toolkit开发套件包以及软件包是否激活，若
显示为Activated，则表示当前安装的CANN版本已经激活，
CANN功能可用。

Status Ascend-cann-toolkit开发套件包以及软件包的安装状态：

● Installed：Ascend-cann-toolkit开发套件包或软件包已经安
装。

● Not Installed：Ascend-cann-toolkit开发套件包或软件包未安
装。

只有安装且已经激活的CANN才可用。

CANN激活按钮。

只有该按钮为可编辑状态才允许该操作。

 

图 14-29 CANN Manager 界面（Windows 系统）

界面参数以及图标解释如表14-10所示。
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表 14-10 CANN Manager 界面参数以及图标说明（Windows 系统）

参数以及图标 说明

Remote
Connection

Ascend-cann-toolkit开发套件包所在远程环境IP地址。

Remote CANN
location

Ascend-cann-toolkit开发套件包的安装路径，默认为$HOME/
Ascend/ascend-toolkit/{sotftware version}。

Change CANN 可以进行多版本Ascend-cann-toolkit开发套件包切换。

Package CANN包名称。

Component 组件名称。

Version CANN版本号以及各软件包版本号。

Host OS Arch Host侧操作系统以及架构。

Activation 安装的Ascend-cann-toolkit开发套件包以及软件包是否激活，若
显示为Activated，则表示当前安装的CANN版本已经激活，
CANN功能可用。

Status Ascend-cann-toolkit开发套件包以及软件包的安装状态：

● Installed：Ascend-cann-toolkit开发套件包或软件包已经安
装。

● Not Installed：Ascend-cann-toolkit开发套件包或软件包未安
装。

只有安装且已经激活的CANN才可用。

 

14.7.2 切换/激活 CANN 包

切换 CANN
● Linux系统：

a. 请参考“概述”进入CANN管理页面，通过以下两种方式进入如图2 选择
Toolkit版本所示界面。
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图 14-30 选择 Toolkit 版本

▪ 单击CANN location右侧的 ，系统弹出Toolkit所在路径的页面。如图
14-30所示。

▪ 单击CANN管理页面中的“Install CANN”按钮，然后单击系统弹出的图

14-31所示界面的 。
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图 14-31 选择 Ascend-cann-toolkit 开发套件包安装路径

b. 选中需要替换的Toolkit版本，单击“OK”。弹出确认页面，如图14-32所
示。

图 14-32 确认页面

i. 选择“OK”，CANN切换到新版本，MindStudio重启后该CANN处于激
活状态。

ii. 若在切换CANN之前，已经有工程打开，则还会弹出图14-33、图14-34
所示界面，用于确认切换后的CANN版本信息。

图 14-33 CANN 未安装提示信息

MindStudio
用户指南 14 操作指南

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 581



图 14-34 确认 CANN 版本信息

iii. 选择“Cancel”，CANN切换到新版本，但是状态为未激活状态，此时

新版本CANN不可用。如果需要激活，请单击“ ”按钮，按照系统提
示操作即可。

● Windows系统：

a. 请参考“概述”进入CANN管理页面，单击页面右侧的“Change CANN”，
弹出切换CANN界面。

b. 选中需要替换的Toolkit版本，单击“OK”。弹出确认页面，如图14-35所
示。

图 14-35 确认页面

i. 选择“OK”，CANN切换到新版本，MindStudio重启后该CANN处于激
活状态。

ii. 若在切换CANN之前，已经有工程打开，则还会弹出图14-36、图14-37
所示界面，用于确认切换后的CANN版本信息。

图 14-36 CANN 未安装提示信息
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图 14-37 确认 CANN 版本信息

激活 CANN

注意

只有“ ”按钮处于非置灰状态时，即当系统存在已经安装但是未激活的CANN时，
才可以执行该操作。

请参考“概述”进入CANN管理页面，单击CANN对应的“ ”按钮，系统出现提示
页面。按照提示操作即可。

14.7.3 配置交叉编译环境
进入CANN管理页面，在CANN管理界面选择“Cross Compiler”页签，系统显示当前
激活状态的CANN需要安装的编译环境，如图14-38所示。如果Status显示“Not
installed”，请参见《MindStudio安装指南》的“配置编译环境”章节进行手动配
置。

说明

● MindStudio安装服务器环境下的Ascend-cann-toolkit开发套件包版本需要和运行环境下的
CANN软件包版本保持一致。

● MindStudio安装服务器环境下需要同时安装Ascend-cann-toolkit开发套件包和运行环境对应
的CANN软件包。
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图 14-38 配置交叉编译环境

配置完成后，重新启动MindStudio，再次进入CANN管理，可以看到“Status”变成
“Installed”。

14.8 全局环境变量设置
有以下三种方式进入全局环境变量设置界面：

● 在MindStudio工程界面菜单栏依次选择“File > Settings... >
Appearance&Behavior > System Settings > Global Environment Variables”，
弹出全局环境变量设置界面。

● 在MindStudio工程界面菜单栏依次选择“Ascend > Global Environment
Variables”，弹出全局环境变量设置界面。

● 单击MindStudio快捷工具栏 图标，弹出全局环境变量设置界面。

以上三种方式打开的全局环境变量设置界面如图14-39所示。
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图 14-39 全局环境变量设置

表 14-11 全局环境变量界面参数以及图标说明

参数以及图标 说明

添加全局环境变量按钮。单击此按钮会弹出新建全局变量窗口，
在窗口中需要输入以下参数项。

● Name：环境变量名，支持英文字母、数字、下划线、“-”，
长度需小于或等于128。必填项。

● Value：环境变量值。选填项。

单击“OK”即配置好全局环境变量，单击“Cancel”即退出新建
全局变量窗口。

删除全局环境变量按钮。选中已有的全局环境变量，再单击此按
钮，即可删除全局环境变量。

修改全局环境变量按钮。选中已有的全局环境变量，再单击此按
钮，会弹出修改全局变量窗口,即可修改全局环境变量。

OK 单击此按钮，当前页面配置好的全局环境变量生效并退出该页
面。

Cancel 单击此按钮，取消在当前页面的操作并退出该页面。

Apply 应用全局环境变量按钮，单击此按钮，当前页面配置好的全局环
境变量生效。
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14.9 日志管理

14.9.1 使用前必读

工具简介

MindStudio为昇腾AI处理器提供覆盖全系统的日志收集与日志分析解决方案，提升运
行时算法问题定位效率。MindStudio提供全系统统一的日志格式，并以图形化的形式
提供跨平台日志可视化分析能力及运行时诊断能力，提升日志分析系统的易用性。

通过Log工具，您可以进行以下操作：

● 日志管理

● 设置日志级别

在MindStudio窗口底部单击“+Log”标签，显示“Log”窗口，您可以通过该窗口查
看日志信息，如图14-40所示。

图 14-40 log 界面

说明

● localhost默认始终置顶存在，用于查看本地的系统运行日志。

● 在Windows系统下，使用SSH连接时，目标地址不能是Windows本身的服务器地址。

● 在Linux系统下使用Log工具打开文件夹和文件功能，需要使用nautilus、gedit软件；如果系
统未安装此软件，请使用MindStudio安装用户执行以下命令进行安装。

● Ubuntu18.04-x86/aarch系统：sudo apt-get install nautilus gedit。

● EulerOS2.8-aarch系统、Centos7.6-x86/aarch系统和银河麒麟OS V10 SP1-aarch系
统：sudo yum install nautilus gedit。

● Centos8.2-x86/aarch系统：sudo dnf install nautilus gedit。

● log文件默认使用gedit软件打开，配置命令为xdg-mime default
org.gnome.gedit.desktop text/x-log。

14.9.2 日志管理

在“Log”窗口的System Log页签里，您可以查看系统运行日志，操作步骤如下：
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说明

● MindStudio不支持通过界面方式删除设备上的System Log日志。如需对日志进行管理：

● RC场景：请使用root用户登录到设备侧，对/var/log/npu/slog目录下的日志进行管理操
作。

● EP场景：请使用连接到的SSH用户对$HOME/ascend/log/目录下的日志进行管理操
作。

● 进行系统日志查看前，需要已添加Device设备，才能获取到Device设备的相关日志。

● 对于已安装芯片的Windows服务器，日志落盘路径为C:\Program Files\Huawei\Ascend\alog
\device-{device-id}，需登录此服务器才能对日志进行管理操作。

步骤1 在MindStudio界面的“Log”窗口，单击“System Log”页签，在显示的设备列表
中，选中某个设备，展开该设备的日志列表。

图 14-41 日志列表（RC 模式下）

图 14-42 日志列表（EP 模式下）

MindStudio
用户指南 14 操作指南

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 587



步骤2 双击日志列表中某日志文件，展示日志内容。

说明

本处 多展示该日志文件中 新的5000条日志，且 多展示1M的日志内容。

图 14-43 System log 页签（RC 模式下）

图 14-44 System log 页签（EP 模式下）

步骤3 在System Log页签，您可以进行如下操作。

● 单击 图标： 提供查询功能，按关键字搜索日志内容。

● 单击 图标：清除显示的日志。

● 单击 图标： 打开日志文件，展示该日志文件的全部日志内容。

● 单击 图标：打开日志文件下载到的IDE所在机器的本地存储
路径。

----结束

14.9.3 设置日志级别
Log工具提供界面方式修改系统的日志级别，设置日志级别方法：

步骤1 在MindStudio界面的“Log”窗口，单击“System Log”页签，在显示的Device设备
列表中，选中某个设备，单击右键，选择“Set Log Level”。如图14-45所示。

图 14-45 选择 Set Log Level
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步骤2 在弹出“Set Log Level”窗口，您可以设置日志级别。如图14-46所示。

说明

● 日志级别说明请参考《日志参考》。

● 执行修改日志级别后，针对PCIe场景，如果重启昇腾AI处理器，Device侧日志级别将恢复为
系统默认级别。

图 14-46 Set Log Level 窗口

步骤3 设置日志级别后，单击“OK”。

----结束

14.10 常用快捷键
本节介绍IntelliJ IDEA的常用快捷键，了解更多内容请参考相关官方文档。

表 14-12 常用快捷键

快捷键 说明

Alt + 左方向键 切换当前已打开的窗口中的子视图，比如Debug窗口中有
Output、Debugger等子视图，用此快捷键就可以在子视图中切
换（必备）

Alt + 右方向键 按切换当前已打开的窗口中的子视图，比如Debug窗口中有
Output、Debugger等子视图，用此快捷键就可以在子视图中切
换（必备）

Alt + 前方向键 当前光标跳转到当前文件的前一个方法名位置（必备）

Alt + 后方向键 当前光标跳转到当前文件的后一个方法名位置（必备）

Ctrl + = 展开代码

Ctrl + - 折叠代码

Ctrl + / 注释光标所在行代码，会根据当前不同文件类型使用不同的注释
符号 （必备）

Ctrl + F 在当前文件进行文本查找（必备）

Ctrl + R 在当前文件进行文本替换（必备）

Ctrl + Z 撤销（必备）
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快捷键 说明

Ctrl + Y 删除光标所在行或删除选中的行（必备）

Ctrl + X 剪切光标所在行或剪切选择内容

Ctrl + C 复制光标所在行或复制选择内容

Ctrl + D 复制光标所在行或复制选择内容，并把复制内容插入光标位置下
面 （必备）

Ctrl + W 递进式选择代码块。可选中光标所在的单词或段落，连续按会在
原有选中的基础上再扩展选中范围 （必备）

Ctrl + E 显示 近打开的文件记录列表（必备）

Ctrl + N 根据输入的类名查找类文件（必备）

Ctrl + G 在当前文件跳转到指定行处

Ctrl + Q 光标所在的变量/类名/方法名等上面，显示文档内容

Ctrl + Alt + L 格式化代码，可以对当前文件和整个包目录使用（必备）

Ctrl + Alt + O 优化导入的类，可以对当前文件和整个包目录使用（必备）

Ctrl + Shift + F 根据输入内容查找整个项目或指定目录内文件（必备）

Ctrl + Shift + R 根据输入内容替换对应内容，范围为整个项目或指定目录内文件
（必备）

 

14.11 全局依赖的 Python SDK 设置
本章节讲解如何设置全局依赖的Python库。

步骤1 在工程界面中，单击菜单栏中的“File > Project Structure”，进入“Project
Structure”设置页面。

步骤2 在左侧菜单栏中选择“Platform Settings > SDKs”，参考图14-47添加Python库。

图 14-47 添加全局 Python 库
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说明

● 从Interpreter后面的 选择解析器版本，需要选择python3.7.5版本。

● System Interpreter表示使用本地Python解释器，若选用以下四种方式，您需要提前安装依
赖并配置python镜像，安装依赖包括conda、pipenv等。

1. Virtualenv Environment：使用虚拟管理环境，在创建Python虚拟环境的目录下创建独
立的Python库和解释器，创建好后，会在创建目录下重新根据当前用户的~/.pip/pip.conf
文件中配置的PIP源通过PIP工具进行库的下载。

2. Conda Environment：选择Anaconda python解释器并利用conda创建虚拟环境。

3. Pipenv Environment：整合了virtualenv与pip，可同时创建虚拟环境并进行库管理功
能。

4. SSH Interpreter：远程Python解释器。通过SSH方式添加远程设备的Python SDK，并通
过Deployment功能，详细请参见Deployment，可以将指定项目中的文件、文件夹同步
到远程指定机器的指定目录。

步骤3 添加完成后，请确保算子开发相关Python库已存在，包括：te、topi等。

如下图示例所示：

图 14-48 查看 Python 库

步骤4 在Project Structure窗口中单击“Apply”。

步骤5 单击“OK”，关闭Project Structure窗口。

----结束
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15 MindStudio 管理（Linux）

15.1 查询MindStudio版本

15.2 启动MindStudio

15.3 停止MindStudio

15.4 更新MindStudio

15.5 卸载MindStudio

15.1 查询 MindStudio 版本
安装完成后您可以通过如下方式查询所安装MindStudio版本是否正确。

● MindStudio安装完成后，在欢迎界面中，单击左下角的设置图标，再单击
“About”，查看所安装的版本信息，如图15-1所示。

图 15-1 查询版本号
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● 进入MindStudio工程页面，单击菜单栏的“Help > About”弹出版本信息，查看
版本信息是否正确。

说明

图15-1中的版本号只是样例，请以实际安装的版本为准。

15.2 启动 MindStudio
如果用户关闭了MindStudio，想要重新启动，则可以参见如下方式操作：

使用MindStudio的安装用户，进入软件包解压后的“MindStudio/bin”目录，执行如
下命令启动MindStudio：

./MindStudio.sh

启动MindStudio后，查询进程命令为：

ps -ef|grep idea

说明

如果启动MindStudio时，提示无法为对象堆保留足够空间，请参见如何解决设置超大内存后无
法启动MindStudio处理。

15.3 停止 MindStudio

如果用户想要关闭MindStudio，在MindStudio运行界面直接单击窗口右上角的 退
出即可。

15.4 更新 MindStudio

手动更新

建议使用 新版本的MindStudio，以便获得 新功能。

MindStudio为绿色版软件，如果用户想更新版本，请参见卸载MindStudio章节卸载已
安装的MindStudio， 然后参见《MindStudio安装指南》重新安装新版本
MindStudio。

通过 IDE 界面检测更新 MindStudio

步骤1 在MindStudio主界面，单击菜单栏中“Help > Check for Updates...”，在界面的右下
角弹出更新提示，如图15-2所示。

图 15-2 更新提示
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说明

如果界面右下角的提示信息为“No IDE or plugin updates available”，则说明MindStudio当
前版本已经是 新版本。

步骤2 单击提示信息中的“Update...”。

步骤3 弹出如图15-3或图15-4所示更新界面，显示当前 新版本的MindStudio相关信息，请
根据弹出界面进行升级。

● 若弹出如图15-3所示更新界面，单击“Download”，跳转至 新MindStudio软
件包获取页面，下载 新版本的软件包。 新包下载完成后请参见卸载
MindStudio章节卸载已安装的MindStudio， 然后参见新版本的《MindStudio安
装指南》重新安装新版本MindStudio，更新完毕。

图 15-3 更新界面 1（示例）

– Ignore This Update：忽略此次更新，退出更新界面。

– Remind Me Later：提醒稍后进行更新。

– Download：跳转至 新MindStudio软件包获取页面。

● 若弹出如图15-4所示更新界面，请执行步骤4和步骤5。
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图 15-4 更新界面 2（示例）

– Ignore This Update：忽略此次更新，退出更新界面。

– Remind Me Later：提醒稍后进行更新。

– Update and Restart：更新并重启MindStudio。

步骤4 单击“Update and Restart”，开始更新并重启MindStudio。

● 如果升级包下载完毕并验证无问题，提示以下信息，如图15-5所示，单击
“Restart”重启MindStudio后进入步骤5。

图 15-5 Restart

● 如果升级包下载完毕后提示本次下载升级包出现的问题，例如如图15-6所示，建
议单击“Open download page”进入MindStudio软件下载页面，获取 新软件
包后手动升级IDE。

图 15-6 Open download page

步骤5 补丁文件包下载完成后，开始升级MindStudio，如图15-7所示。
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图 15-7 Update

在升级的过程中，MindStudio的部分可执行文件和配置信息等由于版本不一致会提示
修改等信息，提示信息示例如图15-8所示。

图 15-8 提示信息

● Cancel：取消升级MindStudio，等待当前版本MindStudio自动重启。

● Proceed：继续升级MindStudio，自动重启后进入新版本MindStudio。

----结束

说明

MindStudio升级完成后，请将CANN更新至配套版本。

15.5 卸载 MindStudio
如果用户不再使用MindStudio与Ascend-cann-toolkit开发套件包功能，则可以参见该
章节将其卸载。如果用户只卸载Toolkit，则请慎重，可能会造成MindStudio其他功能
不可用。如果用户想更换Ascend-cann-toolkit开发套件包版本，则可以参见CANN管
理章节安装新版本Ascend-cann-toolkit开发套件包。

手动卸载 MindStudio
用MindStudio的安装用户，在linux系统的$HOME目录下删除MindStudio安装包解压
后的目录：MindStudio。

删除命令为：

rm -rf MindStudio
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● 卸载MindStudio不会删除如下目录中的数据：

– $HOME/.cache/Huawei/MindStudioMS-{version}：MindStudio安装以及启
动后的运行日志等信息。

– $HOME/.config/Huawei/MindStudioMS-{version}：用户配置数据。

– $HOME/.mindstudio：包含Toolkit安装路径（mindstudio.properties文
件）、MindStudio隐私声明界面用户所做的操作信息等配置文件。

– AscendProjects：用户创建的工程。

● 如果用户想要完全恢复MindStudio初始配置，则请使用MindStudio安装用户进入
$HOME目录分别执行如下命令，删除用户配置数据：
rm -rf .cache/Huawei/MindStudioMS-x.x/
rm -rf .config/Huawei/MindStudioMS-x.x/
rm -rf .mindstudio/
rm -rf {用户创建的工程路径}

手动卸载 Ascend-cann-toolkit 开发套件包

请参见《CANN 软件安装指南》中的卸载章节。
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16 MindStudio 管理（Windows）

卸载 MindStudio
如果用户不再使用MindStudio，则可以参见该章节将其卸载。如果用户想更换
Ascend-cann-toolkit开发套件包版本，则可以参见CANN管理章节安装新版本Ascend-
cann-toolkit开发套件包。

步骤1 进入C:\Users\个人用户目录下，删除.mindstudio文件夹。

步骤2 卸载MindStudio安装包。

● 当要卸载的是由MindStudio_{version}_win.zip免安装压缩包得到的
MindStudio，删除解压后的文件即可。卸载MindStudio不会删除如下目录中的数
据，如有需要，请删除对应路径下的文件：

– C:\Users\个人用户\AppData\Local\Huawei\MindStudioMS-{version}\：
MindStudio的缓存和历史记录。

– C:\Users\个人用户\AppData\Roaming\Huawei\MindStudioMS-{version}\：
MindStudio的设置和插件。

● 当要卸载的是由MindStudio_{version}_win.exe安装包得到的MindStudio，进入
MindStudio安装路径下的bin目录，双击Uninstall.exe，弹出卸载MindStudio界
面，选择需要卸载的项，单击Uninstall进行卸载。
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图 16-1 MindStudio 卸载界面

勾选项 说明

Delete MindStudio {Version} caches
and history

删除MindStudio的缓存和历史记录。
勾选该项，将删除对应C:\Users\个人
用户\AppData\Local\Huawei\目录下
的MindStudioMS-{version}文件夹。

Delete MindStudio {Version} settings
and plugins

删除MindStudio的设置和插件。勾选
该项，将删除C:\Users\个人用户
\AppData\Roaming\Huawei\目录下
的MindStudioMS-{version}文件夹。

 

说明

如果用户使用了算子样例功能，则卸载MindStudio不会删除从CANN包中同步的开发样例工
程，即{MindStudio安装路径}\plugins\ascend-foundation\samples\operator_demo_projects
\下的内容，如不需要该部分的内容，请手动删除。

----结束

通过 IDE 界面检测更新 MindStudio
步骤1 在MindStudio主界面，单击菜单栏中“Help > Check for Updates...”，在界面的右下

角弹出更新提示，如图16-2所示。

图 16-2 更新提示
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说明

如果界面右下角的提示信息为“No IDE or plugin updates available”，则说明MindStudio当
前版本已经是 新版本。

步骤2 单击提示信息中的“Update...”。

步骤3 弹出如图16-3或图16-4所示更新界面，显示当前 新版本的MindStudio相关信息，请
根据弹出界面进行升级。

● 若弹出如图16-3所示更新界面，单击“Download”，跳转至 新MindStudio软
件包获取页面，下载 新版本的软件包。 新包下载完成后请参见卸载
MindStudio章节卸载已安装的MindStudio， 然后参见新版本的《MindStudio安
装指南》重新安装新版本MindStudio，更新完毕。

图 16-3 更新界面 1（示例）

– Ignore This Update：忽略此次更新，退出更新界面。

– Remind Me Later：提醒稍后进行更新。

– Download：跳转至 新MindStudio软件包获取页面。

● 若弹出如图16-4所示更新界面，请执行步骤4和步骤5。
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图 16-4 更新界面 2（示例）

– Ignore This Update：忽略此次更新，退出更新界面。

– Remind Me Later：提醒稍后进行更新。

– Update and Restart：更新并重启MindStudio。

步骤4 单击“Update and Restart”，开始更新并重启MindStudio。

● 如果升级包下载完毕并验证无问题，提示以下信息，如图16-5所示，单击
“Restart”重启MindStudio后进入步骤5。

图 16-5 Restart

● 如果升级包下载完毕后提示本次下载升级包出现的问题，例如如图16-6所示，建
议单击“Open download page”进入MindStudio软件下载页面，获取 新软件
包后手动升级IDE。

图 16-6 Open download page

步骤5 补丁文件包下载完成后，开始升级MindStudio，如图16-7所示。
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图 16-7 Update

在升级的过程中，MindStudio的部分可执行文件和配置信息等由于版本不一致会提示
修改等信息，提示信息示例如图16-8所示。

图 16-8 提示信息

● Cancel：取消升级MindStudio，等待当前版本MindStudio自动重启。

● Proceed：继续升级MindStudio，自动重启后进入新版本MindStudio。

----结束

说明

MindStudio升级完成后，请将CANN更新至配套版本。
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17 附录

17.1 安全加固建议

17.2 公网URL

17.3 FAQ

17.1 安全加固建议
● 63342~63391端口段是MindStudio的内置Server服务端口段，可用于打开本地的

web服务、html文件和xml文件等。为了提高安全性，建议此端口段仅支持本地使
用，在防火墙中不要对其他设备开放。

● 6942~6991端口段是MindStudio进程单实例绑定端口段，用于防止启动多个IDE
进程，并不用于通信。为了提高安全性，建议此端口段仅支持本地使用，在防火
墙中不要对其他设备开放。

● 在执行远程运行等操作时，会把相关文件传输到远端。为了提高安全性，建议远
端用户的umask值设置为0027，远端路径尽量选择个人用户路径。如果对ONNX
算子编译时出现异常，需要自行将依赖包google/protobuf目录权限值设置为
755。

● 尽可能依赖本用户安装的CANN包；或者至少保证安装CANN包的普通用户是可信
任的。以避免提权风险。
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17.2 公网 URL
表 17-1 公网 URL 说明

序号 URL地址 说明

1 ● https://ascend-repo.obs.cn-
east-2.myhuaweicloud.com/
MindStudio/Upgrade/
updates.xml

● https://ascend-repo.obs.cn-
east-2.myhuaweicloud.com/
MindStudio/Upgrade/

MindStudio检查更新地址

2 https://plugins.jetbrains.com/
files/brokenPlugins.json

Intellij插件市场地址

3 https://plugins.jetbrains.com/
plugins/list

Intellij插件市场更新地址

4 https://download-
cdn.jetbrains.com/jdk/feed/v1/
jdks.json.xz

JAVA工程的JDK下载地址

5 https://bbs.huaweicloud.com/
forum/forum-945-1.html

建议或意见反馈地址

6 https://www.jetbrains.com/help/
idea/

帮助地址

7 https://www.jetbrains.com/help/
idea/sharing-your-ide-
settings.html#settings-repository

共享IDE配置帮助地址

8 https://www.hiascend.com 昇腾官网地址

 

17.3 FAQ

17.3.1 Windows 上远程打开 MindStudio 时，偶现复制的内容无法
粘贴到编辑器窗口中

问题现象

Windows上远程打开MindStudio时，偶现复制的内容无法粘贴到编辑器窗口中。

解决方案

步骤1 MobaXterm自带划取复制能力，导致打开的MindStudio也带上该能力，可以设置
disable “select on copy”来解决，如下图所示。
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步骤2 打开MindStudio的“Settings”页面，选择“Tools > Terminal”，取消勾选“Copy
to clipboard on selection”选项，如图17-1所示。

图 17-1 MindStudio 设置

----结束
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说明

也可以当复制内容之后，在MindStudio编辑器窗口中光标不要再次选中内容，直接将复制的内
容粘贴到对应位置即可解决。

17.3.2 MobaXterm 启动 MindStudio 编辑字符时，偶现方向键变
成数字

问题现象

MobaXterm启动MindStudio编辑代码或者在MindStudio配置界面输入字符时，偶现
方向键变成2468的数字。

解决方案

卸载或者切换不使用搜狗输入法，然后用MobaXterm远程连接启动MindStudio。

17.3.3 配置不受信任的网址访问浏览器
UT用例运行结束后，如果需要通过浏览器打开覆盖率html文件，可能会出现图17-2所
示提示。

图 17-2 提示

请单击菜单栏中的“File > Settings”，参考图17-3修改。
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图 17-3 勾选 Allow unsigned requests

17.3.4 如何解决中文显示乱码和界面显示不全不规整问题

问题现象
● 例如在新建APP应用工程时，中文显示乱码，例如README_CN.md文件，如图

17-4所示。

图 17-4 中文显示乱码
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● 界面显示不全不规整，例如标题显示不全，如图17-5所示。

图 17-5 标题显示不全

解决方法

请自行安装微软雅黑字体(msyh.ttc)。

17.3.5 如何解决代码 大行宽与参考值不一致问题

问题现象

打开工程目录下的文件时，代码 大行宽与参考值不一致，参考值一般默认为120。如
图17-6所示。

图 17-6 代码 大行宽与参考值不一致

解决方法

步骤1 在MindStudio主界面选择“File > Settings > Editor > Color Scheme > Color Scheme
Font”，进入字体选择界面，如图17-7所示。

MindStudio
用户指南 17 附录

文档版本 01 (2022-06-14) 版权所有 © 华为技术有限公司 608



图 17-7 Color Scheme Font

步骤2 在“Font”参数后的下拉框中选择与当前字体不一致的字体，单击“Apply > OK”，
返回工程目录下的文件查看代码 大行宽与参考值是否一致。

● 是，操作完成。

● 否，重复进行步骤步骤1~步骤2直至代码 大行宽与参考值一致。

说明

如果在等宽字体中未能找到合适字体，请把“Show only monospaced fonts”参数前的小
方框去掉勾选，在等宽字体除外的其他字体中进行选择。

----结束

17.3.6 使用 MindInsight 查看训练工程日志信息时显示浏览器无法
连接

问题现象

使用MindInsight可视化，单击“View”查看训练工程日志信息。打开Web UI，可视
化查看实时训练信息，显示浏览器无法连接，如图17-8所示。
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图 17-8 浏览器无法连接

解决方法

步骤1 进入MindStudio后台，编辑sshd_config配置文件。
vi /etc/ssh/sshd_config

步骤2 将AllowAgentForwarding由no改成yes后保存退出。

步骤3 重启sshd服务使修改生效。
systemctl restart sshd.service

步骤4 再次开启MindInsight可视化，单击“View”查看训练工程日志信息。

----结束

17.3.7 如何获取帮助和提出建议
在使用MindStudio的过程中，如果想查看更多相关信息，请直接在MindStudio主界面
的菜单栏中单击“Help > MindStudio Help”，该操作会连接网络并跳转至昇腾社区
MindStudio（https://www.hiascend.com/software/mindstudio）查看。

如有任何问题想要咨询或者提出改进建议，请直接在MindStudio主界面的菜单栏中单
击“Help > Ascend Developer Zone”，该操作会连接网络并跳转至昇腾论坛
（https://bbs.huaweicloud.com/forum/forum-945-1.html）进行反馈。

说明

使用MindStudio Help和Ascend Developer Zone功能时需要使用浏览器登录网页，如果未安
装浏览器，请用户自行安装。
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图 17-9 更多信息和帮助

17.3.8 自动保存文件的设置方法

通过以下设置，可实现MindStudio空闲15s后自动保存文件，避免因异常情况导致文件
因未保存丢失。

打开MindStudio的“Settings”页面，选择“Appearance & Behavior > System
Settings”，勾选“Save files if the IDE is idle for xx seconds”选项，如图17-10所
示。可根据个人情况设置具体时间。

图 17-10 自动保存

17.3.9 如何解决 MindStudio 界面闪退后，重新启动 MindStudio
时提示进程已存在

问题描述

由于网络异常等原因导致MindStudio界面闪退。用户重新启动MindStudio，报错提示
已有进程存在。如图17-11所示。
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图 17-11 提示信息

解决方法

步骤1 执行ps -ef | grep java命令查看后台进程。找到对应的进程号PID，例如713。

步骤2 执行kill -9命令关闭已有进程。例如执行kill -9 713命令关闭713进程。

步骤3 执行./MindStudio.sh重新启动MindStudio。

----结束

17.3.10 如何解决分屏显示两个 MindStudio 工程时，目标工程打开
精度比对功能窗口显示在另一个工程上

问题描述

同时打开两个MindStudio工程并分屏显示，在其中一个工程中打开精度比对功能窗口
时，精度比对窗口显示在另一个工程上。

解决方法

先单击目标工程名称以聚焦此工程，再打开精度比对功能窗口，如下图所示。

17.3.11 C 语言 printf 信息在 Debug 时 Console 中概率性没有内容
输出

问题现象

C语言printf信息在Debug时Console中概率性没有内容输出。

解决方案

这是gdb内部的bug，可以通过setbuf或setvbuf设置无缓冲，或者printf后主动调用
fflush及时输出缓冲来规避该问题。
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17.3.12 在 Windows 系统环境下创建训练样例工程时报错“Unzip
failed. There is probleam occurred when unzipping file.”

问题现象

在Windows系统环境下创建训练样例工程时，弹出报错对话框，提示“Unzip failed.
There is probleam occurred when unzipping file.”

解决方案

修改环境变量TMP，指向非用户目录下的其他有读写权限的目录，如D:\temp。
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17.3.13 创建训练样例工程时报错“Download failed. Please see
the log for more detail. You can also download sample from
https://www.hiascend.com/software/modelzoo manually.”

问题现象

创建训练样例工程时，弹出报错对话框，提示“Download failed. Please see the log
for more detail. You can also download sample from https://www.hiascend.com/
software/modelzoo manually.”

解决方案

1. 检查网络是否为连通状态，若网络不通则先将网络调试为连通状态。

2. 若网络为连通状态，则查看日志，若日志出现如下图中字段“No module named
'requests'”，则需要进入命令行界面执行命令“pip3 install requests”安装
requests模块。

日志落盘路径为：
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– Linux：/home/XXXX/.cache/Huawei/MindStudioMS-XX/log/idea.log
– Windows：C:\Users\XXX\AppData\Local\Huawei\MindStudioMS-XX\log

\idea.log

17.3.14 如何解决设置超大内存后无法启动 MindStudio

问题描述
● 在Windows启动MindStudio失败。

● 在Linux启动MindStudio时，报错“Cound not reserve enough space for xxx
object heap”，提示信息如下。

问题原因

用户在菜单栏选择“Help > Change Memory Settings”，弹出的Memory Settings窗
口（以图17-12为例）中设置的运行内存大小超过启动运行主机的内存大小。如主机内
存为512MB，而用户设置内存为2014MB。

图 17-12 Memory Settings（Linux）

设置的运行内存大小应在256~2147483647范围内。若超过该范围，单击“Save and
Restart”，将提示“The value should be an integer”。

解决方法

访问用户目录下的mindstudio64.exe.vmoptions文件，修改-Xmx参数的值，设置一个
合理的大小，该值至少小于主机内存。

● Windows端：C:\Users\个人用户\AppData\Roaming\Huawei\MindStudioMS-
{version}\mindstudio64.vmoptions
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● Linux端： ~/.config/Huawei/MindStudioMS-{version}/mindstudio64.vmoptions

17.3.15 在 Linux 端使用 MindStudio 时出现阻塞，等待不定时间方
可恢复

问题描述
● 启动MindStudio时出现界面卡住，且控制台阻塞在日志输出“WARN -

o.ssh.connection.utils.KMCUtil - start init kmc”。

● 使用MindStudio时出现阻塞，且查看/root/.cache/Huawei/MindStudioMS-
x.x/log/idea.log，有如下日志报错“WARN - o.ssh.connection.utils.KMCUtil -
kmc warn entropy may not enough, entropy_avil=2,
read_wakeup_threshold=64”。

问题原因

曾在如图17-13SSH连接配置界面设置保存密码。SSH插件使用KMC加密套件做密码保
存。而/dev/random产生随机数的原理是利用当前系统的熵池（random pool）来计算
出固定一定数量的随机比特，然后将这些比特作为字节流返回。熵池就是当前系统的
环境噪音，熵指的是一个系统的混乱程度，系统噪音可以通过很多参数来评估，如内
存的使用，文件的使用量，不同类型的进程数量等等。如果当前环境噪音变化的不是
很剧烈或者当前环境噪音很小，比如设备刚启动时产生的随机数熵值不足，/dev/
random会阻塞当前的程序，直到根据熵池产生新的随机字节之后才返回。当熵源不足
时，使用haveged组件进行补熵。
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图 17-13 SSH 连接

解决方法

通过添加haveged服务解决随机数阻塞问题。

步骤1 检查操作系统是否安装haveged服务。

● 对于CentOS、OpenEuler、EulerOS 、Kylin系统，执行以下命令进行检查。
/bin/rpm -qa | grep -w "haveged"

● 对于Ubuntu系统，执行以下命令进行检查。
dpkg -l | grep -w "haveged"

若没有回显数据，则表示未安装haveged服务。

步骤2 安装haveged服务。

● 对于CentOS、OpenEuler、EulerOS 、Kylin系统，执行以下命令进行安装。
sudo yum install haveged

● 对于Ubuntu系统，执行以下命令进行安装。
sudo apt-get install haveged

步骤3 检查服务是否已经启动。
systemctl status haveged.service

● 回显包含“Active: active (running)”信息，表示服务已启动。

● 回显包含“Active: inactive (dead)”信息，表示服务未启动，执行以下命令启动
服务。
systemctl start haveged.service

步骤4 设置该服务开机自启动。
 systemctl enable haveged.service

----结束
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17.3.16 基于 MindX SDK 开发应用，运行应用工程时，出现“can
not find the element factory : mxpi_xxxpostprocessor”

问题描述

使用MindX SDK时，出现“can not find the element factory :
mxpi_xxxpostprocessor”，先在“$HOME/Ascend/mindx_sdk/
<sdk_version_package>/opensource/bin”路径下执行./gst-inspect-1.0
mxpi_xxxpostprocessor(插件名) 检查插件，发现插件能够正常加载，但运行时仍然报
同样的错误信息。

原因分析

gstreamer的历史缓存没有清除。

解决方法

步骤1 确认环境已安装python3.9，将“libpython3.9.so.1.0”拷贝至/usr/lib64/路径下。

步骤2 执行以下命令（根据具体运行环境选择x86_64.bin或者aarch64.bin）清除gstreamer的
历史缓存，再运行程序即可。
rm ~/.cache/gstreamer-1.0/registry.x86_64.bin

----结束

17.3.17 编译时出现依赖不存在的报错“libgfortran.so.4: No such
file or directory”

原因分析

opensource文件中的so文件需要依赖libgfortran.so.4，在编译环境中找不到。

解决方案

执行以下命令安装gfortran。

apt-get update
apt-get install gfortran-4 （如果环境中找不到gfortran-4，也可以安装>=4的版本）
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